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Predmluva

Ucebni text Matematika s programem Maple vznikl prepracovanim puvodniho dila ,Matema-
tickd analyza — cviceni s pouzitim Maple®, které vzeslo z feseni projektu FRVS ¢. 2785 /2010,
rozsitenim o nékteré nové funkcionality pritomné v pozdéji vydanych verzich systému Ma-
ple, tj. verzich 15 a 16, a doplnénim o kapitolu vénovanou linearni algebie. Soucasné byly
odstranény nékteré znamé nedostatky predchoziho textu. Text jesté neni dokoncéen. Posledni
aktualizace: 12. 3. 2013.

Nejviditelngjsi zménou uvedenou v Maple 16 je vylepSeni vizualizace. Veskeré grafy vy-
padaji mnohem lépe a profesiondlnéji. Dalsi novinkou jsou matematické aplikace zvané Math
Apps prinasejici interaktivni vyukové demonstraéni dokumenty. Oproti verzi Maple 14 byly
také vylepseny ruzné pomocné nastroje jako napt. InverseTutor pro vykresleni funkce a jeji
inverze do jednoho grafu spolu s osou symetrie. Nakonec jesté uvedme funkcionalitu zva-
nou Clickable Math nabizejici moznosti upravy/vyhodnoceni/vykresleni zobrazeného vyrazu
(rovnice).

V matematice je zvykem vynechavat symbol pro nasobeni, tecku, mezi vyrazy, které spolu
nasobime. Dostavame tak napt. vyrazy 3z, 27, xy ve skutecnosti predstavujici 3-x,2 -7,z -y.
Prestoze je soucasna verze systému Maple jiz natolik ,,chytra* a umi s vyrazy timto zpusobem
pracovat (tj. vynechavat symbol pro ndsobeni), je pii tom tieba velké opatrnosti a predevsim
zacinajicim uzivatelim vynechdvani symbolu pro nasobeni nemuzeme doporucit. Z tohoto
duvodu je ve vsSech ptikazech systému Maple i v samotném textu dusledné dodrzovano
vkladani symbolu pro ndsobeni, byt to nékdy pusobi nezvykle (viz napi. 2 - 7).

I pfes mnohé kontroly se v textu mohou nachézet chyby. Autor bude vdéény za upozornéni
na jakoukoli chybu, pfipadné navrh na vylepsSeni.



1 Uvod do systému Maple

1.1 Systém Maple

vvvvvv

problému. S jeho pomoci také muzeme vytvaret dokumenty vysoké kvality, prezentace a in-

teraktivni uzivatelské nastroje. Maple patii do skupiny systému pocitacové algebry umoznujici
jak symbolické, tak numerické vypocty. Systém navic obsahuje komponenty podporujici

vyuku matematiky.

Vyrobcem systému je kanadské spoleénost Maplesoft Inc., jejiz webové stranky! posky-
tuji siroké informace o systému a jeho dalsich ptibuznych programech jako je MapleSim,
MapleNet, Maple T.A. a mnoho dalsich nastroju a programu. Webové stranky mimo jiné
obsahuji tzv. Aplikacéni centrum? (Application Center), z néjZ si mize kazdy zaregistrovany
uzivatel stahnout ukazkové programy demonstrujici pouziti systému Maple pfi feSeni mnoha
ruznych matematickych i technickych problému. Poskytuji i tzv. Studentské centrum? (Stu-
dent Help Center), kde si zaregistrovany student muze stahnout mnoho studijnich materialu.
Dalsfmi vyznamnymi zdroji informaci o Maple jsou diskuzni férum uZivateli Maple* a web
distributora Maple pro Ceskou a Slovenskou republiku®, kde je vétsina dokumentt v ¢eském
jazyce [6], [10].

Systém Maple je vyvijen od roku 1980, v némz se objevila jeho prvni limitovana verze.
V roce 2005 byla uvedena verze Maple 10 s novym grafickym uzivatelskym rozhranim zvanym
Standard Worksheet a tzv. dokumentovym rezimem (Document mode). Diky nim se ovlddani
systému Maple stalo vyrazné jednodussim. V soucasné dobé vznika kazdy rok nova verze,
v dobé psani této inovované a rozsitené verze puvodniho textu byla na trhu nejnovéjsi verze
Maple 16. Budeme proto prezentovat moznosti pravé zminéné nejnovéjsi verze systému,
nicméné naprosta vétsina prikazu a funkci, jez budeme pouzivat, je v Maple dostupna jiz od

Se systémem je mozné pracovat nékolika ruznymi zpusoby, které volime pii spusténi
programu ze startovaciho menu pocitace nebo kliknutim na ptislusnou ikonu na plose. Maple
je k dispozici pro ruzné opera¢ni systémy. V nasledujicim textu popiSeme, jak program
spoustime v nejrozsitenéjsim operacnim systému Windows.

1.1.1 Standardni zapisnik (Standard Worksheet)

Grafické uzivatelské rozhrani Maple zvané Standard Worksheet se spusti ze startovaciho
menu pocitace vybérem polozky Programy > Maple 16 > Maple 16 nebo kliknutim
na ikonu Maple 16 na plose. Toto prostiedi poskytuje veskeré moznosti systému Maple

thttp://www.maplesoft.com
Zhttp://maplesoft.com /applications /index.aspx
3http://maplesoft.com /studentcenter /index.aspx
4http:/ /www.mapleprimes.com
Shttp://www.maplesoft.cz



a pomdahd vytvaret elektronické dokumenty (zapisniky) zobrazujici matematické vypocty,
texty a komentaie spolu s propracovanou pocitacovou grafikou. Nékteré je mozné v zapisniku
potiebné informace. Jelikoz jsou vytvorené dokumenty interaktivni, tj. v jistém smyslu
L,ZIvé* muze si uzivatel sdm upravovat preddefinované hodnoty parametru, vyhodnocovat
piikazy, a ziskavat tak nové vysledky.

Menu zapisniku Maple mé tii vodorovné listy: hlavni menu (Menu Bar, zcela nahore),
ndstrojovou listu ( Toolbar, pod hlavnim menu) a kontextovou listu (Context Bar, pod néstro-
jovou ligtou). Zapisnik ddle obsahuje palety (Palettes, svisly blok na levé strané®), vlastnf pra-
covni pole — dokument (Document), do néjz zadavame piikazy, texty, provadime vypoctové
a grafické akce, a stavovou listu (Status Bar, zcela dole). Vlastni pracovni pole je mozné
zobrazit pres celou obrazovku skrytim palet a vsech list (kromé hlavniho menu) kliknutim
na prislusné polozky v zalozce View hlavniho menu.

Untitled (2)* - [Server 3] - Maple 16 X . ‘ .e . ‘ [ =| = éj]
File Edit View Insert Format Tahble Drawing Plot SEI’EEdEhEEt Tools Window Hel& HIAVNI MENU
DBAESS XBR S5¢ TPX E& @= NI OHd & [BEx @ @  NASTROJOVA LISTA

'— — —

leavoribes J :’ Text Drawing Plot Animation Hide ’.
| > MapleCloud () | Lz D Gmenentonen_ D) 2 ) B[Z]U E]== Ghth :=i- KONTEXTOVA LISTA
lp Live Data Plots J p
[b\l'ariables J
W Handwriting =

PRLETY DOKUMENT

-

Input Window...

l [ Expression
[ P Uniits (SI)

L3

C:&-Droﬁram Filesﬁaele 16 Memorx: 2.0M_Time: 0.355 Math Mode

gl

Obrazek 1.1: Maple 16: Prostiedi Standard Worksheet.

1.1.2 Klasicky zapisnik (Classic Worksheet)

U 32bitovych operacnich systému je k dispozici téz tzv. Classic Worksheet, ktery se spusti ze
startovacitho menu pocitace vybérem polozky Programy > Maple 16 > Classic Worksheet
Maple 16 nebo kliknutim na ikonu Classic Worksheet Maple 16 na plose. Tento zapisnik
Maple je uréen predevsim pro méné vykonné pocitace s omezenou pameéti. Neposkytuje také
vechny funkce, pitkazy a moznosti systému Maple jako Standard Worksheet [6].

6Palety se automaticky zobrazuji v levém bloku. Prostiedi systému nabizi blok pro palety i po pravé
strané obrazovky (automaticky zavieny), kam je mozné nékteré (ale i vSechny) pfesunout.
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[laMaple 14 - [maplel4.mws - [Server 1] 10| x|
=151 x|

@F\\e Edit Yiew Insert Format Spresdshest  Window  Help

CEREE e B EE L F=] 6] FRR [ E E |

E11. piiklad

> (x2-5%x+6)*(x2-1) /((x-1)*(x-2));
2 2 -
(x"=5x+6)(x"-1)
(x-1)x-2)

> simplify(%)
(x=3)ix+1)

E2. priklad

> Sum{l/n*2, n = 1 .. infinity)=sum{1/n"2, n = 1 .. infinity),
@ 2
St
: 6
n=1n

3. piiklad

> plot{sin{x), x = -5 .. 5);

-

[TTime: 015 [Bytes: 76@ |Avaiable: 1316 |

Obrazek 1.2: Prostiedi Classic Worksheet v Maple 14 (pfevzato z [6]).

1.1.3 Prikazovy radek a kalkulacka Maple

Se systémem Maple muzeme pracovat i pouze v rezimu tzv. prikazového Tddku spustitelného
ze startovactho menu pocitace vybérem polozky Programy > Maple 16 > Command-
line Maple 16. Piikazovy tadek je urcen k feSeni rozsahlych a slozitych tloh. K dispozici
pritom nejsou zadné grafické prvky.

#  CAProgramData\Microsoft\Windows\Start Menu'\Programs\Maple 16\Command-line Maple 16.Ink "= |
Maple 16 <X86 64 WINDOWS>
_- Copyright <{c)> Maplesoft, a division of Waterloo Maple Inc. 2812
All rights reserved. Maple is a trademark of
Waterloo Maple Inc.
Type 7 for help.

Obrdzek 1.3: Maple 16: Piikazovy fadek.

Daéle je mozné pouzivat (a vytvaret) tzv. maplety, tj. grafickd uzivatelska rozhrani ob-
sahujici okénka, textova pole a dalsi vizualni prvky umoznujici pouhym klikdnim spoustét
vypocty. Kalkulacka systému Maple je specialni typ mapletu, ktery je k dispozici pouze
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pro operacni systémy Windows. Spousti se ze startovactho menu pocitace, kde se vybere
Programy > Maple 16 > Maple Calculator [6].

1.1.4 Document Mode, Worksheet Mode

Déle se budeme vénovat pouze rozsitenému prostiedi Standard Worksheet. V tomto prostredi
je mozné pracovat ve dvou zakladnich rezimech: Worksheet Mode a Document Mode. Prvné
jmenovany odpovida prostiedi Classic Worksheet, v némz je kazdy piikaz Maple uvozen sym-
bolem [> a musi byt ukoncen stiednikem (vysledek se zobrazi na dalsim fadku uprostied)
nebo dvojteckou (vysledek se nezobrazi). Otevird se v hlavnim menu zvolenim File > New
> Worksheet mode. Document Mode poskytuje prehlednéjsi zapis ptrikazu a matema-
tickych vzorcu bez ,prebytecnych® symbolu. Pti otevieni nového souboru z nastrojové listy
je automaticky spustén pravé tento rezim, jinak je mozné jej téz oteviit z hlavniho menu
v polozce File > New.

Obvykle je zapisnik nastaven do jednoho rezimu’, ktery je mozné zvolit pii otevirdni
nového souboru v hlavnim menu (File > New > ...). Existuje vSak i moznost prepinat
mezi rezimy v ramci jednoho zapisniku, kdy je ¢ast vytvorena v jednom rezimu, ¢ast v jiném.
Z Document Mode se prepneme do Worksheet Mode kliknutim na ikonku [> v ndstrojové
listée. Naopak z Worksheet Mode se do rezimu Document Mode prepneme vybérem polozky
v hlavnim menu (Format > Create Document block) [6].

Zapis v rezimu Document Mode Zapis v rezimu Worksheet Mode

Tento text je v reZimu Text Mode. B
Stiskem klavesy Enter jsme se dostali na dal3i fadek. Tento text je téZ v reZimu Text Mode.

Na nisledujicim #adku se pfepneme do refimu Math hMode.
Tento text je v rezimu Math Mode.

pikaz L
piikaz
néjaky text > prtkaz
méfaky text prikaz
256-125 > ptikaz;
32000 phikaz
solve(x* — 7x +12=0) (> 256-125
4,3 32000

| > 256%125;

32000

Obrazek 1.4: Rezimy zépisu (pfevzato z [6]).

1.1.5 Math Mode, Text Mode

Pro rozliseni piikazii a obycejného textu slouzi kontextova lista zapisniku, kde mame na
vybér Text Mode a Math Mode. Math Mode odpovida piikazim (po stisku klavesy Enter
dojde k vyhodnoceni), v Text Mode piseme texty dokumentu podobné jako napt. v textovém
editoru (po stisku klavesy Enter prejdeme na novy radek bez jakéhokoli vyhodnoceni). Volit
rezim zapisu muzeme bud kliknutim mysi (v kontextové listé nad dokumentem jsou uvedeny

"Ten zpravidla volime pii prvnim spusténi po instalaci systému nebo jej muzZeme ndsledné nastavit
v hlavnim menu: Tools > Options... > Interface.



ndzvy predstavujici jednotlivé moznosti) nebo vybérem polozky v hlavnim menu (Edit >
Switch to Text/Math Mode). Totéz lze rychleji provést kldvesou F5.

V rezimu Worksheet Mode 1ze pro text i pro piikazy pouzit oba druhy zapisu. Pro psani
textu je nutné kliknout na ikonku T v nastrojové listé nebo zvolit polozku v hlavnim menu
(Insert > Text). Podobné pro zépis piikazu jazyka Maple je nutné kliknout na ikonku [>
v nastrojové listé nebo zvolit polozku v hlavnim menu (Insert > Maple Input). Pti otevieni
nového souboru je zapisnik automaticky nastaven na psani piikazu.

K prikazim mame déle moznost zapisovat komentére uvedenim symbolu miizky (#)
pred text, ktery ma byt komentérem (viz obrazek 1.5) [6].

256-125 # néjaky komentdf
32000

> 256%*125; # néjaky komentir
32000
[>

Obrdzek 1.5: Zapis komentare v piikazovém rezimu (pfevzato z [6]).

1.2 Zakladni ovladani systému

Jiz vime, jak spustit systém Maple a jak zvolit pracovni prostiedi, které chceme. Oteviit
jiz vytvoreny program muzeme z hlavniho menu (File > Open...) nebo spusténim pro-
gramu rovnou z operacniho systému (prostfednictvim néjakého souborového manazeru).
Kdyz chceme vytvoreny dokument ulozit, zvolime polozku File > Save (resp. File >
Save As...) v hlavnim menu systému Maple. Dokumenty prostiedi Standard Worksheet
maji priponu mw, dokumenty prostiedi Classic Worksheet priponu mws. V prostiedi Stan-
dard Worksheet je mozné otevrit oba typy soubort, v prostiedi Classic Worksheet pouze typ
Mws.

Maple poskytuje také moznost exportovat dokumenty jako soubory jinych typu. Pod-
porovany jsou typy: HTML, PDF, LaTeX, Maple Input, Maplet, Maple Text, Plain Text,
Maple T.A. a Rich Text Format. Pro export dokumentu vybereme polozku Export As...
ze zalozky File v hlavnim menu.

Nyni si ukazeme, jak v Document Mode zadavat jednoduché prikazy. Budeme proto
predpokladat, ze zapisnik je jiz nastaven pro psani piikazu (Math Mode).

Zakladni operace: pro s¢itani pouzivame symbol plus (+), pro odéitdni minus (—), pro néso-
beni (*), ale pozor, pro déleni musime pouzivat pouze lomitko (/), dvojtecka (:) ma jiny

vyznam (viz dale).

Zadani zlomku: zadame c¢itatel, lomitko (/) a jmenovatel. Pro opusténi zapisu jmenovatele
staci stisknout Sipku doprava (ve zlomku je téz mozno pohybovat se Sipkami).

Zadani mocniny: zaddme zdklad, symbol stiiska (") a exponent. Pro opusténi zapisu ex-
ponentu je opét mozné pouzit Sipku doprava.

10



1.2.1 Vyhodnoceni prikaza

Piikaz vyhodnotime stiskem klavesy Enter. Vysledek se zobrazi na dalsim fadku uprostied.
aby se provedl. Tato moznost nadale zustala (tj. zaddme-li za piikaz strednik, ,nic nepo-
kazime*) a v nékterych situacich je dokonce jedind mozné — napf. textovy rezim ( Text Mode)
piikazu v Worksheet Mode nebo pii psani piikazu v prostiedi Classic Worksheet. Z predeslych
verzi Maple se uchovala i funkcionalita symbolu dvojtecka (:), kterd po zarazeni za piikaz
a nasledného stisku klavesy Enter potlaci zobrazeni vysledku na dalsim fadku (tj. piikaz
se vyhodnoti, ale na obrazovku se nic nevypise). Proto neni mozné dvojtecku pouzivat jako
operator déleni. V. Document Mode je navic mozné zapisovat piikaz i s vysledkem na jeden
radek. Po napsani ptikazu k tomu staci namisto stisku klavesy Enter pouzit klavesovou
zkratku ,,Ctrl + =*.

Jak bylo zminéno dfive, interaktivni dokumenty v Maple jsou
,zivé“. Tim mame na mysli skutecnost, ze i v difve vytvoreném doku-

|»

W Favorites
mentu s vyhodnocenymi piikazy otevieném po libovolné dlouhé dobé | e l
o« , . ’ . . . MapleClou
muzeme kterykoli vyraz upravit, znovu vyhodnotit (stisknout En- (uftep J
L P Handwriting J

ter nebo ,,Ctrl + =%) a dostaneme novy vysledek. Oznaé¢ime-li mysi
nékolik (libovolné mnoho) piikazu a stiskneme ikonku ! (vykfiénik) |3 Expression
z nastrojové listy, vsechny oznacené prikazy budou postupné vyhod- 2 o
noceny. K vyhodnoceni vsech piikazu v dokumentu slouzi ikonka J ¢ J a2
I (tii vykficéniky). ,

Maple obsahuje vice nez tisic symboli, pomoci nichz muzeme I = vl
tvorit matematické vyrazy a typograficky kvalitni text. Patii mezi
né pismena a ¢islice, jimiz vytvaiime jména (posloupnost znaku
zacinajici pismenem, za kterym muze nasledovat kombinace pismen, ab =
¢isel a vybranych symbolu), redlnd ¢isla (celd, racionélni, iraciondlnf,
s desetinou teckou nebo v notaci pohyblivé fadové ¢arky), komplexni a, Ja
¢isla, aritmetické, booleovské a jiné operatory (4, —, !, /, *, [ , lim, . .. Va a4
), konstanty (7, e, ...), imagindrni jednotku, nekone¢no, matema- & In(a)
tické funkce (cos(x), sin(3), ... ) a proménné (pojmenované jménem
...). Velkou prednosti systému Maple je jeho schopnost symbo-
lickych matematickych vypoctu. Nékteré z matematickych symbolu,
které muzZeme pouzit, nejsou na kldvesnici, a tak se zadavaji bud [;J fla) fla,b)
z palety nebo pomoci svych nézvu [6]. =

logm(:‘) ]Og.',(:‘)

sin(a) cos(a) tan(a)

f=(a,b) ==

1.2.2 Palety

Palety jsou pojmenované ,,obdélnicky“ s nabidkou preddefinovanych )
symbolu, zdpisu, vyrazu apod. (obrazek 1.6), zpravidla pii levém |l J
okraji zapisniku. Kazda paleta obsahuje symboly ptislusné sku- || J
piny. Naptiklad paleta s ndzvem Ezpression nabizi nékteré zdkladni || commen symbols J
L J
L J
L J

= Units (SI)

I Lrits (FPS)

matematické vyrazy, paleta Greek pismena tecké abecedy atd.
Standardné zustava nékolik palet nezobrazenych. V hlavnim menu
(View > Palettes) muzeme seznam zobrazenych palet upravit tim,
ze nékteré pridame, odebereme, ale tieba i jinak seradime. Totéz lze =
provést jen za pomoci mysi. Pridrzenim levého tlacitka vybranoupa- oy .« 1/ 6. pay oty.
letu presuneme na jiné misto, stisknutim pravého tlacitka vyvoldme

stejnou nabidku, jako bychom postupovali pres hlavni menu. Kliknuti levého tlac¢itka mysi na
nékterou z palet zobrazi (piip. skryje) symboly, které paleta nabizi. Vlozit z palety symbol

P Makriz

P Components

= Greek
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do zapisniku pak stac¢i pouhym kliknutim, ptipadné ,pretahnutim“ s pomoci levého tlacitka
mysi. Obecné barevné zvyraznéné symboly ve vyrazu je mozné ddle specifikovat (upravovat)
dosazenim hodnoty, s niz potfebujeme pracovat [6].

10

Priklad 1.1: Vlozte do dokumentu vyraz . 2.
i=1

Reseni: Pro zapséni zadaného vyrazu potiebujeme celkem dva ruzné symboly: sumu
a mocninu. Sumacni symbol nalezneme v paleté Expression. Kliknutim na tuto paletu
ji otevieme (na obrdzku 1.6 je jako jedind oteviend) a vybereme z ni piitomny sumaéni
symbol. Po jeho vlozeni do zapisniku pak jednoduse prepiseme obecné symboly (k, n a f)
pozadovanymi hodnotami. Pohybovat ve vzorci se muzeme pomoci Sipek na kldvesnici,
s vyhodou lze vyuzit klavesy Tab, pritom k upravé vyrazu muzeme pouzivat i vSechny
ostatni klavesy jako napt. Delete, Backspace, mezernik, ... Znak f prepiSeme mocninnym
vyrazem. To muzeme provést bud vlozenim dalsiho symbolu z palety Expression (symbol
a®) a naslednou tpravou (specifikaci hodnot a, b), nebo uzitim jiz zndmé klavesy pro tvorbu
mocnin — stiisky (7).

8

Priklad 1.2: Vlozte do dokumentu vyraz %
i=1

323 —642
1724

Priiklad 1.3: Vlozte do dokumentu vyraz

1n(e5)!-sin(NT'")73-13
\/log,(16)—1

Priklad 1.4: Vlozte do dokumentu vyraz

1.2.3 Nazvy symbola

Mimo palet muzeme k zdpisu symbolu uzivat jejich nazvu. Napiiklad symbol 7 vlozime
zapsanim jeho ndzvu Pi®, pro odmocninu je vyhrazen nazev sqrt, takze \/x vloZime napsdnim
sqrt (x). Pri vkladani symbolt pomoci nazvu nebo pii tvorbé piikazu se muze hodit funkce
,dokon¢ovani“. Pro zadani symbolu pak sta¢i napsat jeho ivodni pismeno (pismena) a po-
moci klavesy Esc nebo klaves ,,Ctrl + mezernik“ nasledné z vyskakovaciho okénka zvolit
pozadovany piikaz. Na obrézku 1.7 je ukézka nabidky pro dokonceni zépisu pismen so [6].

323 —642

Priklad 1.5: Vlozte do dokumentu vyraz |*5-—r

bez pouziti palet.

Reseni: Pro absolutni hodnotu z pozadovaného vyrazu pouzijeme pifkaz abs, pii zaddvani
mocnin vyuzijeme symbolu stiisky (7). Vysledny zapis zadaného vyrazu tedy bude:
abs((3273-6472)/(17%274)).

ln(e5)!-sin(l7T'7T)f3

o 13 Y6z pousiti palet.

Piiklad 1.6: Vlozte do dokumentu vyraz

8Maple rozlisuje mals a velka pismena. Napiiklad zapis Pi piedstavuje Ludolfovo éislo 7 i s jeho hodnotou,
zatimco zdpis pi predstavuje pouze symbol (fecké pismeno) .
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=0l i
solve sohe
salve sofva (agn )
solve sofvalegn, x|
solve (system) sofve | [egnl, egnz, ., (xI x2, 1)
solve_group (DETools) (symmetry generator and variables) DEToals [sofve group [ {Bsf), [10])
solvefor gokefor
sark sort
sork (list) sorf(Baf)
sort (with ordering funckion) sorf(Baf ) ™
Rl b

Obrazek 1.7: Funkce automatického dokoncovani (ptevzato z [6]).

1.3 Napovéda

Vyznamnou soucasti systému Maple je jeho napovéda. K dispozici je nékolik ruznych typu
napovedy, které nejlépe najdeme v hlavnim menu v nabidce Help. Zakladni stranky ndpoveédy
zobrazime vybérem polozky Maple Help®.

Vyhleddvat v ndpovédé mizeme bud zadédnim hledaného textu do textového pole v levé
horni ¢asti okna (na obrazku 1.8 je v tomto poli zapsin text abs), nebo tematickym vy-
hleddvanim v pfipravené stromové struktufe témat v levé ¢asti okna (na obrazku 1.8 je roz-
balena Matematika a v ni téma Calculus, tedy Matematickd analyza). Odkliknutim zadaného
slova abs v textovém vyhledavacim poli ndpovédy zobrazime v hlavni ¢asti okna napovédu
prave k prikazu abs. Jak muzeme vidét na obrazku 1.8, napovéda obsahuje zakladni popis
prikazu, obecny zapis ptikazu pro jeho pouziti a konkrétni ukazkové priklady.

1.3.1 Tour of Maple, Quick Reference, Quick Help

Nabidka Help hlavniho menu poskytuje jesté nékolik jinych forem napovédy. Polozka Take
nuti na Quick Reference otevie tabulku informaci o ovladani systému Maple, zejména pro
nové uzivatele. Jedna se o zakladni informace s odkazy do napovédy Maple Help pro je-
napoveéda. Standardné se objevuje v kazdém novém zapisniku pfi pravé strané v podobé
cerného okénka (pokud toto nastaveni nezrusime). Po zavieni je mozné ji vyvolat stiskem
klavesy F1, ¢i jako polozku v hlavnim menu [6].

1.3.2 What’s New, Startup Dialog

Dalsimi druhy napovédy jsou prehled rozsiteni stavajici verze Maple oproti predchéazejici verzi
(dostupné pres Help > What’s New) a tzv. Startup Dialog obsahujici tipy pro praci
se systémem Maple. Startup Dialog se zobrazuje vzdy po spusténi systému (pokud toto
nastaveni nezrusime) [6].

9Pro vyvoldni této napovédy mizeme také pouzit klavesovou zkratku ,,Ctrl + F1%, nebo posledni ikonku
nastrojové listy.
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abs - The absolute value function

Calling Sequence
abs(x) K

abs(n, x)

Parameters

x - expression or rtable

n - positive integer

¥ Description

» The abs function returns the absolute value of the expression x

* You can enter the command absusing either the 1-D or 2-D calling sequence. For example, abs(-11) is equivzlent to
[-11].

» I[fxis an rtable (Array. Matrix. or Vector), the abs function applies the abs function to each entry in the table, and
returns the resulting rtable.

» Ifxincludes a function £. then abs will attempt to execute the procedure abs/f to determine the abselute value of the
corresponding part of x. The user can thus easily extend the functionality of abs.

» The derivative of absis denoted by abs(1, x). This is signum(x) for all non-0 real numbers, and is undefined

: g:zf;::t’l\::::z::; otherwise. Neither first order nor higher order derivatives of abs can be determined if xis an rtable.
. Ewaluation

. Factorization and Sobving Equations
. Financial Functions

FunctionAdvisar

» Higher order derivatives of abs are denoted by abs(n, x), where n is 2 positive integer. When n is known, the
| expression is automatically simplified to the appropriate expression in a derivative of either signum or abs.
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Geometry 11

Graphing Calculator
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Obrdzek 1.8: Hlavni napovéda systému Maple.

1.3.3 Manuals, Resources, and more

Vyvolanim Manuals, Resources, and more piejdeme do dalsi oblasti napovédy, z niz
popiSeme tTi nejdulezitéjsi ¢asti.

Maple Portal

Od verze Maple 13 je k dispozici tzv. Maple Portal. Spustit jej muzeme samostatné (Maple
Portal mé vlastni ikonu na plose) nebo ptes ndpovédu v hlavnim menu (Help > Manuals,
Resources, and more > Maple Portal). Maple Portal slouzi jako pomocnik novym
i zkuSenéjsim uzivatelim hledajicich pokrocilejsi napovédu. Je v ném mozné rychle najit
detailni popis prace se systémem Maple od feSeni nejjednodussich problému az po velmi
slozité tlohy [6].

Applications and Examples

Z népovedy je mozno vyvolat i spustitelné soubory (tj. jiz vytvorené dokumenty) demon-
strujici moznosti systému Maple. Otevieme je pres ndpovédu v hlavnim menu (Help >
Manuals, Resources, and more > Applications and Examples) a pak kliknutim na
zvoleny piiklad [6].

Manuals

Déle je je mozné vyvolat anglické manualy User manual, Introductory Programming
Guide, Advanced Programming Guide a Getting Started with Maple Toolboxes
podrobné popisujici moznosti systému Maple. Otevieme je pfes napovédu v hlavnim menu
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Talking to Maple

Mapie Portal

The Maple Portal is designed as a starting place for any Maple user. Maple's Tutorials will help you get started with Maple, leam about the key tools available in Maple, and lead you through a series of
problems. From here, investigate maore detailed topics in the Portals for Engineers, Students, and Math Educators

inutes to complete

How to Get Started
Entering Math

Putting Your ldeas Together

Combining Text and Math
Solving Equations
Expressions, Functions, and Procedures

bl

How do l...

—.enter a simple expression?
..enter a function?

L.Bnter a matrix?
~.evaluate an expression?
L.plot a function?

Commands and Packages

Using Top Commands and Packages
Getting Help

Plotting

2-0 and 3-D Plots
Using the Plot Builder Assistant

Werking with Matrices

Creating Matrices and Yectors

Data Structures

including lists and Arrays

Data Manipulatien

Importing and Exporting Data
Rancdom Distributions
Statistics, Regression, and Curve Fitting

Tools and Features

Learn rore about Maple's tools and features, such as palettes and contesxt-
sensitive menus

Palettes

Context-Sensitive Menus

Cornrnand Completion

Eguation Labels

Assistants

Maple Help

FPlotting Guide

Applications
Example Worksheets

Word Processing Teels

Sections and Tables
Docurment Enhancements

Dynamic Applications

Exploration Assistant
Expression Plotting
Interactive Circle Plotting

Manuals

Pertals for...

Engineers —

Math Educators
Units Working with Units

_I Customizing Unit Settings ma_ v v _I;I
5 0

Memery: - Time: - Text Mode

Obrazek 1.9: Maple Portal (prevzato z [6]).

(Help > Manuals, Resources, and more > Manuals) a pak kliknutim na zvoleny
manudl [6].

1.3.4 Pomocnici, instruktori a resené tulohy

Systém Maple poskytuje také jiz pripravené ,pomocné nastroje“ pro feseni uloh. Jsou to tzv.
Pomocnici (Assistants), Instruktori (Tutors) a Ulohy (Tasks), které vyvolame z hlavniho
menu (Tools > Assistants nebo Tools > Tutors anebo Tools > Tasks). Pomocnici (As-
sistants) obsahuji napiiklad nastroje pro hledani funkéni zavislosti v datech, optimalizaci
funkci, feseni diferencialnich rovnic a dalsi. Pro dany typ tlohy maji implementovano nékolik
¢asto pouzivanych algoritmu. Po vyvolani provedou uzivatele nastavenim a specifikaci pa-
rametru tlohy a zvolenou metodou tlohu vytesi. Instruktori (Tutors) provedou uzivatele
feSenou problematikou pomoci jednoduchych nazornych prikladu. Ulohy (Tasks) zobrazuji
na piikladech, jak Fesit ruzné dlohy. Zobrazi se vyvolanim z hlavniho menu (Tools > Tasks
> Browse) [6].

Od verze Maple 16 najdeme v zélozce Tools hlavniho menu také vyukové demonstracni
dokumenty pod nazvem Math Apps. Tyto matematické aplikace byly vytvoreny ke znazornéni
ruznych matematickych a fyzikalnich konceptu. Kazdy z dokumentu obsahuje struény popis
prislusného konceptu a nékteré interaktivni prvky jako napt. tlacitka, posuvniky, ,klikatelné*
grafy apod.

1.3.5 Piikaz ? (otaznik)

Symbol ? (otaznik) je dalsim ze zpusobu zobrazeni ndpovédy. Zapsanim a provedenim piikazu
? otevieme hlavni stranku napovédy. Otaznik spolu s ndzvem piikazu otevie napovédu na
strance tykajici se zadané¢ho prikazu. Tedy napi. piikaz 7evalf otevie hlavni napovédu
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systému na strance popisujici syntaxi a sémantiku piikazu evalf spolu s piiklady jeho
pouziti. Zapsanim dvou otazniku na zacdtek prikazu otevieme tutéz stranku napovedy
ve ,sbaleném® tvaru osnovy, v niz je mozné oteviit (odkryt) libovolné ¢asti. Zaddnim tif
otazniku pred piikaz otevieme nédpovédu na piikladech pouziti tohoto piikazu [6].

Oteviit napovédu na strance zadaného piikazu (resp. klicového slova) muzeme téz stisk-
nutim klavesy F2 (za ptitomnosti kurzoru na klicovém slové).

Priklad 1.7: Zjistéte, k ¢emu slouzi ptikaz sum a jak se pouziva.

Priiklad 1.8: Zjistéte, jak je mozné v systému Maple pracovat s vektory a maticemi.

1.4 Provadéni vypocta

Maple provadi presné numerické vypocty s celymi, racionalnimi i iracionalnimi ¢isly. Kazdy
zadany matematicky vyraz se snazi zjednodusit (napt. zlomek zkrétit a prevést na zdkladni
tvar, upravit algebraicky vyraz, ... ), ale ne za cenu ztraty presnosti. To znamend, ze napiiklad
racionalni ¢isla (zlomky) udrzuje stale v jejich zdkladnim tvaru. Podobné s konstantami ,
e a dalsimi, s odmocninami a jinymi vyrazy pracuje jako se symboly. Timto je zarucena
absolutni pfesnost vypoctu i v piipadé, kdy nepracujeme pouze s celymi ¢isly [6].

Jsou vsak situace, kdy pottebujeme znat pribliznou hodnotu realného nebo racionalniho
¢isla v pohyblivé tadové carce. K tomu slouzi piikaz evalf, jenz vrati zaokrouhlenou hod-
notu svého argumentu na pocet platnych cifer mantisy specifikovany systémovou proménnou
Digits. Ta je standardné nastavena na hodnotu 10. VSechny vypocty, pfi nichz je nutné za-
okrouhlovat ¢isla, provadi proto Maple s pfesnosti na 10 platnych mist. Proménnou Digits
muzeme nastavit na takika libovolné pfirozené ¢islo. Omezeni, jak vysoké toto Cislo muze
byt, zjistime pifkazem kernelopts(maxdigits). Pro predstavu uvedme, Ze pro Maple 16 je
toto cislo 38 654 705 646, tedy vice nez 38 miliard platnych cifer, s kterymi dokaze systém

teoreticky“!Y pocitat [6].
Pi=m evalf(Pi,5) =3.1416
Digits = 10 evalf[ 5](Pi) =3.1416
evalf(P1) evalf(P1,20) =3.1415926535897932385
3.141592654 | evalf[20](Pi) = 3.1415926535897932385

Obrazek 1.10: Prikaz evalf.

Aniz bychom ménili nastaveni proménné Digits, muzeme zobrazit libovolny vyraz s poza-
dovanou presnosti pouze pomoci pitkazu evalf. Piikaz je mozné pouzit s jednim nebo dvéma
parametry. Jediny zadany parametr znamend, ze tento zadany vyraz bude vyhodnocen na
pocet platnych mist specifikovany v proménné Digits. Druhy parametr, ktery fekne funkci
evalf, na kolik platnych mist m4 vyraz vyhodnotit, Ize bud’ piidat do kulatych zavorek za vy-
hodnocovany vyraz, nebo do hranatych zavorek umisténych pred kulatymi - viz obrazek 1.10.

Maple rozeznava presnd Cisla (mezi néz patii i zminéné symboly 7 a e, zlomky atp.)
a cisla typu Floating-Point, nebo-li ¢isla v pohyblivé fadové carce. Jestlize systému zadame

vevs

tickou nepouzitelnost pro vyssi pocet (zavisly na typu tlohy) cifer.
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vyraz, v némz néktery z jeho podvyrazu bude typu Floating-Point, muze Maple na cely
vyraz pohlizet jako by byl tohoto typu a bude vysledky vypoctu zaokrouhlovat. To nejlépe
uvidime na dalsich piikladech na obrazku 1.11 [6].

2,313 2 _
= ale T+ 1.5 =2.166666667
J2+3=J2+/3, alk J2.0 +3 =1.414213562 + /3

Obrdzek 1.11: Presnd ¢isla a ¢isla typu Floating-Point (pfevzato z [6]).

1.4.1 Prikazy

Pro provedeni vypoc¢tu mame zpravidla vice moznosti. Tou zékladni, ktera je k dispo-
zici ve vSech verzich systému, jsou prikazy jazyka Maple. Chceme-li napiiklad vypocitat
odmocninu z ¢isla 2,5, zapiSeme v systému Maple pitkaz sqrt(2.5). Stejného vysledku
dosdhneme pouzitim symbolu pro odmocninu z palety Expression. Pokud chceme urcit
nejmensi spolecny nasobek ¢isel 10, 12 a 15, muzeme vyuzit prikazu lcm nebo zapsat Cisla
na fadek za sebe (oddélend ¢arkami) a pres pravé tlacitko mysi zvolit z kontextové nabidky
Apply Function > Least Common Multiple, viz obrazky 1.12, 1.13 [6].

10,12, 15
Zuf: |
Copy ChrlHC
Copy full precision
Copy as MathML
Paste CerlHy

Ewaluate
Evaluate and Display Inline Ctrl+=
Explore

Apply Function Greatest Cammon Divisar

Apply a Command Least Common Multiple

Dok Product

Map Command Onka

Select Element »
SirnpliFy 3
Canstruckions ]
Canversians ]
Plats 1
2-D Math ]
Table »

Obrdzek 1.12: Provedeni vypoc¢tu pomoci kontextové nabidky (pfevzato z [6]).

Priklad 1.9: Zobrazte ¢islo 7 s presnosti na pét desetinnych mist.

Resenid: Pro zobrazeni pfiblizné (zaokrouhlené) hodnoty s pozadovanou pfesnost{ vyuzivame
piikazu evalf. Funkci evalf dame jako prvni argument vyraz, jehoz ptibliznou hodnotu
chceme urcit (tj. 7). Druhy argument bude specifikovat pocet platnych mist. Jelikoz chceme,
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aby pocet desetinnych mist byl roven péti, pocet platnych mist nastavime na 6. Ziskame tak
vysledek na obrazku 1.14.

sqrt(2.5) = 1.581138830
J 2.5 =1.581138830
lem (10,12, 15) =60

integer lcm

10,12, 15 ——— 60

Obrazek 1.13: Ruzné moznosti provedeni vypoctu (pievzato z [6]).

evalf(m, 6) = 3.14159

Obrdzek 1.14: Reseni piikladu 1.9.

Piiklad 1.10: Zobrazte Eulerovo ¢islo s presnosti na dvé desetinnd mista.

Priklad 1.11: Vypocitejte, kolik je 1 — % — % — %. Pro¢ neni vysledek roven 07

1.4.2 Oznaceni vysledkua

Kazdému zobrazenému vysledku se v zapisniku pritazuje ¢iselné oznaceni, které se zapisuje
zcela vpravo na Fadek s odpovidajicim vysledkem. Oznaceni je mozné potlacit (tj. nezobra-
zovat), znovu vyvolat, pfipadné upravit jeho formét v hlavnim menu (Format > Equation
Labels > ...). Diky oznacCeni se muzeme na predeslé vysledky odvoldvat a pouzivat je
pii tvorbé dalsich piikazu. V ukdzkach vytvorenych dokumentu (prezentovanych v tomto
textu) je oznaceni vysledku vzdy potlaceno. Pouziti oznaceni ilustruje obréazek 1.15.

2
3 6
_16 @
3
83
24 2)
5—n
55— R 3
104+ @)
34 )

Obrazek 1.15: Oznaceni vysledku (pfevzato z [6]).

Pokud chceme napiiklad pricist ¢islo 10 k vysledku s oznacenim (2), pak napiseme ,,10
+ “ a pres klavesovou zkratku ,Ctrl + L* vlozime pozadované oznaceni (tedy do ,vyska-
kujictho okénka® zaddme ¢islo 2 a potvrdime (OK)). Misto kldvesové zkratky ,Ctrl + L
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je mozné pouzit horni menu (Insert > Label...). Pozor, zipis (2) vytvoreny (pouze)
na klavesnici pti tvorbé ptrikazu Maple nepochopi, pro vlozeni oznaceni do ptikazu je tieba
dusledné pouzivat predesly postup s ,,vyskakujicim okénkem* zobrazenym na obrazku 1.16

6].

x|
IEquatiu:un ;I

Identifier: I

Tvpe:

Cancel |

Obrazek 1.16: ,Vyskakujici okénko“ pro zadani oznaceni (ptrevzato z [6]).

Maple déle nabizi moznost odkazovat se na posledni tii vysledky (v tomto piipadé je
jedno, zda byly zobrazeny ¢i nikoliv, a zda maji néjaké oznaceni) pomoci symbolu % (pro-
cento). Jedno procento (%) predstavuje posledni vysledek, dvé procenta (%%) predposledni
a tii procenta (%%%) pred-predposledni. Upozornéme, ze vysledek ziskany témito piikazy
zavisi na poradi vykonanych ptikazii, ne na jejich umisténi v zapisniku! Tedy napi. % vypise
posledni vysledek ziskany predchozim (¢asové) vykonanym piikazem (obrazek 1.17).

2
— 135
3 +
83
5—n

%, %%, %%%

Obrdzek 1.17: Vyuziti procent pii odkazovani se na predchozi vysledky (ptevzato z [6]).

1.4.3 Vytvareni proménnych

Odkazovat se na vyrazy muzeme také po jejich prifazeni k néjaké proménné. Operatorem

prifazeni je (dvoj)symbol :=

(dvojtecka + rovnitko).

Namisto (dvoj)symbolu := muzeme k pfitazeni pouzit pitkaz assign. Tak, jak muzeme
vyrazy do proménnych pfifazovat, muzeme téz pritazeni rusit (tj. odebrat proménné ulozenou
hodnotu). Zminéné provedeme piikazem unassign nebo pfifazenim nézvu proménné v apo-

strofech (obrazek 1.18).

Pritazovat hodnoty muzeme i do tzv. systémovych proménnych. Jiz jsme se setkali
s proménnou Digits vyjadiujici pocet platnych mist, s nimiz Maple pocité. [lustraci na obrazku
1.19 muzeme srovnat s obrazkem 1.10.

Odstranit ulozenou hodnotu v systémové proménné nelze. Do systémovych proménnych
muzeme hodnoty pouze prifazovat, nebo vratit piikazem restart nastaveni vsech systémovych
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a o
a ¢
a =2 assign(e, 2)
2 c
a 2
2 wnassign('c')
e
b c
b a
bi=3-a 2
6 o i="aq'
b a
6 a
a

Obrdzek 1.18: Prifazeni hodnot do proménnych a odstranéni ulozené hodnoty (prevzato z [6]).

Pi

!
Digits

10
evalf (P1)

3.141392654

Digits := 35

5
evalf (Pi)

3.1416

Digits = 20

20
evalf (P1)

3.1415926535897932383

Obrazek 1.19: Proménna Digits a piikaz evalf (prevzato z [6]).

proménnych na jejich puvodni hodnoty. Provedeni ptikazu odstrani vSechny ulozené hodnoty
v paméti (tedy i ndmi definované proménné, nactené baliky atd.). Piikaz restart se proto
pouziva zpravidla na pocatku feseni nové tulohy, zejména pak na zacatku kazdé prace se
zépisnikem (aby se predeslo tomu, ze budeme pouzivat proménnou, v niz je z diivéjska
ulozena pro nds nespravna hodnota) [6].

1.4.4 Baliky

Knihovna pifkazli jazyka Maple je rozdélena na hlavni knihovnu a tzv. baliky!'!. Pifkazy,
s nimiz jsme se doposud setkali, patti do hlavni knihovny, a muzeme je tak pouzivat ihned
po spusténi systému. Naproti tomu vétsina specidlnich piikazu nalezi do baliku, které musime
ptred pouzitim pifslusného pifkazu bud naéist do dokumentu pomoci piikazu with, nebo za-
dat piikaz spolu s nazvem baliku. Nacteni baliku pomoci prikazu with umozni pouzivani
vsech ptikazu z prislusného baliku. Naopak zadani piikazu spolu s nazvem baliku je nutné
provadeét pii kazdém pouziti tohoto piikazu, pokud balik nenac¢teme (piikazem with).

HKromé pojmu balik se v estiné pouzivd také termin knihovna.
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Nacteni baliku muzeme zrusit prikazem unwith. Pokud balik nenac¢teme a pouzijeme
z néj néjaky piikaz, Maple jej nerozpozna a piikaz vypise jako textovy tetézec. Naptiklad
piikazy pro préaci s vektory a maticemi nalezi do baliku LinearAlgebra. Jestlize chceme
tedy pouzit piikaz Eigenvalues pro nalezeni vlastnich ¢isel matice, na¢teme nejprve balik
LinearAlgebra, jak dokumentuje obrazek 1.20 [6].

-2 1 -1
Matice:=| 1 -1 0
-1 0 -1
-2 1-1
1 -1 0
-1 0 -1
with( LinearAlgebra) :
Eigenvalues( Matice)
0
-1
-3
unwith( LinearAlgebra)
Eigenvalues( Matice)
-2 1-1
Eigenvalues 1-1 0
-1 0 -1

LinearAlgebra| Eigenvalues| ( Matice)
0
-1
-3

Obrdzek 1.20: Pouziti balik.

Jednim z vyznamnych baliku je balik s ndzvem RealDomain. Systém Maple pracuje s
komplexnimi ¢isly a prave balik RealDomain umoziuje omezit se pouze na mnozinu realnych
cisel'? (obrézek 1.21).

Jednotky

Praci s jednotkami umoznuje balik Units. Pti vypoctech tak nemusime pracovat jen s ¢isly,
ale muzeme jim prifazovat i jednotky. K vlozeni jednotek do zapisniku vyuzijeme palety
Units. Obrazek 1.22 ilustruje pouziti jednotek pii vypoctu gravitaéni sily pusobici v tthovém
poli Zemé (kde gravitacni zrychleni je pfiblizné rovno 9,81 ms~2) na téleso o hmotnosti
10 kg. Vidime, ze Maple umi jednotky také zjednodusovat (resp. upravovat na jiny tvar).
Ke zjednoduseni vyrazu ptitom slouzi piikaz simplify.

Maple rozpoznava jednotky ruznych soustav a velikosti, s nimiz umi pracovat a vzajemneé
je prevadét. Pro prevod jednotek je k dispozici specialni néstroj zvany Units Calculator.

12Uplny seznam pifpadii (resp. pifkazil), v nichZ se miizeme pomoci tohoto balfku omezit jen na redlna
¢isla, nalezneme v ndpovédé k baliku RealDomain
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simplify

1
(-8)°

.soh=e(x3 +x, x)

In(-1)

(V)
csen(x) x
(-8)'"°
0,1 -1
In

with(RealDomain) :

simplify( )

I
1
3
(-8)
-2
Soi’ve(x3 +x, x:)
0
In(-1)
undefined

Obrdzek 1.21: Pouziti baliku RealDomain.

simplify (%)

Fi= 10[[;@]]-9.81%

&

98.10 [[k=] [ ]

[s]?

98.10 [[V]

Obrazek 1.22: Pouziti jednotek (pfevzato z [6]).

-
Maplesoft

— _

Units Calculator

Convert between over 500 units of measurement. See Units help index for details.

First, select a dimension from the drop-down box. Then select the units to convert from and to.
Click the "Perform Unit Conversion" button. The "Convert Back" button converts in the

opposite direction.

Convert: I*°

Result- 3.048000000

From: [feet (ft)

Dimension: llength

||

||

To: [meters (m)

Perform Unit Conversion | Convert Back |

Obrazek 1.23: Units Calculator (pfevzato z [6]).

1.4.5 ResSeni rovnic

Spustit jej muzeme z hlavniho menu pfes Tools > Assistants > Units Calculator....
Ukazku poskytuje obrazek 1.23.
Pokud chceme pouzit jednotku, ktera neni v paleté Units, muzeme si ji vytvorit sami
tak, ze pridame jednotku s ndzvem unit a nazev prepiSeme. V systému Maple 16 je imple-
mentovano pres 500 jednotek (tzn. v paleté Units je pouze nékolik vybranych) [6].

K fteseni rovnic v systému Maple slouzi piikaz solve a nékolik piikazi k nému ptribuznych
zavislych na typech rovnic, viz tabulka 1.1.
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Tabulka 1.1: Ptrikazy pro feseni rovnic

Typ rovnice Piikaz pro reseni

Rovnice a nerovnice solve, fsolve

Obycejné diferencialni rovnice dsolve

Parcialni diferencialni rovnice pdsolve

Rovnice v oboru celych ¢isel isolve

Rovnice v oboru celych ¢isel v koneéném télese | msolve

Linearni integrélni rovnice intsolve

Systémy linearnich rovnic LinearAlgebra[LinearSolve]
Rekurentni rovnice rsolve

Pomoci interaktivniho prostiedi Standard Worksheet muzeme Tesit rovnice téz pomoci
kontextové nabidky. ZapiSeme rovnici a pravym tla¢itkem mysi zvolime pozadovany prikaz.
Obrazek 1.24 ilustruje nékteré piiklady feSeni rovnic.

Rownice
SO.IEVé‘(JC:: +3-x+ 6=0)
-2, -3

solve

S 6=0— [x=-2}, {x=-3}

Nerovnice

SO.IEVé‘(JC:: +35x+6< 0)
RealRange(COpen( -3), Cpen(-2))

solve

S H6 <05 (3 x< -2}

Rekurenini rovnice
rsolve({N(t4+1) = (14 a —b)- N(t), N(0) =AU}, N(t))
M (l+a—b)

30lVe reCUrtence

N(t+1)=(14+a—b) N(t), N(0) =0 ——5 o (1+a—b)

Diferencialni rovnice

a’sofve[ [%N{r) = (@ — b)-N{(t), N(0) =NEJU

N(t)=npeld 2!
d zolve DE

17 (8) = (a —b)-N(z), N(0) =M0——— N[z} —ApeldT !

Obrazek 1.24: Ukéazka tfeSeni ruznych druhu rovnic pouzitim jednak prikazu, jednak kontextové
nabidky (pfevzato z [6]).

Ptikazy pro feSeni rovnic nemusi vzdy zobrazit vSechna feSeni. Pokud je chceme zobrazit,
pridame pifkazu solve nepovinny parametr Al1Solutions, viz obrazek 1.25 [6].

Symbol _Z2~ na obrizku 1.25 piedstavuje libovolnou celoéiselnou proménnou. Ze jde
o celo¢iselnou proménnou pozname podle toho, ze se v symbolu vyskytuje pismeno Z. Po-
dobné by vyskyt napiiklad pismena C znac¢il proménnou komplexni. Cifra 2 v symbolu
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solve (sin(x) =cos(x))

R
4

solve (sin(x) = cos (x), AllSolutions )

1

St 72~
about( _Z2)

originally ZZ, renamed EZ-~:
iz assumed to be: integer

list assurmnptions

Fl———————— { F2~uinteger}

Obrdzek 1.25: Zobrazeni vSech feseni rovnice (pfevzato z [6]).

proménné oznacuje poradi, v jakém byla proménna v zapisniku zavedena. A nakonec znak
~ vyjadiuje, ze proménna spliuje néjaky predpoklad. Jaké predpoklady proménna spliuje
pritom zjistime pitkazem about, pifipadné zapisem proménné a po kliknuti pravym tlac¢itkem
mysi zvolenim What Assumptions z kontextové nabidky. V zobrazeném piikladu na
obrazku 1.25 je predpoklad celociselnosti (u jiz celo¢iselné) proménné piebytecny.

Soﬁve(x4 —2:2+ 2=0)
Rc:lc:lrt’_?f[_ZACl -2 _Z'3 + 2, index = 1), Jf?c:lc:litOf[_Z"Cl -2 _2'3 + 2, index =2),
RoorOf[_Z4 -2 _2’3 + 2, index=3 ), ROOIOf(_Z4 -2 _2’3 + 2, index =4)

allvalies ({%})

1 1 1 1 1 1 1 1
?—?I—?\I4+21,?—?I+?\F4+2I,?+?I
1 1 1 1
—?\."4—21,?4'?1{'?\#4—21
evalf (%)

{ -0.5290855140 — 0.7429341359 1, - 0.5290855140 + 0.7429341359 1,
1.529085514 — 0.2570658641 1, 1.529085514 4 0.2570658641 1}

Obrdzek 1.26: Tvar zobrazeni feSeni rovnice (prevzato z [6]).

Daéle muze prikaz solve zobrazit vysledek se strukturou Root0f vyjadiujici koten (tj. Feseni)
rovnice v nevyhodnoceném tvaru. Reseni pak vyhodnotime bud pifkazem allvalues (pro
symbolické vyjadreni), nebo piikazem evalf (pro numerické vyjadieni) — obrazek 1.26. Ve-
dle prikazu muzeme téz vyuzit pravého tlac¢itka mysi, zvolit z kontextové nabidky polozku
All Values (pro symbolické vyjadieni) a ziskany vysledek prevést na numerickou hodnotu
zvolenim Approximate > 10 (pro 10 platnych mist) z kontextové nabidky.

Symboly _Z ve struktufe Root0f nyni nepiedstavuji celo¢iselnou proménnou (nebot za
pismenem Z nenésleduje ¢islo), nybrz proménnou libovolnou (tj. i komplexni).

Systém Maple po zadani prikazu vypise zpravidla pouze feseni, pripadné chybova hlaseni
¢i varovani. U piikazu solve (a nejen u néj) toto chovani zpusobuje ,prazdny vypis“ v piipadé,
ze Maple zadné TeSeni nenasel. Pro vypis podrobnéjsich informaci o prubéhu vyhodnoceni
pifkazu a vysledcich slouzi proménnd infolevel. MuzZeme ji nastavit bud pro kazdy piikaz
samostatné, pricemz do hranatych zdvorek za proménnou vlozime nazev prislusného piikazu,
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nebo ji nastavime vsem prikazum soucasné na stejnou hodnotu uvedenim slova all do hra-
natych zavorek. Proménna muze nabyvat hodnot 1, 2, ..., 5. Cfm vy3sf hodnota je pFifazena
v proménné infolevel, tim vice informaci o vyhodnoceni piikazu obdrzime. Standardné
neni proménnd nastavena na zadnou hodnotu, coz v podstaté odpovida nastaveni proménné
na hodnotu 0. Pouziti proménné infolevel dokumentuji obrazky 1.27 a 1.28 [6].

SOEV&‘(XE < 0)
infolevel [salve] =1

Soﬁve(x2<0)
solve: Warning: no solutions found

Obrazek 1.27: Proménnd infolevel a ,prazdny vypis“ piikazu solve (pfevzato z [6]).

solve( {x +y=2,x—y=0})

[x=1,y=1}
infolevel| salve] == 1:
solve( {x +y=2,x —y=0})

{x=1.y=1}

mfolevel| salve] == 3

solve( {x+y=2,x—y=0})

Main: Entering sclver with 2 eguations in 2 wariables
Linear: solving 2 linear equations

Rational: # equations 2

Rational: 2 eguations solved, rank: 2

Main: solving successful - now forming solutions

Main: Exiting sclver returning 1 solution
{x=1y=1}

mfolevel| salve] == 5

solve( {x+y=2,x—y=0})

Main: Entering sclver with 2 equations in 2 wariables
Transformer: solving the uncoupled linear subsystem in {x, v}
Linear: solving 2 linsar equations

Rational: # eguations 2

Rational: # eguations 1

Rational: # equations 0O

Rational: backsubstitution at: 2

Rational: backsubstitution at: 1
Rational: 2 eguations solved, rank: 2

Main: sclving successful - now forming solutions

Main: Exiting sclver returning 1 solution
{x=1y=1}

Obrdzek 1.28: Proménnd infolevel a piikaz solve.

Piiklad 1.12: Reste nerovnici: [z — 2| < 1 pro x € R.
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Resend: Pro Feseni nerovnice pouzijeme pitkaz solve. Ziskany vysledek odpovida zapisu
x € (1,3). Vyraz RealRange znadi redlny interval, vyraz Open(1) vyjadfuje otevieny in-
terval (v bodé 1). Pokud bychom zadali argument piikazu solve do slozenych zavorek (tj.
solve({|1x-2[<1})), ziskali bychom vysledek ve tvaru nerovnosti.

solve(|x —2| < 1)
RealRange( Open( 1), Open(3))

Obrdzek 1.29: Reseni pitkladu 1.12.

Piiklad 1.13: Reste nerovnici |z — 2| < 1 pro z € Z.
Piiklad 1.14: Reste nerovnici |z — 2| > 1 pro z € Z.

Priklad 1.15: Urcete kofeny polynomu 2® — 3 - 22 — 13-z + 15 pro = € R.

Reseni: Kofeny polynomu muzeme uréit riznymi zpusoby. Jednak je mozné pouzit pifkaz
solve a hledat body, v nichz je polynom nulovy. Systém Maple nabizi téz piikaz roots pro
hledani kofenu polynomu jedné proménné. Oba postupy ilustruje obrazek 1.30.

Soh=e(x3 —32 —13x+ 15=O)
5.1,-3
roozs(x3 —3. - 13- x+ 15)
[[]-- 1]‘ [5‘ 1]- [ -3, 1]]

Obrdzek 1.30: Reseni piikladu 1.15.

Vystup pitkazu roots je tvofen seznamem dvojic. Kazda dvojice obsahuje hodnotu
korenu a jeho nasobnost.

Piiklad 1.16: Reste nerovnici z < 22 — 12 <4 -2 pro z € R.

Piiklad 1.17: Uréete obecné kofeny kvadratického polynomu tvaru a - 2? +b -z + ¢ pro
a € R\ {0},b € R,c € R,z € C. Zamyslete se, jak byste v feSeni postupovali, kdybychom
povolili moznost a = 0 a x omezili jen na redlna ¢isla.

Piiklad 1.18: Reste rovnici tan(z) = /3 pro z € R.

Piiklad 1.19: Reste soustavu rovnic
S5-x—T7-y=-9,

3-x+y=>5
prox € R,y € R.
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2 Matematicka analyza s Maple v R

2.1 Vyrazy a jejich tpravy

2.1.1 Zjednoduseni vyrazu

Ke zjednoduSeni vyrazu slouzi predevsim piikazy simplify, normal a combine. Piikaz
simplify provadi zdkladni zjednoduSeni zadaného vyrazu, piikaz normal je urc¢en pro upravy
zlomku a piikaz combine slucuje vyrazy. Vybrané priklady pouziti muzeme pozorovat na
obrazku 2.1.

X x—2y
Iifv
ﬂmplﬁ[ x+2y i 2 —4y J
x+1
x4+ 2y
Slmpféﬁ/{ Cb +1ﬂr€:] )
de
1 X
mal | —
Hmma[ . +x+1 ]
x+1 +Jr2
x(x+1)
normaf[i +— expanded
x x+1 P
x+1 +Jr2
x2 +x
Combme(esin(a)-cos(b).ccos(a)-sin(.?;))
sin(a+b)
€
combine(2-sin(x) -cos(x) )
sin( 2 x)

Obrazek 2.1: Zjednodusovani vyrazu.

2.1.2 Omezujici podminky

Piikazu simplify (stejné jako ostatnim piikazim) muzeme doplnit omezujici podminky
(resp. predpoklady), které budou aplikovany pii zjednodusovani zadaného vyrazu. Prove-
deme to bud piiddnim druhého parametru assume = podminka, nebo zdpisem assuming
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podminka za piikaz simplify. Jako druhy parametr muzeme uvést také mnozinu ome-
zujicich rovnosti. Konkrétni piiklady vidime na obrazku 2.2.

simplify( )

Simpf;ﬁ'( \/xc_z assume= reaf)

csgn(x) x

I

Simpfgﬁ'( \/? , assume = posz’rfve)

o 2 i
simplifv\ || X~ , assume = negative

Simpfgﬁ'(\/?) assuming x :: real
Simpfg@'(\/? ) assuming x :: positive
Simpfg'fy( (-1 }Z) assuTing z 1 even

Simpfgﬁ'( (-1 }2) assuming z :: odd
-1

vi=x+6r+5x+4u—2r—9x-y+12
6x+4r+4u—9xy+12
Simpfgfv(v: {x=2,}'=3:u=1})
40 — 18y

Obrazek 2.2: ZjednoduSovani vyrazi — dalsi moznosti pifkazu simplify.

2.1.3 ijrava polynomu

Predevsim pro tpravy polynomu méame k dispozici prikazy collect, coeff, sort, factor
a expand, jejichz pouziti shrnuje tabulka 2.1 a na piikladech dokumentuji obrazky 2.3, 2.4.

Tabulka 2.1: Ptikazy pro upravy predevsim polynomu
Piikaz | Pouziti
collect | vytykani ve vyrazech (nejen polynomech)
coeff koeficient u zvoleného ¢lenu polynomu
sort setfidéni ¢lenu polynomu (nebo prvku seznamu)
factor | rozklad polynomu na sou¢in kofenovych ¢initelu
expand | rozndsobeni / rozvinuti (nejen u polynomi)

2.1.4 Prevod vyrazu na jiny tvar

Zavérem této sekce zminime velmi univerzalni prikaz convert. S jeho pomoci muzeme
prevadeét zadany vyraz (ptipadné jinou datovou strukturu jako napf. seznam) na jiny (zvo-
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a-In(x) -ln(x) x —x
aln(x) —Iln(x)x—x
collect( %, In(x) )
(a—x)In(x) —x
collect(a +a-\[3 ,a)
(1+V3)a

py=2"—8 X +23x" +68 X —244- " — 224 x +384:

caeﬁ(pl_. X, 4)
23
caeﬁ(pl_. x, 1 )
-224
caeﬁ(pl_. X, O)
384

SOP‘I(]. +x +3 372 —4-:{4)
~4x X 3041
SOP‘I(l +X +3x2— 4-x4: x, tdeg, a.sceﬂdmg)
1+3_7cz+:153—4::(4

Obrdzek 2.3: Pouziti piikazi collect, coeff a sort.

6 5 4 3 2
pafl =x —8-x +23-x +68-x —244.-x —124.- x+ 384
6 5 4 3 2
x —8x +23x +68x —244x —224x+ 384
pol, ==x' — 6% +22.X — 48-x + 40
4 3 2
x —6x +22x —48x+ 40

5, :Zfacmr(poi’l}
(x—1) (x=3) (¥ —=8x+32) (x+2)°
5, :Zfacmr(pafz}

(=]

(¥ —2x+10) (x—2)

expand(.sl)
6 5 4 3 2
x —8x +23x +68x —244x —224x+ 384
expand(.sj)
4 3 2
x —6x +22x —48x+40

Obrdzek 2.4: Pouziti piikazi factor a expand.

leny) tvart. Obrazky 2.5 a 2.6 ukazuji pouziti piikazu pro prevod desetinného ¢&fsla na zlomek

1 Jelikoz m4 pifkaz convert mnoho riiznych pouziti, doporuc¢ujeme étendii podivat se na stranku napovédy
k tomuto pifkazu (viz ?convert).
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(priddvdme parametr rational) a pro prevod vyrazu na parcidlni zlomky (piidavdme para-
metr parfrac?).

convert(0.125, rarional )
1
8
convert( 12.567, rational )
12567
1000
convert(0.33333333, rational )
33333333
100000000
ALE POZOR!!! (za desetinou te¢kou je 10 "trojek™)
convert(0.3333333333, rational )
1
3
_ (xs + 1)
f=13 2
(" =)
41
1 2
X =X
convert( f, parfrac)
1 1
x—— +
¥ x—1
X
= —X
(x-b)
X
(x—=1Db)
convert( f, parfrac, x)
1 . + b i
v=b " (x—p)
convert( f, parfrac, b)
X
2
(-x+5)

Obrdzek 2.5: Pouziti piikazu convert.

Jak jsme jiz vidéli, v prostiedi Standard Worksheet je obvykle vice moznosti, jak fesit
danou ulohu. U vyse uvedenych piikladu (na obrazcich 2.1 — 2.6) je mozné vyuzit také
kontextové nabidky. Do dokumentu vlozime vyraz, ktery chceme upravovat, klikneme na
néj pravym tlacitkem mysi a z kontextové nabidky zvolime pozadovany piikaz (¢asto i s
upfesnénim pozadované upravy, tj. napi. vybereme Simplify>Simplify nebo Combine>exp
¢i Simplify>Assuming Real atp.). Timto zpusobem muzeme obdrzet napiiklad vysledky
na obrazku 2.7.

2Symbol I v systému Maple znaéi imagondrni jednotku.
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(4. —6-22—2)

fi=—
(' —2-¥ —2-x+4)
4% —6x" —2
X —2x —2x+4
convert( f., parfrac)
,
3x 1
3 + 2
x —2 Xr—=-

convert( f, parfrac, real)
1.01 i 1.27+2.00x 0.992
x—2 ¥ 11259921050 x + 1.587401052 X — 1.259921050
convert( f, parfrac, complex)
0.980 + 0.003341 0.999 + 0.00528 1 1.00 — 0.002941 1.02 — 0.005681
x—2. x+0630—1091 x+0.630+1.091 -1.26 +x

Obrazek 2.6: Moznosti piikazu convert pii rozkladu vyrazu na parcidlni zlomky.

X + x—2y simplify x4+ 1
x+2y 2 gyl x+2y
L'l‘ X normal .7C+1+.‘!C2
x x+1 x(x+1)

esin(a) rcos(b) E:cos(a) -sin(b) combing esin[a) cos(b) + cos(a) sin( &) combing esin(a +5)
3 assuming real
g EEEE
lect
a-ln(x) -ln(x) x —x“=% (@ —x) In(x) —x

=8 231 68 1 —244- % — 224 x + 38428 (x— 1) (x—3) (P —8x+32) (x+2)

2

d z :
(x—1) (x—3) (® —8x+32) (x+2)2"E" P —8x +23x" +68x — 24457 — 224 x + 384
0.125 convert to rational 1
o Lo * 8
X convert to partial fractions inx b + 1
(x=b)* (x—b)*  x—b

Obrazek 2.7: Zjednoduovani vyrazu pomoci kontextové nabidky.
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Piiklad 2.1: Uréete hodnotu vyrazu —W pro b=16,z =9,y = 3.

Reseni: Pro vyfeseni mame vice moznosti. Pouzijme nejprve pifkaz simplify podobné
jako na obrazku 2.2. Muze se stat, ze prikaz neupravi ,najednou” zadany vyraz az na nej-
jednodussi tvar. V takovém piipadé (ktery pravé nyni nastane) jej pouzijeme dvakrat. Dalsi
moznosti je pouzit vyhodnocovaci prikaz eval.

simplify x+b (ax—bx) .{b=16,x=9,y=3}

Vv a—>b
1
=2
3 25
simplifv( %)
3
3
nebo
Simpfgﬁ[szmpfﬁ{ : r—l—b . (a-x—z-x) \ {b=16,x=9,}'=3}]]
y a-
3
3

e

C1

Simpfgﬁ:[evaf[ x+b  (ax—bx) \ {b=16,x=9,y=3}]]

}.3 a—2>b

5

3

Obrdzek 2.8: Reseni pifkladu 2.1.

Priklad 2.2: Vytvoite polynom, ktery méa jeden trojnasobny kofen s hodnotou % a jeden
dvojnasobny s hodnotou —5. Necht je vysledny polynom v rozndsobeném tvaru.

Reseni: Polynomu spliujicich zadan{ je nekoneéné mnoho, piipustime-li moznost mit
i dalsi koreny. Koreny jednozna¢né urcuji korenové cinitele polynomu. Polynom majici pouze
kofeny zminéné v zadéni bude tvofeny tfemi ¢initeli tvaru (z — 2) a dvéma tvaru (z — 5).
Roznasobeny tvar ziskdme piikazem expand.

] (x+35) ]
3 387 2 675

11 2

h.JlL-.a

expand [ [

Obrdzek 2.9: Reseni pifkladu 2.2.

Piiklad 2.3: Zjednoduste vyraz cos(n - 7) za predpokladu, ze n je sudé.
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Piiklad 2.4: Zjednoduste vyraz

Priklad 2.5: Zjednoduste vyraz

sin(2 - x) — cos(x)
cos(2-x) — 1+ sin(x)

Priklad 2.6: Rozlozte na soucin: 4 - 22 - (y? — 2%) +25-v - (22 — ¢?).
Priklad 2.7: Zjednoduste: (2-h+5-5)>—(2-h+5-5)-(2-h—5"-5).

Priklad 2.8: Necht

pr=a"+15- 21 4+85 23 +225 - 2 + 274 -2+ 120, py=2a’+6-x+8.

Zjednoduste 2. Vysledek rozlozte na soucin kotenovych ¢initelu. Vyraz g—f rozlozte na

p2
parcialni zlomky.

2.2 Funkce jedné proménné

2.2.1 Definice funkce

V prostiedi Standard Worksheet jsou 2 zpusoby, jak definovat funkci. Vytvorme naptiklad
funkci f(x) = 2% Prvni moznosti (k dispozici jen v prostiedi Standard Worksheet a pro
matematicky rezim Math Mode) je napsat funkéni predpis stejné, jak jsme to udélali pred
chvili, s tim rozdilem, Ze namisto rovnitka (,,=“) pouzijeme symbol pro prifazeni (,:=%),
tedy f(x):=x"2. Po spusténi prikazu musime v nasledné zobrazeném vyskakujicim okénku
potvrdit, Zze se jednd o definici funkce. Druhou moznosti (platnou i v jinych prostiedich
systému Maple), jak vytvorit funkci, je pouziti sipkové notace. Piikaz pak vypada nasledovné:
f:=x->x"2. Sipku vytvoifme pomlékou nésledovanou symbolem ,vétsi nez“ (,>%).

V prostredi Standard Worksheet si definovani funkce muzeme ulehé¢it vyuzitim palet.
Bud je mozné pii vytvaieni pifkazu pouzit sipku z palety Arrows, nebo miZzeme vzit celou
Sablonu piikazu vytvoreni funkce z palety Expression a modifikovat v ni pozadované sym-
boly. Funkéni hodnotu definované funkce v daném bodé ziskame zapisem nazvu funkce spolu
s hodnotami parametru v zévorce (nemusime pfitom zadavat pouze numerické hodnoty).

Dulezité je v Maple dusledné rozlisovat funkce a vyrazy, 1épe feceno funkéni operatory
a vyrazy. V matematice totiz uzivame pojem funkce i v pripadech, které v Maple predstavuji
vyrazy (funkéni vyrazy — napt. f(z)). Jestlize vytvorime vyraz, napiiklad x~2, a pritadime
jej k néjaké proménné, napr. g, jedna se stale pouze o vyraz. Hodnotu g pro x = 5 nemuzeme
proto urcit jako funkéni hodnotu v bodé 5, ale musime pouzit vyhodnocovaciho piikazu eval,
pripadné do z priradit hodnotu 5. Naproti tomu funkéni hodnotu funkce f (nebo vhodnéji
feceno funkéniho operdtoru) v bodé 5 ziskdme specifikaci argumentu operatoru (funkce) f,
viz obrazek 2.11 [6].

Déle Maple nabizi piikaz unapply, ktery ze zadaného vyrazu udéld funkci (funként
operétor). Tento piikaz mé dva argumenty: vyraz, z néhoz chceme udélat funkei, a nezavisle
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f:zx—>x2

x—x
z(x) =¥

=%
£(5) _
z(5)
fla+b)

(a+b)?
z(3-¢)

O9¢

Obrdzek 2.10: Definice funkce v prostiedi Standard Worksheet.

f:: x—}xz X ==E'x':
o apply( f. x) i
) X
g:=x
2
* apply(f. 5) )
£(5) 25
25
g(5) unapply(g. x) .
»
x(5)° Xx—x
eval( g, x=15)
25 unapply(g.x) (5)
¥ 25
X
Xx:=235
g
25
f(x)
25

Obrazek 2.11: Rozdil mezi funkei a vyrazem (pfevzato z [6] a doplnéno).

proménnou. Podobné mame k dispozici téz piikaz apply, ktery z funkéniho operdtoru udéla
vyraz (aplikuje funkéni operdtor na zadany argument /argumenty) — prava ¢ast obréazku 2.11.

Vyrazy a funkce muzeme téz definovat po castech pomoci pitkazu piecewise. Argu-
menty v zavorce urc¢uji vzdy nejprve interval nasledovany funkéni hodnotou na tomto in-
tervalu. Posledni mnozinu bodu jiz zapisovat nemusime, stac¢i funkéni hodnota. Maple ji
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doplni ve zbyvajici mnoziné zatim nedefinovanych bodu. Je mozné téz sestrojit funkci,
ktera je definovana pouze na libovolné podmnoziné redlnych ¢isel. Pokud mé funkce de-
finovana po ¢astech pouze dva ruzné predpisy, muzeme k jejimu vytvoreni vyuzit symbolu
oteviené slozené zavorky z palety Expression (viz obrazek 2.12) [6].

= x—piecewise(x < 0,-1,x=0,0,1
F
x—piecewise(x <0, -1,x=0,0,1)

f(-8)

-1
F(0)

0
£(153.6)

1

2= x—piecewise (x < 0, -x, undefined )
x—plecewise(x < 0, —x, undefined)

72(-8)

8
f2(4)

undefined
] X=<m
&) = 1 X =0
xﬁpz’ecewz’se{x <, 0,1 <, 1]

£(0)

0
£(3)

0
£(4)

1

Obrazek 2.12: Funkce definovana po ¢astech (pfevzato z [6]).

2.2.2 Vlastnosti funkci

Definice 2.1: Definicnim oborem funkce f nazyvame mnozinu vSech hodnot, pro néz je
funkce f definovdna. Znacime ji D(f)3. Oborem hodnot funkce f nazyvdme mnozinu viech
hodnot, kterych funkce f na svém definiénfm oboru nabyva. Znacime ji H(f)%.

Definice 2.2: Funkce f se nazyvé shora ohranicend, pokud existuje K € R tak, ze f(z) <
K pro vsechna x € D(f). Analogicky, funkce f se nazyvé zdola ohranicend, pokud existuje
L € R tak, ze f(x) > L pro vSechna x € D(f). Funkci f nazyvame ohranicenou (omezenou),
pokud je f ohrani¢end zdola i shora.

3V literatufe je téz mozné se setkat s oznacenim Dom/(f).
1V literatufe je téz mozné se setkat s oznacenim Im(f), ptipadné R(f).

35



Definice 2.3: Funkce f se nazyva sudd, pokud pro vsechna x € D(f) plati, ze —x € D(f)
a f(x) = f(—x). Funkce f se nazyva lichd, pokud pro vsechna = € D(f) plati, ze —z € D(f)

a f(r) = —f(-x).

Definice 2.4: Nechf M C D(f) obsahuje alespoii 2 body. Rekneme, ze funkce f je na M
(a) rostouct, jestlize Va1, x9 € M : 1y < g = f(x1) < f(22),

(b) klesajici, jestlize Va1, 29 € M : 11 < x9 = f(21) > f(x2),

(c) nerostouct, jestlize Vay,x9 € M = 21 < 9 = f(21) > f(x2),

(d) neklesagict, jestlize Vi, 29 € M : 21 < 29 = f(x1) < f(x2),

(e) konstantni, jestlize Vay,xo € M : f(x1) = f(x2).

Definice 2.5: Necht M C D(f) obsahuje alespoii 2 body. Rekneme, ze funkce f je na M
(a) prostd (injektivni), jestlize Vay,x9 € M : 1 # x5 = f(21) # f(29),

(b) zobrazenim na mnozinu N C H(f) (surjektivni), jestlize Vy € N : dx € M A f(z) = v,
(c) bijektivni z M do N, jestlize je prostd na M a soucasné je zobrazenim na mnozinu N
(tedy injektivni a surjektivni).

Systém Maple nemé zadné piikazy na urcovani pravé definovanych vlastnosti. To vsak
neznamena, ze tyto vlastnosti nemuzeme urcovat sami. V nékterych piipadech nam muze
systém Maple pomoci.

I definiéni obor a obor hodnot funkce musime zjistit sami. Systém Maple muzeme efek-
tivné vyuzit pouze v pripadech, kdy si nejsme jisti, jestli dany bod patii do nékteré z mnozin,
a to bud pokusem o vyhodnoceni funkce v daném bodé nebo hleddnim feSen{ rovnice, kdy
se uvazovana funkce rovna danému bodu.

Piiklad 2.9: Urcete D(f) a H(f) funkce f(z) = In(x).

Resend: 7 piednasky Matematické analyzy vime, ze D(f) = Rt = {z € R|z > 0}
a H(f) = R. Systém Maple bychom vyuzili asi jen v piipadé, kdybychom si nebyli jisti, jak je
definovana funkce In(z) a chtéli se napiiklad presvédcit, ze neni definovédna pro z = 0. V tom
piipadé bychom mohli zkusit ziskat funkéni hodnotu v bodé 0. Na obrézku 2.13 vidime, ze
obdrzime chybovou zprévu, kterd je sice trochu matouci (zminovano je déleni nulou), nicméné
funkéni hodnota neexistuje. Podobné muzeme napiiklad ovérit, ze 0 € H(f), feSenim rovnice
In(x) = 0. Upozornéme, ze Maple pocita standardné s komplexnimi ¢isly, a tak vyhodnoceni
funkce In(x) pro zaporné x nezpusobi zadnou chybu. Jelikoz se pohybujeme v oboru redlnych
¢isel, je tfeba se omezit pouze na néj nactenim baliku RealDomain (viz obrazek 1.21).

In(0)

Error, (in 1n) numeric exception: division by zero

solve(ln(x) =0)

Obrdzek 2.13: Reseni piikladu 2.9.

Pro zjisténi, zda je funkce (shora, zdola) ohranic¢end, ¢i nikoliv, muzeme vyuzit prikazu
minimize a maximize pro hledédni nejmensich a nejvétsich funkénich hodnot. V piipadé, ze
funkce neni ,,v nékterém sméru“ ohranicenda, vraci zminéné pirikazy hodnotu oo, resp. —oo.
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Dalsi funkéni vliastnosti muzeme urcovat (ovérovat) za pomoci piikazu evalb nebo verify.
Tyto prikazy otestuji, zda je zadany vyraz pravdivy, ¢i nikoliv. Ukazme si to na néasledujicim
prikladu.

Piiklad 2.10: Urcete, zda je funkce cos(z) sudd nebo licha.

Reseni: Opét z prednasky vime, ze funkce cos(z) je funkel sudou. Sudost funkce otestu-
jeme zjisténim pravdivostni hodnoty vyrazu cos(z) = cos(—x), lichost podobné podle prav-
divostni hodnoty vyrazu cos(z) = —cos(—x). I tentokrat bychom sprdvné méli pouzit balik
RealDomain, nebot bez néj ovéiujeme zminéné rovnosti pro vsechna komplexni z. V obou
pripadech vsak ziskame stejny vysledek.

evalb(cos(x) =cos( -x) )
true
evalb(cos(x) =-cos( -x) )

false

Obrdzek 2.1/: Reseni piikladu 2.10.

Prestoze muzeme vytvorit logické vyrazy i pro zbylé funkcéni vlastnosti, prikazy evalb
a verify vétsinou vraceji hodnotu FAIL jako znameni, ze nedokéazi o pravdivostni hodnoté
rozhodnout. Nékteré dalsi priklady je proto potieba Tesit samostatné a systém Maple vyuzit
jen k ,drobnym podiloham* — jako v nasledujicim piikladu 2.11.

Piiklad 2.11: Urcete, zda je funkce cos(x) na R rostouci, klesajici, prosta ¢i bijektivni.

Resend: 7 piednasky vime, ze funkce cos(z) na celé mnoziné R zidnou ze zminénych
vlastnosti nesplnuje, coz muzeme dokazat nalezenim protipiikladu. Vezméme napt. body
x1=0axy =2 -7 Plati, ze 1 < x5 (tj. 1 # x2) a soucasné cos(x1) = cos(xz). Tedy funkce
neni rostouci, neni klesajici a neni prosta, z ¢ehoz plyne, ze nemuze byt ani bijektivni.
Systém Maple tu muzeme pouzit ke zjistovan{ funkénich hodnot (i kdyz v tomto pripadé
zname funkéni hodnoty zpaméti).

V praxi se nam vsak ¢asto hodi najit intervaly, v nichz funkce nékteré vlastnosti splnuje.
Funkce cos(z) je periodickéd s periodou 2 - 7 a na intervalech [k - m, (k+ 1) 7| pro k € Z

je bijektivni (tedy i prostd), pro suda k je na téchto intervalech vzdy klesajici, pro lichd k
rostouci.

Priklad 2.12: Dokazte, ze funkce sin(z) je ohranicend.

Piiklad 2.13: Uvazujme funkci f(z) = m. Je f suda nebo lichd? Urcete jeji defini¢ni
obor a obor hodnot. Je f ohrani¢ena?

Priklad 2.14: U nésledujicich funkei urcete, zda jsou sudé, liché, nebo ani jedno.

(a) flx)=9 a2, (b) f(2) = V2, (0) fla)=1.
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Priklad 2.15: Definujte funkei f, pro niz platf:
(a) D(f)=(0,1), H(f) = (0,2),
(b) D(f) =R\ {1}, H(f) =R\ {0},
(c) D(f) =R\A{0}, H(f) =R\ {1},
(d) D(f) =R, H(f) =R*, f je prostd,
(e) D(f) =R\ (-2,2), H(f) =R,
(f) D(f) =R, H(f) =R\ (-2,2),
(2) D(f) =R, f je prosta a ohranicen,

(h) H(f) =R, f je suda.

Priklad 2.16: Naleznéte k € R tak, aby byla funkce f(z) = 2® —k - 22+ 2 - x lich4.

Priklad 2.17: U nésledujicich funkei urcete, zda se jedna o bijekci, ¢i nikoliv.
(a) f:R=R, f(z)=a-z+b,a,beR,
(b) f:Ry =Ry, f(z) =z,
(c) f:R—=Ry, f(z)=a?
(d) f:R—=R, f(z) =2%

(e) f:R\{0} =R\ {0}, f(z) = 1.

2.2.3 Inverzni funkce

Definice 2.6: Necht f je prostd funkce. Funkci f~!, pro niz plati: D(f™') = H(f) aVz €
D(f): 3y € H(f) tak, ze f~Y(y) = x & f(x) = y, nazyvame inverzni funkci.

Poznamka 2.1: 7 definice plyne, ze funkce a jeji inverze jsou osové symetrické vzhledem
k ptimce y = z.

Systém Maple mé uchovano nékolik zakladnich funkei s jejich inverzemi v tabulce s ndzvem
invfunc. Praktic¢téjsi je vyuzit piikazu InverseTutor nebo InversePlot z baliku Student [Calculus1]
vykreslujicich do jednoho grafu funkei, jeji inverzi a osu y = x jakozto osu symetrie. Piikaz
InverseTutor provadi zminéné v mapletu, pfikaz InversePlot slouzi pro pouziti v doku-
mentu (obrazek 2.15).

Hledat predpis inverzni funkce muzeme rovnou podle definice 2.6, a to feSenim rovnice
f(y) = z pro nezndmou y.
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Priklad 2.18:

with( Student| Caleulusl |) :
X
Inver.s*epfaz( e,-4 ..2)
Reflection actossyp=x
g
&
-~
6 e
&
e
e
4 s
-~
Ve
rd
2 s
~
_/ /
#
-4 2 A 2 4 6
v x
-
/ -2
~
~
4 -4
| fix) {{x) reflected across y=x
Oy the interval [ -4, 2], a graphof f(x) = ¢ the line y= », and the
reflection of £/ #) across the liney = x.

Obrazek 2.15: Vykresleni funkce a jeji inverze.

gl

X—X
¥(x) = solve(f(y) =x.3)
x—rsolve(f(y) =x,y)

vix)[1]
Jx

~Vx

y(ix)[2]

Obrdzek 2.16: Reseni piikladu 2.18.

Naleznéte inverzni funkei k funkci f(x) = 22

Reseni: Nage odpoved by mohla byt velice struénd, nebot funkce f neni prostd, a tak
k ni neexistuje funkce inverzni. Nicméné je mozné funkci f rozdélit na dvé funkce prosté

a hledat inverzi ke kazdé zv1ast.

V systému Maple provedeme dfive zminény postup, tj. budeme fesit rovnici f(y) = x.
Ziskdme 2 feseni, a to pravé pro 2 ,prosté ¢asti“ funkce f. Pro # < 0 je inverze k 2 rovna

—+/z, pro > 0 je rovna /x (obrazek 2.16).
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Priiklad 2.19: Naleznéte inverzni funkce k néasledujicim funkcim:
(a) flz)=2-z+1, (c) flz) =14, (e) fla) =1,
(b) f(z) =27, (d) f(z) =v1-u, (£) f) =3l

Priklad 2.20: Existuje funkce, ktera je sama sobé inverzi? Pokud ano, je jedina, nebo jich
existuje vice?

2.2.4 Slozena funkce

Operatorem slozeni funkei je v systému Maple symbol @ (zavina¢). V praxi se bez néj vsak
obejdeme, kdyz pouzijeme kulaté zavorky. Na obrazku 2.17 je nékolik prikladu vytvoreni
slozené funkee, které potvrzuji rovnost f(f~'(z)) = z.

flx) = _
.T_*.TJ
g(x) =x ,
x—*xl'j
(f@g)(x)
X
f(g(x))
X
£(x) = sin(x)
x—+sin(x)

x—+arcsin(x)

Obrazek 2.17: Slozena funkce.

2.3 Vykresleni grafu funkce

2.3.1 Vykreslovani

Prostredi Standard Worksheet poskytuje nékolik moznosti, jak zobrazit graf funkce nebo
vyrazu. Nejrychlejsi a ziejmé nejjednodussi moznosti je zapsat do dokumentu vyraz (resp.
funkci), ktery chceme vykreslit, kliknout na néj pravym tlacitkem a z kontextové nabidky
zvolit Plots > 2-D Plot.
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ET;] Interactive Plot Builder: Seleck Plot Type

—Select Plot Type and Functions

x|

Edit Functions |

—Select Plok

2-D plok

2-D polar plat
3-0 conformal plok of a complex-valued Function

2-D conformal plot of a complex-valued Function
2-D complex; plat

3-0 camples: plak

—Select Yariable Purposes, Ranges, and Plot Options

¢ ks [« =] |0 o o
Options | Preview |
r

Cn "Plo’ return plok command

Flot I Cancel |

Obrazek 2.18: Zvoleni typu vykresleni v Plot Builder (pfevzato z [6]).

ET,] Interactive Plot Builder: Specify Expressions

x|
File

— Expressions

Add
Edit:

Remove

i

— Wariables

fAdd

Remoye

d

6] | Quik |

Obrdzek 2.19: Okénko pro zadani vyrazu z funkéniho predpisu a nezavisle proménnych v Plot
Builder (ptevzato z [6]).
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Déle muZzeme vyuzit pomocnik Plot Builder, a to dvéma zpisoby. Bud’ opét zapiSeme
do dokumentu vyraz z funkéniho predpisu, klikneme pravym tlacitkem mysi a zvolime Plots
> Plot Builder, nebo zamitime do hlavniho menu a vybereme Tools > Assistants > Plot
Builder.... V prvnim piipadé se objevi okénko Interactive Plot Builder (obrizek 2.18),
v némz upfesnime typ vykresleni. Pokud uvazujeme funkci jedné proménné, volime 2-D
Plot. Je mozné volit i jinou moznost jako napiiklad vykresleni v polarnich soufadnicich
(2-D polar plot). Kliknutim na tlac¢itko Plot zobrazime graf v dokumentu [6].

V druhém piipadé, kdy Plot Builder vyvolame z hlavniho menu, se ndm objevi okénko
(viz obrézek 2.19), do néjz zaddme vyraz z predpisu funkce, kterou chceme zobrazit (zadani
nam umozni tla¢itka Add, resp. Edit), a proménné (pokud vyraz obsahuje pouze proménné,
systém je vyplni sdm). Kliknutim na tlacitko OK ptejdeme do jiz zndmého okénka pro zvolent
typu vykresleni (obrazek 2.18). Dalsi moznosti k vykresleni grafu vyrazu nebo funkce je prikaz
plot.

Pii vykreslovani muzeme specifikovat nékolik atributtt ménicich podobu grafu. Opét je
nékolik moznosti, jak atributy zadavat. Pii pouziti pomocnika Plot Builder se v okénku
Interactive Plot Builder (obrézek 2.18) objevuje tlacitko Options. Kliknutim na toto
tlacitko prejdeme na okénko (viz obrazek 2.21) umozinujici nastavit parametry vykresleni
jako jsou rozsah hodnot zavisle i nezévisle proménné, barva a styl vykreslované ktivky, titulek
grafu, legenda atd. Uzitecné je navic tla¢itko Preview umoznujici predbézné si prohlédnout
soucasny stav a nasledné pokracovat v dalsim nastavovani atributu vykresleni grafu.

2

\ 1004 /  |plot [ x )

A 'l

\ / . 100 ,

A 201 f’f \ /
\ / \ 20 /
\ 60 / Y /
, 60 /
X — \\‘ / \\' ,’f
\ 40- / /
AN S \-.\_ 40 1 /
W / 20 y,
r T —= = T 1 ~ -
-10 -3 0 3 10 -10 5 0 3 10
X

Obrazek 2.20: Vykresleni grafu pomoci kontextové nabidky a piikazu plot (pfevzato z [6]).

Pfi pouziti piikazu plot muzeme totéz provést specifikaci nepovinnych parametru jako
jsou thickness pro tloustku kiivky, color pro jeji barvu, labels pro popisky os, legend
pro tvar legendy u obrazku, axes pro nastaveni soutadych os a dalsi. Ukdzku pouziti prikazu
plot s nastavenim nékterych nepovinnych parametru nabizi obrézek 2.22 [6].

Vzhled grafu muzeme upravovat i po jeho vytvoreni a umisténi do dokumentu. Jednak lze
na graf kliknout pravym tlac¢itkem mysi a z kontextové nabidky vybirat vlastnosti grafu, které
jsme mohli ménit jiz diive, nebo muzeme vyuzit kontextové listy tésné nad dokumentem. Po
kliknut{ levym tlacitkem mysi na graf se ve zminéné listé zobrazi néstroje skupiny nazvané
Plot. K dispozici je téz skupina s nazvem Drawing. Nastroje v téchto skupinach umoznuji
do hotového grafu pridavat text, kreslit, ¢i jinak graf upravovat [6].

Jestlize chceme vykreslit vice funkei (resp. vyrazi) do jediného grafu, zapiseme vsechny
do hranatych, pripadné slozenych, zavorek jako prvni parametr piikazu plot. Uzivatelum
doporucujeme pouzivat spise hranaté zavorky, v nichz systém Maple respektuje poradi. Po-
kud nechceme u vykreslovanych funkei nic dale specifikovat, je nam jedno, v jakém potadi
Maple funkce ,vezme*“ a vykresli, pouzijeme libovolné zavorky (tj. hranaté nebo slozené).
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x|
>z

Wariables Label  Orientation
# |-1IZI ko IlD Ix Ihnriznntalll
Range from | to | | |horizantal ~ |
~Skyle ~Title

IdeFauIt VI I
~Line ITimes ;”10 ;ILI;'
Idefault ;I Idefault ;I —Caption

~Symbaol I

Idefault ;”m;l ITimes vlm ~| B | i |

~Color ~Miscellaneous

IRed LI Resalution IBDD vI
Cuskam |E Adaptive Plotting

Find Discontinuities

<]

AXES

Show Removable
Innrmal vl Advanced Settings |
Mumber of Points 200 -
ITimes v"lEl 'l B | I |

Fill ko x-axis I

N

—Wiew
~Coordinate System

Icartesian ;I
Preview | Flok I Command | Back. | Reset | Cancel |

Constrained Scaling I

Obrazek 2.21: Okénko Plot Builder pro nastaveni parametru grafu (pfevzato z [6]).

pﬁoi:(xQ, x=-5 .3, calor=biue, thickness =3, legend

="Graf funkee x"2", [abels = [ "x", "y"])
251
201
154

¥
104
5 -
4 3 0 2 4
X
m Graf funlice x72

Obrazek 2.22: Vykresleni grafu pii specifikaci nékterych nepovinnych parametru (ptrevzato z [6]).
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Pokud vsak chceme napt. kazdé z kiivek priradit néjakou barvu, pouzitim hranatych zavorek
se barvy aplikuji v tom poradi, v jakém ocekavame. Pti pouziti slozenych zavorek tomu tak
byt nemusi, viz obrazek 2.23.

pfoz( [xz, xg, x:] x=-2 .2, thickness= 3. color= | green, red, brown | ) pZoz( {xz, xg, x:} x=-2 .2, thickness =3, color= | green, red, brown | )

g 8-
6 64
44 4 4
14 74

Obrazek 2.23: Vykresleni grafu vice vyrazu piikazem plot.

K dispozici je déle piikaz display z baliku plots, kterym muzeme dosdhnout stejného
vysledku. Jednotlivé grafy nejprve vytvorime a pfifadime do proménnych, jez dame jako
parametry pravé piikazu display (obrézek 2.24).

2 .
pl = pi’oz(x ,x=-2..2, thickness =13, cofa}‘:g?‘een)

PLOT(...)
p2 = pi’or(x{ x=-2..2, thickness =3, color= red)
PLOT(...)
p3 = plot(x,x=-2 .2, thickness=3, color = brown)
PLOT(...)
plots[ display] ([ p1, p2, p3])
8 -
6 -
4_
2 -
2 - 0 i 2

Obrazek 2.24: Vykresleni grafu vice vyrazi pomoci pitkazu display.
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2.3.2 Animace

V systému Maple muzeme téZ vytvaret animace. Animace se sklada z nékolika grafu, které
jsou po spusténi zobrazené v sekvenci za sebou. Vytvoiime ji bud’ pifkazem animate z baliku
plots, nebo pomoci Plot Builderu. Obrazky 2.25 a 2.26 ukazuji nastaveni Plot Builderu
pro vytvoreni animace, obrazek 2.27 ilustruje tentyz priklad pii pouziti piikazu animate.

E1: Interactive Plot Builder: Specify Expressions =|

File
~ Expressions
At singx) Add
Edit |
Rermoyve |
~ Variables
i add
Ed
Rermoyve |

Obrazek 2.25: Zadani vyrazu z predpisu funkce v Plot Builderu (pfevzato z [6]).

Ukonceni Plot Builderu, resp. provedeni piikazu, umisti do dokumentu ,prazdny* graf.
Kliknutim na néj zobrazime skupinu néastroju v kontextové listé s nazvem Animation.
Pomoci téchto nastroju muzeme animaci spustit, zmeénit jeji rychlost, podivat se na libovolny
snimek animace atd.

Animace muZeme upravovat stejné jako grafy, tj. ménit tloustku, barvu a druh kiivky,
souradné osy, legendu apod. Navic mame k dispozici nékolik nepovinnych parametru, diky
nimz muzeme napiiklad uréit pocet grafi, z nichz se animace skladé (parametr frames), nebo
kolik grafu vyjma posledniho mé ztstat trvale zobrazenych po spusténi animace (parametr
trace) [6].
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F1: Interactive Plot Builder: Seleck Plot Type |

~Select Plot Type and Functions

Anirnakion Edit Functions |

~Select Plok

2-D plat

z-D polar plat

3D confarmal plot of a complex-valued Function
2-D conformal plot of a complesx-valued Function
Z-0 comples plok

3D complex: plat

~Select Yariable Purposes, Ranges, and Flok Options

Ix Bxis Ix;l I—ID ko Ill:l—

I.‘mimat.iocn FarameteT In;l ID ko |2—
r

Options | Preview

On 'Plot’ return plat command

Plok I Cancel |

Obrdzek 2.26: Zvoleni druhu vykresleni (animace) v Plot Builderu (pfevzato z [6]).

with(plots)
animate [ plot, [A*sin(x), x=-10.10], A=0..2)
A=2.0000

.fﬁ‘-, | .'/\ ;'m\

Obrazek 2.27: Animace vytvorend prikazem animate (prevzato z [6]).

46



Piiklad 2.21: Vykreslete funkci f(z) = 2° + 15 - 2* + 85 - 23 + 225 - 22 + 274 - z + 120.

Reseni: K vykresleni zadané funkee ji staci zapsat do dokumentu a pouzit néktery z difve
uvedenych postupu. Musime vSak mit na paméti, co bychom radi na grafu vidéli a ze je
mozné ziskany vysledek ovlivnit. Naptiklad v tomto piipadé, kdyz nespecifikujeme rozsah
vykresleni (pouzije se standardni rozmezi -10..10) zcela zkreslime informaci o chovani funkce
na intervalu [—5, 0].

Flx) =2 +15x" +85¢ +225:% +274x 4 120 plot(f(x),x=-6.0)
x—x +15x +85% 42255 4 274x + 120 o
plot(f(x))
300000 4 04
200000 4 r T T L —,
-6 -3 -4 -3 -2 -1 0
x
100000 4 -50 4
r 100
@ 5 0 5 10

Obrdzek 2.28: Resent prikladu 2.21.

Priklad 2.22: K funkci g(x) = €*® naleznéte inverzni funkci. Vykreslete do jednoho grafu
funkci g(x), jeji inverzi a funkei f(x) = z. Do grafu pridejte také legendu.

Piiklad 2.23: Zkoumejte zavislost funkce h(z) = e** na parametru a € R (pomoci ani-
mace). Kdy je funkce rostouci a kdy klesajici?

Priklad 2.24: Vratte se k pifkladim 2.12 — 2.20 predchozi sekce a vykreslenim graft se
ujistéte o spravnosti vasich odpovédi.

2.4 Limita a spojitost funkce

Definice 2.7: Funkce f(z) ma v bodé zy € R limitu L € R, jestlize ke kazdému ¢ > 0
existuje 0 > 0 tak, ze pro vSechna x € (xy — J,z9 + 0) ruzna od zo plati: |f(x) — L| < e.
Takovou limitu nazyvame vlastni limitou ve vlastnim bodé.

Definice 2.8: Funkce f(z) mé v bodé zy € R limitu L € R zleva, jestlize ke kazdému
e > 0 existuje 6 > 0 tak, ze pro vSechna = € (g — 6, x¢) plati: |f(xz) — L| < e. Analogicky
definujeme limitu zprava.

Definice 2.9: Funkce f(x) ma v bodé zy € R limitu rovnu +o0, jestlize ke kazdému M € R
existuje 0 > 0 tak, ze pro vSechna x € (xo—0,xz¢+0) ruzné od x plati: f(x) > M. Analogicky
definujeme limitu rovnu —oo. Takovou limitu nazyvame nevlastni limitou ve vlastnim bodé.
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Definice 2.10: Funkce f(z) mé v bodé +oo limitu rovnu L € R, jestlize ke kazdému e > 0
existuje K € R tak, ze pro v8echna x > K plati: |[f(x) — L| < e. Analogicky definujeme
limitu v bodé —oo. Takovou limitu nazyvame vlastni limitou v nevlastnim bodé.

Priklad 2.25: Definujte limitu zprava.

Priklad 2.26: Definujte nevlastni limitu v nevlastnim bodé.

Systém Maple ve verzi 16 nabizi téz tzv. Matematické aplikace, které najdeme v hlavnim
menu (Tools > Math Apps). Jednou z polozek v sekci Calculus je dokument s ndzvem
Definition of a Limit s definici limity a jeji ndzornou interaktivni demonstraci — viz obrazek
2.29.

1. Choose a function: | Cubic x| EpSilOl’l—DElta

2. Choose a value for ¢

U

Cc=
-9.0 6.0 -3.0 0.0 30 &0 9.0

3. Ask for an | Give me a new epsilon! "
£= |.6393
] Le

4_Try to choose & small enough so that |x — ¢ < §implies

|flx)=L| < eT. If the blue strip is ariver, and the purple strip is a
bridge, then the furction (green) must only cross the river where the
bridge is! x| ©

U

0.001 0.5

5_Ifit's not possible to choose such a &, the function f{x) does not 23y
have a limit at the point ¢!

Reset Shade Region

x—3d ¥+

Obrdzek 2.29: Interaktivni demonstrace limity.

K vypoctu limity pouZijeme bud pifslusny symbol z palety Expression (a upravime
v ném barevné symboly, jak potiebujeme), nebo piikaz 1limit, ktery mé povinné dva para-
metry — vyraz (tj. i funkéni vyraz) a bod, v némz hleddme limitu. Také je mozné zadat do
dokumentu vyraz, jehoz limitu chceme urcit, kliknout na néj pravym tlac¢itkem a z kontex-
tové nabidky zvolit polozku Limit. Otevie se nam okénko, v némz je dale tfeba specifikovat
bod, v némz hleddme limitu. Muzeme déle uvést i typ limity — oboustrannou (zdkladné
zvolend), limitu zleva nebo limitu zprava.

V pripadé pouziti palety specifikujeme jednostrannou limitu zapsanim symbolu + nebo
— do exponentu bodu, v némz chceme limitu urcit. Prikazu limit muzeme zadat treti
(nepovinnny) parametr ve tvaru right nebo left pro limitu zprava, resp. zleva. Vsechny
zminéné postupy ilustruje obrazek 2.30. V jeho pravé ¢asti je definovana funkce a pii ur¢ovani
limit pouzivan funkéni vyraz f(z). Funkéni operator (tj. f) pouzit nemuzeme.

Systém Maple v nékterych piipadech zobrazuje neocekavané vysledky, které muzeme
oznacit za chybné. Jednd se napiiklad o limity na obrazku 2.31. Vypsanym vysledkem se nam
systém snazi dat omezeni na funkéni hodnoty v okoli bodu, v némz hledame limitu. Podle
uvedenych definic v tomto textu vsak musime konstatovat, ze prislusné limity neexistuji.

48



ftmzz[

.i’imz'z[

,X= O] = undefined

:~<|»—~:~<|n—t

x=0, righz] =

. 1
xhlnu? = undefined

ol

lim =

1
x—=0t X

1 limit
oboustranna limita: — —blrm undefined
X

1 limit
—

X——

Iimit( f(x),x=0) = undefmed
Iimit( f(x),x=0, right) =

xhi)nﬂf(r) = undefined

lim f( )=

x—=0t

limita zprava: —
X

Obrazek 2.30: Urceni limity v bodé.

. : [1]
lim sin| —
X— X
-1..1
. X
Ll (1)
-1—-I1.1+41

Obrdzek 2.31: Nedostatky Maplu pii urcovani limity.

Priklad 2.27: Urcete nasledujici limity:

sin(x) . -1
() lim =5 () lim ==,
(b) lim S, () lim tan(r)

Priklad 2.28: Urcete nasledujici limity:

Va2— ¥z

@ Jim i () lim Y, ) Jim
(b) lim S (@)t 3s () tim
ooz cos@) 2o V221 Jm

Jak byste limity urcovali bez systému Maple?

Priiklad 2.29: Definujte funkci, ktera:
(a) ma vlastni limitu ve vlastnim bode,

(b) mé vlastni limitu v nevlastnim bodeé,
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(¢) ma nevlastni limitu ve vlastnim bodeé,
(d) mé nevlastni limitu v nevlastnim bodé,
(e) spliuje vsechny predchozi body (a) — (d).

Jak jsme se zminili v sekci 1.3.4, Maple obsahuje pomocné nastroje, které ndm ulehcuji
feSeni tloh a pomahaji v uceni nékterych matematickych postupu pii jejich feseni. Jednim
z takovych nastroju je maplet zvany Limit Methods. Spustime jej z hlavni nabidky zvo-
lenim Tools > Tutors > Calculus — Single Variable > Limit Methods.... Tento
nastroj umi tesit zadané limity krok po kroku pomoci implementovanych matematickych
pravidel. Muzeme mu tedy zadat vyraz a bod, v némz chceme uré¢it jeho limitu, a ne-
chat naptiklad maplet zobrazit celé feSeni krok za krokem kliknutim na tlac¢itko All Steps.
Vysledek tohoto postupu na piikladu 2.28.(b) muzeme vidét na obrazku 2.32. V mapletu si
vsak muzeme zobrazit pouze nasledujici krok vypoétu, pokusit se pouzit nékteré z imple-
mentovanych pravidel nebo pozadat o napovedu, které pravidlo pouzit.

E1aCalculus 1 - Limit Methods x|
File Edit Rule Definition Apply Rule  Understood Fules  Help
Enter a function
’7Functicun I(cos((1I2)*x)-sin((1,|'2)*><}|)Il'cos(x) ‘Wariable Ix ak IF‘iII'E Direction I vl
—J2+ lm cos| —x =]
2 1 2
1 I— T m
T2 lim  sin(x)
r— [v Show Hints Gek Hink |
1 ey 1
—2 +cos| lim —x
2V 1 2
1 Ir— T o
= — - Canstank Tdenkity |
2 Iim  sin(x)
- % - Canskank Mulkiple
1 1 )
> 2 + cos 5 Iim x Sum Difference
1 B Cox— T T Product Quotient
) lim  sin(x)
- % - Power Change
- I'Hopital's Rule Divide by zero
1 JZ £ !
7 Tim .sm[ t:l Factor Rewrite
x — % T
£ Exponential Matural Logarithm |
_1 s . :
= 2 V2 = <krige j <hyperbolic = j
il | pl “arckrig= ;I <archyperbaolic = ;I
Undo | Mext Skep | All Steps | Close |

Obrdzek 2.32: Pomocnik pro uréovani limit.

Definice 2.11: Rekneme, ze funkce f(x) je spojitd v bodé zo, pokud ma v tomto bodé
vlastni limitu a plati: lim f(x) = f(zo).
T—T0
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Definice 2.12: Rekneme, ze funkce f(x) je zprava (resp. zleva) spojitd v bodé zg, pokud
ma v tomto bodé prislusnou jednostrannou vlastni limitu a plati: lim+ f(z) = f(zo) (resp.
T—TQ

Jim f(z) = f(a0))

Definice 2.13: Rekneme, ze funkce f(z) je spojitd na intervalu J € D(f), pokud
(a) f je spojitda v kazdém vnitinim bodé intervalu J

(b) a patii-li levy (resp. pravy) koncovy bod do intervalu J, je v ném funkce f spojita
zprava (resp. zleva).

V systému Maple muzeme jednak testovat rovnost limity a funkéni hodnoty, jak plyne
z definice. Pro urcéovani spojitosti funkce na intervalu je vsak mozné (a vhodné) vyuzit
piikazu discont hledajiciho nespojistosti funkce. Piikaz mé dva povinné parametry, a to
vyraz, jehoz nespojitosti uréujeme, a nezavisle proménnou. Dalsi moznosti je pouzit prikaz
iscont testujici spojitost na zadaném intervalu. Odpovédi je pravdivostni hodnota, zda je
funkce na daném intervalu spojitd, ¢i nikoliv.

f:: X — 3 7 :
X plot(tan(x),x=-5..5,y=-3 .3, thickness=3)
3_

74

¥
14
af 3 1 1

1_

R iy

-3

plot(tan(x),x=-5..5,y=-3 .3, thickness = 3, discont= true)
discont= true) 39
2_
¥
14
4 2 ; 4
3 -z -l 1z 3 1
-2
_44 3

-6 4

-3

discont( f(x),x) discont( tan(x), x)
1 1
51 [J‘C_ZS’= + ?rc}
”_ZI~

Obrazek 2.33: Zobrazovani nespojitych funkei.

Pokud je funkce y = f(z) nespojitd na daném intervalu jen v konetné mnoha (izolo-
vanych) bodech, systém Maple ji v téchto bodech spojuje tiseckami rovnobéznymi s osou y.
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Jestlize chceme nespojitosti zobrazit korektné, pouzijeme nepovinny atribut discont piikazu
plot, ktery nastavime na hodnotu true — viz obrazek 2.33.
Od verze Maple 14 je mozné také zobrazovat odstranitelné nespojitosti (obrazek 2.34).

(x—1]3 f(x) = plecewise(x + 5,x,6)
fi=x— 2, : x— piecewise(x # 5,x, 6)
“—

plot(f(x),x=-5.5,y=-15 .10, thickness = 3, discont plot(f(x). thickness=3)

= true)

s...__/

plot(f(x).x=-5.5,y=-15 .10, thickness =3, discont | plot( f (x), thickness =3, discont= [ showremovable] )

= [ showremovable]) 10+
D_
5.
Y
“—T/
4 z 0 2 4 i0 - 3 10
x X
5
_5.
_IU -
10
_15 4

discont( f(x),x) discont( f(x), x)
{-1.1} {5}

Obrdzek 2.34: Zobrazovani nespojitych funkei a vyznacovani odstranitelnych nespojitosti.

Vysledkem piikazu discont u funkei definovanych po ¢astech jsou vzdy body ,,podezielé”
z nespojitosti. Pro zjisténi, zda se jedna o nespojitosti ¢i nikoliv, je potteba v téchto bodech
provést test (existence a) rovnosti limity a funkéni hodnoty. Obrézek 2.35 ukazuje pouziti
piikazu discont v piipadé funkce f(z) zadefinované po ¢éstech.

discont( piecewise(x < 0,x,x = 0,x),x)

{0}

Obrdzek 2.35: Pouziti pfikazu discont u funkce definované po ¢éstech.
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2_16
z e 4
Piiklad 2.30: Naleznéte cislo C' € R tak, aby funkce f(z) = { r—4 T

C .ox=4
bylavspojité pro vSechna x € R.
Reseni: Jelikoz x°—16 = (x—4)-(x+4), plati f(z) = z+4 pro x # 4, a tedy lin}L f(z)=8.
z—

Z definice spojitosti pak dostavame: C' = f(4) = 8.

Priklad 2.31: Urcete body nespojitosti funkei:

r+1 . > 2
(a) f(x)=12-2—1 ...1<x<2,
z—1 o<1

(c) fz) ==L beR.

3-22—-1 ... 2<0
Piiklad 2.32: Naleznéte cisla ¢, d € R tak, aby funkce f(z) =< c-2+d ... 0<zx<1

VT + 8 o>

byla spojita pro vSechna x € R.

Piiklad 2.33: Uved'te pifklad funkce, kterd na uzavieném intevalu neni spojité, ale ma
limitu v kazdém bodé tohoto intervalu.

2.5 Derivace funkce

Definice 2.14: Nechf f je funkce, 7y € R. Existuje-li lim [@)=J(zo) nazyvame tuto limitu

T—T0 T—Zo
derivaci funkce f v bodé xg.

Poznamka 2.2: Derivace funkce f(x) je funkce, kterd je definovand ve vsech bodech,
v nichz existuje limita z predchozi definice. Tuto funkei znacime nékolika zpusoby: f'(z),
=) pebo %(xx). Analogicky muzeme definovat druhou derivaci funkce f(z) jako derivaci

funkce f’(x) a podobné derivace vyssich fadu.

Poznamka 2.3: Limita v definici 2.14 muze byt vlastni i nevlastni. Podle toho rozlisujeme
také vlastni a nevlastni derivaci. V tomto textu si situaci uleh¢ime a budeme uvazovat pouze
vlastni derivace. Z tohoto divodu budeme slovo ,vlastni“ vynechavat a slovem ,derivace*
budeme vzdy rozumét vlastni derivaci.

Systém Maple nabizi (jako obvykle) nékolik moznosti, jak urcit derivaci funkce. Opét
muzeme vyuzit kontextové nabidky (tj. zapsat do dokumentu vyraz, ktery chceme derivovat,
kliknout na néj pravym tlacitkem mysi a z nabidky zvolit polozku Differentiate s vybérem
nezdvisle proménné). Déle je mozné pouzit oba jiz uvedené symboly zapisu derivace, které
jsou k dispozici v paleté Expression. Systém Maple (v rezimu Document Mode) rozpozna
i zépis f'(z) (tj. pouziti apostrofu jako symbolu derivace). Dlasi moznosti je piikaz diff
majici dva povinné argumenty: vyraz a nezavisle proménnou.
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diff (¥ +2-x+6,x) =2x+2

differentiate wrt. x

X +2x+6 > 2x+2

(¥ +2x46)'=2x+2

Obradzek 2.36: Ptehled moznosti pfi vypoctu derivace.

Pii pocitani derivaci musime byt opét opatrni a rozliSovat mezi funkénim operatorem
a vyrazem. Vsechny zminéné zpusoby urceni derivace funkce (nebo lépe vyrazu) vraci vysledek
jako vyraz. Pokud chceme poté uréit jeho funkéni hodnotu, musime bud pouzit pitkaz eval,
nebo ze ziskaného vyrazu udélat funkci piikazem unapply, pifipadné pouzit apostrofovou
notaci pro zapis derivace, viz obrazek 2.37.

h(x) = CA2x+6 D(h)
x—>x2+2x+6 x=2x+2
5 D(k) (2)
£ 6
15 1(x)
2x+2
D(sin)
eval(%,x=2) Cos
6
D(sin) (x)
7= unappfv[ ih(r]. X cos(x)
e “ldx T
x—+2x+2
g(2)
6
h'(2)
6

Obrdzek 2.37: Vypocet derivace v bodé.

Systém Maple disponuje téz pitkazem D predstavujicim diferencialni operator. Jeho ar-
gumentem je funkéni operdtor a vysledkem derivace opét jako funkce (funkéni operdtor) —
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prava c¢ast obrazku 2.37.

dgf?"(x2+2-x+6,x,x) =2

dgﬁ”(x2+2-x+6:x:x:x) =0

(¥ +2x+6)"=2

(Z+2x+6)" =0

Obrazek 2.38: Vypocet derivaci vyssich fadu.

Derivace vyssich radu zadavame tak, jak jsme zvykli s tuzkou na papife®. Pfi pouziti
piikazu diff se n-ta derivace specifikuje tak, ze zaddme nezédvisle proménnou n-krat (jako
argument ptikazu)®. Systém Maple (opét pouze v rezimu Document Mode) umi rozpoznat
i zapis s ¢islem derivace v exponentu vyrazu v kulatych zavorach — toto je nutné pri odkliknuti
jesté potvrdit ve vyskakujicim okénku (obrazek 2.38).

Stejné jako u limit poskytuje Maple jednak pomocné nastroje pro vypocet derivaci, ale
od verze 16 také matematickou aplikaci s definici a zndzornénim derivace (Tools > Math
Apps > Calculus — Derivative Definition) — viz obrazek 2.39.

Derivative Definition
20

10 U

00 20 40 60 &0 10,0

=20, -10 M 10 20

—m\_ Q

Obrdzek 2.39: Interaktivni znazornéni derivace.

Prvnim z pomocnych nastroju pro vypocet derivace je maplet zvany Derivatives. Spustime

5Je mozné pouzit i zkrdceny zépis ve tvaru diff (f(x),x$n).
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jej z hlavni nabidky zvolenim Tools > Tutors > Calculus — Single Variable > Deri-
vatives.... Maplet pro zadanou funkci vypocitd jeji prvni a druhou derivaci, zvolené funkce

vykresli do jednoho grafu.

[1a Calculus 1 - Derivative |
File Help
i Flot Window ~Enter a function and an inkerval [a,b]
1 4
| Fix) = [x*cos(x)
a=n b =|Fi
a
~Derivatives
-1
¥ I Flxi= Icos(x)-x*sin(x)
-9 W Displare P in the plot
| P = |-2*sin(x)—x*cos(x)
_3 [ Display F'{x) in the plot
Display I Plot Options Close
~ Maple Cammand
DerivativePlotistoar (=) 0 .. Pi, 'order's[1] 'wiew's[0. .. 2.1, -2.51 .. 1.24]]:

Obrazek 2.40: Pomocnik pro vypocet a zobrazeni derivaci.

zl
File Edit Rule Definition Apply Rule  Understood Rules  Help
Enter a function
’7Functi0n |x*sin(x) ‘ariable [x Stark |
% {xsin(x)) ’
= %x] sin(x) +x [ %sin[x]]
) d | Show Hints Get Hink |
=sin(x) +x [ Esm(x)
= sin(x) + xcos(x)
Constank Identity
Constant Multiple
Sum Difference
Product Quotient
Power Chain Rule
Inteqgral Rewrite
Exponential Matural Logarithm
<krige ;I <hvyperbalic > LI
<arckrigz> LI <archyperbolic > LI

Obrdzek 2.41: Pomocnik pro vypocet derivaci.

Druhy takovy nastroj je maplet s ndzvem Differentiation Methods. Spustime jej
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z hlavni nabidky zvolenim Tools > Tutors > Calculus — Single Variable > Differen-
tiation Methods.... Stejné jako analogicky pomocnik u limit umi fesit derivace zadanych
funkei krok po kroku pomoci implementovanych matematickych pravidel (kterda nalezneme
v népoveédé). Muzeme mu tedy opét zadat vyraz a nezavisle proménnou a nechat maplet
zobrazit celé feseni krok za krokem kliknutim na tlacitko All Steps. Vysledek tohoto po-
stupu muzeme vidét na obrazku 2.41. V mapletu si také muzeme zobrazit pouze nasledujici
krok vypoctu (Next Step), pokusit se pouzit nékteré z implementovanych pravidel nebo
pozadat o ndpovédu (Get Hint), které pravidlo pouzit.

Priklad 2.34: Urcete:

() Z(f() - g(x)), (c) d(a-a®+b-a®+c-x+d),

(b) £ (f(glx). (@) & (%),

Piiklad 2.35: Uved'te piiklad spojité funkce na intervalu J, kterd na tomto intervalu neni
diferencovatelna (tj. nema v alespon jednom bodé derivaci). Dokazete uvést piiklad funkce
spojité na intervalu J, kterd na tomto intervalu nema derivaci pravé ve dvou bodech?

Poznamka 2.4: Geometrickou interpretaci derivace funkce f(z) v bodé z( je smérnice
tecny k funkci f(x) v tomto bodé. Jestlize tedy y = k - x + ¢ je rovnici tecny v bodé xg, pak

k= f'(xo).

Priklad 2.36: Urcete rovnici tecny k funkci f(z) = 22 v bodé zy = 1. Vykreslete do
jednoho grafu funkei f(z) i tuto te¢nu.

Priklad 2.37: Najdéte bod zy tak, aby tecna k funkci f(x) = x3 v tomto bodé byla
rovnobézna s piimkou y = 12 - z — 5. Vykreslete do jednoho grafu funkei f(z), nalezenou
tecnu a zadanou primku.

Priklad 2.38: Najdéte bod z, tak, aby tecna k funkci f(x) = 2 v tomto bodé byla kolma
na piimku y = —% -x—>5. Vykreslete do jednoho grafu funkei f(x), nalezenou teénu a zadanou
primku.

2.5.1 Diferencial

Definice 2.15: Rekneme, ze funkce f je diferencovatelna v bodé xg, jestlize je v ném
definovand a jestlize existuje A € R tak, ze }lLir% f(:""O*h)*}{(IO)*A'h = 0. Funkce A - h (h € R)
—

se nazyva diferencidlem funkce f v bodé xy a znaci se df (zo)(h).

Poznamka 2.5: Jak jiz bylo zminéno v piikladu 2.35, ,diferencovatelnd funkce® je totéz
co ,funkce majici derivaci.

Diferencial je mozné pouzit k urcéeni ptiblizné hodnoty funkce v okoli bodu se znamou
funkéni hodnotou. V systému Maple se tato ,,vyhoda® smazavéd, jelikoz samotny Maple nam
okamzité vypise pribliznou funkéni hodnotu s ,libovolnou® presnosti. Presto je mozné si na
piikladech vyznam pojmu ovérit a vyuzit Maple alespon k dilé¢im vypoctim.
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Piiklad 2.39: Urcete piiblizné: arctan(1.01).
Reseni: Vyjdeme z definice 2.15. Ta nam 11k, ze f(xo+h) ~ f(xo) +df (x¢) - h. V nasem
piipadé o = 1 a h = 0.01. ResSeni ziskané v Maple je znazornéno na obrazku 2.42.

. . d 1
Derivace zadané funkce: x arctan(x) =
X

1+.vc2

S pfesnosti na 10 mist pomoci Maple: arctan( 1.01) = 0.7903732467

Pfiblizné pomoci diferencialu:

1 1
5--0.01=arctan(1.0) + 200

arctan(1.01) =~ arctan(1) + =0.7903981634
1

Obrdzek 2.42: Reeni pitkladu 2.39.

Priklad 2.40: Urcete priblizné: v/51.
Piiklad 2.41: Urcete piiblizné: v/123.
Piiklad 2.42: Urcete piiblizné: 2.95%,

2.5.2 Taylortv polynom

Definice 2.16: Necht n € NU{0} a f je funkce majici v bodé xy € R derivace az do fddu
n. Polynom

f' (o)
1!

f/l (xo)

N f(n) (z0)
2! ’

n!

T (x) = f(zo) + (x — o) + (z —m0)? + .. (x—x9)",x €R,

se nazyva Tayloruv polynom stupné n funkce f v bodé xy. Funkci
R(z) = T (x) - f(x)
fikame Tayloruv zbytek a cely vyraz
T(x) + R} (x)

nazyvame Taylorovym vzorcem.

Poznamka 2.6: Jak jsme si mohli vSimnout, aproximace funkéni hodnoty pomoci dife-
rencialu je vlastné specialni ptipad Taylorova polynomu pro n = 1. Tayloruv polynom také
muzeme vyuzit k aproximaci funkéni hodnoty v okoli bodu se znamou funkéni hodnotou.

vvvvvv

vysoké musi byt n, abychom docilili pozadované presnosti aproximace.

Poznamka 2.7: Necht jsou splnény predpoklady definice 2.16. Pak existuje ¢islo © € (0, 1)
tak, ze
fO D (@ + 0 - (= x0))

Fa(e) = (n+1)!

)n—&—l.

(x — o
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Poznamka 2.8: Kdyz polozime v Taylorové vzorci zy = 0, vSechny vyrazy se ndm zjedno-
dussi. V takovém piipadé také nékdy mluvime o Maclaurinové vzorci. Pro Maclauriniv
zbytek pak plati:

F0(© - )

n+1
(n+1)! '

Rj(z) =

Systém Maple obsahuje piikaz taylor vypisujici Tayloruv vzorec piislusny zadané funkci
v prvnim parametru piikazu. Druhym povinnym parametrem je bod, v némz se vzorec
realizuje. Standardné je vzorec vypisovan pro n = 5, coz je o jedna nizsi hodnota nez
zékladni nastaveni systémové proménné Order. Tato proménna predstavuje fad Taylorova
zbytku, tedy cislo n + 1. Pocet ¢lenu Taylorova vzorce tak muzeme ovlivnit prenastavenim
proménné Order nebo zapsianim této hodnoty na misto tretiho (nepovinného) parametru
piikazu taylor®.

Neékdy se ndm muze hodit pracovat pouze s Taylorovym polynomem (tedy bez Taylorova
zbytku). K tomu je potfeba pouzit piikaz convert, kterému zaddme jako prvni parametr
Tayloruv vzorec (ziskany piikazem taylor) a na misto druhého parametru zapiSeme slovo
polynom (¢imz se ,zbavime* vyjadieni Taylorova zbytku pomoci funkce O).

taylor(sin(x), x=x0) =
sin(x0) + cos(x0) (x —x0) — % sin(x0) (.‘:c—.‘:afi}2 — % cos(x0) (x—x0}3 + ,)1—4 sin(x0) (x—x0}4 + % cos(x0) (.‘:c—xﬂ}5

+0((x—x0)%)

. . L3 1 3 6
taylor(sin(x),x=0) =x 6 ¥ + 20 © +O(x)

‘ x _ 1 2,1 3, 1 4 1 3 1 5 1 7 1 g 1 0 10
rq»i’or(c:x—O:lO)—l-i-x-l-zx T Xt o e o Xt gt o %t g +0(x'?)

1 4 1 s 1 & 1 7 1 8 1 9
t 0 Y720 Y00 T a0320 T e2sm0

convert( %, polynom) =1 +x + % &+ % 4 EYiR

Obrazek 2.43: Ukézka pouziti piikazu taylor.

Maple 16 déle poskytuje matematickou aplikaci Taylor’s Theorem (Tools > Math Apps
> Calculus — Taylor’s Theorem) — viz obrazek 2.44 s interaktivni demonstraci zave-
deného pojmu.

Piiklad 2.43: Najdéte Maclaurinuv polynom funkce tan(x) patého stupné.
Priklad 2.44: Vytvoite Tayloruv polynom pro funkci z* ¢tvrtého stupné v bodé 1.

Priklad 2.45: Pomoc{ Taylorova polynomu vyjadiete funkci f(z) = 2°+at+a3+22+2+1
jako polynom v proménné x — 2.

Jak jsme se zminili v poznamce 2.6, Tayloruv polynom muzeme vyuzit k nalezeni ptiblizné
funkéni hodnoty. Diky poznamkam 2.7 a 2.8 mame navic nastroj, jak urcit tuto hodnotu se
zadanou presnosti. Podobné jako v pripadé pouziti diferencidlu plati i zde, ze (podstatné)

5V tomto pifpadé nedojde ke zméné hodnoty ulozené v proménné Order, ovlivnén bude pouze pifslusny
vypis piikazu taylor.
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Taylor Polynomial Alx) = sk -
2
e U
vl 2 1 0 1
ordern = I—J
- n T T n 3m\ =w 0 g 10
2 4 2 4
-1 X [ Play animation {(order increases from 1 to 10) ]
1 a
_2 _ r_‘l
he g
|—_}"(.r) ——— Taylor polynomial | flx) =
Atx=0, for the function f(x) = sin(x), a graph of e
f(x) and the approximating Taylor polynomial(s) of
degree(s) 3.

Obrazek 2.44: Interaktivni demonstrace Taylorova polynomu.

jednodussim zpusobem ziskdme dokonce presnéjsi hodnotu pouhym pouzitim systému Maple.
Presto muze Maple slouzit jako pomocnik pfi vypoctu a souc¢asné diky nému muzeme oveérit,
zda byla splnéna pozadovana presnost vypoctu.

Piiklad 2.46: Urcete hodnotu Eulerova ¢isla e s chybou mensi nez 1073,

Reseni: Chceme zjistit hodnotu ¢isla e, vezmeme si proto na pomoc funkei f(z) = e” a bu-
deme hledat funkéni hodnotu f(1). Funkei musime aproximovat v néjakém jiném bodé nez
je bod 1 (nebot pro ten bychom dostali piesnou hodnotu e a v ni¢em by ndm to nepomohlo),
soucasné ale ne piilis daleko od tohoto bodu (¢im déle od tohoto bodu bychom hledali apro-
ximaci, tim nepfesnéjsi bude vysledek). Abychom si situaci co nejvice zjednodusili, vezmeme
bod 0 (ktery je ,blizko“ bodu 1), pro néjz mame tvar Taylorova (resp. Maclaurinova) zbytku
uréeny poznamkou 2.8.

Mame tedy funkci f(x) = e® a vime, Ze pro piislusny Maclaurinuv zbytek plati:

©-z
. e
R (1) = ——— - 2"t

(@) (n+1)!
kde © € (0,1). Nés bude zajimat funkéni hodnota v bodé 1, tj. pro z = 1 dostavame:
o©

(n+1)!
V zadan{ je pozadovana presnost 1072, M4 tedy platit:
|RS (1) <1072,

Dosazenim ziskdme: o o

n+ 1)!' TS

Nyni je tfeba si uvédomit, ze €® < 3, jelikoz © € (0,1). MiZeme proto psit, Ze plati:

e® 3
CES T
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Kdyz nyni najdeme n takové, ze

pak bude jisté platit:

-3

Ziskané n predstavuje stupen Maclaurinova polynomu, takze uz zbyva pouze popsany postup
aplikovat v systému Maple — obrazek 2.45.

Hledame tedy # spliiujici nerovnost: Maclaurintiv polynom jakeo funkee:

; aprox ‘= unappfy( conveﬂ( m}'for( cx, x=0,7 ) ,pofymm) . x)
-3 1 2 1 3 1 4 1 3 1 6
—_— <2 10 1 2 = L _+r 2

(n+1)! x—>1+x+2x+6x+24x+120x+?20x

Aproximace Maclaurinovym polynomem:

UpTElVO'Ll dostaneme: eva{f{ aprox( 1 ) ) =2 718055556

3
(n+1)!>3-10"=3000 Priblizn4 hodnota v Maple:
evalf(e') =2.718281828

a nasledné: .
Chyba aproximace:

(n4+1)!1>3000 =n=>6 chyba = |evaff(apmx(1}}— ex’aff(eln =0.000226272

Obrdzek 2.45: Reseni pitkladu 2.46.

Piiklad 2.47: S chybou mensi nez 10~ uréete hodnotu &isla:

(a) + (b) ¥/250.

2.6 VysSetreni prubéhu funkce

Nez za¢neme s vySetfovanim prubéhu funkce na prikladech, pripomenme si zakladni dulezité
pojmy a jejich vlastnosti.

Poznamka 2.9: Necht f(z) je funkce. Pokud f’(z) > 0 pro vsechna x € J, pak je f(x)
na intervalu J rostouci. Pokud f’(x) < 0 pro vSechna x € J, pak je f(z) na intervalu J
klesajici.

Definice 2.17: Rekneme, Ze funkce f(z) ma v bodé z, € R lokdlni minimum, jestlize
existuje § € R, § > 0 tak, ze f(z) > f(zo) pro vSechna = € (xg — 0, + J). Analogicky
definujeme lokalni maximum funkce. Lokalni minima a maxima se souhrnné nazyvaji lokalni
extrémy.
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Poznamka 2.10: Necht f(z) je spojitd v bodé . Jestlize existuje 6 € R, d > 0 tak, ze
f(z) je neklesajici na intervalu (z¢ — d,x¢) a nerostouci na intervalu (xg,zg + 6), mé f(x)
v bodé xg lokdlni maximum. Analogické tvrzeni plati pro lokdln{ minimum.

Poznamka 2.11: V ptedchozi poznamce jsou zamérné pouzity vyrazy ,neklesajici* a ,ne-
rostouci“. Lokalni minimum (resp. maximum) se totiz muze podle definice nachazet i na
intervalu, kde je funkce konstantni. V tom pripadé se jednd o tzv. neostry extrém. Pro piipad
ostrych extrému je mozné v predchozi poznamce nahradit slovo ,neklesajici“ za ,rostouci*
a ,nerostouci za ,klesajici“.

Poznamka 2.12: Body xg, v nichz f'(zq) = 0, nazyvame staciondrnimi body. Tyto body
a body, v nichz funkce f(x) neméd derivaci, jsou ,podezrelé“ z toho, Ze jsou lokdlnimi extrémy
funkce. Jestli se skuteéné jednd o extrém, uréime bud podle definice 2.17, poznamky 2.10
nebo poznamky 2.13.

Poznamka 2.13: Necht f'(zg) = 0 a f"(z¢) # 0. Pokud f”(zo) < 0, ma funkce f(x)
v bodé ¢ lokdlni maximum. Pokud f”(zo) > 0, mé funkce f(z) v bodé x( lokdlni minimum.

Definice 2.18: Necht f(z) je funkce, J interval. Rikdme, Ze f je konvexni na .J, jestlize
pro kazdé dva body 1, x5 € J, x1 < 22 a kazda dvé nezaporna realnd cisla aq, ay takova, ze
a1 + as = 1 plati:

flay -z +ag-x) < ay - f(ar) +ag- f(x2).

Pokud za tychz predpokladu plati:
flay o1+ az - x9) > ay - f(xy) + as - f(xg),

fikame, Ze f je konkavni na J. Pokud zménime vSechny neostré nerovnosti na ostré, mluvime
o ryzi konvexite, resp. ryzi konkduvite.

Poznamka 2.14: Necht f m4 na intervalu J C D(f) druhou derivaci. Pokud f”(z) > 0
pro vSechna =z € J, pak je f na J konvexni. Pokud plati ostrd nerovnost, je f na J ryze
konvexni. Analogicky, pokud f”(x) < 0 pro vSechna x € J, pak je f na J konkdvni. V piipadé
ostré nerovnosti je ryze konkavni.

Poznamka 2.15: Body, v nichz se méni ryzi konvexita funkce na ryzi konkavitu a naopak,
nazyvame inflexnimi body. Necht tedy o € R, § € R, § > 0. Pokud f(z) je na (zo—4, o) ryze
konvexni a na (zg, zo + d) ryze konkdvni (resp. naopak), nazyvame bod xy bodem inflexnim.

Poznamka 2.16: V bodech nespojitosti xy funkce f(z) zkoumdme, jestli v nich jsou

asymptoty bez smérnice, a to ovérenim, zda lim f(z) = oo nebo lim f(z) = +oc.
T—x0~ r—xgt

Déle zkoumédme, zda mé funkce f(x) asymptotu (asymptoty) se smérnici, tj. zda existuji
A, B € R tak, ze lim f(x) =A-x+ Bnebo lim f(x)=A-x+ B.
T—r00 T—r—00

Plati, ze
A= lim m (resp. A = lim M)

r—0o0 I r——00 I

T—r00 T—r—00

B = lim (f(z)— A ) (resp.B: lim (f(:p)—A-:p)).
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P1i vysetfovani prubéhu zadané funkce f(x) zkouméme vlastnosti popsané v piedchozich de-
finicich a poznamkach, spolu s nékterymi diive zavedenymi pojmy. Aplikujeme tak nasledujici
postup:

1.

Zjistujeme D(f), hleddme nulové body (tj. takovd z, pro ktera f(z) = 0), prusecik
s osou y (tj. f(0)), urcujeme, kdy je funkce kladna, zaporna, a hleddme body nespoji-
tosti funkce f.

. Vysetfujeme funkci f'(z). Hledame D(f’), nulové body a intervaly, kde je funkce f'(x)

kladna (tj. f(x) je rostouci) a kde zdpornd (tj. f(z) je klesajici).

. Vysettujeme funkci f”(z). Hleddme nulové body a intervaly, kde je funkce f”(z) kladna

(tj. f(z) je konvexni) a kde zédporné (tj. f(x) je konkdvni). Ovéfujeme, zda je néktery
z difve nalezenych stacionarnich bodu lokdlnim extrémem funkce f(x).

Hledame asymptoty funkce f, a to asymptoty bez smérnice a asymptoty se smérnici.

. Vykreslujeme graf funkce f(x).

Piiklad 2.48: Vysetiete prubéh funkce f(z) =z - e .
Resent:
Budeme prochazet pravé uvedeny postup, pricemz budeme vyuzivat moznosti Maple 14.

1. Defini¢ni obor funkce vidime na prvni pohled z jejitho predpisu. Funkce neni definovana

pouze v bodé nula, tedy D(f) = R\ {0}. K nalezeni nulovych bodu a intervali, kde je
funkce kladnd, resp. zdpornd, vyuzijeme piikaz solve’. V tomto piipadé vsak pifkaz
zadné teseni nenajde. Musime jej proto urc¢it ,sami“. Vyraz er je pro libovolna =z
kladny, z ¢ehoz plyne, ze f(xz) > 0 pro z > 0 a f(z) < 0 pro x < 0. Pro nalezen{
nespojitosti pouzijeme piikaz discont.

1 Znamenka:
fx) =xe
solve( f(x) < 0)
Warning, sclutions mayv have been lost
Nulove body:

) < solve( f(x) = 0)
solve( f(x) =0.x) Warning, sclutions mayv have been lost
Prusecik s osou y :
Neni. Funkce f{x) neni
definovana v bodé 0.

Body nespojitosti:

1
di.scam[x-ex \ x) ={0}

Obrdzek 2.46: Reseni pifkladu 2.48 — bod 1.

"Upozornéme, 7e pifkaz solve mé jednu ,nepifjemnou“ vlastnost: v piipadech, kdy nenalezne 7zadné
feSeni, na vystup nic nevypise a prejde na dalsi radek.
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2. Vypocteme f'(x). Definiéni obor prvni derivace je stejny jako u puvodni funkce, tedy
D(f") = R\{0}. Déle pouzijeme piikaz solve. Nyni jiz dostavame vSechny pozadované
vysledky od Maple. Pro nalezeni stacionarnich bodu je mozné téz pouzit piikaz extrema
vypisujici funkéni hodnoty ve staciondrnich bodech. Prvnim parametrem piikazu je
vyraz, jehoz stacionarni body hledame, druhym parametrem je mnozina omezujicich
podminek (kdyz zadné nejsou, uvedeme prazdné slozené zévorky). Dalsim paramet-
rem je nezavisle proménnd zadané funkce a poslednim ¢tvrtym parametrem je nazev
proménnné (v apostrofech), do niz se ulozi staciondrni body — viz obrézek 2.47.

der] = dif(r) Prvni derivace je kladna (tj. funkee f je rostouci):
X
1 solve(derl > 0,x)
i—_ cx RealRange( - o0, Open(0) ), RealRange( Open( 1), o)
et -5
X
Prvni derivace je zaporna (tj. funkee f je klesajici):

Nulové body:

solve(derl < 0, x)

solve(derl =0, x) RealRange( Open(0) . Open(1) )

1
Extrémy:
extremal( f(x), { }.x'bod")
{e}
bod
{{x=1}}
Obrdzek 2.47: Reseni piikladu 2.48 — bod 2.
B & Druha derivace je kladna (tj. funkee f je konvexni):
der? .= ——f (x)
dx solve(der? > 0, x)
1 Warning, solutions may have bsen lost
e
x3 50?\;9(.{3 >0, x)
RealRange( Open(0), o)
Nuloveé body:

Druha derivace je zaporna (tj. funkee f je konkavni):

solve(der2=10,x) solve(der? < 0,x)

Warning, sclutions may have been lost

Safve(x3 <0, x)
RealRange( - oo, Open(0) )

Extrémy:

eval(der2, x=1)

Obrdzek 2.48: Resen{ piikladu 2.48 — bod 3.
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3. Vypocteme f”(x) a do tfetice pouzijeme piikaz solve, ktery podobné jako poprvé
nezvladne vypocitat zkoumané nerovnosti. Jelikoz je vyraz er vzdy kladny, muzeme
nerovnosti zjednodusit a hledat pouze znaménka vyrazu 2. Vyhodnocenim druhé de-
rivace ve stacionarnim bodé x = 1 zjistime, Ze se jedna o lokalni minimum.

4. Poc¢itdme difve uvedené limity a zjistujeme, ze zadand funkce mé asymptotu se smérnici
tvaru y = o + 1 a asyptotu bez smérnice v bodé x = 0 (obrédzek 2.49).

Se smernicr: Bez smernice:

Predpokladame, Ze smémice ma rovnici y=4-x + B. | O¢ekavat ji miiZzeme pouze v bodé nespojitosti.
Jeji obeeny tvar jex=K. K = R.

— o f(x)
Ay = i, = lim f(x) = e
1 =0T
4= lim LX) lim f(x) =0
= X —+-ca X x—=0
1

1
By= lim (f(x) = 4y)
1

Asymptota se smérnici bude jedna (tj. bude stejna pro
x — ® aprox — - ®). Bude mit tvar y=x + 1.

Obrdzek 2.49: Resen{ piikladu 2.48 — bod 4.

plot([ f(x),x+1].,x=-3 .3,y=-5 .10, color= [ red, green],
linestyle= [ solid, dash, thickness= [ 3, 2], discont=true)
104

Obrdzek 2.50: Resen{ piikladu 2.48 — bod 5.
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5. Vykreslime graf funkce f(x). Pouzijeme k tomu piikaz plot, jemuz nastavime nékolik
nepovinnych parametri pro lepsi vzhled. Do grafu vykreslime zadanou funkcei f (¢ervené)
a asymptotu se smérnici y = = + 1 (zelené ¢arkované). Parametr discont nastavime
na true, aby byla spravné zobrazena nespojitost funkce f.

Piiklad 2.49: Vysetiete prubéh funkee f(z) = 5.
Resent:
1. Defini¢ni obor funkce f je celd mnozina redlnych éisel, tj. D(f) = R. K nalezeni

nulovych bodu a intervalu, kde je funkce kladnd, resp. zaporna, vyuzijeme klasicky
piikaz solve. Pro nalezeni nespojitosti pouzijeme opét ptrikaz discont.

flx) = X Znameénka:
v solve( f(x) < 0)
RealRange( - o0, Open(0) )
Nulove body:
Sol;vgz;(x) }=0. x) solve( f(x) >0)
0 RealRange( Open(0), o)

Priseéik s osou y : Body nespojitosti:

0
/(0) 0 discont( f(x),x) =1}

Obrdzek 2.51: Reseni pifkladu 2.49 — bod 1.

2. Postupujeme zcela analogicky predchozimu piikladu. D(f’) = R.

der] = if{ Y) Prvni derivace je kladna (tj. funkee f je rostouci):
Codx’

| 82 solve(derl > 0,x)

— =X RealRange( Open( -1), Open(1))

CHl (P1)

Prvni derivace je zaporna (tj. funkee f je klesajici):
Nulove body: solve(derl < 0, x)
RealRange( - o, Open( -1) ), RealRange( Open( 1), o)

solve(derl =0, x)
-1.1 Extrémy:

extremal( f(x), { }.x'body")

{{x=-1}, {x=1}}

Ix..'ll»—t
Mlv—~

body

Obrdzek 2.52: Reseni pifkladu 2.49 — bod 2.
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3. Opét postupujeme stejné jako v prikladu 2.48. Tentokrat vsak ziskdvame nulové body
druhé derivace zadané funkce. Jak vidime z intervalu konvexity a konkavity, vsechny
tfi ziskané body jsou body inflexni. Stacionarni body jsou dva, bod x = 1 je lokalnim

maximem funkce f a bod z = —1 jejim lokdlnim minimem.
& Druha derivace je kladna (tj. funkee f je konvexni):
der2 := ——f(x)
dx solve(der? > 0, x)
~ 6x N g x3 ReafRange( Open( —\.*'T): Open(0) )_. ReafRange( Open( v"l?): o0 )
2 2 2 3
(X+1)  (F+1)

Druha derivace je zaporna (tj. funkee fje konkavni):

solve(der? < 0, x)

Nulové body: RealRange( - @, Open( -[3') ). RealRange( Open(0). Open( /3 ) )
solve(der2=10, x) Extrémy:
0, v"{?r _\"IIT .
eval(der2, x=1)
1
2
eval(der2, x=-1)
1
2

Obrdzek 2.53: Reseni piikladu 2.49 — bod 3.

4. Urcime asymptoty se smérnici a bez smérnice.

Se smernicr: Bez smeérnice:

Predpokladdme, Ze smérnice ma rovnici y=4-x + B. |Funkce je spojitd na celé mnoziné R, a nema
tak asymptotu bez smérnice.

A = tim L)
1T T
0
4= lim L)
- X—+-om X
0

B, = lﬂnm(f{x) — 4, x]

0
B, = \lli‘ﬂ;l (f{x) —Az-x)
0

Asymptota se smérnici bude jedna (tj. bude stejna pro
x — @ aprox — - ®). Bude mit tvar y=0.

Obrdzek 2.5/: Resen{ piikladu 2.49 — bod 4.

5. Vykreslime graf funkce f(z).
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plot([ f(x),0],x=-10.10,v=-2 .2, color= [ red, green],
linestyle= [ solid, dash], thickness=[3,3])

2_

Obrdzek 2.55: Reseni pifkladu 2.49 — bod 5.

Priklad 2.50: Vysettete prubéh funkce:
(a) f(z) = (2* = 1)°,
b) f(2) = 2=,

(c) flz) =Lk,

(&) f(z) = {xQ In |z

.x#0
. x=0.

Pti vysetfovani prubéhu funkce nam mohou déale pomoci nékteré prikazy nachazejici se
v baliku Student [Calculusl]. Predstavme si alespon nékolik z nich. Piikaz Asymptotes,
vypiSe asymptoty funkce (zadané systému jako vyraz) se smérnici i bez smérnice. Pouziti na

funkcich z prikladu 2.48 a 2.49 ilustruje obréazek 2.56.

with( Student| Calculusl |) :

1
AS}'mpmreS[x-cx . x]
[v=x+1,x=0]

Asympmres{ 5 X .X
x +1
[¥=0]

Obrazek 2.56: Pouziti piikazu Asymptotes z baliku Student [Calculusi].
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Diky dalsimu piikazu, FunctionChart, zobrazime graf funkce (zadané jako vyraz) s vy-
znacenim vyznamnych bodu a funkénich vlastnosti. Na obrazku 2.57 jsou zobrazeny graf
vySetfovanych funkei z prikladu 2.48 a 2.49. Jsou v ném znazornény extrémni a limitni
body, monotonie funkce a konvexita s konkavitou.

with( Student| Caleulusl ]) : FuncrfonCharr[ x

, pointoptions = | symbaolsize=20] ]
41

1
FunctionChart\x-e” . pointoptions = | symbolsize= 20 ]]

08
-0 On the irterval [ -10, 10], a chart of £ (x) =

x

1
On the interval | -10, 10|, a chart of f () = xe? .

Obrdzek 2.57: Pouziti ptikazu FunctionChart z baliku Student [Calculusi].

Do baliku Student[Calculus1] ddle nélezi piikazy CriticalPoints pro hledani sta-
cionarnich bodu, ExtremePoints pro hledani extrému, InflectionPoints pro hledani in-
flexnich bodu, Roots pro hledani korenu a dalsi.

Zavérem uvedme jesté pifkazy RollesTheorem a MeanValueTheorem pro vizualizaci Rolle-
ovy veéty, resp. Lagrangeovy véty o stfedni hodnoteé.

Poznamka 2.17: Rolleova véta: Necht funkce f splituje tyto predpoklady:
(1) Je spojitd na uzavieném intervalu [a, b].
(2) V kazdém bodé otevieného intervalu (a,b) mé vlastni nebo nevlastni derivaci.
(3) Plati f(a) = f(b).
Pak existuje ¢islo ¢ € (a,b) tak, ze f'(c) = 0.
Pozniamka 2.18: Lagrangeova véta o stfedni hodnoté: Nechtf funkce f spliuje tyto
predpoklady:
(1) Je spojitd na uzavieném intervalu [a, b].
(2) V kazdém bodé otevieného intervalu (a,b) mé vlastni nebo nevlastni derivaci.

Pak existuje ¢islo ¢ € (a,b) tak, ze plati f'(c) = f(bl)):a(“).
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27 . 2 A
with ( Student| Caicufu.sl 1): . .-MeanVafueThearem[xg —5x +8x—1,x=1.3)
RofiesTheorem[x‘ +2x—3,x=-2.0)

Mustrati on of Rolle's Theorem

— /) ' x
Forthe function f(x) = 2 +2 x —3 on the interval [ -2, U], a graph m
showingf'(x), the line comecting l: =2, f —2}] anid l:D,f[Dj ], O the interval [1, 3], the Tean ¥ atue Thearem is illustrated for
the fanctionf () = — 32 +8r —1.

tangents parallel to the line connecting |: =2, f1-2) ) and
(0.r(0)).

Obrdzek 2.58: Ilustrace vyznamnych tvrzeni piikazy z baliku Student [Calculus1].

2.7 Integral funkce

2.7.1 Neurcity integral

Definice 2.19: Rekneme, 7e funkce F(z) je na intervalu I primitivnd funkei k f(x), jestlize
pro véechna = € I plati F'(z) = f(x).

Poznamka 2.19: Ke kazdé funkeci f(z) spojité na I existuje na intervalu I nekonecné
mnoho primitivnich funkei lisicich se o tzv. integracni konstantu.

Definice 2.20: Mnozinu vsech primitivnich funkei k funkei f(z) nazyvame neurcity in-

tegral a znacime
/ f(z) de.

Poznamka 2.20: Necht F(z) je primitivn{ k funkei f(z). Pak plati:

/ F@) do = F(z) + C,
kde C' € R je integracni konstanta.

V systému Maple méame opét nékolik moznosti, jak spocitat integral ze zadané funkce,
presnéji feceno, jak k této funkci urcit funkci primitivni. Systém Maple totiz k vysledkum
neptidavé integracni konstantu (resp. ji poklada standardné rovnu 0), coz musime mit stéle
na pameéti.

Pii vypoctu muzeme vyuzit symbol pro integrovani z palety Expression, piikaz int,
jehoz parametry jsou vyraz, ktery chceme integrovat, a proménna podle niz integrujeme.
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Nakonec muzeme zapsat vyraz do dokumentu, kliknout na néj pravym tlacitkem mysi a z
kontextové nabidky zvolit Integrate a nasledné proménnou, podle niz chceme integrovat
(viz obrazek 2.59).

an dx

n+1

X

n+1
fm(xn,x)

n+1

n+1
n integrate wrt x xn+1
X

n+1

Obrazek 2.59: Vypocet primitivni funkce.

K vypoctu integralu se nejcastéji pouzivaji 2 zakladni metody - metoda per partes a sub-
stituéni metoda.

Poznamka 2.21: Metoda per partes vychéazi z pravidla pro derivaci souc¢inu. Jeji predpis
pro funkce u(x) a v(z) (které maji na daném intervalu spojité derivace) vypada nasledovné:

/u(x) V' (2) de = u(x) - v(z) — /u’(x) -v(x) d.

Substituéni metoda poskytuje feseni pro integraci slozené funkce. Jestlize F'(z) je primitivn{
funkei k f(z) a funkce ¢(x) ma derivaci v kazdém bodé svého definiéniho oboru, pak plati:

/ Fo(@) - o/ (x) de = / £(t) dt = F(t) = F(p(z)

pii substituci ¢ = p(x)

2.7.2 Metoda per partes

Systém Maple obsahuje balik s ndzvem IntegrationTools. Pro aplikaci metody per partes
slouzi pfikaz Parts majici dva parametry — integral, ktery chceme urcit, a funkci, jejiz
derivaci chceme pocitat (v poznamce 2.21 tomu odpovida funkce u(z)). Pro zédpis integralu
se v tomto piipadé pouziva pitkaz Int®, ktery vytvoii integral symbolicky a nevyhodnoti jej
(narozdil od piikazu int). Pro vyhodnoceni symbolicky zapsaného vyrazu muzeme pouzit
prikaz value.

Priklad 2.51: Pomoci metody per partes urcete f - e’ dx.

Resend: V systému Maple pouzijeme vyse popsané pifkazy. Pfi aplikaci metody per partes
méame vZdy vice moznosti®, jak volit funkci, kterd se bude derivovat. Nékteré moznosti vedou
k cili, jiné ne, jak je vidét i na tomto feseni (obrazek 2.60). Druhd volba funkce, kterd se ma
derivovat, vedla k jesté vypocetné naroénéjsimu integralu, nez byl v zadani.

8Pozor na to, ze Maple rozlisuje mald a velks pismenal
9Ve skute¢nosti jich je nekoneéné mnoho.
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Nagéteni baliku IntegrationT ools:
with( IntegrationTools )
| Change, CollapseNested, Combine, Expand, ExpandMultiple,

Flip, GetIntegrand, GetOptions, GetParts, GetRange,
GetVariable, Parts, Split, StripOptions]|

Cheeme integrovat po ¢astech integral:
X
Im(x- €, x)

& d
xe dx

Nejprve zvolme x jako funkei, ktera se ma derivovat:
Parrs(fm(x- g, xc) \ x)
xe' — [ & -:'x)

Nyni zvolme funkci €' jako funkei, ktera se ma derivovat :
Parrs(fm(x- e, r) . ex)

1 2« |12x-
—XxX e — —X € dx
2 7

e

Vyhodnoceni prvné ziskaného vysledku:
value( %%)

X X
Xe —¢€

Obrdzek 2.60: Reseni pitkladu 2.51.

Piiklad 2.52: Pomoc{ metody per partes urcete [z - sin(z) dx.

Resend: Aplikujeme stejny postup jako v predchozim pifkladu'®. Pestoze zvolime vhodné
funkci, ktera se bude derivovat, nedospéjeme hned k vysledku. Metodu per partes je tieba
v nékterych piipadech aplikovat vicekrat, a toto je pravé jeden z nich. Takze metodu per
partes aplikujeme na ziskany vysledek jesté jednou a ziskdme hledané feseni (které opét
vyhodnotime piikazem value).

2.7.3 Substituéni metoda

Pro aplikaci substitu¢ni metody slouzi piikaz Change, opét z baliku IntegrationTools.
Piikaz ma dva parametry (zcela analogicky k piikazu Parts) — integral, ktery chceme uréit,
a substituci, jiz zamyslime pouzit.

Zavedenim substituce prejdeme k jiné proménné, v niz také obdrzime vysledek. Na
zaver se proto musime ,vratit“ k proménné puvodni, coz provedeme zavedenim téze substi-
tuce (nazpét) pomoci piikazu subs. Pifkaz subs ma 2 povinné parametry — substituce, jez
hodldme zavést, a vyraz, v némz budou substituce aplikovany!®.

10Pouze nebudeme nacitat balik IntegrationTools, nebot jsme jej nacetli jiz difve.
" Upozornéme na rozdil mezi pifkazy Change a subs. Pifkaz Change zavede substituci proménnych v za-
daném integralu, zatimco piikaz subs provede substituce v zadaném vyrazu.
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[i= Im(xz-sin(x}: x)

i sin(x) dx
Parz.s( L X )

-cos(x) ¢ - [ | (-2xcos(x)) -:'x)

Metodu per partes aplikujeme jesté jednou...

Parts ( %, x)
2 . . .
-cos(x) x” +2xsin(x) + | (-2sin(x)) dx
a pomoci piikazu value uréime vyslednou hodnotu integralu:

value( %)

-cos(x) ¥ + 2 xsin(x) +2cos(x)

Obrdzek 2.61: Reseni pitkladu 2.52.

Piiklad 2.53: Pomoci substituéni metody urcete [ sin®(z) - cos(x) dz.

Reseni: Postupujeme analogicky jako v predchozich piikladech. Pokud jsme pfi predchozi
praci se systémem Maple nenacetli balik IntegrationTools, je tieba jej nacist. Zavedeme
substituci, ziskdame ,tabulkovy® integral, ktery vyhodnotime piikazem value, a dalsi substi-

tuci se vratime k puvodni proménné.

Im( sins(x} -cos(x), x)
[

si:nl{_:sc}3 cos(x) dx

Pouzijeme substituéni metodu:
Change(fm( sing{x} -cos(x), x:) ,t=sin(x) )
[£ ds

Pomoci pifkazu value uréime hodnotu ziskaného integralu:

value( %)

1 4
—t

4

a pomoci piikazu subs se vratime k pivodni proménné:
subs(t=sin(x), %)

ry sin(x}4

Obrdzek 2.62: Reseni pitkladu 2.53.

Pri vypoctech integralu se uplatnuji i nékteré dalsi postupy jako naptiklad rozklad na
parcialni zlomky, pravidlo o integraci souc¢tu funkci, ¢i pravidlo o integraci funkce nasobené
konstantou (podrobnosti najdeme téz v napovédé systému). Pro rozklad na parcialni zlomky
je mozné pouzit jiz diive zminény piikaz convert s parametrem parfrac.
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Piiklad 2.54: Pomoci vhodné metody (resp. vhodného postupu) urcete nasledujici in-
tegraly. Piikazem int nasledné ovérte spravnost vaseho vypoctu.

(a) [ 222 da, @) [ mg do,

(b) [ Y2 (h) [z-Va?+1 dz,
(¢) [(z—1) (z—2)(z—3) da, (i) [ cos*(x) da,
@) [ e 4= G) [ -In(z) d,
() [ =t do, (k) [arctan(z) dz,
(f) [cos(5-x+6) dx, 1) [a®-e* du.

Jiz jsme se setkali s vyukovymi nastroji pro vypocet limit a derivaci. Podobny néstroj
je k dispozici i pro integrovani. Spustime jej z hlavni nabidky zvolenim Tools > Tutors >
Calculus — Single Variable > Integration Methods.... Maplet nas krok po kroku povede
vypoctem zadaného integralu, nabizi tradi¢né napovédu k jednotlivym krokum a pravidla,
ktera je mozno pouzit (viz obrézek 2.63).

[1a Calculus 1 - Integration Methods x|
File Edit Ruls Definition Apply Rule  Understood Rules  Help
Enter a function
’VFunction Isin(x)"Z ‘ariable Ix froml tol Skark |
2
Jsm“x dx
= L—Lcos(bc) dx
2 2
1 1 W Show Hint: Get Hink |
=J7dx+ Tcos(E‘c)dx " Show Hints =t i
1 1
=X+ |-y cos(2x) dx
= = Constant Identity
1 1
=S x- cos(2x) dx Constant Mulkiple Surn
1 1 1 Difference Power
= —x-— | —cos{u) du
2 212 Patts Partial Fractions
1 1
= — x-— |cosi ) di Change Rewert
7% oot
Siolve Rewrite
S SIS S {2)
T *- 4 sty Exponential Matural Logarithm
1 1. . -
- T_,(_ I 5!?‘3(2.’() <hrig= | <hyperbolic > |
= <arckrigs> 7 || <archyperbalic> |
Flip | Jain | Split
Undo | ek Step | Al Skeps i Close |

Obrazek 2.63: Vyukovy nastroj pro pocitani integralu.

2.7.4 Urcity integral

Definice 2.21: Méjme funkci f(x), kterd je ohrani¢end na uzavieném intervalu |a, b|.
Rozdélme interval [a,b] na n podintervalu a oznac¢me toto déleni d. Délku i-tého podin-
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tervalu (proi = 1,2, ...,n) i samotny podinterval oznac¢me stejnym symbolem Az;. Oznac¢me
déle m; infimum f(z) pro x € Ax; a M; supremum f(z) na tomtéz intervalu. Nyni definujeme
dolni integradlni soucet predpisem:

s(d) = imi - Ax;
i=1

a horni integradlni soucet predpisem:

i=1

Definice 2.22: Necht plati piedpoklady a oznaceni definice 2.21. Nyni definujeme dolni
integrdl jako supremum vsech dolnich integrélnich souctu (pro ruzna déleni d), tj.:

/b fx) dv = sup s(d)

a horni integrdl jako infimum vsech hornich integrélnich souctu (pro ruzna déleni d), tj.:

/f(x) dr = i%fS(d).

Definice 2.23: Jestlize plati:

jﬂ@dleﬂwﬁw,

pak fekneme, ze ohranicend funkce f(x) je na intervalu [a, b] integrovatelnd (resp. ma urcity
integral). Spole¢nou hodnotu z predchozi rovnosti nazyvame Riemannovym integrdlem z funkce

f(z) na intervalu [a, b] a znacime:
b

Poznamka 2.22: (Newtonova-Leibnizova formule) Jestlize je funkce f(z) na intervalu
la, b] integrovatelna, funkce F'(z) na intervalu [a, b] spojitd a primitivni k f(x), pak plati:

/ﬂ@dwﬂﬂ@ﬁ=ﬂw—F@-

K vypoctu uréitého integralu systém Maple nabizi preddefinovany symbol v paleté Ex-
pression. Je mozné pouzit i ptikaz int podobné jako pro neurcity integral s tim rozdilem, ze
nyni pii specifikaci proménné, podle niz integrujeme, uvddime i jeji rozsah (rozsah integrace).
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a a b b
e —ea—e +eb
- X
im(x-e,x=a..b)

a a h h
e —eca—e teb

Obrdzek 2.64: Vypocet urcitého integralu.

F:= unappf}'[jxg dx, x:)

X— ! X
3
F(5) —F(1)
124
3
F:= unappf}'[jx-cx dx, m:)
x—(-1+x) ¢

F(b) —F(a)

a

|[—1+b}eb—{—1+a}e

Obrdzek 2.65: Vypocet urcitého integralu pomoci Newtonovy-Leibnizovy formule.

Je samoziejmé mozné vyuzit i Newtonovy-Leibnizovy formule, pficemz si pomuzeme
prikazem unapply pro prevod vyrazu na funkci. Na tomto ptikladu si muzeme vSimnout, ze
ruznymi postupy je mozné dojit ke stejnému, ale jinak upravenému vysledku.

Pro geometrickou interpretaci urcitého integralu a nazorné zobrazeni diive definovanych
pojmu (dolni integrélni soucet, horni integralni soucet, ...) poskytuje systém Maple piikaz
RiemannSum z baliku Student [Calculus1]. Pitkaz ma dva povinné argumenty, a to funkci,
jiz chceme integrovat, a interval, pres ktery chceme integrovat. Pokud zadédme jen tyto pa-
rametry, piikaz vypocita integralni soucet pro funkéni hodnoty ve stredech podintervalu
vzniklych rozdélenim puvodniho intervalu a vypise hodnotu tohoto souctu. K dispozici je
vsak nékolik parametru, které muzeme nastavit.

Prvnim je parametr method urcujici, jakou metodou budou voleny funkéni hodnoty
v podintervalech vzniklych z rozdéleni puvodniho intervalu. Pro dolni integralni soucet
pouzijeme nastaveni method=lower, pro horni integralni soucet nastaveni method=upper
(zdkladni nastaveni odpovidd zépisu method=midpoint). Dalsim parametrem je output
(vystup). Pro nds jsou zajimavé zejména moznosti output=plot (zobrazi funkci v grafu
i s délenim puvodniho intervalu a zdkladnimi informacemi) a output=animation (vytvoii
animaci sestavajici z grafu v pripadé output=plot pro ruzné jemna déleni puvodniho inter-
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with ( Student| Caleulusl ) :
RiemannSum( g +11-x+ 9, x=0 .4, method= upper, outpur=pfor)

4
A upper Riemarm sum approximation of | F(x) dy, where
1]
flx)= P =72+ 11249 andthe partition is uniform . The approxit ate
value of the integral is41.54560000. Number of subinterwals used: 10.

Obrdzek 2.66: Geometrickd interpretace urcitého integralu — vykresleni.

with ( Student| Calculusl]) :
Rz’emannSum( x3 -7 x2 + 11-x+ 9,x=0..4, method= lower, partition
=[0,05.0.6,09,23,24,25,36,39.4], ompm=animaziom)

-2

-4

4
At atimated low et Rismanh sum approximation of | f(x) dx, where
0
Flx) =2 =72 4+ 11 2 +9 andthe partition is uniform . The approxim ste
walue of the integral is 3153605355, Number of subintervals uged: 9.

Obrdzek 2.67: Geometricka interpretace ur¢itého integralu — animace.

valu)'?. Nakonec uved me jesté parametr partition specifikujici déleni puvodniho intervalu.
Parametru je mozné priradit ¢islo (v tom pripadé se puvodni interval rozdéli na zadany pocet
stejné velkych intervali) nebo seznam bodu, v nichz se ma puvodni interval rozdélit.
Pokud nechceme pouzivat ptikaz RiemannSum, je mozné vyuzit dalsi z nastroju systému
Maple, ktery nalezneme v menu zvolenim Tools > Tutors > Calculus — Single Variable

12V animaci tak muZzeme sledovat, jak se pro riizné jemnd déleni ptivodniho intervalu méni hodnota
aproximace integralu.
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> Approximate Integration.... V tomto mapletu (obrazek 2.68) muzeme zadat funkei,
interval, pocet podintervalu tohoto intervalu a zvolit metodu, ktera bude pouzita k vypoctu
urcitého integralu. Na vybér mame pfitom i nékolik dalsich metod kromé Riemannovych
soucti. Maplet také nabizi srovnani provedené aproximace integrélu a jeho skutecné hodnoty.
Ptesto tento néstroj postrada nékteré moznosti, které ndm poskytuje piikaz RiemannSum.

f1aCalculus 1 - Approximate Integration x|

File Help

B Flc't Windomw ~Enter a function, interval, and number of partitions

Fx) = [sin(x)

1_

a=|0 b=|Pi
& n=|to
064 ~ Riemann Sums

 upper { lower = random

0.4+ " left (% midpoint € right

02 ~ Meswton-Cotes Formulas

(1) Trapezoidal Rule {2} Simpson's Rule
= (3} Simpson's 38 Rule (" {4) Boole's Rule
" Mewton-Cotes Formula with order = |5

— Parfition bvpe
f* Mormal  Subintervals

Area (Approximate Inteqgral) = |2, 008248408

Actual Inkegral = |2,
d Display I Animate Plot Options Compare | Close |

~ Maple Command

spproximatelrtisin(=), 0. .Pi, 'partition' = 10, 'method' = midpeirt, 'partitiomtype' = nomial . 'ouepae! = 'plot!, 'boweptions! =
['$illed' = ['transparency'=.5]]]1:

Obrdzek 2.68: Maplet pro piiblizny vypocet urcitého integralu a jeho geometricka interpretace.

Piiklad 2.55: Pomoci vhodné metody (resp. vhodného postupu) aplikované pomoci exis-
tujicich piikazu urcete nasledujici integraly. Piikazem int nasledné ovérte spravnost vaseho
vypoctu.

1 In(3)
(a) [arctan(x) du, d) [ =% dr,
0 In(2)
9 1 2.
(b) 1f v 4, (e) [ 2*-cos(x) dz,
0
z In(2)
(¢) [sin(z) - cos?(z) du, ) [ Ver—1dx
0 0

2.7.5 Aplikace urcitého integralu
Obsah plochy

Jiz z geometrické interpretace urcitého integralu vidime jednu z jeho moznych aplikaci pro
feseni praktickych tloh, a tou je vypocet obsahu plochy vymezené dvéma (piipadné i vice)
kiivkami.
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Poznamka 2.23: Necht f(z) je na intervalu [a,b] nezdpornd integrovatelnd funkce. Pak
pro obsah S plochy vymezené funkei f(z), osou x a pfimkami x = a, x = b plati:

S:iﬂ@dm

Pokud je naopak funkce f(x) na tomto intervalu nekladnd, pak pro obsah S plochy vymezené
tymiz kiivkami plati:

S:—]ﬂﬂdu

7 ptredchozi poznamky muzeme odvodit i jak poc¢itat obsah plochy v pripadé, kdy funkce
f(z) na intervalu [a, b] protind osu x (interval rozdélime na podintervaly, v nichz je funkce
nezépornd, a podintervaly, v nichz je nekladnd). Podobné muzeme odvodit, ze pro vypocet
obsahu S plochy vymezené funkcemi f(x),g(x) takovymi, ze Vo € [a,b] : f(z) > g(x),
a primkami x = a, x = b plati:

b

5= / (f(2) - glx)) da.

Funkce je mozné zadavat téz parametricky, a to naptiklad rovnicemi = = (), y = ¥(t),
t € la,bl.

Poznamka 2.24: Necht je funkce f zaddna rovnicemi z = ¢(t),y = (), t € [a, b], piicem?z
funkce ¢(t), () jsou spojité pro t € [, f]. Je-li p(t) ryze monotonni a mé spojitou derivaci
na [a, b], pficemz p(«a) = a, p(B) = b, pak pro obsah S plochy vymezené funkei f(z), osou x
a primkami z = a, x = b plati:

B
5= / (1) - (1) dt] .

Piiklad 2.56: Urcete obsah plochy vymezené kiivkami 22 a x3.

Resent: V zadéni pifkladu nenf zminén interval, na kterém se plocha nachézi, nebot in-
terval uréi samotné kiivky 22 a 2% protinajici se pravé ve dvou bodech. Soufadnice priseciki
na ose x tvori hledané body a a b. Pruseciky zadanych funkci zjistime napt. prikazem solve.
Poté staci pouze ,,dosadit do vzorecku“!3. Plochu, jejiz obsah po¢itame, miZzeme zobrazit té
graficky. K vybarveni plochy mezi funkcemi vyuzijeme piikaz implicitplot z baliku plots
(viz obrazek 2.69).

Priiklad 2.57: Urcete obsah plochy vymezené osou x a funkei zadanou rovnicemi
x=1t—sin(t),y =1 —cos(t),t € [0,2-].

Resend: Funkce x = t —sin(t) je na [0, 2- 7] ryze monotonni a mé spojitou derivaci, takze
muzeme vyuzit predchozi poznamku. Pii vykreslovani plochy vyuzijeme atributu filled,
jenz nastavime na hodnotu true. Tim dosdhneme vykresleni plochy pod kiivkou funkce az
k ose x. Soucasné nastavime atribut scaling na hodnotu constrained, abychom méli na
obou osach stejné meéritko (a graf funkce tak nebyl zkresleny).

13Jesté je tieba védét, kterd ze zadanych funkef je na ziskaném intervalu ,vetsi“.
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2 2m
.mfve(x =x) 4
0.0,1 S=J (1—cos{r})-[ﬁ(z—sin{r))sz
1 0
S=J‘ 2 — % dx S=3m
0
5= 1 plot([t —sin(t),1 —cos(t),t=0.2-w],color

2 ="NavyBlue", thickness =2, filled= [ color

= cyan|, scaling = constrained)
with( plots) :

2
p= pfaz[ [xh_. X ]_. x=0..1, color="NavyBlue", thickness
=2, scaling= conm'amed) :

2 3 " .
region = impficizpfaz[ﬂ: x=0.l,y=x .x, color= cyan') :

display( [region, p])
1 2
15
0g 1
06 0.5
¥ 0
04 0 1 2 3 4 5 3]
02
i}

0 0z 04 06 O0F 1
x

Obrdzek 2.69: Reseni piikladu 2.56 vlevo, feseni piikladu 2.57 vpravo.

Priklad 2.58: Urcete obsah plochy ohranicené kiivkami:
(a)y:4_x27y:$27 (d)y:tan(x),y:O,x:i
(b) y:x?)?y:_x?y:la
(c) y=2% 2=y (6) y=e" y=e" y=2.

Priklad 2.59: Urcete obsah plochy ohranicené:
(a) funkel y = 22 — 2 -z + 2, jeji tecnou v bodé [3, 5] a soufadnymi osami,
(b) funkcf y = 2® a tecnou v bodé z = 1,

(c) parabolou y = 2? — 6 - r + 8 a tetnami v bodech [1,3] a [4, 0].

Priklad 2.60: Urcete obsah plochy ohranicené osou x a kfivkou zadanou parametricky:
(a) 2 =312, y=3-t—1t3,t € [-V/3,V3],
(b) =2 (t—sin(t)),y =2 (1 —cos(t)),t € [0,2 - 7],

(c) . =3-sin’(t), y = 3-cos’(t),t € [0, 7).
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Piiklad 2.61: Odvodte vzorec pro obsah kruhu o poloméru r.

Délka oblouku kiivky

Poznamka 2.25: Necht ma funkce f(z) spojitou derivaci na intervalu [a, b]. Pak pro délku
kiivky [ funkce f(x) od bodu a k bodu b plati:

b

zz/ 1+ (f'(2))? da.

a

Poznamka 2.26: Necht je funkce f zaddna parametricky rovnicemi x = ¢(t),y = (t),t €
[a, B], pricemz funkece (), (t) maji spojité derivace pro t € [« §]. Pak pro délku kiivky [
funkce f od a k [ plati:

B
1= [Vw®r+ w)

Piiklad 2.62: Urcete délku kiivky funkce y = In(z) mezi body = =1 a = = 10.

Resend: Funkee (In(z)) = % je spojitd na [1,10], muzeme tedy vyuzit poznamky 2.25,

pripadné piikazu ArcLength z baliku Student [Calculusl] (obrazek 2.70).

1

— ar::tanh[

evalf (%)

1= J VI,--"f1+ [ 1

4 jn(x) ]2 d

X

I=-y2 + arctanh[ %\.-“?] +

101 ¥

101 ]

[=9.417201566

101

plot(ln(x),x=1 ..10, color="NavyBlue",
thickness =2, scaling= constrained)

with ( Student| Calculus1]) :
AreLength(ln(x),x=1..10)

—ﬁ+arctanh[%ﬁ] +./ 101
1
— arctanh[ Tol J 101 ]

ArcLength(In(x),x=1 ..10, output = plot)

(==l I PR SO NS B e |

The atc length of f{x) =In(x) onthe interval [1, 10]. The
coordinae system 15 C artesian

Obrdzek 2.70: Reseni pitkladu 2.62.

81




Piiklad 2.63: Urcete délku kiivky zadané parametricky rovnicemi x = cos3(t), y = sin®(¢),
te|0,2- 7.

Reseni: Funkce cos®(t), sin®(t) maji na intervalu [0, 2 - 7] spojité derivace, takze mizeme
vyuzit poznamky 2.26, ptipadné opét piikazu ArcLength z baliku Student[Calculusi]
(obrazek 2.71).

2 . . with ( Student| Caleulus1]) :

i 2 2
= icos X 3 iS‘i:rl X 3 X : : 3- in(: ’ SX=T
i’—j v"l [ P (x) ] + [ s (x) ] d A}cf_engrh([cos[x] . sin(x) 6]_x T ]'c)

3 . 3 A}'cﬂengrh([cos(x]s, sin(x]sl:x=—m..m ouzpm=pfor)
pfar( [ cos(x),sin(x) ,x=-1 ..TE]_. color

="NavyBlue", thickness =2 ) i
l 4
0.3
T S T
4 2 4 4 2 4
X
5 ! — /)
.
FERE
— sl - l+[—_m)]
v dx
X
— | gls)ds
-m
The atc length of f(x) = [cos[x}3, sin[x}3] on the interval

[ -1, '.lt]. The coordinate system is Cattesian,

Obrdzek 2.71: Reeni pitkladu 2.63.

Priklad 2.64: Urcete délku kiivky:

% na intervalu [0, 1],

)

b) y = e““;ﬂ na intervalu [—1, 1],
)
)

Priklad 2.65: Urcete délku kiivky zadané parametricky:
(a) z=t% y=t— L tc[0,V3
(b) x =t-cos(t), y="t-sin(t), t € [0,4- 7],

(¢)  =cos(t) +t-sin(t), y = sin(t) —t - cos(t), t € [0,2 - 7.

Piiklad 2.66: Odvod'te vzorec pro délku kruznice o poloméru r.
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Objem rotac¢niho télesa

Poznamka 2.27: Necht je funkce f(x) spojitd a nezdpornd na intervalu [a, b]. Pak rotacni
téleso vzniklé rotaci kiivocarého lichobéznika ohrani¢eného shora funkei f(z), osou x a pfimkami
xr = a, x = b kolem osy x ma objem V:

V:w-/fQ(x) dz.

a

Poznamka 2.28: Necht je funkce f zaddna parametricky rovnicemi x = ¢(t),y = ¥(t),t €
[, 8], pricemz funkce (t) méa spojitou derivaci pro t € [«, 5] a funkce ¥(t) je spojitad
a nezaporna pro t € |«, 5]. Pak pro objem V rotacniho télesa vzniklého rotaci oblasti z €
(@), p(B)] ay € [0,9(t)] kolem osy x plati:

B

ver [v)- ] d

67

Priklad 2.67: Vypoctéte objem télesa, které vznikne rotaci oblasti ohranicené kiivkami
y =22, y =2 — 22 kolem osy z.

Reseni: Objem budeme pocitat podobné, jako kdyz pocitdme obsah plochy vymezené
dvéma kfivkami. Pfesnéji feceno: vypocteme objem rotacniho télesa, které vznikne rotaci
funkce y = 2 — 22 kolem osy z, a od né&j odecteme objem télesa, které vznikne rotaci
funkce y = 22 kolem osy x. JelikoZ obé funkce splituji piedpoklady poznamky 2.27, mtzZeme
k vypoctu objemu pouzit uvedeny vztah. V systému Maple lze jednak vykreslit zadanou
oblast, ktera ma rotovat kolem osy x, dile muzeme vyuzit piikazu plot3d pro vykres-
lovani trojrozmérnych grafu, prikazu animate pro vytvoreni animace a v neposledni fadé
také prikazu VolumeOfRevolution z baliku Student[Calculusl]. Nastavenim parametru
coords=cylindrical vytvoiime rotacni téleso vzniklé rotaci kolem jedné z os. Dale nastavu-
jeme parametry jako thel, o néjz mé zadana (resp. zadané) funkce rotovat, a interval oblasti
— obrazky 2.72 a 2.73.

Poznamka 2.29: Méjme funkci zadanou parametricky rovnicemi x = f(t),y = g(t),z =
h(t),t € |o, B]. Pak téleso vzniklé rotaci této funkce kolem osy z je popsino parametricky
rovnicemi = = f(t),y = \/g(t)? + h(t)? - cos(s),z = 1/g(t)> + h(t)? - sin(s),t € [a, f],s €
0,2 -]

Priklad 2.68: Vypoctéte objem télesa, které vznikne rotaci plochy vymezené kiivkou za-
danou parametricky rovnicemi x =t —sin(t),y = 1 — cos(t),t € [0,2 - 7] a osou x kolem této
0Sy.
Reseni: Zadand kiivka spliuje predpoklady pozndmky 2.28. Vypocet objemu tedy pro-
vedeme dosazenim do prislusného vzorce. V systému Maple opét vykreslime zadanou ob-
last, ktera mé rotovat kolem osy z, a poté i ziskané téleso pomoci piikazu plot3d. Pritom
vyuzijeme poznamky 2.29 — obrazek 2.74.
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1 242 L 22 with( Student| CaleulusI]) :
V=J'I:-J‘ (2—x) dx —Il:-j‘ (r) dx

-1 -1 Volume{)ﬁm’ofurmn(xz_J —xz,x=—l ..l)
V= 16 Tt 16
3 3

— 2 2] .— — g ; - 2 2
pl .—pfot( [x 2 —x ]_,x——l .1, color="NavyBlue", thmr’mess—2) : Volumeﬂﬁielwfmmm(x 2 —xx=-1.1,

. . . 2 2
region = plots| implicitplot] (O,x=—1 Jl,y=x .2-x, color=cyan, output=plot)

grrkfrefme=2) :

plots[ display] ( [region, pI])

The solid of revolution created on —1 = x < 1 by rotation
of f{x) =* andg(x) =2 — 2 shoutthe axisp=10.

Obrdzek 2.72: Reseni pifkladu 2.67.

2 2

plot.?d( [2 TXLX ]= 0=0.2-mx=-1.1, axes = frame, plots| animate] (ploz.?d, [ [2 —xz,xz], 0=A.4x=-1.1,
coords = eylindrical, orientation=[90, 0, 120 ])

axes = frame, coords = cylindrical, orientation= [ 90, 0,

5.
120]]. 4= = . 2% fames=100

2 2
H A=1.5703
_1
0 7

h
]—

14
- e 21012 <05 0 05 1

0 0.5 1

Obrdzek 2.73: Reseni pifkladu 2.67.

Priklad 2.69: Urcete objem télesa vzniklého rotaci plochy ohranicené zadanymi kiivkami
kolem osy x:

(a) y* =z, y =217 () y=z,y=1,y=2
(b) y=0,2=0,y=sin(x), z =T, (d) 22 +y* =4, 2+y=2.
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2m R plot3d([t —sin(t), (1 —cos(¢) ) -cos(s), (1 —cos(z) ) -sin(s) ],
V=J'E-J‘ (1 —cos(r)) -|— (r—sin(z))|dr §=0.2-m1t=0.2-m aves=frame, labels=["x", "y","z"],
0 scaling= constrained, orientation= 90, 0, 160] )

plot([t —sin(z), 1 —cos(z),1=0..2-1], scaling
= constrained, color="NavyBlue", thickness
=2, filled= [ color= cyan]) -2

T
5 6 -1012
0s ® z

Obrdzek 2.74: Reseni pitkladu 2.68.

Priklad 2.70: Urcete objem télesa, které vznikne rotaci plochy ohranicené kiivkou zada-
nou parametricky a osou x kolem této osy:

(@) z =t y=t—L te[0,V3]
(b) x=3-sin’(t), y =3-cos®(t), t € [-5, %],
(c) x =sin®(t), y = 1 — cos(t), t € [0, 7],

(d) z=2+sin(t), y =2+ cos(t), t € [0,2 - 7.

Piiklad 2.71: Odvod'te vzorec pro objem koule o poloméru r.
Piiklad 2.72: Odvod'te vzorec pro objem vélce o poloméru podstavy r a vysce valce v.

Piiklad 2.73: Odvod'te vzorec pro objem kuZele o poloméru podstavy r a vysce kuZele v.

Obsah plasté rotacniho télesa

Poznamka 2.30: Necht je funkce f(x) spojitd a nezdporna na intervalu [a,b] a m4 zde
spojitou derivaci. Pak pro obsah S rota¢ni plochy vzniklé rotaci kiivky y = f(z) kolem osy
x plati:

b

S:2w /ﬂ@-wLumedx

a
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Poznamka 2.31: Necht je funkce f zaddna parametricky rovnicemi x = ¢(t),y = ¥ (t),t €
la, B], pricemz funkce @(t) a 1 (t) maji spojité derivace pro t € o, 5] a funkce ¥(t) je
nezaporna pro t € [«, 5]. Pak pro obsah S rota¢ni plochy vzniklé rotaci grafu funkce f kolem
osy x plati:

B
S=2.7. / (1) (@) + (W(0)? d.

Priklad 2.74: Vypoctéte obsah plasté rotaéniho kuzele, ktery vznikne rotaci funkce y = x
pro x € [0, 3] kolem osy .

Resend: Jelikoz plati vechny piedpoklady pozndmky 2.30, staci dosadit do uvedeného
vzorce. K dispozici mame také prikaz SurfaceO0fRevolution z baliku Student [Calculusl]
(obréazek 2.75).

3 with( Student| Calculusl]) :

|| 2 -
s=2m|x/1+ [i(x)] dx SurfaceOfRevolution(x, x=0.3)
) W dx 9 E\f{?
S=ory2 SurfaceOfRevolution(x, x=0 ..3, output = plot)

pi’ot.?d(x, 0=0.2-m x=0..3, axes= frame, coords = cylindrical,
labels=["x","y", "z"], orientation= 90, 0, 120])

Sutface of revolution formed whenf(x) =20 <x <3, is
rotated about a horizontal axis.

Obrdzek 2.75: Reseni pifkladu 2.74.

Priklad 2.75: Vypoctéte obsah plaste télesa, které vznikne rotaci kiivky zadané parame-
tricky rovnicemi o = cos?(t),y = sin®(t),t € [0, 7] kolem osy z.

Reseni: Zadand kiivka spliiuje viechny piedpoklady poznamky 2.31. Pouzijeme proto
prislusny vztah pro vypocet obsahu plasté (obrazek 2.76).
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pfor.?d([coss(z):sina{!) -cos(s), sina{r) -sin(s) ],5=0 L2mt=0..m,

axes = frame, labels= [ "x", "y", "2" ). orientation= | -90, 0, 20 ]}

Obrdzek 2.76: Reseni pitkladu 2.75.

Priklad 2.76: Urcete obsah plasté télesa vzniklého rotaci plochy ohranicené zadanymi
kiivkami kolem osy x:

(d) 2 +y? =4, 2 +y=2.

Priklad 2.77: Urcete obsah plasté télesa, které vznikne rotaci plochy ohranicené kiivkou
zadanou parametricky a osou x kolem této osy:

(a) x:tZay:t_§7t€ [07\/3]’
(b) & =3-sin’(t), y=3-cos®(t), t € [-5, %],
(¢) @ =sin®(t), y = 1 — cos(t), t € [0, 7],

(d) x =2+sin(t), y =2+ cos(t), t € [0,2 - 7].

Piiklad 2.78: Odvod'te vzorec pro povrch koule o poloméru r.
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Piiklad 2.79: Odvod'te vzorec pro povrch valce o poloméru podstavy r a vysce véalce v.

Drive uvedené piikazy baliku Student [Calculus1], tedy piikazy ArcLength, VolumeOf-
Revolution a SurfaceOfRevolution, jsou k dispozici i ve formé mapletu, jez najdeme v
hlavnim menu (Tools > Tutors > Calculus — Single Variable).

2.7.6 Nevlastni integral

Definice 2.24: Necht je funkce f(z) integrovatelnd v kazdém intervalu [a, t], kde a < ¢ < b,
t

a necht je f(z) neohranicend v levém okoli bodu b. Existuje-li vlastn{ limita lirbn [ f(z) dz,
t—b—

b
pak fekneme, ze integrdl [ f(z) dz konverguje, a klademe

t

[t s

b
Pokud zminénd limita neexistuje nebo je nevlastni, fikdme, ze integrdl [ f(z) dx diverguje.
a

Poznamka 2.32: 'V piipadé neohranicenosti funkce f(z) na intervalu [a, b] v pravém okoli

bodu a definujeme integral [ f(z) dz analogicky.

1
~ ’ . v 1
Piiklad 2.80: Urcete Of—m dz.

Reseni: V systému Maple obdrzime feseni automaticky pouhym zadénim integrélu a pro-
vedenim piikazu. Musime si vSak uvédomit, ze zadana funkce \/1;_7 neni v bodé 1 spojita
a na intervalu [0, 1] ohrani¢end! Spravné bychom se tedy méli o ziskaném vysledku presvedcit
urcenim limity z definice 2.24.

Obrdzek 2.77: Reseni piikladu 2.80.
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1
Piiklad 2.81: Urcete [z -In(z) dx.
0

Poznamka 2.33: Pokud je funkce f(x) neohrani¢ena na intervalu [a,b] v pravém okoli
bodu a i v levém okoli bodu b, rozdélime interval [a, b] libovolnym bodem ¢ € (a,b), ¢imz
prejdeme k piipadum popsanym v definici 2.24 a poznamce 2.32.

Definice 2.25: Necht je funkce f(z) integrovatelna v kazdém intervalu [a,b], kde a < b.

Existuje-li vlastni limita bhm f f(z) dx, pak fekneme, ze integrdl [ f(z) dx konverguje,
—00 Y

a klademe
b
/ f(z) de = hm f(z) dx.

(o]
Neexistuje-li zminénd vlastn{ limita, fikdme, ze integrdl [ f(z) dx diverguje.
a

b
Poznamka 2.34: Analogicky definujeme nevlastn{ integral [ f(x) dx. Je-li funkce f inte-

—00
o

grovatelnd na kazdém omezeném intervalu, pak fekneme ze integrdl [ f(x) dx konverguje,
—0o0

jestlize pro néjaké a € R konvergujf oba nevlastni integrdly [ f(z) dz, [ f(x) dx a klademe

7f(x) dx = /af(x) da:+7f(x) dx

oo

Priklad 2.82: Urcete f x% dz.
2

Resent: V systému Maple obdrzime Feseni opét automaticky pouhym zaddnim integralu

a provedenim piikazu. Jako v predchozim ptipadé bychom si vSak méli uvédomit, zda existuje
b

vlastni limita bhm f dz. Pti vypoctu limity Maple zahlasi, ze neumi urcit, jestli b < 0.
— 00 2

Je mozné mu ,pomoci“ zavedenim predpokladu, ze b > 0, pomoci piikazu assume (obrézek
2.78).

Priklad 2.83: Urcete nésledujici integraly:

a) [ \/LE du, (¢) [sin(z?) du,
1 1
J 1 do, (@) [ do
—00 0
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Doposud jsme se setkali pouze s piiklady, kdy Maple umi nalézt symbolické teseni (pii
pouziti ,standardnich® funkei). Jsou vsak pripady, kdy Maple zavadi funkce nové ¢i symbo-
lické feseni nenalezne. Pokud Maple zahrne do vysledku novou funkci, najdeme jeji predpis
v napovedé. Napiiklad na obrazku 2.79 je v feSeni zahrnuta tzv. chybova funkce erf (x)

s predpisem

b |~

limJ L&
b—»m') 2

Warning, unable to determine if 0

is between 2 and b; try to use
assumptions or use the
AllsSolutions option

1

2

assume(b > 0)

b
lim [[ —1, dx}
bh—oo £

, X

0| —

Obrdzek 2.78: Reeni pitkladu 2.82.

2. (Of et dt)

N

erf(z) =

2
jexdx

je_xz In(x) dx

_y2
jex dx

j e_xz-ln(x] dx

2

2

im(e_xh: x=0.1, numeric)

0.7468241328

m’a{f(fm(e_xzr x=0 ..1) )

0.7468241328

z'm( e -In(x),x=0..1, numeric, method=_Dexp

-0.9059404763

-0.9059404763

)

eva{f(fm( e_x2 In(x),x=0..1, method= _unad) )

Obrdzek 2.79: Symbolickd a numerickd integrace.

Jestlize Maple nenalezne symbolické teseni, vypise ndmi zadany piikaz jako vysledek.
V pifpadé urcitého integralu muzeme hledat numerické feseni, a to bud piiddnim nepo-
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vinného parametru numeric piikazu int, nebo pouzitim piikazu evalf na integral zadany
piikazem Int!4. Numerickych metod pro vypoéet urcitého integrélu nabizi Maple nékolik.
Mezi nimi je mozné volit specifikaci parametru method (vice v ndpovédé systému).

14Upozornéme na rozdil v zadani evalf(Int(..)) a evalf(int(...)). Prvn{ moznost vede na nume-
rické feseni zadaného integralu, v druhém piipadé je nejprve vyhodnocen integrdl symbolicky pfikazem int
a nasledné vysledek preveden na numerickou hodnotu piikazem evalf.
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3 Matematicka analyza s Maple v R"

Ackoli v sobé nazev kapitoly obsahuje prostor R”, ¢asto se budeme omezovat na funkce dvou
proménnych, tedy prostor R?, pro néjz mame v systému Maple grafickou podporu.

3.1 Funkce vice proménnych

3.1.1 Definice funkce vice proménnych

Funkci vice proménnych definujeme v systému Maple zcela analogicky k funkci jedné proménné
(viz 2.2.1). V prostiedi Standard Worksheet pouzivdme tytéz postupy, pouze ,priddvame*
proménné - obrazky a .

Fley) =2 +y 7.1
(%) = +y 1
g(0.1)
g=(xy) =X +y 1
{ NI h(0,1)
x.y)—x +y undefined
h(-1,1)
h == (x,v) —piecewise(x < 0,-x, x-y < 0,-y, undefined) !
(x, y) —piecewise(x < 0, -x, xy < 0, -, undefined) h(1.-1)
1

Obrdzek 3.1: Definice funkce dvou proménnych.

3.1.2 Vykresleni funkce dvou proménnych

V zavéru predchozi kapitoly jsme se jiz setkali s piikazem plot3d pro vykreslovani troj-
rozmérnych grafu. V systému Maple mame tedy moznost vykreslovat funkce dvou proménnych,
a to opét podobnymi postupy jako v ptfipadé funkce jedné proménné. Prvni zpusob nabizi
kliknuti pravym tlac¢itkem na funkci (resp. vyraz) dvou proménnych v dokumentu a zvoleni
Plots > 3-D Plot se specifikaci proménnych. Dalsi moznost poskytuje pomocnik zvany
PlotBuilder a nakonec mame k dispozici jiz zminény piikaz plot3d.

Narozdil od vykreslovani funkci jedné proménné Maple nyni v grafu standardné nezobra-
zuje soufadnicové osy. Pokud je chceme zobrazit (a na vybér mame z nékolika typu: normal,
boxed, framed), je tieba pii tvorbé grafu specifikovat parametr axes. Graf je mozné upra-
vovat i po jeho vytvoreni kliknutim pravého tlacitka mysi a volenim pozadovanych parametru
grafu z kontextové nabidky. Kliknutim na graf a pfidrzenim levého tlacitka mysi muzeme
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14

fi=(xpz) —>pz'ecewflse(x <0AYy<0Az< D,xz_.x-y-z)

o

(x,wz) —}piecewife(x <0 and y<0and z <0, xE: xyz)

fi= (epnuy) =247 4 zu—v
(x. 0z, u,v) —o? -I-Jf'E +zu—v

£(1,2.3.4,5)
12

Obrdzek 3.2: Definice funkce vice proménnych.

s grafem funkce otacet podle pohybu mysi, pripadné provadét dalsi upravy, které si predem
vybereme v kontextové listé, resp. kontextovém menu.

Rozdil mezi piikazy plot a plot3d je také v povinnosti specifikovat rozsah nezavisle
proménnych. Zatimco u piikazu plot se pouzije standardni interval [—10,10] pfi nezadani
rozsahu, piikaz plot3d zadéani rozsahu vyzaduje pro obé nezavisle proménné, jinak se nepro-
vede a vypise chybové hlaseni.

Stejné jako v pripadé funkce jedné proménné musime i zde myslet na to, jak ma graf
funkce vypadat a piipadné vyzkouset ruznd nastaveni parametru (tj. napf. rozsahu nezavisle
proménnych), abychom dostali ndzorny graf. Nékterd zobrazeni mohou velmi zkreslovat
(resp. zobrazovat graf funkce chybné).

Systém Maple kvili efektivité (rychlosti) vykreslovani pocita funkéni hodnoty! jen v nékolika
bodech. Graf byvé zpravidla rozdélen na ¢tvercovou sit bodw, v nichZ je spocitdna od-
povidajici (funkéni) hodnota. Parametry sité se pro ruzné typy grafu lisi, naptiklad v Maple
16 je pro piikaz plot3d standardné pouzita sit 25x25 bodi, pro piikaz implicitplot sif
26x26 bodu atp. Zbylé body grafu jsou ziskané linedrni (rovinnou) interpolaci.

Pokud chceme po systému presnéjsi zobrazeni, mame nékolik moznosti. Prvni je omezeni
rozsahu nezavisle proménnych (viz obrazek 3.4). Muzeme také nastavit parametr numpoints
urcujici, v kolika bodech bude vypocitana (funkéni) hodnota. Dalsi moznosti je nastavit ex-
plicitné sit poc¢itanych bodi pomoci parametru grid. Ten specifikujeme dvojici v hranatych
zévorkach: [pocet bodt na ose x, pocet bodu na ose yl?.

Ve skutecnosti nemusi jit jen o funkéni hodnoty, vykreslovat mtzeme napiiklad i hodnoty vyhovujici
néjaké rovnosti (nerovnosti).

2Piikazu implicitplot je mozné navic nastavit parametr gridrefine, ktery ,zjemnuje“ sit pocéitanych
bodu. Standardni nastaveni je 0. Nastaveni na hodnotu 1 (zjednodusené) znamend, ze misto jedné (funkéni)
hodnoty v daném misté sité budou uréeny dvé funkéni hodnoty. Pfi dalsim zvySovani hodnoty parametru
gridrefine se vzdy rekurzivné pocitaji dvé nové (funkéni) hodnoty misto jedné piredchézejici. Vice informact
nalezneme v napovédé k pitkazu implicitplot.
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plot3d(x" +y.x=-5 .5, y=-5.5)

g gy s s
L7 ,;-.I'; 4
<, 'J:p,

pEotSd(xz +yx=-5.5y=-5.5 axes= normai)

piot.?d(xz +ux=-5.5y=-5.5 axes =ﬁ'amed)

1)
.-‘.t} ]
bttty i g
Vestsetotans i vl
“Eebatrigt gyl
et

Obrdzek 3.3: Vykresleni funkce dvou proménnych pomoci piikazu plot3d.

L,x=—5 S5,y=-5.5, axes=ﬁ*amed]
Xy

plot3d [

1

x-y

plor.?d[ ,x=-3 .3, y=-3 ..3,axes=ﬁ*amed]

Obrdzek 3.4: Ukéazka riznych nastaveni piikazu plot3d.

3.1.3 Defini¢éni obor funkce dvou proménnych

Systém Maple nam déva moznosti, jak zakreslit do grafu dvourozmeérnou (piipadné i t¥irozmérnou)
oblast. K zakresleni dvourozmérné oblasti zadané implicitné (rovnosti ¢i nerovnosti) slouzi
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pfozSd[L,x=—5 5, y=-5.5, axes pfor3d[L,_r=—5 W5, y=-5.5, axes
Xy Xy

= framed, grid= [40,40]] = framed, numpoints = 1700]

Obrdzek 3.5: Ukazka dalsich nastaveni piikazu plot3d pro piesnéjsi vykresleni.

piikaz implicitplot z baliku plots. Pokud chceme zadanou oblast vyplnit, nastavime pa-
rametr filled na hodnotu true.

Pro vykresleni oblasti vymezenych vice nerovnostmi (resp. rovnostmi) je nékdy nutné
pouzit jiny postup. Pokud je oblast vymezend linearnimi nerovnostmi, je mozné pouzit prikaz
inequal z baliku plots.

Priklad 3.1: Nakreslete oblast A = {(z,y) € R? : 2? + 4 < 1}.
Reseni: Pouzijeme piikaz implicitplot, kterému navic specifikujeme i parametr view
pro rozsah soufadnych os® (obrdzek 3.6).

Priklad 3.2: Nakreslete oblast A = {(z,y) € R*: |z| + |[y| < 1}.

Reseni: Pravé v tomto piipadé se projevi nedostateény pocet generovaych bodi pro
vykresleni zadané oblasti. Vyuzijeme proto parametru gridrefine, ktery poskytuje ptikaz
implicitplot (obrazek 3.7).

Priklad 3.3: Nakreslete oblast A = {(z,y) e R*: 2 >0,y > 0,z +y < 1}.

Resent: Pozadovand oblast je zaddna tfemi nerovnostmi, pficemz viechny jsou linedrn.
Vyuzijeme proto prikazu inequal. Piikaz ma nékolik nepovinnych parametru, v nichz muzeme
napiiklad specifikovat barvu, kterou budou vykreslovany body patiici (resp. nepatiici) do
zadané mnoziny (oblasti) nebo hraniéni body (obrézek 3.8).

3Neplést s nastavenim rozsahu nezdvisle proménnych!
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p 2
plots| implicitplot | {xh +y <1,x=-2.2,y=-2.2,view=[-2.2,-2.2]
coloring = [ cvan, white], filled = true, thickness = 2)
2 —
Fyaali
-2 1 0 i 2
2
(R
-2
Obrdzek 3.6: Reseni pifkladu 3.1.
plots| implicitplot] (x| + V] < 1.x=-2.2,y=-2 .2, view=[ -2.2,-2.2]

coloring = [ cyan, white]., filled= true, thickness = 1, gridrefine=6)

2_

=

Obrazek 3.7:

Reseni prikladu 3.2.
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plots| inequal | ({0 =x, 0 =y, x+y<1}.x=-1.2,y=-1.2,
optionsfeasible = ( color = cyan) ., optionsexcluded= ( color=white)
optionsopen = | color = white, linestyle= dot |. labels= [ "x","y"])

Obrdzek 3.8: Reseni prikladu 3.3.

Priklad 3.4: Nakreslete oblast:
ER*:0<z<y<1},

) A={(z,y)

) A=A{(z,y)

&) A={(z,y) ER: (x— 2+ 92 > 1},

) A={(z,y) e R?: 1 < [a] +[y| < 2},

) A={(z,y) eR*:z < 2* +y*> < 1}

Vykreslovani dvourozmérnych oblasti vyuzijeme pii urcovani defini¢nitho oboru funkce

dvou proménnych. Systém Maple nema zadny nastroj pro nalezeni defini¢niho oboru funkce,
nic ndm vsak nebrani vyuzit jej pti podilohach vedoucich k hledanému teseni.

Piiklad 3.5: Urcete defini¢ni obor funkce f(z,y) = \/<ZB2 + % - 1) (2?2 4y —6-x)

a zakreslete jej v roviné.
Reseni: Vyraz pod odmocninou musi byt nezaporny, tj.

(xQ—k@—l)-(ﬁ—l—yg—ﬂx)ZO.
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Ptedchozi nerovnost se nam rozpadne na 2 ptipady, které bychom déle upravovali. V tuto
chvili vsak jiz muzeme vyuzit prikazu implicitplot a prislusnou oblast — defini¢ni obor
funkce f(z,y) — rovnou vykreslit. Opét je nutné specifikovat néktery z parametru ,kvality“
zobrazeni, pouzijeme proto napiiklad znovu parametr gridrefine (obrézek 3.9).

(y—2)

plots| implicitplot | [ { ¥ + 2

R —

coloring = [ cyan, white], filled = true, thickness = 2, gridrefine=3

5_

Obrdzek 3.9: Reseni pifkladu 3.5.

Priklad 3.6: U nasledujicich funkei urcete jejich defini¢ni obor a zobrazte jej v roviné:

(a) f(x,y) = \/1—$2—4'y2, (d) f(a?,y) :aI‘CCOS(xLer),
(b) f(x,y) = /sin(z? + y?), (e) flz,y) =V1—a24 /1 -2,
(c) f(x,y) =In(z +y), (f) f(z,y) =In(z-In(y — x)).

V systému Maple je mozné vykreslovat téz vrstevnice funkei dvou proménnych, tj. mnoziny
bodu se stejnou funkéni hodnotou. Slouzi k tomu ptikaz contourplot, piipadné je mozné
vrstevnice zakreslit do grafu funkce nastavenim parametru style piikazu plot3d na hodnotu
patchcontour (lze nastavit i dodateéné v kontextové listé ¢éi kontextovém menu).

Piikaztim contourplot a plot3d muzeme dale zadat parametr contours urcujici, kolik
vrstevnic se zobrazi!, pifpadné jaké vrstevnice (tj. vrstevnice jakych funkénich hodnot)® -
obrazek 3.10.

4zaddme pfirozené ¢islo
5zaddme seznam funkénich hodnot
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pfaw[mmaurpfar]( / m ,x=-5.5y=-5 ..S) pfazi‘d(\j % -I—y2 L,x=-5.5y=-5.5,

o

// \ style= patchcontour, axes = ﬁ‘ame)

7D
D)

RS

Obrazek 3.10: Zobrazeni vrstevnic funkce dvou proménnych.

Priklad 3.7: Zobrazte vrstevnice nasledujicich funkei:

(a) flw.y) =" =4, () fla,y) =12

(b) f(%?/):wz—iyz, (d) f(z,y) =z-v.

3.2 Limita a spojitost funkce vice proménnych

3.2.1 Limita funkce

Definice 3.1: Reckneme, Ze funkce f(z,y) ma v bodé [zg,y0] € R? limitu L € R, jestlize
ke kazdému e > 0 existuje 6 > 0 tak, ze pro v8echny [z, y] spliujici |z — x¢| < 0, |y —yo| <6
a [x,y] # [zo,yo] plati | f(z,y) — L| < &, a piseme

lim  f(z,y) = L.

(z,y)—(x0,y0)

Poznamka 3.1: Analogicky k vlastnim a nevlastnim bodim a limitam definujeme tyto
body i v prostoru R?. Limita se nazyva nevlastni, jestlize je rovna oo nebo —oo. V opa¢ném
pripadé se nazyva vlastni. Nevlastni bod je bod s alespon jednou soutadnici rovnou oo nebo
—00, tj. bod typu [a, +00] nebo [£o00, al, kde a € R U {—o0, o0}.

Poznamka 3.2: Taktéz analogicky definujeme piislusné pojmy v prostoru dimenze vétsi
nez 2.
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Poznamka 3.3: Z&asadni rozdil mezi limitou funkce jedné proménné a limitou funkce dvou
proménnych spociva v okoli limitnitho bodu a tedy sméru ptiblizovani k limitnimu bodu.
U funkce jedné proménné se blizime pouze po jedné piimce (a to zleva nebo zprava). Naproti
tomu u funkce dvou (a vice) proménnych se k limitnimu bodu blizime po ruznych piimkach,
parabolach ¢i jinych mnozinach. Pokud v daném bodé limita existuje, nesmi zalezet na cesté,
po jaké se k tomuto bodu priblizujeme.

V systému Maple mame moznost pocitat limity funkei dvou (i vice) proménnych. Nemame
k tomu vsak jiz symbol v paleté Expression, a tak musime pouzit piikaz 1limit. Ptikaz
pouzivame jediny, limitni bod zapiSeme do slozenych zavorek. Pokud bychom pouzili piikaz
dvakrat za sebou vzdy pro jednu proménnou, tj. napf. 1limit(limit(f(x,y),x=a),y=b),
nepocitali bychom diive definovanou limitu. K limitnimu bodu bychom se totiz v tomto
pripadé blizili pouze ve dvou smérech (nejprve po ose = a nasledné po ose y).

fimir(xg-y: {x= 1:y=2})

b2

I T 1 = 1=
hmir[ - {x=0,y D}]
undefined

Limita funkce tri proménnych
fimir(xz-y +z {x=1,y=2,z=3} )
5

Obrdzek 3.11: Vypocet limity funkce vice proménnych.

Systém Maple limitu v mnohych pifpadech neumi uréit, i kdyz limita existuje. Casto je
proto vhodnéjsi pouzit ,klasicky“ zpusob urceni limity a Maple pouzit jako pomocnika pii
diléich vypoctech a pro vykresleni funkce (vyrazu) v blizkosti limitnitho bodu (pro vysloveni
hypotézy o existenci limity a jeji hodnoté). Pokud je mozné do vyrazu, jehoz limitu pocitdame,
dosadit, TeSeni je trivialni. Pokud pfi dosazeni dostavame neurcity vyraz typu ,,%“ nebo 2=,
upravujeme puvodni vyraz, abychom do néj mohli ,dosadit“. Nejbéznéjsimi upravami jsou
rozsireni zlomku, pouziti (souc¢tovych) vzorcu ¢i substituce.

Klicova je otazka, zda limita viubec existuje. Pokud ocekavame, ze zadany vyraz nema
limitu, je mozné vyuzit priblizovani k limitnimu bodu z ruznych sméru (tj. napi. po ruznych
primkéach, po pifimkéch a po parabolach, ...). Pokud dostaneme ruzné vysledky (limity), li-
mita neexistuje. Casto je vyuzivana transformace do polérnich soufadnic a nésledné pfiblizo-
vani se k limitnimu bodu po kruznicich. V tomto ptipadé je nutné mit na paméti, ze vysledna
limita nesmi zaviset na tihlu (¢) a ze ptiblizovani se po kruznici je opét pouze jeden z moznych
zpusobu piiblizovani se k limitnimu bodu! Nicméné existuje tvrzeni, které nam za jistych
predpoklada dovoli uré¢it limitu funkce (vyrazu) pouzitim jen této metody.

Poznamka 3.4: Plati-li pro funkci f(x,y) po transformaci do poldrnich souradnic

lim  f(z,y) = lim h(r) - g(p),

(z,y)—(z0,50) r—07t
pricemz

lim h(r) =0 a g(p) je ohranicend pro ¢ € [0,2 - 1),

r—0+
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pak
lim  f(z,y) =0.

(z,y)—(x0,y0)

Priklad 3.8: Urcete lim
(x,y)—(0,0)

Resend: Pravé v tomto piipadé od systému Maple obdrzime chybné feseni.

1
x2 +y2 .

Pouziti systemu Maple k vypoétu
limity:

pi’oz.ﬁ'd[ 5 1 —.x=-3.3,y=-3 .3, axes
x +y

. 1

limit {x=0,y=0} _ T B

2 +}'2 ] frame, view=[ -3 ..3,-3..3,0..6]
undefined

Obrdzek 3.12: Pokus o ziskani feseni prikladu 3.8 v Maple.

Jiz prvni pohled nam napovida, ze by limita méla existovat a méla byt rovna co. K urc¢eni
limity musime vyjit z definice nevlastni limity. Potfebujeme ukéazat, ze pro libovolné velké
M € R existuje § > 0 tak, ze pro vSechna [x,y] spliujici |z| < 6, |y| < § a [z,y] # [0, 0] plati
f(z,y) > M. 1

Méjme proto libovolné, ale pevné M € R. Polozme § = . Pro |z,y] splnujici

) p p @ [z, y] spliyj

lz| < 0, |y| < & a [x,y] # [0,0] nyni plati: 2> +y? < 262 = - £ toho uz vidime, ze

skutecné f(x,y) > M pro tato [z,y], a tedy

1
lim

—— = Q.
(z,9)—(0,0) 22 4 y2

Piiklad 3.9: Urcete lim 5V
(w)=+(0.0) Y

Resend: Od systému Maple neziskdme feseni. Nejprve musime ,odhadnout®, zda limita
existuje a pokud ano, ¢emu je rovna. Z toho vyvodime postup, jakym vyslovenou hypotézu
dokazat. Diky tvaru zadani nemusime uvazovat nad zménami znamének, funkéni hodnoty
jsou vzdy nezéporné. Pro |z| < 1 a |y| < 1 plati (zkuste dokdzat):

1:2+y2>x2-y2

a podil ¢itatele a jmenovatele bude tim mensi, ¢im mensi (v absolutni hodnoté) budou z a y.
To nés privadi na myslenku, ze limita existuje a je rovna nule.

6Vyuzijte nerovnost (|z| — |y[)? > 0 platnou pro [z, y] # [0, 0].
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Nyni bychom mohli opét postupovat podle definice. Vzali bychom libovolné, ale pevné e
a k nému bychom ,vytvorili“ § tak, abychom splnili predpoklady definice 3.1 pro L = 0.

Zkusme vsak k vypoctu limity pouzit transformaci do polarnich soutadnic, tzn. provést
substituci: [z,y] = [r - cos(p),r - sin(yp)]. Ziskdme tak (viz obrazek 3.13) vyraz tvaru

r? - cos?(p) - sin®(ip).
Aplikaci pozndmky 3.4 dostévame h(r) = r? a g(¢) = cos?(p)-sin®(p). Plati, ze lim h(r)=0
r—0
a g(p) je ohrani¢end pro ¢ € [0,2 - 7). Tedy

2,2
im —Y _p
(z,y)—(0,0) T2 + 12

)

Pouziti systéemu Maple k vypoctu limity:

2 2 pfmj’d[ f i -, x=-3.3,y=-3 .3, axes
Eimiz[ : J

2 Y {x=0,y=0 X +y
2 2° 2 -
x +y

= frame, view=[ -3 ..3,-3..3,0..6]

XV

22
ffmir[ —, {x=0_.y=0}}

X4y

Transformace do polarnich souradnic:
709

. X -y
Subs[{x=r-cos{qp]:y=r-sm{qa}}: —

2

w cos( cp]2 sin cp}2

2 cc:s{cp:l2 +7 si*_rl{(p:l2

Zjednoduseni:
simplify( %)
2 2. 2
ricos(q) sin(q)”

Obrdzek 3.13: Reseni piikladu 3.9.
Piiklad 3.10: Urcete ( I)IH% )% pitmo z definice limity.
z,y)—(0,0

Priklad 3.11: Urcete:

=2y

I " sy
(a) <z,y>1§fo,o> daty’? (©) (:c,y)lgz0,0) Varty?’
b)  lim 2 |
( ) (x,y)—(0,0) w4yt (f lim sm(;t-y)’
( ) 1 Ty (I7y)*>(072)
C 1m —S

2 2
(@,y)—(0,0) TV’

(d) lim —A— (g) lim Meerlol
(@y)—(1,1) Vai+y? (zy)—(00)  THY
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3.2.2 Spojitost funkce

Definice 3.2: Rekneme, ze funkce f(x,y) je spojitd v bodé [z, 1] € R?, jestlize ma
v tomto bodé vlastni limitu a plati

lim z,Y) = f(Zo,Yo)-
(x,y)—>(o,0)f( y) = f(zo,y0)

V systému Maple médme pro hledani bodu nespojitosti funkce jedné proménné piikaz
discont. Ten vsak ,funguje” jen pro funkce jedné proménné. Pro funkce vice proménnych
muzeme vyuzit piikazu singular hledajiciho tzv. singularity. Jeho pouzitim pak muzeme
odhalit nékteré body nespojitosti. Pitkaz singular ma vSak nékolik ,nedostatku“ (resp.
somezeni“), takze je vhodnéjsi hledat nespojitosti ,klasicky“ a Maple vyuzivat k dilcim
ukolum.

Priklad 3.12: Je funkce

spojitd na celém R2?
Resend: V pitkladu 3.11.(b) pilny ¢tendf zjistil, ze funkce f(z,) nemé v bodé [0, 0] limitu.
Podle definice 3.2 proto f(z,y) neni v tomto bodé spojité.

Priklad 3.13: Urcete body nespojitosti u nasledujicich funkei:

() f(r.) = =

(b) f(,y) =sin ().

(€) fla,y) = avecos (2),

(@) fle,y) =In|1—a* 2,

2242

ﬁ oz y] £ 10,0]

© ﬂx’y):{o eyl =[0,0]

Piiklad 3.14: Urcete C € R tak, aby byla nésledujici funkce spojitd v bodé [0, 0]:

AT

X . _ )T [x,y]%[OaOL

(a) f(z,y) {C .. |@,y] =10,0]
i B % [z,y] # [0,0]

(b) f(z.y) {C - zyl =0,
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3.3 Parcialni derivace funkce vice proménnych

Definice 3.3: Necht je funkce f(z,y) definovéna v bodé [zg,yo] a n&jakém jeho okoli.
Polozme ¢(x) = f(x, o). Existuje-li derivace funkce ¢(z) v bodé zg, nazyvame tuto derivaci

parcidln{ derivaci funkee f(z,y) podle proménné z v bodé [z, yo] a znacime f7 (o, yo) (resp.
of (107240))
ox :

Poznamka 3.5: Predchozi definici muzeme zapsat nasledovné:

fa/c(fL"o,yo) = leI?O f(:E, yoi : j:[()ﬂ?o; 3/0)‘

%) ¢i parcidlni derivace funkei

Pozndmka 3.6:  Analogicky definujeme f; (7o, yo) (resp. g

vice proménnych.

V systému Maple mame nékolik moznosti, jak uréovat parcidlni derivace funkei (vyrazu).
Jednak mame v paleté Expression jiz preddefinované symboly pro derivaci (% f, a% ),
vyuzit muzeme téz piikaz diff fungujici pro vyrazy libovolného poctu proménnych. Muzeme
téz zapsat vyraz (funkci) do dokumentu, kliknout pravym tlacitkem mysi a z kontextové
nabidky zvolit Differentiate a proménnou, podle niz chceme derivovat. Oproti derivaci
funkce jedné proménné neni mozné nyni pouzivat apostrof jako symbol pro derivaci. Re-
spektive to mozné je, ale apostrof ma vyznam parcidlni derivace podle proménné z, takze
muzeme timto zpusobem derivovat pouze podle této proménné.

Stale musime mit na paméti rozdil mezi funkci a vyrazem (jak to ,vnima“ Maple, ktery
vétsinou pracuje s vyrazem). Pro derivovani funkei z pohledu systému Maple (tj. funkénich
operatoru) mame piikaz D (s nimz jsme se setkali jiz v pripadé funkci jedné proménné, viz
sekce 2.5). Na obréazku 3.14 vidime, ze vysledek pouziti piikazu D muze byt ponékud matouct
(viz vysledek piikazu D[2] (g), kde by bylo vhodnéjsi obdrzet (x,y)->1). Piikaz D totiz vzdy
vraci opét funkei (funkéni operétor).

Poznamka 3.7: Podobné jako v pripadé derivace funkce jedné proménné méa svuj geome-
tricky vyznam i parcidlni derivace funkce dvou proménnych. Také parcialni derivace funkce
f(z,y) v bodé [xg,yo] je smérnici tecny k funkeci f(z,y), a to v bodé [zo, yo, f(z0,v0)]- Ta-
kovych tecen je vSak nekoneéné mnoho. Konkrétné parcidlni derivace funkce f(z,y) podle
proménné x je smérnici teény ke kiivce vzniklé jako prusecik grafu funkce f(z,y) a ro-
viny y = yo. Podobné parciédlni derivace funkce f(x,y) podle proménné y je smérnici tecny
ke kiivce vzniklé jako prusecik grafu funkce f(z,y) a roviny z = x.

Tvrzeni pozndmky 3.7 nyni zobrazime graficky. Na pomoc si vezmeme funkci f(x,y) =
22 + y* a budeme pocitat jeji parcidlni derivaci v bodé [—1,1] podle proménné x. Podle
zminéné pozndmky je tato parcidlni derivace smérnici tecny v bodé [—1, 1, 2] ke kfivce vzniklé
jako prusecik funkce f(z,y) aroviny y = 1. Pro vykresleni funkce f(z,y) pouzijeme jiz znamy
piikaz plot3d. Pro vykresleni roviny y = 1 pouzijeme piikaz implicitplot3d k vykreslovani
objektu v tiirozmérném prostoru zadanych implicitné. Nésledné vykreslime tecnu k funkci
f(x,y) (jejiz smérnici urcuje parcidlni derivace) piikazem spacecurve pro vykreslovani pro-
storovych kiivek zadanych parametricky.

Rovnice tecny je dana rovnici z = k- x + ¢, pricemz hodnota k je pravé parcidlni derivace
funkce f(x,y) v bodé [—1,1] a je tedy rovna —2. Bod ¢ jiz dopocitdme dosazenim bodu
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2 o
g=(xy) = x +y D[1](g)
2 (ry)—=2x
(xy)—=x +y
d
Py g(x.y) D[2](g)
2x !
d differentiate wrt 1
Eg{x_-}') g erentiate w.r X {x:y} =2y
2x
diff (g(x.¥).x) o differentiate wr.t. 2 1
2x = i
differentiate wrt x
glxy) > 2x
D[1](g)(3)
. 6
<= &%)
] 1 D[2](g)(3)
d 1
T, &)
1
diff (g(x.y).y)
1
{ differentiate wrt v
glxy *

Obrdzek 3.14: Vypocet parcidlni derivace v Maple.

dotyku ([—1, 1, 2]) tecny k funkci f(z,y). Nakonec do grafu jesté pro ndzornost zaneseme bod
dotyku pomoci piikazu pointplot3d. Vse vykreslime najednou piikazem display a ziskame
obrazek 3.157.

flny) = 4y ploss|display] (p (1.4) )

2 2
(xy)—=x +y

pl ==plot3d(f(x.y),x=-3 .3, y=-3 .3, axes
= framed) :

p2 = plots| implicitplot3d] ([ y=1],x=-3 .3,y=
-3 .3.z=-1..16, aves=frame, color =white) :

p3 = plots| spacecurve] ([ t,1,-2-1],t=-3 ..1, axes
= frame, color= blue, thickness=3) :

p4 = plots[ pointplot3d]({[ -1. 1. 2]}, axes

= framed, color = red, symbolsize=20) :

Obrazek 3.15: Geometricky vyznam parcialni derivace.

"Vsechny pouzité pifkazy kromé pifkazu plot3d nélezi baliku plots, ktery je potieba naéist pied jejich
pouzitim, pripadné pouzivat spolu s volanim piislusného baliku, jak je tomu pravé na obrazku 3.15.
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Definice 3.4: Necht bod [xg,y] patii do definicniho oboru parcidlni derivace funkce
f(z,y). Existuje-li parcidlni derivace funkce f(xg,yo) podle proménné x v bodé [z, yol,
nazyvame tuto derivaci parcidlni derivaci 2. fadu funkce f(z,y) v bodé [z, yo] podle proménné

T a znacime ,
0 f(fo,yo))

"
f:r:p (33'0, ?Jo) (resp. 8[E2

Existuje-li parcidlni derivace funkce f!(xq,yo) podle proménné y v bodé [z, yo], nazyvame
tuto derivaci smisenou parcidlni derivaci 2. fadu funkce f(z,y) v bodé [z, yo] a znac¢ime

0% f (o, yo)) .

J glsly (70, Yo0) (resp. D0y

Poznamka 3.8: Analogicky definujeme ,zbylé“ parcidlni derivace 2. fadu a parcialni de-
rivace vyssich radu.

V systému Maple postupujeme pti zadavani parcidlnich derivaci vyssich fadu podobné,
jak tomu bylo u derivaci vyssich fadu v pripadé funkce jedné proménné.

= (xwnz —>1'.r1(xz+}'2+z2 .y . ,
= o) ol by 2 D) # = difirad
{x:}':z)_*ﬁ
diff (f(x.2),x) Yyt
2x
N D[L1](f) # =diffifix.y.2).xx)
x +y +z 5 422
&’ . (eyz) =55~ 3
axg f{x_.}_.z} X +}' +z (x“—l—y“—l—z“)
2 _ 4 x
Ay HE (P4t +P) D[1,2](f) # = diffifix.y.2).xy)
(x:}':z}*‘ rx )
d@ﬁﬂ{f{xr}'rz):x:x) (x2+y2+zg)h
2 44
7. 2 S 3
CHYAs (P4 ) D[2.11(f) # = dififix.2.%)
" f(xy.) (x.3.2) = - ——2
ox0y e . (xz-l-yz-l-zz)2
dxy
) (2 47 2)3
| MR D[2,2]() # = dif{fxy.2)33)
dﬁ{f{x:}lrz):x:}') o 4_!;2
_ dxy - (xy,z)—= 2 *2 2 , ; 232
(x2+},2+22)— vyt (xh+yh+zh)

Obrdzek 3.16: Parcialni derivace vyssich fadu funkei vice proménnych.

Poznamka 3.9: (Schwarzova véta) Necht md funkce f(x,y) spojité smisené parcidlni de-
rivace f,; a f,; v bodé [zg,yo]. Pak plati:

f;/y(ﬂfo,yo) = f{,’x(il?o,yo)-
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Priklad 3.15: Urcete vSechny parcialni derivace 1. a 2. fadu u nasledujicich funkei:
() flz.y)=a* y+In(2), (©) fle.y)=a".

(b) flz,y) = (z*y+y)", (d) flz,y)=2-y-In(x+y).

Piiklad 3.16: Urcete vSechny parcidlni derivace 1. fadu funkce f(z,y) v bodé A:
(a) f(o,y) =In (2 + a2+ 97), A=[1,2],

(b) f(z,y) = (1+]log,(2))°, A= [e,e],
(¢) flz,y)=In(z+ L), A=[1,2].

3.3.1 Smérové derivace

Definice 3.5: Necht f je funkce n proménnych, X = [xy, 23, ...,2,] vnitini bod D(f)
aw = (u,uy, ..., u,) vektor. Necht ¢(t) = f (X +¢-u). M&-li funkce ¢(¢) derivaci v bodé
t = 0, nazyvame ji derivaci funkce f v bodé X ve sméru vektoru w nebo také smeérovou
derivact funkce f a oznacujeme ji fi (X). Tedy:

) i 2O =20 P ) f(X)

t—0 t t—0 t

fu

Smérové derivace muZeme pocitat bud rovnou z definice nebo vyuzZijeme pifkaz baliku
Student [MultivariateCalculus] s nédzvem DirectionalDerivative.

Priklad 3.17: Vypoctéte smérovou derivaci funkce f(z,y) = x? + y* v bodé [-2,2] ve
smeéru vektoru u = (3, 5).

Reseni: Vyuzijeme pifkazu DirectionalDerivative, ktery mé 3 povinné parametry —
vyraz, bod, v némz hleddme smérovou derivaci, a piislusny smér (obrazek 3.17).

with ( Student| MultivariateCaleulus]) :
Dr}‘ecrianafDe}'h’am’e(xg -I—yz: [xv]=[-2,2],[3.5] )
4

— /34
17

Obrdzek 3.17: Reseni pitkladu 3.17.

Systém Maple nabizi dale maplet s ndzvem Directional Derivative, ktery miuzeme
spustit z hlavni nabidky: Tools > Tutors > Calculus - Multi-Variable > Directional
Derivatives.... Maplet pro zadanou funkci, bod a smér vypocita smérovou derivaci a zobrazi
ji graficky spolu s funkei a te¢nou rovinou v daném bodé. V mapletu je dédle mozné zobra-
zit animaci sestavajici ze smérovych derivaci v ruznych smérech ve stejném bodé (ukazku
poskytuje obrazek 3.18).
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g ——— ™ F ] ™
Multivariate Calculus - Directional Derivative ﬂ

File Help
Plot Window

Options
f= |~ 24yn2

Point:
[ X + |¥ ] =[ -2 r |2 ]
Direction:
[3 L ]
# of Frames: |10

Values

Actual Value |1.3720

[ Display |’ Arimate ” Plot Options ] l Close l

Maple Command

DirectionalDerivacive( x~Z+y"Z, [x. ¥] = [-E. E], [3, 5], output = plot, awes = bowed, =caling =
unconstrained)] ;

Obrdzek 3.18: Maplet zobrazujici smérové derivace.

Priklad 3.18: Urcéete smérovou derivaci funkce

“[S

772)7

(b) f(z,y) =In(e®* +¢€¥) v bodé [0, 0] ve sméru vektoru uw = (cos(a), sin(a)).

(a) f(x,y) = arctan(x - y) v bodé [1, 1] ve sméru vektoru u = (

3.3.2 Diferencial

Definice 3.6: Rekneme, ze funkce f(z,v) je diferencovatelnd v bodé [z, yo], jestlize existuji
realnd ¢isla A, B tak, ze

lim Jf(wo+h,yo + k) — flxo, ) — (A-h+ B -k)
(h,k)—(0,0) m

Linearn{ funkce A - h + B - k proménnych h, k se nazyvé (totdlni) diferencial funkce v bodé
[0, yo] & znadi se df (xo,yo)(h, k), resp. df (zo, yo).

=0.

Poznamka 3.10: Je-li funkce f(z,y) diferencovatelnd v bodé [zg, o], pak mé v tomto
bodé parcidlni derivace a plati A = f; (20, %0), B = f,(z0,%0), ti.

df (zo,y0) = fr(x0,90) - b+ [y (20, 90) - k.
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Poznamka 3.11: Tecna rovina k funkei f(x,y) v bodé T = [z, yo, (0, yo)] mé tvar

z = f(wo,90) + f2 (%0, %0) - (x — z0) + £, (0, %0) - (¥ — %o)-

Podobné jako v pripadé funkce jedné proménné vyuzivame diferencial k vypoctum od-
hadu funkénich hodnot v okoli bodu, v némz funkéni hodnotu zname. I tady pochopitelné
plati, Zze samotny systém Maple urci funkéni hodnotu presnéji. Presto jej muzeme vyuzit
k diléim vypoctum a kontrole presnosti ziskanych aproximaci.

Priklad 3.19: Urcete priblizné: 4/1.023 + 1.973.
Resend: Budeme uvazovat funkci f(z,y) = /23 + y3. Aproximaci ziskdme podle vztahu:

f(@o+h,yo+k) = f(zo,y0) +df (0, y0) = f(w0, yo) + folwo, o) - (x —20) + £, (20, ¥0) - (¥ —Yo)-

V nasem piipadeé: [zg, 0] = [1,2], [z, y] = [1.02,1.97]. Systém Maple vyuzijeme k vypoctu
parcidlnich derivaci v prislusnych bodech a celkovému souc¢tu vypoctenych hodnot (obrazek
3.19).

der y:i=

2
A
V3 +y

h.a|m

——
1.022 +1.97° =2.950691614

S presnosti na 10 mist: - =2.

L ree w . - /
Priblizné pomoci diferencialu: 1.02° +197 =~
ex-‘a{f‘(\f 1P +2° + eval(der x, {x=1,y=2})-(1.02—1)
)

+eval(der y, {x=1,y=2})-(1.97 -2 )
2.950000000

Obrdzek 3.19: Reseni piikladu 3.19.
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Piiklad 3.20: Urcete priblizné:

(a) 3.05%99 (c) arctan(gge),
(b) v/3.05 - cos(62°), (d) log,(4.01-0.972).

Piiklad 3.21: Urcete rovnici teéné roviny k funkei f(x,y) = /1 — 2% — 32
v bodé [\/Lg, \/Lg, \/Lg] a rovinu i s funkei vykreslete.

Resend: Vyjdeme z poznamky 3.11. V Maple vykreslime funkei f(z,y) i te¢nou rovinu po-
moci piikazu plot3d (v némz nastavime parametr pruhlednosti — transparency — pro vétsi
prehlednost), navic doplnime i bod dotyku (¢ervené) tecné roviny piikazem pointplot3d
z baliku plots (obrézek 3.20).

plots| display] (pl. p2, p3)

V3 —x—y

pl = plot3d(f(x,y),x=-1.1,y=-1.1, aves=framed, color
= blue, numpoints = 1000) : ¥

p2 = plot3d(t(x,v).x=0.0.98,y=0.0.9, axes = frame, color
= yellow, transparency=10.5) :

p3= pfaz.s'[pafmpfoﬁd]{ H% %: % ]_-axes

W W W

= framed, color= red, symbolsize=20 | :

Obrdzek 3.20: Reseni piikladu 3.21.

Priklad 3.22: Urcete rovnici teéné roviny a rovinu i s funkci vykreslete pro:
(a) funkci f(z,y) = 2* + y* v bodé [2, -1, 5],
(b) funkci f(z,y) =2*+2-2% -y —x-y+x v bodé [1,0,2],
(c) funkci f(z,y) = In(z? 4+ y*) v bodé [2,1,In(5)],

(d) funkci f(z,y) = e+ v bodé [0,0, 1].
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3.3.3 Tayloriv polynom

Definice 3.7: Necht n € NU {0} a f(z,y) funkce majici v bodé [z, yo] € R? a néjakém
jeho okoli spojité parcialni derivace az do fadu n. Polynom

1/ ,1) = £ t0) + 5 (a0, 0) - (2 = ) + 5 Can,0) - (0= o)

2 2 2
"‘l‘ <ﬂ(x0,y0) Sz —x)* 42 aaxafy (z0,%0) - (x — 20) - (¥ — Yo) + g_ngc(ilfo;yo) (y — 3/0)2)

2! \ 0x?
1 ~—/n o"f i ;
X ( )mm,yw (2= 20)" - (y — o)
se nazyva Tayloriv polynom stupné n funkee f(x,y) v bodé [xg, yo]. Funkci

Rl(z,y) = T!(z,y) — f(z,y)

fikame Tayloriv zbytek a cely vyraz

T!(z,y) + Rl (z,y)

nazyvame Taylorovym vzorcem.

Podobné jako v jednorozmérném pifpadé existuje i nyn{ ,,predpis“ pro R (z,y), ktery ndm
iekne, ,jak dobrou® aproximaci dané funkce f(x,%) je polynom T (x,%). My jej potiebovat
nebudeme, a proto ¢tenafe pouze odkazeme na dalsi literaturu (napt. [2]).

V systému Maple slouzi k ziskani Taylorova polynomu funkce vice proménnych piikaz
mtaylor. Piikaz m4 2 povinné parametry, a to vyraz (funkéni predpis) a seznam proménnych
s pripadnou specifikaci bodu, v némz ma byt polynom rozvinut. Pokud bod nespecifikujeme,
bude pouzit nulovy bod. Muzeme si dale v§imnout, ze narozdil od piikazu taylor v jedno-
rozmérném piipadé nyni ziskdme ,pouze” Tayloruv polynom (bez chybového ¢lenu). Stejné
jako drive vyuzivame k nastaveni tadu chybového ¢lenu systémovou proménnou Order,
piipadné tfeti (nepovinny) parametr piikazu mtaylor (viz obrézek 3.21).

Priiklad 3.23: Urcete Tayloruv polynom pro
(a) funkei f(z,y) ={ v bodeé [1,1],

(b) funkei f(z,y) = ZTS; v bodé [0, 7],

(c) funkci f(z,y) = sin(x + y) v bodé [0, 0] tak, aby byl chybovy ¢len Fadu 9,
(d) funkei f(z,y,z) = (cos(z +y)) - z v bodé [0, 0, 0].

Priklad 3.24: Pomoci Taylorova polynomu urcete ptiblizné:
(a) v1.023 +1.973,
(b) v/3.05 - cos(62°),
(c) arctan(ggs),

)

(d) log,(4.01-0.97%).
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( ):2+,1'2
mtaylor\ e L[x=1,p=1]
10 2

E42e (x—1) 426 (y—1) 43 (x—1) +4& (v—1) (x—1) +3¢ (y—1)° te (x—1) +6¢ (v

—D(x=1) +6 (y=1) x—1]+13—052 y—1) +16—952(7c—1}4+?:3—02 y—1) (x—1)" +9¢ (»
v 4
—1)2(_xc—1}2+‘3—052(;,-—1}3(x—1}+16—952 y—1) +15—3¢2(x—1} +13—932(1,-—1)(;{—1)“l

) 2 ) 2 ) 4 2 5
+lOcL(y—l}h(x—1}3-I—lOch(}'—l}S(x—1}L+13—9€(y—1}4(x—1}+15—3€(y—1])
2,.2
miayior( &, [x])
22 4 22 4
1+x +y T +yx +5y

):2+1'2
mrmfor( . [x vl 10)
1 6 1 24 1 42 1 ﬁ 1 1 1 -1-4 1 ﬁ 2 1 8

1 ].
?C ]f 7( 'L?C 'L 6’( ¥ 21’( 6 435 6'L?C 4'!; 6 41

Obrdzek 3.21: Vypis Taylorova polynomu funkce dvou proménnych.

3.4 Extrémy funkce vice proménnych

3.4.1 Lokalni extrémy
Definice 3.8: Necht p : R® x R® — R je funkce, pro niz pro libovolnd X, Y, Z € R™ plati:
(a) p(X,Y) =0,
(b) p(X,)Y)=0& X =Y,
(¢) p(X,Y) = p(Y, X),
(d) p(X,Z) < p(X,Y) + p(Y, Z).

Takovou funkci nazyvame metrikou (resp. vzddlenost?) v R™. Pomoci metriky definujeme e-
okoli bodu X € R" jako mnozinu O.(X) ={Y € R" | p(X,Y) < e}. V piipadé¢, ze hodnota
€ neni podstatna, mluvime pouze o okoli bodu X.

Definice 3.9: Rekneme, ze funkce f : R” — R nabyva v bodé X* € R lokdlniho mazima,
jestlize existuje okoli bodu X* takové, ze pro vSechna X z tohoto okoli plati: f(X) < f(X™).
Je-li uvedend nerovnost ostra, mluvime o ostrém lokdlnim mazimu.

Poznamka 3.12: Zcela analogicky definujeme (ostré) lokdlni minimum. Minima a maxima
souhrnné nazyvame extrémy.

Priklad 3.25: Napiste definici lokalniho minima.

Definice 3.10: Mg¢jme funkci f : R® — R. Bod X* € R" nazveme staciondrnim bodem
funkce f, jestlize v bodé X* existuji vSechny parcidlni derivace funkce f a plati:

of
ox;

(X*)=0 pro i=1,..,n.
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Poznamka 3.13: Funkce f : R” — R muze mit lokalni extrém pouze ve svém stacionarnim
bodé nebo v bodeé, kde alespon jedna z parcidlnich derivaci neexistuje [2].

Pozniamka 3.14: Nyni se omezime pouze na funkce dvou proménnych. Necht mé funkce
f(z,y) v okoli bodu [z, yo] spojité parcidlni derivace druhého fadu. Oznacme

§ e (0, Y0)  fay (20, Y0)
H1 = fxx(anyO)a HQ =

"

?;/x(x(hy()) fyy(‘r()?yO)
Pak:

e Kdyz Hy > 0, mé funkce f(x,y) v bodé [xg, yo] ostry lokdlni extrém.

(a) Pokud navic H; > 0, pak je v bodé [z, yo| lokdlni minimum.

(b) Pokud navic H; < 0, pak je v bodé [xg, 3] lokdlni maximum.
e Kdyz Hy < 0, nemé funkce f(z,y) v bodé [z, yo] lokdlni extrém.
e Kdyz H, = 0, neumime o existenci extrému timto zpusobem rozhodnout.

Matici druhych derivaci funkce f(x,y), jejiz determinant jsme oznacili Hy, nazyvdme Hes-
sovou matict, jeji determinant, Hs, oznacujeme jako hessidn.

V systému Maple je opét nékolik cest, po nichz muzeme dospét k lokdlnim extrémum
zadané funkce. K dispozici méame nékolik prikazi, které ndm mohou pomoci pii dil¢im
vypoctu, pripadné i nalezeni nékterého z extrému, zadny piikaz vsak obecné nedokéze najit
vSechny lokdalni extrémy. Nejuniverzalnéjsi cesta je projit vyse popsany postup, ktery zname
z prednasky. Systém Maple pritom muzeme vyuzit k vykresleni zadané funkce, vypoctu
parciédlnich derivaci (ptipadné rovnou k vypoctu staciondrnich bodu pomoci piikazu extrema),
vypoctu Hessovy matice ¢ jejiho determinantu. K vypoctu Hessovy matice slouzi prikaz
Hessian z baliku VectorCalculus. Pro vypocet determinantu je urc¢en piikaz Determinant
z baliku LinearAlgebra.

Priklad 3.26: Najdéte lokdln{ extrémy funkce f(x,y) = (z —2)? + (y — 3)® + 5.

Resent: Vyuzijeme pifkaz extrema k nalezeni stacionarnich bodi. Nésledné vypocitame
Hessovu matici piikazem Hessian a jeji determinant pfikazem Determinant. Na zakladé
pozndmky 3.14 pak rozhodneme o lokalnich extrémech (obrazek 3.22).

Priklad 3.27: Najdéte lokdln{ extrémy funkce f(z,y) = (y — 3)* — (z — 2)? + 5.

Resent: Postupujeme zcela analogicky k predchozimu pifkladu. Vyuzijeme opét pifkaz
extrema k nalezeni stacionarnich bodu, piikaz Hessian k vypoctu Hessovy matice a piikaz
Determinant k urceni jejiho determinantu. Na zdkladé poznamky 3.14 pak rozhodneme
o lokélnich extrémech (obrazek 3.23).

w2+y2

Piiklad 3.28: Najdéte lokdlni extrémy funkce f(z,y) =z -y-e 2

Resend: Postupujeme opét stejné. Nyni ziskdvame vic staciondrnich bod, pro néz musime
vyhodnotit Hessovu matici a jeji determinant. Pti tom si ,,pomuzeme® piikazem eval a na-
rozdil od predchozich piikladu nacteme prikazem with potfebné baliky pro ptikazy Hessian
a Determinant (obrézek 3.24).
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= () — (x— 2 . 2 Stacionarni body:
Si=(ey) > (x=2) +(y=3) 5 extremal £ (x,), { }, {(x,y}.bod")
(s)

bod
{{x=2.y=3}}

Stacionarni bod je: [x.y]=[2.3].

Hessova matice:
H := VectorCalculus| Hessian | ( f(x. v). [x¥])

20

02
Prvni prvek Hessovy matice (druha derivace f{x,y)
podle x):
H(1,1)

2

Determinant Hessovy matice:
LinearAlgebra| Determinant|(H)
4

Bod [2.3] je lokélnim minimem funkee fix,v).

Obrdzek 3.22: Reseni pifkladu 3.26.

fi=(ny) = (y—3) —(x—2)2 +5 Stacionarni body: o
{x_.}' _}(}I_S}E_ {x_2)2+5 exﬂ‘ema{f[x,‘}}, { }!" {x";l%:;!‘}o )
bod

{{x=2.y=3}}

Staciondrni bod je: [x.y]=[2.3].

Hessova matice:
H = VectorCaleulus| Hessian] ( f(x. v). [x¥])

-20
02
Determinant Hessovy matice:

LinearAlgebra| Determinant| (H)
-4

Determinant Hessovy matice je zdporny =+ bod [2,3]
neni lokalnim extrémem funkee fx,v).

Obrdzek 3.23: Reseni pitkladu 3.27.
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2 +37 J Stacionarni body: [-1.-1]. [1.-1]. [-1.1]. [1.1]. [0.0].

Fi= (xy) = xype with( VectorCalculus) : with( LinearAlgebra) :

Hessova matice:
H = Hessian( f(x,y), [x,y]) :

plot3d(f(xy).x=-4 .4, y=-4 .4, axes
= framed, numpoints =2000)

Bod [-1.-1]

Determimant(eval(H, {x=-1,y=-1
g"JaE[H{]-: 1)' {xz_l.‘}lz_l}) =-2
Bod [1.-1]

Determinant(eval(H, {x=1,y=-1})) =4 (e_l)—
eval(H(1,1), {x=1,y=-1}) =2¢""

Bod [-1,1]

Determinant(eval(H, {x=-1,y=1})) =4 (c_l)
eval(H(1,1), {x=-1,y=1}) =2¢"}

Bod [1.1]
Determinant(eval(H, {x=1,y=1})) =4 (3_1)2
eval(H(1.1), {x=1,y=1}) = -2¢""

Stacionarni body:
' ' -1 -1
extrema( f(x,y). { }. {x.y}body') = { ¢ "¢} |Bod [0.0]

body Determinant(eval(H, {x=0,y=0})) = -1
{{xz _1:}-= _1}: {xz _1.-.:"’|= 1}- {XZD:}IZO}:
{x=1,y=-1}, {x=1,y=1}} Lokalni minima: [1.-1], [-1.1].

Lokdlni maxima: [-1.-1], [1.1].

Obrdzek 3.24: Reseni piikladu 3.28.

Jak jsme zminili diive, v systému Maple jsou i nékteré prikazy hledajici extrémy funkci.
Jednd se predevsim o piikazy minimize a maximize pro nalezeni globalnitho minima ci
maxima (symbolicky). Stejné piikazy, oviem s velkymi poc¢ateénimi pismeny, tj. Minimize
a Maximize z baliku Optimization, hledaji globdlni extrémy numericky. VSem zminénym
piikaziim je mozné nastavit omezujici podminky, a hledat tak absolutni extrémy na dané
mnoziné (vice v dalsi ¢asti kapitoly). Muzeme také vyuzit mapletu s ndzvem Optimization,
ktery vyvolame napiiklad z hlavniho menu zvolenim Tools > Assistants > Optimi-
zation.... Na vybér mame nékolik metod, kterymi je extrém hledédn, tla¢itkem Solve vypiseme
feSeni, tlacitkem Plot jej zobrazime graficky. Jeho ukazku s nalezenim globalniho minima
funkce f(z,y) = 2? + y* poskytuje obrazek 3.25.

Priklad 3.29: Najdéte lokdlni extrémy funkce f(z,y) = /22 + y2.

Resend: Postupujeme stéle stejné. V tomto pifpadé viak nenalezneme zadné staciondrni
body. Jiz z grafu funkce je na prvni pohled vidét, ze funkce m4 lok&lni minimum v bodé [0, 0],
v némz neexistuje parcidlni derivace. Existenci minima muzeme ovérit vySetfenim lokalniho
chovéni funkce v okoli tohoto bodu nebo vyuzitim pitkazu minimize. Piikaz volany s jednim
parametrem vypise pouze hodnotu minima. Abychom ziskali i jeho polohu, ptiddme druhy
nepovinny parametr location (obrazek 3.26).
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[32 Optimization Plotter x|

[12 Optimization Assistant x|

[-Solver [-Problem

@ Local Default

Objective: Function Edit
€ Linzar Yarizhle Types
B [

™ Quadratic

" Morlinear |Default M
Constraints and Bounds Edit
" Least Squares  |Defaul -

| Cptions

* Minimize " Maximize:

Feasibiity Tolerance [defaulc
Initial Yalues Clear Edit

0100 0.10

|

lution —
Optimality Tolsrance jdefaul:
pimeliy bjective walue: 0 range of [ | = 0.1 ot extrema at 0
wro
Iteration Limit default vro Range of [y =] = 0.1 Lot extrama at 0
N r T e s = | . Jdefault TR
™ Plot Using Problem Domain

On Quit, Return [Salution a top [ sobe | met | out | s

Obrdzek 3.25: Optimization maplet.

fi=(xy) = vlll x?' +}‘2 Stacionarni body:

i xy). { ), {x v} 'bod'
() =d 2+ E';Z;”""[f“ﬂ- { }. {x.»}.bod")
bod

plot3d( f(x,y).x=-3.3,y=-3 .3, axes= frame) |Stacionirni body nejsou.

V bode [0,0] viak neexistuje parcidlni derivace:
X

- 2 2
VXY
em-f[if[x,y}, {x=o,y=0})
dx

Error, numeric exception: division by

Z2eX0

Pouziti prikazu minimize:
minimize( f(x, y), location)
0, {[{x=0,y=0},0]}

Vbodé [0,0] je globdlni (a tedy 1 lokalni) minimum
funkee fix,y).

Obrdzek 3.26: Reseni pitkladu 3.29.

Priklad 3.30: Najdéte lokalni extrémy funkce:
() flo,y)=a®+y° =3 -x-y, (d) floy) =@ +y?)- e,
(b) flr,y)=2* =32 y+3-y—y>,  (e) flz,y)=3-2*-2-2-/y+y—8-x+12,
(¢) flz,y) =2y In(z*+y?), () fle,y) =y-VI+tz+tz-Vy+1,
(8) flzy) =3 —Va? +2+2-/(x =2+ (y = 3)*.
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3.4.2 Absolutni extrémy

Definice 3.11: Méjme funkei f : R* — R amnozinu M C D(f). Rekneme, ze bod X* € M
je bodem absolutniho mazima funkce f na mnoziné M, jestlize pro vSechna X z mnoziny M
plati: f(X) < f(X*). Je-li uvedend nerovnost ostra pro vsechna X # X*, mluvime o ostrém
absolutnim maximu.

Poznamka 3.15: Zcela analogicky definujeme (ostré) absolutni minimum. Misto pojmu
absolutn? minimum (maximum, extrém) pouzivame nékdy termin globdlni minimum (maxi-
mum, extrém,).

Piiklad 3.31: Napiste definici absolutniho minima.

Definice 3.12: Bod X € R"™ nazveme bodem wuzdvéru mnoziny M C R™, jestlize pro
libovolné e plati: O.(X) N M # (. Mnozina vSsech bodu uzdvéru mnoziny M se nazyva
uzdvér mnoziny M a znaci se M. Mnozinu M nazveme uzavrenou, jestlize M = M.

Pozndmka 3.16: Necht je mnozina M uzaviend a ohranicend a funkce f na mnoziné M
spojita. Pak f nabyva absolutnich extrému na mnoziné M bud v bodech lokdlnich extrémi
patiicich do mnoziny M nebo v nékterém hrani¢nim bodé mnoziny M.

Pii hledéni absolutnich extrému muzeme v systému Maple vyuzivat tytéz prikazy jako pii
hledani extrému lokélnich, pricemz specifikujeme navic i mnozinu, na niz extrémy hledame.
Ma to vsak sva omezeni. Prikazu extrema muzeme zadat omezujici podminky pouze ve tvaru
rovnosti. Pifkazim minimize a maximize je mozné zadat omezeni ve tvaru rozsahu (inter-
vali) jednotlivych proménnych. Vice moznosti nam nabizi piikazy Minimize a Maximize
z baliku Optimization hledajici extrémy numericky a maplet Optimization (viz obrazek
3.25), u nichz muzeme zaddvat omezeni i ve tvaru neostrych nerovnosti.

Priklad 3.32: Najdéte absolutni extrémy funkce f(z,y) = 2? —y®> +4 na mnoziné
M: 224+ <1

Reseni: Nejprve vykreslime zadanou funkei i s vyznacenim hranice mnoziny M, které
provedeme piikazem spacecurve. Nésledné provérime lokalni extrémy piikazem extrema
s naslednym vyhodnocenim determinantu Hessovy matice. Tymz piikazem najdeme extrémy
funkce na hranici mnoziny M (obréazek 3.27).

Priklad 3.33: Najdéte absolutni extrémy funkce f(x,y) = 2% + y?> +4 na mnoziné
M: 2? +¢y? < 1.

Resend: Postupujeme stejnym zpusobem jako v predchozim pifkladu. Zadand funkce ma
jeden lokdlni extrém, ktery je soucasné i jejim globalnim minimem na mnoziné M. Abso-
lutnich maxim je nekonetné mnoho a jsou tvofeny hranici mnoziny M (obrédzek 3.28).

Priklad 3.34: Najdéte absolutn{ extrémy funkce f(z,y) =2 +2-2-y—4-2—8 -y na
mnoziné M urcené piimkami z =0,z =1,y =0,y = 2.

Reseni: K zakresleni hranice mnoziny M do zadané funkce potfebujeme nyni pouzit
4x pifkaz spacecurve (pro kazdou pifmku — resp. usecku, zvl4st). Nasledné nalezneme
stacionarni bod funkce piikazem extrema. Tento staciondrni bod lezi mimo mnozinu M,
zadand funkce je v kazdém bodé diferencovatelna, absolutni extrémy tedy lezi na hranici
mnoziny M. Diky tvaru M (jednd se o obdélnik) ji muzeme jednoduse vyjadrit pomoci dvou
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(xy) =Xy +4:

f =
Definice vykresleni funkce

pl =plot3d(f(x,y).,x=-1.5.15,y=-15.1.5,
axes = framed, orientation=[ 71, 56]) :

Definice vykresleni hranice mnoziny M

p2 = plots[ spacecurve]([cos(1),sin(1),
flcos(t),sin(t))].t=0.2-m color= black,
thickness=3) :

Vykresleni pfedchoziho do jednoho grafu
plots| display] ({pl.p2}.labels=[x.y.z]);

Stacionarni body na celem D(f):
extremal( f (x.y). { }. {x.y},bod") = {4}
bod

{{x=0,y=0}}

Staciondrni bod je: [x,v]=[0,0].

Hessova matice:
H = VectorCalculus| Hessian|( f (x, y). [x¥])
20

0 -2

Determinant Hessovy matice:
LinearAlgebra| Determinant| (H) = -4

Bod [0.0] neni lokalnim extrémem funkce f{x,y).

Stacionarni body na hranici mnoziny M:

extremal f(x.y), (¥ +)7 =1}, {x y}body') = {3, 5}

body

{{x=-1,y=0}, {x=0,y= -1}, {x=0,y=1}, {x=1,y=0}}
f(-1,0)=5 f(0,-1)=3

f(o.1)=3  f(1.0)=5

Absolutni minima: [0,-1], [0,1].
Absolutni maxima: [-1,0], [1,0].

Obrdzek 3.27: Reseni pitkladu 3.32.

(x ) —>x2 +y2 +4:

f =
Definice vykresleni funkce

pl =plot3d(f(x,y),x=-15.15,y=-15.15,
axes = framed, orientation=[ 71, 56]) :

Definice vykresleni hranice mnoziny M

p2 = plots[ spacecurve] ([ cos(t),sin(t),
flcos(t),sin(t)) ], r=0.2-m color= black,
thickness=3) :

Vykresleni pfedchoziho do jednoho grafu
plots| display]({pl.p2}.labels=[x.y.z]);

Stacionarni body na celem D(f):
extremal( f(x,y). { }. {x.y},bod") = {4}
bod

{{x=0.y=0}}
Stacionarni bod je: [x,y]=[0.0].
Hessova matice:
H = VectorCaleulus| Hessian | ( f(x. ). [%¥])
20
02

Determinant Hessovy matice:

LinearAlgebra| Determinant | (H) =4

Prvni prvek Hessovy matice (druha derivace f{x,y) podle x):
H(1.1)=2

Bod [0,0] je lokalnim minimem funkce f{x,y).

Stacionarni body na hranici mnoziny M:
exremal f(x.y). [ +3" =1}, {x.y}bodv') = {5}

Absolutni minimum: [0,0].
Absolutni maxima: body na kruznici x2 +y2 =1.

Obrdzek 3.28: Reseni piikladu 3.33.
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= (xy) — 2 +2xy—4-x—8-y: \-’yk:resl_eni grafu:
plots[display] ({pl[ (1..5) }.labels=[x.y.z]);
Definice vykresleni funkce
pl = plot3d( f(x,y),x=-1.3,y=-1 .3, axes = framed) :

Definice vykresleni hranice mnoziny M

p2 = plots| spacecurve|( [t,0,f(2,0)],2=0..1, color
= black, thickness=4) : #y=0

p3 = plots| spacecurve]( [0,t.(0.1)],t=0 ..2, color
= black, thickness=4) : # x=0

p4 = plots| spacecurve| ([ 1,t.f(1,t) ], =0 ..2, color
= black, thickness=4) : #x=1

pJ = plots| spacecurve]( [1.2.f(1.2)],t=0 ..1, color
= black, thickness=4) : #y=2

Stacionarni body na celem D(f}:
extrema( f(x,y), { }, {xy}.bod")
{0} Hranice mnoZiny M:

bod - m.in.r:m.fze{f(x,y},x=0 1,v=0..2, location)
{{x=4,y=-2}} -16. {[{x=0.y=2}, -16]}
maximize( f(x,y),x=0..1,y=0..2, location)
Staciondrni bod je: [x.y]=[4.-2]. Lezi vak mimo M. 0. {[{x=0.y=0},0]}

Absolutni minimum: [0,2].
Absolutni maximum: [0,0].

Obrdzek 3.29: Reseni pitkladu 3.34.

intervalu (rozsahti pro proménné z a y). Presné toto omezeni je mozné zaddvat prikazum
minimize a maximize, takZe je vyuZzijeme® (obrazek 3.29).

Piiklad 3.35: Urcete absolutni extrémy funkce f(z,y) na mnoziné M:
(2) flz,y) =2 +y* M:a? +y* < 1,
(b) flx,y) =x+y,M: |z| <1,y <1,
()
(d)
(e)

r,y)=x-y—x*—y*+ x+y, M je ohranicend pifmkami z =0,y =0,y =4 — ,

e .

(
(
(z,y) = |z| + |y|, M: 2® +y* < 1,
(
(

r,y) =2*+2-x-y+2-y*—3-x—5-y, M je trojihelnikova oblast s vrcholy v bodech
A=10,2],B=[3,0],C =10,—1],

=
~
=
8
<
~
Il

sin(z) - sin(y) - sin(x +y), M: x > 0,y < 7.

Priklad 3.36: Najdéte kladna ¢isla x, y, z takova, ze t+y+2 = 18 a x-y- 2 je maximalni.

Resend: Chceme maximimalizovat funkci f(z,vy,2) = « - y - z. Pfitom ma platit, ze = +
y + z = 18. Tuto rovnost muzeme zahrnout rovnou do predpisu funkce, a ziskat tak funkci
pouze dvou proménnych: z-y- (18 —y —x). Nové vzniklou funkci pfitom maximalizujeme pro
x € (0,18),y € (0,18),z + y < 18. Timto zdpisem jsme zadanou tlohu prevedli na klasické

8Pifkazy minimize a maximize v tomto pifpadé neprochdzi jen hranici mnoziny M, ale celou mnozinu
(coz ndm ale nevadi). Pro jiny tvar mnoziny M, napf. trojihelnik, ¢asto musime prochdzet jednotlivé ¢asti
jejf hranice, tj. napf. jednotlivé isecky (a hledat na nich extrém).
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hledani absolutniho maxima funkce, jak jsme jej tesili v predchozich piikladech. Tentokrat
dokonce nemusime ani vySetiovat funkéni hodnoty na hranici ,,omezujici* mnoziny, nebot
omezujici podminky jsou ostré nerovnosti. Celkem ziskdavame, ze pozadovana kladna cisla
jsow: z =y =z = 6 (obrézek 3.30).

= (xy) 2 x» (18 —x—y): Vykresleni grafu:

lots| display 1.4
Definice vykresleni funkce plots| display|({PIl{ 20

pl = plot3d(f(x,y),x=0.18,y=0 .18, view=[0 ..18, 0
.18,-1000 ..300], axes = framed) :

Definice vykresleni hranice mnoziny M 200
p2 = plots| spacecurve]([1,0,f(r,0) ],t=0..18, color H

= black, thickness=4) : #x=0..18 200
p3 = plots| spacecurve] ([ 0,2, (0,1) ], t=0..18, color :

= black, thickness=4) : #y=0..18 ~400]
p4 = plots| spacecurve|([t, 18- t,f(t, 18-1)],t=0..18, - 600+

color= black, thickness=4) : #x+4y=I18 - 800

1000+ ™

Stacionarni body na celém D(f): 161412505 ¢ 477 0 1614]11{1? 64 =
extremal (x.9). { }. {x.y}.Jbody') = {0.216} "
body

x=0,y=0}, {x=0,y=18}, {x=6,y=06}, {x=18,y
{H{x=0.y=0} {x=0.y b {x=6.y=6}, {x - Determinant Hessovy matice:

=0}} LinearAlgebra[ Determinant | (eval(H, {x=6,y
Stacionarni bod uvnitf mnoziny M: [6.6]. 51) 108
Prvni prvek Hessovy matice (druha derivace fix,
Hessova matice: ¥) podle x):
H = VectorCalculus| Hessian| ( f(x,¥), [x ¥]) eval(H(1,1), {x=6,y=6})
-2y  18—2x—2y -12
18 —2x—2y -2x

Bod [6.6] je lokalnim maximem lezicim uvmtf M,
a tedy i absolutnim maximem.

Obrdzek 3.30: Reseni piikladu 3.36.

Priklad 3.37: Najdéte kladna cisla x, y, z takova, ze x-y-z = 64 a x+y+ 2z je minimalni.

Priklad 3.38: Jakého nejmensiho ¢isla muze nabyt soucet tif kladnych ¢isel x, y, z, jestlize
pro né plati: z -y - 22 = 25007

Piiklad 3.39: Najdéte bod plochy z = x - y — 1, ktery je nejblize bodu [0, 0, 0].

Piiklad 3.40: Urcete rovnici pfimky, pro niz plati, ze ma od bodu [0,2],[1,3] a [2,5]
nejmensi soucet ¢tvercu (druhych mocnin) jejich vertikdlnich vzdélenosti (tj. ve sméru osy
y) — tzv. metoda nejmensich étverci.
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3.5 Vicerozmeérny integral

Poznamka 3.17: Mgjme spojitou funkei f(x,y) na obdélniku [a, b] X [¢, d]. Pak jsou spojité
i funkce ¢(x) a ¥ (y) dané integrély:

d b
o) = [ 1)y o o) = [ s v

Funkce ¢(z) a 1(y) tak muzeme integrovat znovu a ziskat:

b b d
/90(93) dw://f(x,y) dy dz,
d d b
/ () dy = / / f(,y) do dy.

Predeslé integrély nazyvame dvojndsobnymi integrdly.

Definice 3.13: Necht 7' = [a,b] x [c,d] C R? a necht je funkce f(z,y) spojitd na T.
Dvojnygm integrdalem funkce f(z,y) pres mnozinu 7' pak rozumime:

[ 1w as dyz/b/df@s,y) dy dxzfd/bﬂx,y) dx dy

Definice 3.14: Uvazujme nyni oblast, jiz budeme fikat oblast zdkladni, definovanou jako
T ={(z,y) € R? | x € [ay,as],y € [s1(2), s2(x)]}, resp. T = {(z,y) € R? | y € [by,by], 7 €
[p1(y), p2(y)]}, pricemz funkce sy(x), s2(x),p1(y), p2(y) jsou spojité na intervalech [a;, as),
resp. [by, by]. Zékladni oblast ilustruje pro lepsi predstavu obrézek 3.31.

bo

pi(y) T

ay as

(a) (b)

Obrdzek 3.31: Zobrazeni zakladni oblasti (pfevzato z [5]).

Analogicky jako v pfedchozi definici nyni definujeme dvojny integrdl funkce f(x,y) ptes
mnozinu 71" jako:
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as s2(x)

//fxydxdy—//fa:y dy dz,

a1 si(x)

resp. / fz,y)da dy = 7 7y)f(x, y) dz dy.
T

b1 p1(y)

Poznamka 3.18: Sjednocenim konecné mnoha zakladnich oblasti muzeme ziskat tzv. ele-
mentdrni oblast (mnozinu) K (viz obrdzek 3.32).

¥ X=a x+b
D
/fr\ y_d
A
= B
/ y=c

¢

Obrdzek 3.32: Zobrazeni elementarni oblasti (prevzato z [9]).

Poznémka 3.19: Castym krokem pi“i vypoétu integrélﬁ je prohozem’ pofadl’ integrace

N

ve svych mezich.

Definice 3.15: Uvazujme nyni zdkladni oblast T = {(z,y) € R?* | z € [ay,as],y €
[s1(2), s2(2)]}, pricemz funkce s1(x), so(x) jsou spojité na intervalu [ay, as]. Definujme zdkladni
teleso P = {(z,y,2) € R3 | (z,y) € T,z € [h(x,y), ha(x,y)]}.

Trojngm integrdlem funkce f(z,y,z) pres mnozinu P nazyvame:

ag s2(z) ha(z,y)

///fxy, dxdydz—// /fxy, :// /f(m,y,z)dzdydx.

hi(z,y) ar si(z) hi(z,y)

V systému Maple zaddvame vicenasobné integrdly opakovanym pouzitim integracniho
symbolu z palety Expression, piikazu int ¢i vyvolanim kontextové nabidky dokumentu
(po kliknuti pravym tlacitkem mysi na predpis funkce) a zvolenim polozky Integrate spolu
se specifikaci integra¢ni proménné (pouze pro neur¢ity integral).

Pokud chceme do dokumentu zapsat vicendsobny integréal symbolicky (a nevyhodnocovat
jej), pouzijeme piikaz Int. Dalsi moznost, jak zadat (urcity) vicendsobny integral (dvojny
nebo trojny), poskytuje piikaz MultiInt z baliku Student [MultivariateCalculus].
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Symboly z palety Symboly z palety
”(Hy) dxdy ”j(x+y+z) drdy dz
1 2 1 2 1 2 12 2
?x}+E}x Ex»z+?}xz+?zx}
1.5 315
j J (x +7) drdy j j j (x4 +7) dedydz
072 17072
12 36
Textove prikazy Textove prikazy
it nt(x +3.x).y) int(int(t(x +y+2z.x),¥).2)
1 2 1 2 1 2 12
?x}+?}x ?r»z+?}x2+?z Xy
mt(mt(x +yx=2.5),y=0.1) mt(mt(int(x+y+z,x=2.5),y=0.1),z=1.3)
12 36
Kontextova nabidka Kontextova nabidka
ity integrate wrt x %.‘{Q +xy x+y+z integrate wrt x %xz Fxytzx integrate wrt y
integrate wrty 1 2 1 2 1 2 1 2 integrate wrtz 1 2 1 2 1 2
_— -, ' il ] - ' - ' f—_— s = ] - ] - '
2x}+2x} 2x1+2x}+2x} 2x}2+2x}z+22x}

Obradzek 3.33: Vicendsobné integraly.

Pitkaz MultiInt nabizi moznost vypisu integralu jako symbolu i jako integralu, ktery
bude ,rovnou“ vyhodnocen. Navic je mozné nechat vypsat kroky vypoctu integrédlu nasta-
venim nepovinného parametru output na hodnotu steps. Dalsim nepovinnym parametrem,
ktery muzeme specifikovat, je parametr coordinates urcujici, v jakych soutradnicich je in-
tegral uveden. Na vybér mame podle dimenze integralu souradnice kartézské (cartesian[x,y]
nebo cartesian(x,y,z]), poldrni (polar [r,thetal), sférické (spherical [r,phi,thetal)
¢i cylindrické (cylindrical [r,theta,z]), viz obrazek 3.34.

K pfevodiim mezi riiznymi souradnicovymi systémy muzeme vyuzit piikaz changecoords,
ktery prevede zadany vyraz z kartézského systému souradnic do nami zvoleného. Pro dvojné
a trojné integraly je k dispozici piikaz baliku Student [MultivariateCalculus] s nazvem
Change0fVariables prevadéjici proménné mezi difve vyjmenovanymi soutfadnicovymi systémy.
Piikaz mé jednu ,slabinu®, a to, ze zpravidla neptevede integrac¢ni meze do novych proménnych,
coz musime tedy udélat sami (obrazek 3.35).

Priklad 3.41: Stanovte meze dvojnasobného integralu

]://f(x,y)dx dy.

Integral néasledné zapiste i s témito mezemi pro integracni oblast:
(a) R:0<zx<y<1, (c) Q:1< |z|+y| <2,

() Q:z<a?+y* <1, (d) € je A s vrcholy [1,0],[1,1],[0,0].
Reseni: Pii stanovovani mezi ndm muize velmi pomoci obrézek. Nejprve si tedy zadanou
mnozinu €2 vzdy vykreslime a néasledné odvodime meze jednotlivych integralu. Vyuzijeme

pritom ptikazu inequal z baliku plots, transform z baliku plottools a implicitplot
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Student| MultivariateCalculus | [ Multilnt| (3 X +3 }'2: x=1
Ay

1.6, outpur= imeg?‘ai')

6 4 , ,
|| (3_{ + 3}") dxdy
-171

Student| MultivariateCalculus | [ Multilnt| (3 X +3 }'2: x=1
A4, y=-1.6)

1092

Student| MultivariateCalculus | [ Multilnt| (3 X +3 }'2: x=1
A y=-1.6, output= .szep.s)
6 4 , ,
| (3x‘+3y‘)c'xc'y
171

(63 +957) dy
-1

(63y+3))

=—1.6

v

1092

with ( Student| MultivariateCalculus] ) :

%. coordinates = polar| r, theta],

;’»{uhﬂm[r‘: r=1.4,0=0.

output = imeg?‘af]

1
2" 4
| Adrae
0 1
:’»fuhﬂm[r: r=1.4,0=0 % coordinates = polar| r, theta] ]
‘21
2"

Multilnt(r,r=0 .x, =0 .7, 0 =0 .7, coordinates
= spherical[ r, phi, theta), output = integral )
mmm
| Psin(o) drdede
07070

Multilnt(r,r=0 .x, =0 .7, 0 =0 .7, coordinates
= spherical[ r, phi, theta] )
1 5
?TC

el me(35° +3).x=1.4).y=-1.6)

6 4 , ,

L (3x‘+3y‘)c'xc'.y
-171

im(im(fix2 + 3}'2:x=1 ..4):}'=—1 ..6)
1092

Obrazek 3.34: Vicenasobné int

egraly s ptikazy Multilnt a Int.

changecoords(x2 +y2, [x.»], polar, [r, 0])
2 2 2 . 2
¥ cos(ﬁ) + sm(B)

changecoords(xz + }'2 + ZE: [x. ¥, z]. spherical, [r, 0, 0] )
” si:rl[q:i]2 (:05(0]2 +7 sin(¢|]2 si:rl(ﬁ]2 +7 (:os((j:;]2

chaﬂ’igeco::):“.a’.s(.1:2 + }'2 + 22: [x,y, z]. eylindrical, [r: 0, z] )

7 cos(6)2 + = sin(ﬁ)2 + 7

changecoords(x — y. [ x, ¥]. logarithmic)

ln(_vc2 +y2) -2 arctan[ %]

T

with ( Student| MultivariateCaleulus]) :

ChangerVariabfe.s(;’»{ukﬂm( <+ y?: x=1.4,y=-1.6,

output = imeg?‘ai'): [carze.sianx . pola.rr e])
y=6 x=4 -
| [ &
y=-1"x=1

dr do

ChangeOfVariabfe.s(;’»{uhﬂm( 2+ }'2 + 22: x=1.4,y=-1.6,

z=0 .3, output = integral ), [carze.sianx_ - .sphericai’r . e])
x=4 ) o
# [sin(8)| do dr d@

z=3 y=6

z=0"y=-1"x=1

22 2
ChangeOfVariabfes[M.'uhﬂm[ x +y +z.,x=1.4,y=-1.6.z

=0..3, output = imeg?‘ai'): [carze.sianx o evlindrical U
x=4 2 2
| (r” + z“) rdrdfdz

z=0"y=-1"x=1

z=3 y=6

Obrazek 3.35: Transformace

mezi soufadnicovymi systémy.
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z baliku plots, s nimiz jsme se jiz setkali pii vykreslovani oblasti a defini¢nich oboru funkei

v sekei 3.1.3.

()

plots[inequal | ({0 € x,x <y y < 1},x=-1.2,y=-1.2,
optionsfeasible = ( color = cyan) , optionsexcluded
= (color=white), labels= [ "x", "y"])

2

Obrazek 3.36: Zobrazeni oblasti €2 z piikladu 3.41.(a)

Z obrazku 3.36 muzeme vyvodit 2 ruzné (ekvivalentni) zapisy integra¢nich mezi:
1.0<y<1,0<z<uy,
2 0<zx<,z<y<1.

Celkem tak ziskdvame:

I=/Q f(x,y)dxdyo/lo/yﬂx,y) dmdyjjf(w) dy dz.

(b) Z obrazku 3.37 muzeme vyvodit opét 2 ruzné (ekvivalentni) zapisy integrac¢nich mezi.
Dostavame vsak vyrazné komplikovanéjsi zapis nez v predchozim ptipadeé, a tak zapisme
pouze jednu moznost (kterd je jednodussi):

1. -1 <2 <0, —\/1—x2<y<\/1—x2,
0<z<l,—vV1I—-22<y<-— (a;—l)2u }L—(x—%)2<y§\/1—:c2.

2

Celkem tak ziskdvame:

0 Visa? 1 —Vi-(e-3)
I—//fa:ydxdy:/ / f(z,y) dydx+/ / flz,y) dy dz +
Y 0 _yica?
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po :=pi’oz([—\.- 1 —xz__\.- 1

-3 ]:x=0 .1, coi’or=bi’ack) :

/

/
/1
p7 =plot| | - | ——[x——
\"J 4

2
1y /1 1
Y A )
2) 2

=0..1, color=black, i’ine.sayi’e=doz] :

p3 = plots| implicitplot| (O:x= 0.1, y=Jx(1—x)

2
+ 1 —x ,color=cyan) :

p4 = plots| implicitplot ) (O:x= 0.Ly=-J1-— X

-Jx (1 —x),color= man)
[1-2 f—]

[ color=

P —pi’oz( [ x=-1..0, color=

filled=

cyan) ) :

black,

-

2

Obrazek 3.37: Zobrazeni oblasti Q z ptikladu 3.41.(b)

pl = plots| implicitplot]

p2 = plots| implicitplot] (
<0].x

color= black, thickness=

[1<

gridrefine = 3, filledregions, coloring = [ "cyan",
plots| display] (pl. p2, view= |

3

24,
i

2, gridrefine=3) :

[ max
=-4.4,y=-2.2, color=black, thickness=2

-3.3.-3.3])

2

I+ ] x=-4.4,y=-2.2,
(1= =l b + 1 —2)

"white"]) -

-1

a

-3

Obrazek 3.38: Zobrazeni oblasti Q z piikladu 3.41.(c)

[ v tomto pripadé mame dvé (zdkladni) moznosti, jak zapsat integracni meze. Pro
komplikovanost zapisu ukazme opét pouze jednu z moznosti. Dopliime, ze v piipadech,
kdy je oblast 2 symetrickd (kolem pocatku ¢i kolem nékteré z os) a podobné i zadand
funkce (vzhledem k ose z), pocitdme zpravidla integrdl pouze pro ¢ast oblasti (tj.
napf. jen pro jeden kvadrant) a vysledek vyndsobime poctem odpovidajicich si ¢ésti.
V tomto piikladu bychom tak mohli pocitat integrél pouze pro oblast nélezici prvnimu
kvadrantu a vysledek vynasobit ¢tyimi (pokud by funkce f(x,y) byla symetricka kolem

osy z).
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1. 2<z< -1, -2 -2 <y<z+2,
—1<z<0,—rz—-2<yL<—zz—-1 Uz+1<y<ax+2,
0<z<lz—2<y<z—1U —z2+4+1<y<—x+2,
1<z<2/z-2<y<—x+2

Celkem tak ziskdvame:

1 a+2 0 —z—1
I://f(x,y)d:cdy:/ / flz,y) dy dz + / / f(z,y) dy do +
O Z2 g2 S
0 z+2 1 2—1 1 —a+2
—l—//f(x,y)dydx—i—//fxy dydx—i—//fxy dy dx +
Z1a 0 z-2 0 —z+1
2 —z+42
+//f(x,y)dydx.
1 2=2

pl = plots| pointplot | ([[1,0].[1,1],[0,0]], eolor
= red, symbolsize = 20, symbol = solidcircle) :
p2 = plots| impliciplot]( {x=1},x=0.1,y=0 .1,
thickness= 2, color= black) :
p3 = plot([0,x],x=0 ..1, thickness = 2, color= black,
Sfilled= [ color=cyan]) :
plots| display](pl. p2. p3)

1
0z
06

04

0z

Obrazek 3.39: Zobrazeni oblasti Q z piikladu 3.41.(d)

Z obréazku 3.39 vidime, ze situace je velmi podobnd pfipadu (a). Muzeme opét vyvodit
2 ruzné (ekvivalentni) zapisy integra¢nich mezi:

1.0<z<1,0<y <z,
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Celkem tak ziskavame:

T

Izé f(x,y)dxdyo/lo/f(:c,y) dydxo/l/lfxy dz dy.

Yy

Priiklad 3.42: Stanovte meze dvojnasobného integralu

I://f(a;,y)dx dy.

Integral néasledné zapiste i s témito mezemi pro integracni oblast:

(a) :0<z+y<1Az>0Ay>0, () Q:lz|+ |y <3,

(b) Q:2>+y* <1Az >0, (d) ©je A s vrcholy [2,1],[—2,1],[0,0].

Priklad 3.43: Vyjadiete zadané integraly v obraceném potadi integrace.

42 22
Offf:l?ydydiv (c)jffxydyd:c
3 00
2 2.2 1 2
) [ ] f2,y) dy da, (d) Z)fff(ﬂc,y) dy dz.
0 z 23

3.5.1 Geometricka aplikace dvojného integralu
Obsah rovinné oblasti

Poznamka 3.20: Necht Q) C R? je rovinna oblast. Plocha S oblasti 2 je ddna vztahem

:/ﬂ/dxdy.

Priklad 3.44: Urcete obsah oblasti €.
(a) Q je ohranicend kiivkami y = % ay=3—2-u,
(b) Q je ohranic¢end piimkamiy =z, y=z—3,y=2ay=4.

Reseni:

V zadani neni specifikovano, jak mame obsah zadané oblasti hledat. Mohli bychom si
proto vzpomenout na aplikace urcitého integralu funkce jedné proménné a pocitat obsah
oblasti timto zpusobem. U nékterych oblasti je navic jednodussi i jiny zpusob nez pocitat
integraly (jednoduché ¢ dvojné). My si ukazeme vypocet jak pomoci jednoduchého, tak
pomoci dvojného integralu.
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f = x—piecewise(x < 5,2.x—3):

x—piecewise(x < 4,x,4) :

plot( { f- g}, color="NavyBlue", thickness = 2, view
=[2.7,2.4], scaling= constrained) :

) ir == plotteols| transform | ( (x,¥) = [y +f(x)]):

l:_g_g.x =1,
x

Soi’ve[

1
2

o

L:S—E-xl:x= L =
x 2

1, y=1.2, secaling

pl = pfat[

Fa

= constrained, color = "NavyBlue" q = plot(g(x)-f(x),x=2 .. 7, filled = true, color = cyan) :
plots|display](tr(q). p):

region = plots| implicitplot [0, x==_.1y= L .3
x

o |~

— 2x, color=cyan | :

plots| display] ( region, p1)
2

335
18

(%)

235
14

y 2 3 4 5 6 7
14

12

[ .
06e0702081.0
X

Obrazek 3.40: Zobrazeni oblasti  z piikladu 3.44. Vlevo piipad (a), vpravo piipad (b).

(a) Pomoci jednoduchého integralu zvolime jednu proménnou, u niz zndme ¢iselné meze,
a ,odecitame od sebe® dvé funkce vymezujici zadanou oblast. U dvojného integrélu
zapiseme zadanou oblast pouze v integracnich mezich. Pozor na to, Ze pfi vypoctu
dvojnasobného integralu v systému Maple musime zadat funkci, ktera bude inte-
grovana. V pripadé poc¢itani obsahu rovinnych oblasti podle poznamky 3.20 se v in-
tegralu zadna funkce nevyskytuje, i kdyz ve skutecnosti integrujeme konstantni funkci
f(z,y) = 1, kterou také zaddme do integralu v systému Maple.

1

J

J

3-2x

1dydx

1
x

m|._.

-In(2) +

Obrazek 3.41: Vypocet obsahu oblasti €2 z prikladu 3.44.(a)

4 4 y+3

j j 1dxdy
2

2 2%y

Obrazek 3.42: Vypocet obsahu oblasti  z piikladu 3.44.(b)
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Priklad 3.45: Urcete obsahy oblasti €2 z prikladu 3.42 a obsahy oblasti tvofenych inte-
gracnimi mezemi v prikladu 3.43. U piikladu 3.43 vypoctem obsahu piislusné oblasti navic
ovérte rovnost integralu v zaddni a v feSeni.

Priklad 3.46: Pomoci dvojného integralu urcete obsah kruhu o poloméru 7.

Priiklad 3.47: Pomoci dvojného integralu urcete obsah oblasti ohranic¢ené elipsou o délce
hlavni poloosy a a délce vedlejsi poloosy b.
Objem télesa

Poznamka 3.21: Necht f(x,y) je spojitd funkce na mnoziné Q C R? a nechf f(z,y) >0
pro viechna (z,y) € Q. Objem (kolmého) télesa T C R? ohrani¢eného zdola mnozinou €2
a shora ¢ésti grafu funkce f(z,y) je dan vztahem

V= // F(z,y)dz dy.

Priklad 3.48: Urcete objem kolmého télesa ohrani¢eného:
(a) funkel f(z,y) = 2% +y* a mnozinou Q : |z| + |y| <1,
(b) funkel f(z,y) =64 —2? arovinami 3-z+4-y=24,2=0,y=0a 2z =0.
Reseni:

(a) Nejprve v systému Maple zobrazime téleso, jehoz objem pocitame (obréazek 3.43), a jeho
podstavu (mnozinu ), abychom ziskali pfedstavu a snéze odvodili meze dvojného
integralu.

pl :=pim3d( [Jc,y:x2 -I—}'Q],x:—l 1, y=0.1 — |x|, axes plots|display] (p|| (1 -6))
= frame, transparency = 0.6) :

p2 ::pfar.?d( [x:y:xz +y2]_.x=—1 Jl,y=1x —1..0,axes
= frame, transparency = 0.6) :

p3 :=pi’oz3d( [%1—|x.z].x=-1.1,2=0 X +(1- |x:|)2
rransparency = 0.6) :

pd :=pi’m3d( [x |]x-1,z].x=-1.1,2=0 X (1- |¥|}2

transparency = 0.6) :
p3 =plot3d([x 1, 0],x=-1.1,y=0.1—|x):
p6 = plot3d([x,3.0],x=-1.1,y=0.]x — 1) :

Obrdzek 3.43: Reseni pitkladu 3.48.(a) - vykreslen{ télesa.

S mnozinou {2 (resp. jejimi variantami) jsme se uz nékolikrat setkali, takze by nam
nemélo ¢init problémy ptepsat ji do mezi pro proménné x a y. Kdyz si vSak uvédomime,
ze mnozina € je stiedové soumérnd podle pocdtku souradné soustavy (bodu [0,0,0])
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a ze zadand funkce f(z,y) je symetrickd podle osy z, muzeme pocitat objem pouze
casti télesa vyskytujici se v prvnim oktantu (tj. pro z,y,z > 0) a vysledek vynasobit
¢tyfmi (abychom ziskali objem celého télesa rozprostirajiciho se pres ¢tyfi oktanty, pro
nez z > 0).

Pro meze odpovidajici prvnimu oktantu plati:

0<x<1l, 0<y<1l—um

plots| implicitplot] (] + [ < 1.x=-1.1,y=-1.1, view=| 1 1=x
-2..2,-2..2], coloring = [cyan, white], filled = true, V:‘I'J‘ J‘ (f +}'—) dy dx
thickness = 1, gridrefine = 3) 00
5
z =<
4 3

WV

3 -N
-1

Obrdzek 3.44: Redeni piikladu 3.48.(a)

. 21 _a 24—3x plots[ inequal|( {x=0,y=0,3-x+4-y— 24
pl .—pfoz.?d[ [x: y, 64 —x ]’ x=0.8,y=0. 4 : < 0},x=-2..10,y=-2 ..8, optionsfeasible
= [ color="cyan" |, optionsexcluded= [ color
"white" ], labels=["x"."v"]):

transparency = 0.6] :

24 —3.x
x:'

p2= pforj’d[ y

z] x=0.8,2=0.64 — ¢,

transparency = 0.6] : \6

p3 = plots| implicitplot3d]| ([ x=0].x=0..8,y=0.6,z=0 ..64) :
pé :=p3033d( [x0,z],x=0.8,z=0.64 —xz: axes=ﬁame) :
24—3x), y 4
|

p3 :=p3033d[ [%,3,0],x=0.8, y=0..
plors] display] (pI| (1.5))

-

-3z

V=j j 64— dydx

V=1280

Obrdzek 3.45: Reseni pifkladu 3.48.(b)

(b) Postupujeme zcela analogicky k predchozimu piikladu. Pro meze integralu plati:
0<a<8, 0<y< P
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Priklad 3.49: Urcete objem kolmého télesa ohraniceného:
(a) funkei f(z,y) =6—2-2—3-yarovinamix=0,y=0az =0,
(b) funkel f(z,y) = z + 2 -y a podstavou vymezenou grafy funkei y = 2 — 2% a y = |z|,
(c) funkel f(z,y) = e”"tv” a kruhovou podstavou popsanou nerovnicf 22 + 32 < 4,

(d) funkef f(z,y) = 5-2*—2-2-y a trojihelnikovou podstavou vymezenou body [2, 0], [0, 1]
a [0, 0].

2
(e) funkel f(x,y) = <§> a podstavou vymezenou grafy funkel y = x,y = % a primkou

r = 2.

Priiklad 3.50: Pomoci dvojného integralu urcete objem kvadru o rozmérech a, b, c.
Priiklad 3.51: Pomoci dvojného integralu urcete objem koule o poloméru r.

Priklad 3.52: Pomoci dvojného integralu urcete objem vélce o poloméru podstavy r
a vysce v.
Obsah plochy

Pozndmka 3.22: Necht jsou funkce f(z,y), fi(z,y), f;(z,y) spojité na mnoziné Q C R?.
Obsah plochy tvorené grafem funkce f(x,y) nad mnozinou €2 je dan vztahem

s= [[Vi+ ) + (i) do dy
Q

Piiklad 3.53: Urcete obsah plochy tvofené grafem funkce f(z,y) nad mnozinou €2 z prikladu
3.48 v piipadeé (a) i (b).

Resent:

V obou piipadech vyuzijeme pozndmky 3.22, jiz diive vypocitanych integracnich mezi
a predpisu ohranicujici funkce, viz obrazek 3.46.

Piiklad 3.54: Urcete obsah plochy tvorené grafem funkce f(z,y) nad podstavou télesa
z ptikladu 3.49.

Priiklad 3.55: Urcete obsah povrchu koule o poloméru r.

Piiklad 3.56: Urcete obsah ¢dsti plochy koule o rovnici 22 + y? + 22 = 25 vymezené
rovinami z = 2 a z = 4.
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f(xy) =2 4y f(xy) = 64—
() = +) (x,y) >64 — ¥

1 00

1 2 1 % 2
5=4 [[——ln(l-l—-'lx‘)——ln(l+4x‘)x‘
g 2 15 127 3 11
‘0 S=Tln(2}+ 16 N 257 +?ln[?+§ 257]
+%\;’5+8x2—3x—%\;’5+8x2—8xx L
1 16
+4—1n(2—2x+\;“5+3x2—3x)+1n(2—2x
evalf (%)
+/5+82—8x) x?] dx] §=132.5103717

evalf (%)
§=3.004625434

Obrdzek 3.46: Redeni pifkladu 3.53.(a) vlevo, feseni pifkladu 3.53.(b) vpravo.

Integralni soucet

Jak jiz vime, geometrickym vyznamem dvojného integrélu z funkce f(x,y) pfes mnozinu €2
je objem télesa ohrani¢eného mnozinou €2, funkei f(z,y) a ,svislymi plochami“. Tento objem
muzeme pocitat priblizné pomoci dolnich (resp. hornich, ...) integralnich souc¢tu podobné,
jako tomu bylo v pfipadé jedné proménné v sekci 2.7.4. Tentokrat pritom aproximujeme
objem souctem objemu kvadru se ,zjemnujici se ¢tvercovou zakladnou a vyskou spoctenou
napt. z funkéni hodnoty ve stfedu c¢tverce — zdkladny nebo v jednom z vrcholi. K tomu
nam poslouzi piikaz ApproximatelInt z baliku Student[MultivariateCalculus]. Pouziti
piikazu ApproximateInt je takika totozné s piikazem RiemannSum, s nimz jsme se diive
setkali. Piikazu opét povinné zadavame predpis funkce, jiz chceme integrovat, a meze inte-
grace. I v tomto ptipadé muzeme zadavat nepovinné parametry specifikujici typ integralniho
souctu, typ vystupu, rozdéleni integrac¢nich intervalu a dalsi. Ukdzku pouziti muzeme vidét
na obrazku 3.47.

Tak jako v ptipadé funkci jedné proménné, kde muzeme misto piikazu RiemannSum vyuzit
nastroje Approximate Integration spousténém napiiklad z hlavniho menu, méame k dis-
pozici analogicky néstroj i nyni. Opét mé nézev Approximate Integration a tentokrat jej
spustime napftiklad zvolenim Tools > Tutors > Calculus — Multi-Variable > Appro-
ximate Integration... v hlavnim menu (obrazek 3.48).

3.5.2 Geometricka aplikace trojného integralu
Objem télesa

Poznamka 3.23: Necht P je mnozina z definice 3.15 (obecné staci tzv. méritelnd mnozina).
Pro objem V' této mnoziny plati vztah

V:/P//d:cdydz.
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with ( Student| MultivariateCalculus) ) : ApproximateInt(x-y,x=0 .5, y=0 .5, output = plot,
f=(xy) =xy prismoptions = [ color =yellow], axes = frame)
(x,y) —=xy

plot3d( f(x,v).x=0.5,y=0 .5, axes=frame)

g}
Using a midpoint Riemann sun, an spproimation of | Flx p) e de,
]
whete f(x F) =rFx Actual value: 136 25, Approximate value: 156 25,
Grid: 5= 5

Approximatelnt{x-y,x=0..5,y=0.5)
156.2500000

Obrazek 8.47: Aproximace dvojného integralu pomoci integrdlnich souctu.

F B
Multivariate Calculus - Approximate Integration & M
File Help
Plot Window
Options

f= |[x%
® = |0 5
¥ = |0 5

Partition: [ |5 . |5 1

Method:
@ Midpoint ) Lower
() Upper ) Random
Coordinate System:

I @ Rectangular @ Palar

Values

Approximate Value |156.25

Actual Value 156.25

Display ][ Animate ][ Plot Options ][ Close ]

Maple Command

Approximatelnt| v x, x = 0 .. 3, y = 0 .. 5, method = midpoint, coordinates = cartesian, partition = [3. 51,
output = plot, axes = boxed, scaling = unconstrained):

Obrdzek 3.48: Aproximace dvojného integrdlu — maplet.

Priklad 3.57: Urcete objem trojosého elipsoidu daného rovnici

DRIORIGE
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Resend: Nejprve si elipsoid vykreslime pro néjaké konkrétni hodnoty a,b, c. Na obrazku
3.49 jsou pouzity hodnoty a = 13,b = 8,¢ = 6. Nasledné musime odvodit jednotlivé meze
v trojném integralu. Za ,pocatecni“ proménnou vezméme z, pro niz tak plati: x € [—a,al.

a

Proménnou y vyjadiime pomoci proménné z jako: y € {— \/1 — (5)2, \/1 — (£)2] a nakonec

proménnou z pomoci zbylych proménnych jako: z € {—\/1 — (%)2 — (%)2, \/1 — (%)2 — (%)2} .

(35 + (3] + (5] -1}t

v=-8.8.z=-6 .6, axes=frame, scaling = constrained

plots| implicitplot3d] {

Obrdzek 3.49: Reseni piikladu 3.57.

Priiklad 3.58: Pomoci trojného integralu urcete objem télesa z piikladu 3.48.
Priiklad 3.59: Pomoci trojného integralu urcete objem kvadru o rozmérech a, b, c.
Priiklad 3.60: Pomoci trojného integralu urcete objem koule o poloméru r.
Priiklad 3.61: Pomoci trojného integralu urcete objem valce o poloméru podstavy r

a vysce v.
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3.5.3 Transformace souradnic ve dvojném a trojném integralu

U skupiny integralu, kde pracujeme s kruhovymi, kulovymi ¢ valcovymi plochami, byva
vyhodna transformace do polarnich, sférickych ¢i cylindrickych soutadnic.

Poznamka 3.24: (Transformace do polarnich soufadnic) Uvazujme dvojny integral

Zl/ f(z,y)dz dy.

Pro transformaci tohoto integralu do polarnich souradnic danych vztahy
x=r-cos(f), y=r-sin(d)

plati:

// f(z,y)dz dy = //f(r -cos(#),r - sin(0)) - rdr db,

kde r € [0,00),60 € [0,2 - 7].

Poznamka 3.25: (Transformace do sférickych soufadnic) Uvazujme trojny integral

/Q// f(z,y, 2)dz dy de.

Pro transformaci tohoto integralu do sférickych soutadnic danych vztahy

x =r-cos(¢)-sin(f), y=r-sin(¢)-sin(d), =z =r-cos(f)

///f(x’yvz)dx dy dz =

= /// f(r-cos(¢) -sin(f),r - sin(e) - sin(d), r - cos(#)) - sin(f) - r* dr d¢ d,
Qo

plati:

kde r € [0,00),¢ € [0,2-7],0 € 0,2 - 7].
Poznamka 3.26: (Transformace do cylindrickych soutfadnic) Uvazujme trojny in-

tegral
///f(a:,y, z)dx dy dz.
941

Pro transformaci tohoto integralu do cylindrickych soufadnic danych vztahy

x=r-cos(d), y=r-sin(d), z =z

][ reaas dyaz = [[[ 1 costo).r-sin@). ) rar a0 az,

kde r € [0,00),0 € [0,2 - 7],z € R.

plati:
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Priklad 3.62: Pouzitim transformace do polarnich souradnic urcete objem kolmého télesa
ohranic¢eného funkei f(z,y) = e**t¥* a kruhovou podstavou popsanou nerovnici 2 + % < 4.

Reseni: Muzeme vyuzit poznamky 3.24 nebo zapsat dvojny integral pro kartézské souradnice,
ktery jsme jiz vytvorili v piikladu 3.49.(c), a pro transformaci do souradnic poldrnich vyuzit
piikaz ChangeOfVariables (¢i piikaz changecoords). Vyuzijme zminény piikaz.

Integracni meze Maple neprevede, musime je tak vytvorit sami. Podstavou télesa je kruh
o poloméru r = 2, coz vede na nésledujici meze: r € [0,2],0 € [0,2 - 7].

with ( Student| MultivariateCalculus] ) :

2 2
Xty

[ carresianx: ¥ polarr: e] ]

e rdrdd
x=-2 1=—\."|4—x2

V=Im(fm(c?2-r: r=0 ..2)_. 6=0 ..E-E)

2m 2 N

V= ¢ rdrde

0 "0
value( %)

V=-n+e'n
evalf (%)

F=168.3835544

ChangeOfVariabfes[M’ufrij’m[ € :y=—\/4 % ..\.-’Ir-'l % ,Xx=-2.2, output= imeg?'af):

Obrdzek 3.50: Reseni pitkladu 3.62.

Priiklad 3.63: Pouzitim transformace do polarnich souradnic urcete objem kolmého télesa
ohrani¢eného funkei f(x,y) = /1 — 22 —y? a kruhovou podstavou popsanou nerovnici

2+ <1

Piiklad 3.64: Vratte se k pifkladim 3.46, 3.51, 3.52, 3.60 a 3.61. Pfislusné vypocty nyni
proved'te i v jiném systému soufadnic (tj. napf. polarnich, sférickych, ...) a vysledky porov-

nejte s puvodné ziskanymi.

3.6 Nekonecné rady

Definice 3.16: Mgjme funkci f : R — R. Jestlize D(f) = N, nazyvdme tuto funkci

posloupnosti redlngjch éisel a znacime {a,}>2 .

Definice 3.17: Necht {a,}>2, je posloupnost redlnych ¢isel. Symbol

o0

Zan nebo a;+ay+..+a,+ ..

n=1
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nazyvame nekonecnou (¢iselnou) radou. Posloupnost {s,}22; definovanou predpisem
S$1=0ay, Sp=ai+ag, .. S, =01+ a+ ...+ Gy,

nazyvame posloupnosti ¢dstecnijch souctu této rady.

(e}
Definice 3.18: Existuje-li vlastni limita lim s, = s, fekneme, ze fada > a, konverguje
n—oo

n=1
a ma soucet s.
oo
Neexistuje-li vlastni limita lim s,, fekneme, ze fada > a, diverguje.
n—oo
n=1

Poznamka 3.27: Divergenci fady muzeme jesté rozlisit na tii pripady:

e je-li lim s, = oo, fikdme, ze fada diverguje k oo,
n—oo

e je-li lim s, = —oo, fikdme, ze Tada diverguje k —oo,
n—oo

e pokud nh—>Ho10 s, neexistuje, fikame, ze fada osciluje.

V systému Maple zaddvame posloupnosti pomoci piikazu seq nebo pomoci kontextové
nabidky dokumentu. Piikaz seq je mozné pouzit nékolika ruznymi zpusoby s ohledem na to,
jaké mu zadavame parametry. S vyjimkou jediného piipadu mu vzdy zadavame jako prvni
parametr n-ty clen posloupnosti a dalsim parametrem (dalsimi parametry) specifikujeme,
které ¢leny posloupnosti chceme vypsat (coz muzeme uéinit zaddnim intervalu, zapisem
jediné hodnoty — pro jediny ¢len nebo vypisem ¢lenu posloupnosti v seznamu).

V pripadé pouziti kontextové nabidky zaddme do dokumentu n-ty ¢len posloupnosti,
klikneme na néj pravym tlac¢itkem a zvolime polozku Sequence spolu s iteracni proménnou.
V néasledné zobrazeném okénku navolime, které ¢leny posloupnosti chceme vypsat do doku-
mentu. Pouziti kontextové nabidky méa vsak oproti piikazu seq mnohéd omezeni.

Seq(nzrn=0 ..10)
0.1.4.9, 16, 25, 36, 49, 64, 81, 100

Jeq(nz:n=k)
k2
Seq(nz,n=8)
64
Seq(l’!{l’! in [1,3,5, 7])
1.9,25,49

7 sequence wrtn

nt————— 0.1,4,9, 16, 25, 36. 49, 64, 81, 100

7 sequence wrtn
-

64

Obrazek 3.51: Ruzné moznosti vypsani ¢lent posloupnosti.

Posloupnosti {a, } muzeme téz vykreslovat do grafu. Potfebujeme k tomu vytvotit dvo-
jice [n, a,|, které nasledné zobrazime jako body piikazem plot. Pro vytvoreni dvojic [n, a,]
muzeme pochopitelné pouzit piikaz seq, vykresleni bodu je tieba specifikovat parametrem
style nastavenym na hodnotu point (v piikazu plot).
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dvojice == Seq( [n: HE]:M=O ..10)
[0,0],[1.1].[2,4],[3.9].[4,16],[5.25].[6,36],[7,49], [8.64],[9,81].[10,100]

plot( [ dvajice]. style= point, symbol = solidcircle)
1004 [

L
404

20

Obrdzek 3.52: Vykresleni ¢lent posloupnosti.

3

z 1

S (n—2)-Gnt1)

Castedny soudet fady:

1 5
3 16
.mm[ 1 .n=1..00] sum{ 1 .n=1..5)
(3n—2)-(3n+1)° (3n—2)-(3n+1)"
1 5
3 16

Matematicky zapis fady:

oo

: 1 simwrtn N 1 1
I S (3n—=2)-(3n+1) i1 (3n—2)(3n+1) 3
9[k+%] 3
Sum[ (3 7)1(3 +1):?’i=1..00]: % = value( %)
n—2)-(3n
.mm( 1 n=1k w
(3-n—2)-(3-n+1)° - ~ 1 1
IS . as1(3n—=2)(3n+1) 3
1 3
9[!’(1'?]

Obrdzek 3.53: Ruzné moznosti zépisu nekoneénych (i koneénych) fad.

Nekoneéné fady (i konecné soucty) zadavame v Maple nékolika zpusoby. Jednak paleta
Expression nabizi preddefinovany symbol velkého teckého pismene sigma, k dispozici je
také piikaz sum a vyuz{t muzeme opét i kontextové nabidky dokumentu (i kdyz trochu
~komplikované“). Pifkaz sum m& dva parametry (n-ty ¢len fady a ,souctové“ meze). Po
provedeni piikaz vypiSe soucet fady (pokud jej umi urcit). Systém Maple nabizi téz piikaz
Sum s velkym pocatecnim pismenem, jenz slouzi pro matematicky zapis fady s pouzitim
feckého pismene sigma. A pravé takovy zapis je mozné ziskat i pomoci kontextové nabidky;,
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kdyz do dokumetu zapiseme n-ty ¢len rady, klikneme na néj pravym tlacitkem mysi a zvolime
polozku Constructions > Sum > n. Dalsim kliknutim pravého tlacitka mysi (tentokrat na
matematicky zéapis fady) a zvolenim Evaluate (from inert) ziskdme soucet fady (pokud
jej Maple umi uréit) — obrézek 3.53.

S tim, co jiz zname, nam nic nebrani ve vypsani posloupnosti ¢astecnych souc¢tu. Tuto
posloupnost navic muzeme vykreslit, napriklad spolecné se souctem rady — viz obrazek 3.54.

i pl = plot( [ castecne_soucty], style= point, symbol
= solideirele, symbolsize=20) :
castecne_soucty H, Z - .n=1.25 * Cﬂi‘? s :
i1 (3- ;—7} 3 i+1) p2 :=pi’oz[?:n=0..25: color= blue, zhickne.s.s=2]:
2 3 6
1, _] 7] [3 ] [4 [ ; [6 2o | [7 plots| display] (pl, p2)
033 .
0 estenteeRe®
i 1 T I
17 031 o
[13 o 14— [15 —] [16— [17—_[18: vl e
019
18] 1 191 (56,29 {21, 2L] 23 2] [25. 23] | .
5 T 58 61 T 67 |77 70 | :
07
24 25
24, 2| |25, =

3 ] 76 036

025 le
a 3 1 13 20 15
kel

Obrazek 3.54: Vykresleni posloupnosti ¢asteénych souc¢tu a souctu fady.

Existuji nekonecéné tady, jejichz soucet Maple neumi urcit. V takovych piipadech ani
nevypise, zda fada soucet ma (tj. zda konverguje) ¢ zda rada diverguje. V téchto situacich
musime konvergenci fady vysSetfit ,sami“ jinymi postupy, pficemz si samoziejmé muzeme
s,pomahat systémem Maple“ pfti dil¢ich krocich.

Priklad 3.65: Urcete soucty nasledujicich tad:

8
:.h—‘

@) 3 i (6) 3 ©)

Priiklad 3.66: Urcete soucty nasledujicich rad:

(a) i (Vn+2-2-vn+1+n), (b) iarctan(ﬁ).

n=1 n=1

Resent.

(a) Systém Maple zadanou fadu se¢ist neumi. Urcime tedy ¢astecny soucet fady si pro
libovolné (pevné) k a nasledné provéiime existenci limity tohoto ¢dsteéného souctu
pro k — oco. Céstecny soucet s, piitom odvodime na zdkladé nékolika ¢éstecnych
sou¢tu pro ruzné konkrétni numerické hodnoty. Zcela spravné bychom méli (naptiklad
matematickou indukef) dokézat, ze pravidlo, které vypozorujeme z nékterych (nejlépe
nékolika prvnich) ¢astecnych souctu plati skuteéné pro libovolné k.
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Nazna¢me proto takovy dukaz aspon nyni. Diky Maple vime, ze

10

S (VaFa-2 vt T+ va) =1- V- VII+ VI3,

n=1

Z(m_z-M+ﬁ)=1—f—¢ﬁ+¢ﬁ
S (Vet2-2-VatT+va) =1-v2- VI3 +VId

Predpokladejme nyni, ze pro libovolné k > 10 plati:

k
S (Vat2-2-Vatl+va)=1-v2-VE+1+VE+2
Pak plati:
k+3
Z(m_g.\/n—JrH\/ﬁ) = 1-V2-VEk+1+VE+2
n=1

+ (x/k—+3—2-wk+2+Vk+1)
+ (VEFi-2VET34+VE+2)
+

(x/k+5—2-\/k+4+\/k+3>
1-vV2—Vk+4+Vk+5.

Zjistili jsme tedy, ze pokud nase hypotéza plati pro libovolné k > 10, plati i pro k + 3.
Jelikoz vime, ze vypozorovany vztah plati pro k € {10, 11,12}, pak musi nutné platit
pro zcela libovolné k£ > 10.

(b) Systém Maple zadanou fadu secist opét neumi. Postupujeme totoznym zpusobem jako
v predchozim prikladu. Opét je tieba dokazat, ze vypozorovany vztah skutecné plati
pro libovolné k. V tomto piipadé to nechavame na ¢tenafi (obréazek 3.55).

Pokud nedokdzeme urc¢it soucet fady ani my, zpravidla bychom chtéli alespoit odpovéd
na otazku, zda rada konverguje ¢i diverguje. Zabyvat se nyni budeme fadami s nezapornymi
¢leny, u nichz plati, ze bud konverguji (k néjaké konecné redlné hodnoté) nebo diverguji
k nekonec¢nu. Pro zjisténi, zda rada konverguje ¢i diverguje, mame nékolik rozhodovacich
kritérii.

Poznamka 3.28: (Srovnéavaci kritérium) Méjme fady > a,,, > b, s nezdpornymi ¢leny
n=1 n=1

a necht a,, < b, pro vsechna n € N. Pak plati:

e konverguje-li fada > b,, konverguje i fada Y a,,
n=1 n=1

e diverguje-li fada >’ a,, diverguje i fada Y b,.

n=1 n=1
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NIE

£
Il

(Jrn+2 —2-\.fn+1+v-q) zarctzm( 17]
n=1 2.n

SN(nt2z—2/n+1+/n) me[ 1”J
n=1 = .
S 10
2 =2
Z Jn+2 —2yn+1 +yn) ﬂ.mp%,[zmm[ L ]]
= 2.
1-y2 -J11 +J12 n=1 2:n
11 arctan[ 11]
Z\/n+” —2Jn+1 +Vn) ; 1
mplify ;
1-V2 -2 +{13 simplify ?Zlarcan[}n? ]]
12 "
) 12
1-J2 =13 +/14 simplify zmm[ L ]]
n=1 2-n
88 .
Z[\/”‘F?— —2-ynt+1 +n) MCtaﬂ[E]
n=1
88
1—y2 —39 +9 s;‘mp!g@-[zmtm[ L ]]
n=1 20"
88
Je ziejme, ze: arctan[ g]
S(fat2 -2 ntl+/n)=1-/2
) T Je ziejmé, Ze:
Y k+1 +\."{k‘|'—2 & 1 i .
1
1 = arct; _r
x‘:oted}’: nzlafc 311[ 2_n2] arc Em[k—l—l]
Z1(\’IH+2 —2/n+1+/n)= A tedy:
n=
- 5 a4 5o = =
klgpm[l_“'z_“'k—l—l+“'k+2}_1_\"2 Zm’ctan - |= lim arctan[ £ ]zirc
2.0~ ) koo k+1 4

Obrdzek 3.55: Reseni piikladu 3.66. Cast (a) vlevo, ¢ést (b) vpravo.

o oo

Poznamka 3.29: (Limitni srovnavaci kritérium) Méjme tady > a,, > b, s nezdpornymi
n=1 n=1

¢leny a necht existuje

Pak plati:

e je-li L < oo a konverguje-li fada Y b,, konverguje i fada »_ a,,

n=1 n=1
e je-li L > 0 a diverguje-li tada > b, diverguje i fada Y a,.

n=1 n=1

Poznamka 3.30: (Odmocninové kritérium) Necht > a,, je fada s nezdpornymi cleny.
n=1

e Plati-li pro vSechna n € N: /a,, < q < 1, pak fada konverguje,
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e existuje-li

lim a, = q, kde ¢ € RU {—00, o0},

n—oo

pak pro g < 1 fada konverguje, pro ¢ > 1 fada diverguje.

Poznamka 3.31: (Podilové kritérium) Necht > a, je fada s nezdpornymi ¢leny.

n=1

An41

e Plati-li pro vSechna n € N: == < ¢ < 1, pak rada konverguje, plati-li pro vSechna
n € N: “Z% > 1, pak rada diverguje,
e existuje-li
. Ap+1
lim

=q, kde ¢ € RU {—00, 00},

n—oo a’TL

pak pro ¢ < 1 rada konverguje, pro ¢ > 1 fada diverguje.

o0

Poznamka 3.32: (Limitni Raabeovo kritérium) Necht Y a, je fada s nezdpornymi
n=1

¢leny a necht existuje

lim n - (1— a”“) =q, kde ¢ € RU {—00, 00},

n—oo an

pak pro g > 1 fada konverguje, pro g < 1 fada diverguje.

Poznamka 3.33: (Integralni kritérium) Necht je funkce f definovand na intervalu
[1,00), kterd je na tomto intervalu nezéporna a nerostouci. Necht f(n) = a, pro n € N.

Pak fada ) a, konverguje praveé tehdy, kdyz konverguje nevlastni integral
n=1

oo

/ f(z) da.

1

Priiklad 3.67: Rozhodnéte o konvergenci nasledujicich tad:

(a) > w5 (d) > o,
(n)
n=2 n=1
(b) = S (E)’ (e) Z n~1§( )
C nl Ty
(©) n;l (3+5)
Resend.

(o9}
(a) Vyuzijeme srovnavaciho kritéria a toho, ze fada ZQ% diverguje. Jelikoz pro vSechna
n—=

n € N\ {1} plati: 1 < @, podle srovnédvaciho kritéria fada ﬁ diverguje.
n=2
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1 1
.sohe[? < Tn () ]

RealRange( Open( 1), o)

n=1n!
(n+1)n+1

lim (n+1)!

o n

Obradzek 3.56: Pomocné vypocty k feseni prikladu 3.67.

o
(b) Nyni vyuzijeme limitniho srovndvaciho kritéria a znovu rady > %, ktera diverguje.

Jelikoz Tim 22{%)
n—oo n

=, fada ) sin (Z) diverguje.

n
n=1

n=2

(¢) Opét budeme pocitat limitu, tentokrat v odmocninovém kritériu.

Jelikoz lim ,/—2— =1
n—00 \ (3+%) 37

zadana tfada konverguje.
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(d) V tomto pripadé vyuzijeme podilového kritéria, resp. opét jeho limitni varianty.

(n+1)"+1
Jelikoz lim —25'— = e, zadand fada diverguje.
n—oo T

(e) V poslednim piipadé pouzijeme integralni kritérium. Funkce f(z) = xl—() je na inter-
valu [2, 00) nezdpornd a klesajici (predpoklady integralniho kritéria). Jelikoz

7}“(93) dr = oo,

fada Z m diverguje. Pomocné vypocty v Maple k tomuto ptikladu ilustruje obrézek
=2
3.56.

Priiklad 3.68: Rozhodnéte o konvergenci nasledujicich rad:

(@) 3 (Vai—va=1), (d) Sl(1+L), (8) > 2,

n=1 n=1 n=1
() 2 Fm (¢) 3 sin (57) () 32 £,

n=1 n=1
3.6.1 Absolutni konvergence rad
Definice 3.19: Nekonecnd tada ) a, se nazyva alternujici, jestlize pro vsechna n € N
n=1
plati: signum(an11) = —signum(ay,).

Poznamka 3.34: (Leibnizovo kritérium) Necht a,, je nerostouci posloupnost kladnych

¢isel. Pak alternujici fada > (—1)""! - a,, konverguje pravé tehdy, kdyz plati lim a, = 0.

n=1 n—00

Alternujici fady zadavame systému stejnym zpusobem jako veskeré nekonecné rady. Jak

uvidime, systém Maple umi pocitat soucty alternujicich rad. V ptipadech, kdy soucet rady
urcit nedokaze, nam velmi pomuze vyse zminéné Leibnizovo kritérium konvergence.

Priklad 3.69: Rozhodnéte o konvergenci nasledujicich tad:

(@) 34 (-1t (0) 3 - (-1
Resent:

(a) Systém Maple uréi soucet zadané rady.

(b) V tomto pfipadé Maple soucet neurci. Vyuzijeme proto Leibnizova kritéria, diky némuz
zjistime, ze zadana tada diverguje.

145



M s
—_—
2 |-

=
Il
—

]_{_l)n—l ;[ 1 ]_(_l}n—l

In(

[ ]
.

Obrazek 3.57: Pomocné vypocty k feseni prikladu 3.69.

Definice 3.20: Rekneme, ze nekoneénd rada > ay, konverguje absolutné, jestlize konver-

n=1
o (o] (o)
guje fada ) |a,|. Jestlize tada Y a, konverguje a fada la,| diverguje, fikame, ze fada
n=1 n=1 n=1
o0
> a, konverguje neabsolutné.
n=1

Poznamka 3.35: Konverguje-li fada ) |a,|, konverguje i fada Y a,. Diverguje-li fada
n=1 n=1

> an, pak diverguje také fada Y |ay,|.
n=1

n=1

Priiklad 3.70: Rozhodnéte o konvergenci a absolutni konvergenci nasledujicich rad:

(@) X (142)- (-1, 0) 3 s - (1"

Resent:

(a) Systém Maple soucet zadané Fady neurci. Vyuzijeme proto Leibnizova kritéria, diky
némuz zjistime, ze zadand tada konverguje. K posouzeni absolutni konvergence jiz
muzeme vyuzit systému Maple. Zavér tedy je, ze zadana rada konverguje neabsolutné.

(b) Systém Maple neuréi soucet ani jedné z fad. Pro posouzeni konvergence zadané fady
vyuzijeme Leibnizova kritéria, diky némuz zjistime, ze zadand fada konverguje. Kon-
vergenci (resp. divergenci) fady absolutnich hodnot muzeme ovérit napf. integralnim
kritériem, coz jsme provadéli jiz v piikladu 3.67.(e), kde jsme zjistili, ze tato rada
diverguje. Zaveér tedy je, ze zadana rada konverguje neabsolutné.
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n=1
lim ——
. 1 H=% p.ln(n)
H]gnmln[l + " ] 0
0
. 3 1
zln[l +L) = nIn(n)
n=1 " « 1
ad
PZ‘_ nln(n)

Obrdzek 3.58: Pomocné vypocty k feseni prikladu 3.70.

Priklad 3.71: Rozhodnéte o konvergenci a absolutni konvergenci nasledujicich rad

(b) ni::l 3.n1—1 (=11, (e) ni; TN (—1)™,
(c) iln(iﬂ) (=1, (f) 21 )" (=t
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4 Linearni algebra s Maple v C".

Oproti kapitolam vénovanym matematické analyze nyni prejdeme od prostoru realnych ¢isel
R k obecnéjsimu prostoru ¢isel komplexnich C.

4.1 Vektorové prostory

4.1.1 Vektory

Definice 4.1: Necht n € N. Vektorem v prostoru C" rozumime uspofddanou n-tici kom-
plexnich ¢isel. Sc¢itani vektoru definujeme po slozkéch, pii ndsobeni vektoru skaldrem (tj.
komplexnim ¢islem) vyndsobime skalarem kazdou slozku vektoru.

Poznamka 4.1: Vektorem zpravidla ptfesnéji rozumime uspoiadanou n-tici zapsanou jako
sloupec hodnot.

V systému Maple muZeme vektor vytvofit dvéma hlavnimi zptsoby'. Prvnim je zapsat
slozky vektoru do lomenych zavorek, druhy zpusob ptredstavuje pouziti prikazu Vector.
Piikaz nema zadny povinny parametr, nicméné jeho provedeni bez parametru vytvori 0-
dimenzionalni vektor. V nepovinnych parametrech muzeme piikazu predevsim fict, jakou
ma mit vysledny vektor dimenzi a z jakych hodnot se ma skladat.

u={1,2) u = Vector([1,2])
1‘ 1‘
2 2
vi=1{0,1,-1) v = FVeector([0,1,-1])
0 0
1 1
-1 -1
wi={(L0,0,2 -L3+1I) w = Vector([L0,0,2 —L3 +1])
I I
0 0
] ]
2—1 2—1
3+1 341

Obrdzek 4.1: Definice vektoru v Maple.

1V sekci 4.1.2 si ukdzeme jesté jeden vyznamny zpisob vytvoieni vektoru pomoci palet.
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restart Vector(2)
u = Vector( 3, symbol=u)
Error, recursive assignment

vektor u = Vector( 3, symbol=u) Vector(1..3.5)

vektor v := Vector(3, symbol=v) Vector(3.f)

"L’l

Vs

=

(]

1’3

k-veltor_u + [-vektor v
Vector(3, shape=unit[ 3])

kul -I—é"v1 o
Ji'cm2 -I—.i"v2 0
j’cu3 -I—fv3

Obrdzek 4.2: Moznosti pfi definovani vektoru.

Maple standardné vytvori vektor jako sloupec hodnot. Pokud chceme mit fadek hodnot,
pouzijeme piikaz ve tvaru Vector [row]. Vice je patrné z obrazku 4.1 a 4.2. Na obrazku 4.2
Maple pti prvnim pokusu o vytvoreni vektoru vypise chybovou zpravu Error, recursive
assignment. Tato zprava se objevuje vzdy, kdyz se snazime definovat proménnou pomoci
sebe sama. Musime mit na paméti, ze v Maple neni mozné pouzit znaceni, na néz jsme zvykli
z prednasek, tj. napt. u = (uq, ug, usz).

K jednotlivym slozkam vektoru muzeme pristupovat pres indexy. Ty je mozné zapisovat
do kulatych nebo hranatych zavorek, pricemz hranaté zavorky jsou ekvivalentni dolnimu
indexu, tj. u[i] = u;. Funkcionalita kulatych a hranatych zavorek v indexovani vektoru sice
neni naprosto totozna, ale pro nase potieby prakticky bude, a je tak mozné pouzivat oboji
znaceniZ. Indexem muze byt jediné ¢islo (i), seznam hodnot ([iy, %2, ...,%,]) nebo interval
(i1..i2). Pouziti ilustruje obrazek 4.3.

Poznamka 4.2: Vektory v prostorech R? a R3 si piedstavujeme jako orientované tsecky,
tj. tusecky, jejichz jeden krajni bod povazujeme za pocatecni a druhy za koncovy — ten
je oznaceny Sipkou. Ptitom dvé stejné dlouhé, rovnobezné a souhlasné orientované usecky
predstavuji tentyz vektor. Rikdme, ze takové tisecky jsou riznymi umisténimi téhoz vektoru.

Poznamku 4.2 muzeme ilustrovat pomoci prikazu PlotVector z baliku VectorCalculus
— obrazek 4.4.

2Vice o indexovani vektorii, matic a obecnych poli najdeme napi. v ndpovédé: http://www.maplesoft.
com/support/help/Maple/view.aspx?path=rtable_indexing
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u = Vector([1,0,-3,2,4]) :

color= blue, width=0.05)

2

1.5

03

03 1

t u(l) =2
1 2
0 0
3 -3
, 2
4
u(1),ul1]=u, u[1] =3
1.1=1 3
(1.3).u[1.3]=u, , “ )
1 1 1
0 ] 0 0
’ - -3
-3 -3 -3 5
u([1,3.5]).u[[1,3.5]]
1 1
-3 0.] -3
4 4
Obrdzek 4.3: Indexovani vektoru.
u:={(1,2) u=1{1,2.3)
1 1
2 2
VectorCaleulus[ PlotVector] (u, axes = boxed, 3

VectorCalculus| PlotVector] (u, axes = boxed, color
=blue, width=0.08)

z
002040, % HCER :

Séitani vektoru muzeme v Maple znazornit napiiklad pomoci matematické aplikace do-
stupné od verze Maple 16. Spusténim Tools > Math Apps a zvolenim Vector Addition
z Casti Vectors umistime do dokumentu interaktivni graf s dvéma vektory a jejich souc¢tem.
Vektory je pfitom mozné pomoci mysi libovolné ménit. Podobu interaktivniho grafu posky-

Obrdzek 4.4: Vykresleni vektoru.
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tuje obréazek 4.5 vlevo. Kromé aplikace znazornujici s¢itani vektoru nabizi Maple téz aplikaci
pro odéitani vektoru (Vector Subtraction) — obrézek 4.5 vpravo.

Vector Addition Vector Subtraction
10 10
y (3.7, 44 v 5 bh—a
4 a
e (7, 2) b
-10 0 10 -10 -5 0) 5 10

X X
-5
-10 -10

Obrazek 4.5: Interaktivni graf znazofnujici s¢itani vektoru (vlevo) a odéitdni vektoru (vpravo).

Definice 4.2: Nechf n € N. Rekneme, ze V' C C" spolu s vyse definovanymi operacemi
sc¢itani vektoru a nasobeni vektoru skaldrem je vektorovy (resp. linedrni) prostor nad polem
K € {R,C}, jestlize

1. nulovy vektor, tj. (0,0, ...,0), patii do V,
2. Vu,oe VVEIleK: k-u+l-veV.

Poznamka 4.3: Vektorovy prostor nad obecnym polem skalaru spolu s operacemi s¢itani
vektoru a nésobeni vektoru skaldrem (ne nutné definovanymi stejné jako v tomto textu) byva
standardné definovan pomoci osmi axiomt. Ty zajistuji napi. komutativitu a asociativitu
scitani vektoru, existenci nulového a jednotkového prvku a dalsi. Ponechdvame na ¢tenari,
aby ovéril, ze vyse definovany vektorovy prostor vyhovuje i standardni definici.

Poznamka 4.4: Standardni definici vektorového prostoru odpovida daleko vice mnozin
s operacemi s¢itani vektoru a néasobeni vektoru skalarem. My jsme se pro jednoduchost
omezili pouze na ty vektorové prostory, s nimiz budeme déle v textu pracovat.

Definice 4.3: Necht n € N,V je vektorovy prostor nad K € {R,C}. Vyraz

n
i=1

pro uy, U, ..., U, € V, ki, ko,....k, € K nazyvame linedrni kombinaci vektoru uq, us, ..., u,
s koeficienty ki, ko, ..., k,. Vektory uq, us, ..., u,, nazveme linedrné zdvislymi, jestlize existuji
¢isla ky, ko, ..., k, € K tak, ze alespon jedno z nich je nenulové, a plati

=1

Pokud takova netrividlni linearni kombinace neexistuje, nazyvame vektory uy, uo, ..., u, linedr-
né nezavislyma.
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Definice 4.4: Necht V je vektorovy prostor nad K € {R,C}. Rekneme, ze neprazdna
mnozina U C V' je vektorovy podprostor prostoru V nad K, jestlize vyhovuje definici 4.2.
Meéjme dale mnozinu M C V. Prunik vsech vektorovych podprostoru prostoru V', které
obsahuji mnozinu M, se nazyva linedrnim obalem mnoziny M. Bazi vektorového prostoru V'
nad K je mnozina linearné nezavislych vektoru, jejichz linearni obal je roven celému prostoru
V. Koeficienty linedrni kombinace vyjadiujici vektor u € V' ve zvolené bazi {uq, ug, ..., u,}
se nazyvaji souradnice vektoru u v této bazi.

with ( LinearAlgebra) : Basis([v]|(1.3)])
vii=(1,2,3): 1 1
v2i={1,1,1): 5 .
vii=(2,3,4): “r
v4d:=(0,0,1): 3 1
v3 = (0,0,3): Basis([v| (1.4
Basis([v|[(3..5)]) (vl 1 }]}1 0

2

31.10

) 3 1 1
4 1

Obrdzek 4.6: Urcéeni baze vektorového prostoru v Maple.

Pro nalezeni baze vektorového prostoru poskytuje Maple piikaz Basis z baliku
LinearAlgebra. Jeho parametrem je seznam (nebo mnozina) vektoru, z nichz chceme urcit
bézi prostoru, ktery generuji.

Definice 4.5: Bézi ¢, = {e1,e9,...,e,},n € N vektorového prostoru V= K" nad K €
(R, C}, kde
ei(j)=1proi=j, ej)=0proi#j, i,j=12,..,n

nazyvame kanonickou (resp. standardni) bazi tohoto prostoru.

Poznamka 4.5: Pokud nebude uvedeno jinak, budou v dalsim textu souradnice vektoru
udavény vzdy ve standardni bézi. Podobné vektorovy prostor V = K" K € {R,C},n € N
bude vzdy nad ptislusnym polem K.

Priklad 4.1: Necht V = C? se standardni béz{. Urcete soufadnice vektoru u = (3,5, —2)
ve standardni bézi.

Resent: Odpoved je trividlni. Piiklad slouzi k zamyslen{ se nad vyse definovanymi pojmy.
Souradnice vektoru u ve standardni bézi jsou pravée (3,5, —2), nebot

3.e14+5-e—2-e5=3-(1,0,0)+5-(0,1,0) —2-(0,0,1) = (3,5, —2).

Priklad 4.2: Necht V = C3. Uvazujme bdzi a = {(3,0,0),(0,2,0),(0,0,1)}. Urcete
soufadnice vektoru standardni baze v bazi «.

Piiklad 4.3: Jsou vektory u; = (1, —2,3),us = (2,—1,0),us = (1,1, —3) linedrné nezavislé?

Piiklad 4.4: Generuji vektory uy = (1,-2,3),uy = (2,—1,0),u3 = (1,1,-3),uy =
(1,0,—1)} vektorovy prostor R3?
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4.1.2 Matice

Definice 4.6: Necht m,n € N. Matici typu m x n nad mnoZinou komplexnich é&isel C
rozumime obdélnikové schéma

aiq a19 e QA1n
921 29 ... QAon,

)
Am1 Am2 ... Amn

kde a;; € C pro vsechna i € {1,2,...,m},j € {1,2,...,n} se nazyvaji prvky matice. Jestlize
m = n, mluvime o ¢tvercové matici rddu n.

Poznamka 4.6: Jelikoz vektorem muzeme chapat matici typu m x 1, lze vektory v Maple
zadavat stejnym zpusobem jako matice.

Matice v Maple vytvarime predevsim nasledujicimi tfemi zpusoby:

e pouzitim lomenych zavorek se svislou ¢arou oddélujici jednotlivé sloupce matice,
e pouzitim ptikazu Matrix

e nebo pouzitim palety Matrix.

Konkrétni priklady jsou uvedeny na obrazcich 4.7 a 4.8.

A:=(1,2]3,4) A= Mawrix([[1,3], [2.4]]) PEE
13 13 24
24‘ 24‘ 13
24
B:=(0.1,-1|,0,0|0,2 —L 3 +I) | B := Matrix([[0,0].[1,0,2 —I], 071 0
01 0 [-1.0.3 +1]]) B=|102-1I
1 02-1 01 0 “103+1
-103+I1 P o2-I 01 0
-1 03+1 L 02-1
-1 03+I

Obradzek 4.7: Piiklady vytvoreni matice v Maple.

Zcela analogicky, jako jsme pristupovali k jednotlivym prvkim vektoru, specifikujeme téz
prvky matice. Opét vyuzivame zépisu indext do kulatych nebo hranatych zavorek. Ovsem
pozor, v pripadé matic jiz narazime na nékteré odlisnosti téchto dvou zapisu. Pi pouziti
jediného indexu (resp. indexu pro jednu dimenzi), ktery vyjadiuje oznaceni radku matice, je
u kulatych zavorek automaticky bran pouze prvni sloupec, u hranatych zavorek cely radek
matice. Vice je patrné z ptrikladi na obrazku 4.9.
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M := Matrix( 3, symbol=m)

M1 M2

=
]
—

=
3]
]

Matrix(2, 3)

Matrix(1.2,1.3,5)

555
555
fi= ()=
Matrix(3,f)
2 3
X X X
2.3 4
X X
3 4 5
X X

Matrix( 3, shape= identity)

100
010
001

Obrdzek 4.8: Dalsi moznosti pfi vytvareni matice v Maple.

B:= Matrix([[0,10],[1.0,2 —1I], [ -1,0.3

+1]])
01 0
1 02-1
-103+I
B(2,1),B[2,1]=B, ,
1.1=1
B(2)
1
B[2]
[102-1]
B(1.3)
[01-1]
B[1.3]
01 0
1 02-1
-103+1

B(2.3,1.2).B[2.3,1.2]

10 10
—10L -10
B(1) =14
141 0
1 02-1
~103+41
B[1]:=16
16
B
16 16 16
1 02-1
-1 0 341
B[1.1] =19
19
B
19 16 16
1 02-1
-1 0 341

|

Obrdzek 4.9: Indexovani matice.

Poznamka 4.7: Matice znac¢ime velkymi pismeny, jejich prvky pismeny malymi. To zna-
mend, ze napf. prvky matice A budeme v textu znacit a;; (pro vhodna i, j). Systém Maple
rozlisuje velikosti pismen, takze v ném se musime drzet zavedeného oznaceni (tj. pouzivat
stale stejné pismeno véetné jeho velikosti). Pismenem F budeme znacit jednotkovou étvercovou
matici fadu n € N, tj. matici, pro niz plati: Vi,j € {1,2,...n} :e;; =1 proi =j,e;; =0

jinak.
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Definice 4.7: Nad maticemi definujeme nésledujici operace:

e soucet matic: A+ B = C, jestlize A, B, C jsou matice typu m x n (m,n € N) a plati:
Vi € {1, 2, ...,m},j S {1, 2, ,n} L Ciy = Qyy + bij7

e nasobeni matice skaldrem: k- A = B, jestlize A, B jsou matice typu m x n (m,n € N),
ke Caplati: Vi e {1,2,...,m},j € {1,2,....,n} : bjj = k - a;,

e ndsobeni matic: A- B = C, jestlize A je matice typu m x n, B je matice typu n X ¢,
C' je matice typu m x q (m,n,q € N) a plati:

Vi € {1,2, ...,m},k S {1,2, ,q} Gk = Zaij : bjk'
j=1

Definice 4.8: Necht A je matice typu m x n (m,n € N). Matici AT typu n x m nazveme
transponovanou matici matice A, jestlize pro jeji prvky plati: az; = aj; pro vsechna ¢ €
{1,2,....,m},7 €{1,2,....,n}. Ctvercovou matici A fddun € N nazyvame symetrickou, jestlize

plati AT = A.

Definice 4.9: Nechtf A, B jsou ¢tvercové matice iddu n € N spliujici A-B=B-A=FE.
Pak se matice B nazyva inverzni matici k matici A a znaéi se A~1. Matici, k niz existuje
matice inverzni, nazyvame invertibilni matici.

A=Marrix([[1,2,3],[4.5,6].[7,8.9]]) Vi
123 147
456 258
7889 3609
Bi=Matrix([[3,2,1].[6.5,4],[9.8.7]1]) 41
321 Error, (in rtable/Power) singular
65 4 matrix
987 C = Matrix([[1.2.3].[1.0,1],[7.0.0]])
4 4 4 123
A+B=| 10 10 10 101
16 16 16 700
C—l
51015 1
5-4=| 20 25 30 o 0 =
35 40 45 1 3 1
2 2 7
42 36 30 1
AB=| 9% 81 66 ot
150 126 102

Obrazek 4.10: Maticové operace v Maple.

155




Obréazek 4.10 ilustruje pojmy predchazejicich definic v Maple. Séitani matic a ndsobeni
matice skalarem je stejné jak v psaném textu. Totéz plati pro zapis inverzni matice. Pro
nasobeni matic je urcéena tecka (tj. tataz tecka na spodnim okraji fadku, kterou napiiklad
ukoncujeme vétu). Zapis transponované matice se lisi od klasického matematického zapisu
piiddnim symbolu % do exponentu matice. Pro vypocet inverzni a transponované matice
poskytuje navic Maple piikazy MatrixInverse a Transpose, které vsak oba néalezi do
baliku LinearAlgebra, jenz je proto potieba pfed jejich pouzitim nacist. Pokud se po-
kusime vypocitat inverzi k neinvertibilni (tj. singuldrni) matici, vypise systém Maple chy-
bovou zpravu Error, (in rtable/Power) singular matrix.

Matici muzeme systému Maple zadavat i blokové. Na obrazku 4.11 vidime, jak k tomu
pouzit prikaz Matrix.

A= Marrix([[1.2.3].[4.5.6].[7.8.9]])  |C = Marred(2.3)

123 000

456 000‘

780 F:= Matrix([[1.1.1]])
[111]

B = Marrix([[3.2.1].[6.5.4].[9.8.7]])

321 N:=Marrix([[4, E]. [B[1.2].C], [B[3].F]])
65 4 123100
087 456010
E := Matrix( 3, shape = identity) 785001
100 321000
010 654000
001 987111

Obrdzek 4.11: Maticové operace v Maple.

Priklad 4.5: Necht
e <cos(a) —sin(a)>

sin(a)  cos(«)

Urcete A%, A3, ...

Resent: V Maple ziskdme pifslusné matice jednoduse, a to pouhym piepisem maticovych
vyrazi. Nicméné obdrzeny vysledek neni v nejjednodussim tvaru, coz napravime pouzitim
piikazu combine (viz ¢dst 2.1.1). Pfi provedeni indukéntho kroku (k dikazu spravnosti
piedpokladu o obecném tvaru A*) je mozné pro ,lepsi vzhled pouzit pitkaz factor, jenz je
tteba aplikovat na kazdy prvek matice. K takové aplikaci slouzi pifkaz map. Reseni v systému
Maple znazornuje obrazek 4.12.

Piiklad 4.6: Necht

10
A=|2 1], B=(-10 2), 62(100—1)7
2



JEECET A :
sin(a) ~cos(a) . cos(a) -sin( o)
cos() -sin(x) sin(ot) cos( o)
sin(o) cos(a)
A s cos(k-a) -sin(k o)
cc:s[o:)g—sml:cs:]2 -2 cos( o) sin( o) sin(k-ot) cos(k o)
2 cos(a) sin( o) c:c:sl:o:jz—Si'.rl[o:]2 cos(kar) -sin(ko)
sin(ka) cos(ko)
combine( %)
cos(2 ) -sin(2 o) combine(K.4) #=4"""
sin(2 o) cos(2a) cos(ko+ o) -sin(ko + o)
sin(koe+ o) cos(ko+ o)
cambine(AB)
cos(3a) -sin(3 o) map(x— factor(x), %)
sin(3 o) cos(3 a) cos(o (1 +k)) -sin(o (1 +k))
sin(o (1 4+%)) cos(o(1+k))

Obrdzek 4.12: Maticové operace v Maple.

1 2 0 10 0 _13
F=(-20 3], G={01 4|, H=|
0 3 5 10 1 -

Uréete G2 —3-F, A—F, A—-G-F-A, B-A-C-H—-B-F. BT,

Priklad 4.7: K maticim
1 1 1

A:G Z) B:(l—gl 1;[>, (J:(ﬁ Z) F=[2 3 3

-1 -3 -2

urcéete matice inverzni.

Priklad 4.8: Vytvoite matici A typu 4 x 4 tak, aby:

a) a;; =1+ 7,

c) aij =

1 ... pokud |i —j|>1
—1 ... pokud |i —j| <1.

proi,j € {1,2,3,4}.
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Piiklad 4.9: Necht 0 je nulovd matice typu 2 x 2. Existuje nenulova matice A typu 2 x 2
tak, ze:

a) A-A=07
b) A-A=A?

Piiklad 4.10: Ukazte, ze matice

. <cos(a) — sin(a))

sin(a)  cos(a)
reprezentuje oto¢eni v roviné o thel a. Tj. jestlize matici A vyndsobime (sloupcovy) vektor,

ziskame vektor pootoceny o thel «. Ilustrujte graficky.

4.1.3 Soustavy linearnich rovnic

Poznamka 4.8: Soustavy linearnich rovnic muzeme ptehledné zapisovat pomoci matic.
Uvazujme systém

11Ty + a2 To+ -+ Qip Ty = Y1,
Q21 Ty + Q22 To+ -+ Q2 Ty = Y2,
Am1*T1+ Q2 T2+ + AQun Ty = Ym-
Jestlize oznatime A = (a;),xz = (21,%2, .., xn)T,y = (Y1,Y2, -, Ym)’, muzeme uvedeny
systém prepsat do tvaru
A-x=uy.

Balik LinearAlgebra nabizi pro feSeni soustav linedrnich rovnic piikaz LinearSolve.
Piikaz méa dva zakladni parametry, a to matici A a vektor y, ktery neni nutné uvadét
v piipadé, ze je nulovy. Dale mame k dispozici jesté nékolik nepovinnych parametru, z nichz
uvedme parametr free, v némz muzeme specifikovat symbol pro volnou proménou (tj. pa-
rametr pouzity pii zépisu vysledku s nekoneéné mnoha fesenimi). Ukdzku pouziti nabizi
obrazek 4.13.

Mezi pomocnymi nastroji zvanymi Tutors (spustitelnymi napiiklad z polozky Tools
hlavniho menu) najdeme pro linearni algebru mj. nastroj ilustrujici soustavu linearnich rov-
nic graficky — Linear System Plot. Tento maplet je mozné pouzit v oborech R? a R3,
v nichz dané rovnice ptredstavuji piimky nebo roviny. Nazorné tak muzeme vidét, zda
ma zadand soustava rovnic feseni a kolik jich je. Maplet je mozné spustit ptimo z doku-
mentu piikazem LinearSystemPlotTutor z baliku Student [LinearAlgebra]. Jeho podobu
znazornuje obrazek 4.14.

Pomoci piikazu LinearSolve muzeme téz jednodusSe zjistit souradnice vektoru v zadané
bézi — viz priklad 4.11.

Piiklad 4.11: UvaZzujme bazi o = {uy, us, u3} vektorového prostoru V, kde u; = (2, —1,0)7,
ug = (—4,1,2)T us = (3,0, —1)T. Urcete souiadnice vektoru z = (=2, —1,2)7 v bazi a.

Resent: Souiadnice zn v bézi o jsou fesenfm rovnice A - zn = z, kde matice A je tvofena
praveé bazi a. Postup vypoctu ilustruje obrazek 4.15.
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with( LinearAlgebra) : LinearSolve( A4, v)
A=Marrix([[1,2,3],[4,0,1],[0,2,3]]) 1
123 1
401 1
023
y=(6.5,5)
6 B:= Matrix([[1,2,3].[4,5,6].[7,8,9]]):
z:=(6,15,24):
5 LinearSolve( B, z, free='t")
g
A(xp X% X5} =y 3-21,
x, + 2 x, + 3 x, p t,
4x1 + X, =53
2x2 +3 X, 5

Obrdzek 4.13: ReSeni soustav linedrnich rovnic piikazem LinearSolve.

Linear Algebra - Linear System Plot — . @

File Help

Plot of the system . . .
Displaying the system of equations:

1_r1+2_!cl+3x.5=6
4_!c1+[]_t_1+ lx.j=5

[}_rl + 2.1’2 + 3x3 =5

1.6
1.6
1.4+
1.2+

= 1.4+
0.8+ |

1 $

0.6
.44

02

LI B B i
L¥16141.21.0080.60402 1.5 14100602
X ¥

[ EditSystem | [ Plot Options ] [ Close ]

Obrdzek 4.14: Grafické zobrazeni soustavy linedrnich rovnic.

Priiklad 4.12: Uvazujme soustavu linearnich rovnic s neznamymi x, y, z a parametry ¢, d €

C:

r+cy—c-z = =3,
z+(c—1)-y—(c+3) -z -5,
r+(c+1)-y+2-2 = d—1.

Urcete, pro kterd c, d ma soustava zadné, jedno, resp. nekonec¢né mnoho teseni.
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with ( LinearAlgebra) : seq(zn[1]-ul[1],i=1.3)
uy = (2.—1.0): u, == {

\
A= ,-’»fa!?‘ﬂ’( [ Uy iy l:'t3])

&

= o | w e

1
2 2
1

= (—2,—1.2): n[1]-u[1] +zn[2]-u[2] + zn[3]-u[3]
m = Li;;arS;a’e.(A_.z} -2

3 -1
2 2
1
2
-1

Obrdzek 4.15: Reseni pifkladu 4.11.

Reseni: Zapiseme zadanou soustavu maticové a vyuzijeme pifazu LinearSolve. Ziskdme
reSeni vyjadirené pomoci parametru c, d. Pocet feSeni soustavy je zavisly predevsim na hod-
noté jmenovatele. Pokud je nenulovy (¢ # 1), soustava ma jediné feseni. Pokud je jmenovatel
nulovy (¢ = 1), je nutné rozlisit pripady, kdy je nulovy i ¢itatel (d = 0, nekoneéné mnoho
feseni) a kdy je ¢itatel ruzny od nuly (d # 0, tj. kdy zlomek nemd smysl, a tedy ani soustava
feseni). Postup vypoctu je uveden na obrazku 4.16. Pti feseni bylo vyuzito (nové) piikazu
numer pro ziskdni Citatele zlomku a op k ziskédni operandu ze zadaného vyrazu (v tomto
pripadé ze seznamu).

with( LinearAlgebra) : eval(map(x— numer(x),R), {e=1})
A= Matrix([[1, e,-¢]. [1,c — 1,-¢-3], [1l,e + 1,2]]) 4d
1 ¢ -c -3d
le—1-¢c—3 d
let+1 2
yi={-3,-5,d—1) solve( {seg(%[i]=0,i=1.3)})
. (d=0}
-5
o1 A2,y2 = op(eval([4,y]. {c=1,d=0}))
11 -1 -3
R:= LmearSofve{A_.};) 10 -4 |-5
_2CL+C_4dC_3 12 2 -1
c—1
2c—2-3d LinearSolve( A2, y2, free=1t)
e—1 -5 + 41,
d
ce—1 -3 IB
3

Obrdzek 4.16: Reseni piikladu 4.12.
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Piiklad 4.13: Uvazujme bézi a = {uy, uy, u3} vektorového prostoru V, kde u; = (1,1, 0)7,
ug = (1,0, 1), uz = (0,1,1). Urcete souiadnice vektoru v = (1,2, 3)T v bazi a.

Piiklad 4.14: Ktery z vektor u, us, us, us dopliiuje mnozinu o na bézi prostoru R*?:

a) o = {(17 _27 17 _1)T7 (17 07 _17 _1)Ta (]-7 17 _27 O)T}7
u = (—1,2,-1, 1)T,u2 =(3,—-1,-2, —1)T,u3 =(2,1,0, —2)T,u4 =(2,1,-3, —2)T.

b) a = {(1737 07_1)T7 (1707 07_]‘>T7 (07 2’ ]"0)T}7
up = (1,1, =1, 1) uy = (3, 1,0, -3)T, ug = (2,1,0, =2)7, uy = (1, -2,0, —1)7.

Piiklad 4.15: Prostory R,[z] a C,[x] vSech polynomu s redlnymi, resp. komplexnimi,
koeficienty spolu se standardné definovanym souctem polynomu a skalarnim nasobkem po-
lynomu tvoii také vektorovy prostor (pozn. dokazte). Zjistéte, zda jsou nésledujici polynomy
v uvedenych prostorech linearné zavislé nebo ne:

a) Ri[z]: 1 — o, — a2, 2% — 23,23 — 1,

Priiklad 4.16: Uvazujme soustavu linearnich rovnic s neznamymi x, y, z a parametry a,b €
R:

a)

a-rx+y—2-2 =1
r—y+z = 0,
(14a)-y—z = b

r—a-y—2-z = b,
r+(1—a)-y = b—3,
r+(1+a)-y+a-z = 2-b—1.

Urcete, pro kterd a, b ma soustava zadné, jedno, resp. nekonec¢né mnoho reseni.

Priklad 4.17: Uvazujme soustavu linearnich rovnic s nezndmymi x1, x9, r3 a parametry
a,b,c e C:

x1+x2+x3 = 3,
rTit+a-ro+x3 = 2,
bz +2-20+2-23 = c

Urcete, pro kterd a, b, c ma soustava zadné, jedno, resp. nekoneé¢né mnoho feseni.
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4.1.4 Gaussova eliminace

Poznamka 4.9: (Gaussova eliminace) Nenulovou matici A typu m xn nad C lze konecné
mnoha elementarnimi fadkovymi operacemi prevést na tzv. (fddkové) schodovity tvar. Tento
tvar muzeme zapsat nasledujicimi podminkami:

o jelliVi:1<i<k<m,je{l,2,..,n}:a; =0, pak také Vi > k : a;; =0,

o jelliprol <i<m,je{l,2,...,n}:a; prvai nenulovy prvek na i-tém radku,
pak a(i+1)j =0.

Elementarni fadkovou operaci pritom rozumime jednu z nasledujicich transformact:

1. vymeénu dvou radku matice A,

2. vynasobeni nékterého radku matice A nenulovym komplexnim ¢islem,

3. pricteni skalarniho nasobku nékterého radku matice A k jinému jejimu fadku.

Pro prevod matice na schodovity tvar poskytuje Maple prikaz GaussianElimination,
opét z baliku LinearAlgebra. Jeho jedinym povinnym parametrem je matice, jiz chceme
na schodovity tvar prevést. Jednim z volitelnych parametru je parametr method, ktery pii

nastaveni na FractionFree upravi matici na schodovity tvar tak, aby vSechna ¢isla matice
byla cela — obrazek 4.17.

with ( LinearAlgebra) : GaussianElimination ( A, method'="FractionFree')
A4:=Marrix([[1,2.3].[4,0,1].[0.2,3]]) 1 2 3
123 0 -8 -11
401 0 0 -2
023
GaussianElimination(A) B:=Marrix([[1,2,3]. [4,5.6].[7.8.9]]):
Gau.a’smnEhmmazwn(B]
12 3
2
0-8 -11 P23
1 0-3 -6
00 —
1 0 0 0

Obrdzek 4.17: Gaussova eliminace v Maple.

Prikazem GaussianElimination ziskdme rovnou vysledek. Pokud nas zajim&a postup
vypoctu, muzeme vyuzit pomocnika GaussianEliminationTutor z baliku Student [Linear-
Algebra] dostupného téz z hlavniho menu (Tools > Tutors > LinearAlgebra > Gaus-
sian Elimination...). Podobné jako u jinych pomocnych mapleti muzeme sami provadét
zvolené uipravy se zadanou matici nebo nechat systém Maple, aby nam sam ukézal nasledujici
krok vypoctu, pripadné celé odvozeni az k vysledku. Grafickd podoba mapletu je uvedena
na obrazku 4.18 vlevo.

Pomoci Gaussovy eliminace muzeme tesit systémy linearnich rovnic. K tomu Maple nabizi
dalstho pomocnika — piikaz LinearSolveTutor z baliku Student [LinearAlgebral, taktéz
dostupného z hlavniho menu (Tools > Tutors > LinearAlgebra > Linear System Sol-
ving...). Podoba tohoto pomocnika (obrézek 4.18 vpravo) je takika shodnd s mapletem pro
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Lincar Algebra - Gaussian Elimination = Linear Algebra - Gaussian Elimination ==

File Edit Help File Edit Help

pplicd cperasics: 2dd 1/4 simes row 123
2 o zow 3

401
023
2 3|6
-111-19

6 Spplicd specanion: 244 /4 simes sor
2 o0 xov 5

I

5| =

W= W

5

Add multiple Add multiple

1 - | times

F 3
row 1 ~ |adc to
[ 3

row 2 -

S = o o = o ko

do B3 1y ko B2 © k3
wow e W

S~ o o =

do 1 K gy

1)-19

1 11 o wa ]
00 — 00 —|—
1 T
Multigly Multiply
2 | timzs 2 - times
row 1. = row 1 =
Multply Muitiply
Swap Swap
row 1 ~ |with [row 1. + | with
row 2 = row 2 =
[ Edit Matrix ] [ View Properties ] Edit Matrix Solve System . \

[ Undo ] [ Next Step ] [ RilSteps | [ Close ]

Undo ] [ Mext Step ] [ Al Steps § [ Close ]

Obradzek 4.18: Pomocnik pii vypoctu Gaussovy eliminace.

Gaussovu eliminaci. V tomto piipadé vsak muzeme postupovat dale k vypoctu feseni (po-
moci tlac¢itka Solve System). Pii spousténi pomocnika jsme dotdzani, jestli chceme pouzit
Gaussovu eliminaci nebo Gaussovu-Jordanovu eliminaci, ktera upravi matici az do jednot-
kového tvaru.

Jelikoz pro invertibilni étvercovou matici A plati: A-A~! = A71. A = E, kde F je jednot-
kova matice, je mozné vyuzit Gaussovy eliminace i pfi vypoctu inverzni matice. Pro tento po-
stup nabizi Maple dalsiho pomocnika podobného dvéma piedchozim: pifkaz® InverseTutor
z baliku Student [LinearAlgebra], i v tomto pripadé dostupného z hlavniho menu (Tools
> Tutors > LinearAlgebra > Matrix Inverse...).

Priklad 4.18: Resté soustavu linearnich rovnic v R uzitim Gaussovy eliminace:

2.0 —3- 294+ 17-23—29-24—36-25 = 22,
2.0 —3- 29+ 18 25 —27-24+33-25 = 21,
12-21 — 18- 294+ 102 - 23 — 174 - x4 — 216 - x5 = 132,
2-x7—3-a29+21-23—24-24—30-25 = 20,
2-xy =3 a9 +24-23—-21- 04 —27-25 = 19.

Reseni: Zadanou soustavu je mozné Fedit pomocnikem LinearSolveTutor. Lze viak
pouzit i piikaz GaussianElimination, coz provedeme i my. Soustavu zapiSeme maticové
ve tvaru A - x = y, piikaz GaussianElimination pouzijeme na matici A doplnénou o slou-
pec y. V tomto pripadé nemame k dispozici svislou ¢aru oddélujici matici A od vektoru y,
coz musime mit na pameéti.

Po aplikaci Gaussovy eliminace ziskdme matici ve schodovitém tvaru, z niz na prvni
pohled poznédme, Ze soustava ma nekoneéné mnoho feseni zavislych na parametru, ktery
pritadime bud k nezndmé z; nebo z,. Poté zbyva uz pouze dopocitat hodnoty zbylych
neznamych, k ¢emuz pouzijeme piikaz solve. Jeho prvnim parametrem je mnozina rovnic
vyplyvajici ze ziskané matice ve schodovitém tvaru. Proménna res obsahuje vektor feSeni,
tJ (Qfl, Ty euny I5)T

3Pozor! Neplést se stejnojmennym piikazem z baliku Student [Calculusi] pro vykresleni inverznf funkce.
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with( LinearAlgebra) :
A = Marrix([[2,-3,17,-29.-36], [2,-3. 18.-27, 33],

res = ;’Lfa!rix( [Seq( [x{.], i=1 ..5] ]) :

%12,—13: 102,-174.-216], [2.-3.21,-24,-30], |2 =
2,-3,24,-21,-27 _ _
TomeE 5 ; 5 ]]1)? 2o -38 Sofve( {seq((R[L,1.5].res)[1]=R[1 6],
5 3 18 7 33 i=1.4)}, {xl_.xi,xfx,
12 -18 102 -174 -216 [r1=%s—%,x3—%,x4
2 -3 21 -24 -30 assign (%)
2 -3 24 -21 -27 res
yi= (22,21, 132,20, 19) 3.3
22 2 2
21 s
132 1
20 .
19 —%
R = GaussianElimination( Matrix( [ 4, v]) ) 0
2 -317 -29 -36 22
001 2 69-1
0 0 0 -3-270 2
0 00 0 66 0
000 0 0 0

Obrdzek 4.19: Reseni piikladu 4.18.

Priklad 4.19: Resté soustavu linearnich rovnic v C uzitim Gaussovy eliminace:

a)
x+2-1-y = 5441,
B-I)-y+(6-2-1)-2 = 10,
2:x—2z = 5+4+3-1,
r+y—z = 5421,
b)
1+1)-z+3-1-y = —I,
14+2-I)-z+(1—-1)-y = 6+1,
c)
I+0)-z+(1-1)-y = 6+4-1,
Iz+(1+2-1I)-y = =3+45-1.
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Priklad 4.20: Resté soustavu linearnich rovnic v R uzitim Gaussovy eliminace:

r1+3-29—2-234+2-25 = 0,
2-214+6-29—5-23—2-244+4-25—3-2¢ = —1,
5-x3+10-24+15-24 = 5,

201 +6-29+8-14+4-25+18 -2 =

Priklad 4.21: Urcete hodnoty parametru a, b, ¢ € C tak, aby mél nasledujici systém prave
jedno Tesenti:

a-r+b-y = ¢

c-r+a-z = b,

c-y+b-z = a

Priklad 4.22: K matici:
e I -2
o\l T

naleznéte matici inverzni a ovéite, ze A- A~! = E, kde E je jednotkova matice.

Resend: Jednak muzeme vyuzit pomocnika pro hleddni inverzni matice, jednak muzeme
pouzit ptibuzny piikaz k piikazu GaussianElimination, a to ReducedRowEchelonForm
provadeéjici Gaussovu-Jordanovu eliminaci, jelikoz potrebujeme zadanou matici upravovat
az na jednotkovou. Postup vypoctu je uveden na obrazku 4.20.

with( LinearAlgebra) : R = ReducedRowEchelonForm(Matrix([4, E]))
4= Marix([[L-2]. [1,1]]) 10 I 2
[-2 01-11
11
A mv:=R[1.2,3.4]
E = Marrix( 2, shape = identity) I 2
Lo L
01
Matrix([4, E]) AA v
I-210 10
1 T01 01

Obrdzek 4.20: Reseni pitkladu 4.22.

Priklad 4.23: Pomoci Gaussovy eliminace najdéte inverzni matice k nésledujicim maticim:

123 1 —4 -3
A:(fl ?) B:G i) c=|o0o12], F=(0 -5 -3
00 1 1 6 4

U nalezenych matic ovérte, ze souc¢inem matice a jeji inverze vznikne jednotkova matice.

165



Priklad 4.24: Pomoci Gaussovy eliminace najdéte inverzni matice k nasledujicim maticim:

1 =1 141
A:(l‘gl 1;1), B:G é) c=-1 1 o |,
-7 0 I

241 1+71 1+2-71
F= 1-71 3-2-1 1-1
2-3-1 1+1 1+2-1

U nalezenych matic ovérte, ze sou¢inem matice a jeji inverze vznikne jednotkova matice.

4.1.5 Determinant

Definice 4.10: Permutaci mnoziny X nazveme bijektivni zobrazeni o : X — X. Permutaci
o(X) nazyvame transpozici, jestlize existuji ruznd z,y € X tak, ze o(z) = y ANo(y) = z,
a pritom Vz € X \ {z,y} : 0(2) = z. Dvojice prvku a,b € X = {1,2,...,n},n € N tvoii
inverzi v permutaci o, je-li a < b A o(a) > o(b). Paritu permutace o definujeme vztahem
(—1)potet inverzi o ynacime sgn(o).

Definice 4.11: Necht A s prvky a;; je ¢tvercovd matice fddu n € N. Determinant matice
A definujeme vztahem

Al =" 5gn(0) - a150) - G20(2) * - * Gno(m)s

oESH

kde S,, je mnozina vSech permutaci na mnoziné {1,2,...,n}.

Poznamka 4.10: Vyjadfenim determinantu z predchozi definice pro n = 3 ziskame tzv.
Saarusovo pravidlo:

aix G2 13

|A| = |as1 aze as3| = Hair-ax - azs+ an - sz - a1z + Az - G2 - A3
az1 az2 as3

—agy - Gg2 * G13 — A21 * G12 * G33 — A11 * (32 * 423.

V systému Maple slouzi k vypoctu determinantu matice pitkaz Determinant z baliku
LinearAlgebra. Misto néj je mozné pouzit svislych zavorek (jak jsme zvykli z psaného
textu), piipadné i kontextového menu po kliknuti pravym tla¢itkem mysi na matici. Obé
tyto moznosti nevyzaduji nacteni zminéného baliku. Ukazku vypoctu poskytuje obrazek
4.21.

Piiklad 4.25: Uvazujme matice z priklada 4.23 a 4.24. Ovérte, ze pro X € {A, B,C, F'}
plati:
a) |X|=[XT], b) XY =5
Priklad 4.26: Uvazujme matice z piikladu 4.24. Ovéite, ze plati:
|A-B|=A|-|B], [C-F|=]|C|-[F].
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LinearAlgebra[ Determinant] (A)

2-4 3 1 1141
A=|-1 1 0 c=| -I 1 0

0 2 -1 1-10 I
4] |C]

-24+21

LinearAlgebra[ Determimant|( C)

-4 -2+21
2 -4 3 1 -T1+41I
4= -1 1 0 determinant 4 Cc= 101 0 determinant 2421
0 2 -1 1—-10 I

Obrdzek 4.21: Vypocet determinantu v Maple.

Laplacetiv rozvoj determinantu

Poznamka 4.11: K vypoc¢tu determinantu matic vétsich rozmeéru nez 3 x 3 (bez pocitace)
se obvykle pouziva Gaussova elimina¢ni metoda a Laplaceiv rozvoj determinantu. Laplacetuv
rozvoj determinantu nam iikd, ze pro ¢tvercovou matici A fadu n s prvky a;; a prirozena
¢isla k, [ takova, ze 1 < k.1 < n plati:

n n

A= 31 o - Al = D=1 a4,

j=1 =1

kde Ag; je matice A bez svého k-tého radku a j-tého sloupce, tzv. submatice matice A.

Systém Maple nenabizi nastroj, ktery by umeél néazorné provést Laplaceuv rozvoj. Nic
nam vsak nebrani v jeho vytvoteni. Zavedeme proto piikaz laplace jako proceduru se tfemi
povinnymi parametry — ¢tvercovou matici, prirozenym cislem od 1 do n udavajici, podle
kolikatého radku ¢i sloupce méa byt rozvoj proveden, a pismenem r nebo s v uvozovkach
znacicim, jestli se rozvoj povede podle tadku ¢i sloupce.

Smyslem textu neni naucit programovat v Maple, a proto uvedme jen nékolik pozndmek
ke zdrojovému kédu umisténém nize v rdmecku. Procedura ma tii parametry (¢tvercovou
matici, prirozené ¢islo a znak). Pokud neuvedeme parametry v tomto poradi a zminénych
typu, vypise Maple chybovou zpravu Error, invalid input.

laplace := proc (A::(Matrix(square)), i::posint, c::character)
local k, n;
uses LinearAlgebra;
n := RowDimension(A);
if n < i then printf(”Druhy parametr musi byt cele cislo
od 1 do %d.”, n); return; end if;
if ¢ = 7”r” then
add((—1)"(i+k)*A[i,k]*xdet (DeleteRow (DeleteColumn(A,k),i)), k=1..n)
elif ¢ = 7”s” then
add((—1)"(i+k)*A[k, i]*xdet (DeleteRow (DeleteColumn(A,i),k)), k=1..n)
else printf(” Treti parametr musi byt pismeno r nebo pismeno s.”); return;
end if;
end proc:

V proceduie je pouzito nékolik piikazi z baliku LinearAlgebra, ktery je na zacatku
,hacten (pouze pro potieby procedury!). Témito piikazy jsou RowDimension pro zjisténi
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poctu fadku (dimenze) zadané matice, DeleteRow a DeleteColumn pro odstranéni fadku,
resp. sloupce, zadané matice. Dalsimi pouzitymi piikazy (tentokrat jiz z hlavni knihovny Ma-
plu) jsou add pro soucet prvku (zejména numerické) posloupnosti a printf pro formétovany
Vypis.

Aby nedoslo k uplnému vyhodnoceni a byl vidét Laplaceuv rozvoj, je pro determinant
pouzit neexistujici ,,piikaz“ det. Vyhodnotit ziskany vysledek a ziskat tak kone¢nou hodnotu
determinantu lze napt. posloupnosti piikazu eval pro vyhodnoceni a subs, jimz nahradime
fetézec det pitkazem pro vypocet determinantu, tj. napt. pouzit:

eval(subs(det = LinearAlgebra[Determinant], %));

nasledné po ziskaném rozvoji determinantu. Nazev baliku LinearAlgebra je pochopitelné
mozné vynechat, pokud jsme balik diive nacetli (piikazem with). Ukdzku pouziti piikazu
laplace nabizi obrazek 4.22.

2 -4 3 Rozvoj podle tietiho sloupce
A=|-1 1 o0 laplace( A, 3,"s")
- 2 -4
0 2 -1 3 det — det
02 -1 1
Rozvoj podle prvniho radku
laplace(A4,1,"1") eval( subs( det
- 11 = LinearAlgebra[ Determinant], %) )
2dez[ - } +4der[ - +3dez[ H -4
LinearAlgebra| Determinant|(A)
eval(subs ( det = LinearAlgebra| Determinant], %) ) -4
-4

Obrazek 4.22: Laplacetv rozvoj determinantu v Maple.

Poznamka 4.12: Prii ,ruénim“ vypoctu determinantu matice je tifeba znat nasledujici
pravidla:

e determinant trojuhelnikové matice se rovna souc¢inu jejich diagonalnich prvku,

e vymeénou poradi dvou fadki nebo sloupct matice se zméni znaménko determinantu na
opacné,

e vynasobenim néjakého radku nebo sloupce matice nenulovym skalarem k € C, se jeji
determinant zmeéni na k-nasobek puvodni hodnoty,

e pripoctenim skalarniho nasobku néjakého rfadku matice k jejimu jinému tadku, resp.
nasobku néjakého jejiho sloupce k jinému sloupci se hodnota jejitho determinantu
nezmenti.

Priklad 4.27: Urcete hodnotu determinantu matice A pomoci Laplaceova rozvoje, kde

7T 2 3 2
6 6 6 7
A= 8 10 9 10
5 7 3 3

Reseni: Ukazeme dva ruzné postupy.
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7232 = copy(C) :
_ 37— 11— 4. .
66 6 7 F[l] C[ 1—3-C[3]: F[2]=C[2]—4-C[3]:
A= F
8109 10 -2 -13 0
57 33 -5 -16 0
B = copy(4) : 5
B[2] = A[2] —2-4[1]: -
B[3]=A[3] —3-4[1]: _
B[4] :==A[4] —A[1]: d'=eval(subs(op(op(d)[2]) =F.d))
B -2 -130
7232 d=3det| | -5 -16 0
-8203 -2 51
-13 404
-2501 laplace(F. 3."s")
d -2 -13
d = laplace(B, 3, "s") “ -5 -16
-8 23
Jdet| | -13 4 4 'd'= eval(subs(op(d) [2] =%, d))
_ -2 -13
251 d=3dez[ . ‘15U
C:=oplop(d)[2])
-8 23
eval( subs( det= LinearAlgebra[ Determinant], rhs(%) ) )
-13 4 4 ~99
-251
Obrazek 4.23: Prvni feSeni piikladu 4.27.
7232
6 6 67
A=
8 10 9 10
57 33

Rozvoj podle prvniho fadku
d = laplace( A, 1,"t")

66 7 66 7 6 6 7 6 66
Tdet| | 109 10 || —2der| | 8 9 10 | | +3det| | 8 10 10 || —2det| | 8109
73 3 53 3 5 7 3 5 73

eval( subs( det= LinearAlgebra| Determinant |, %) )
-99

Obrdzek 4.24: Druhé teseni piikladu 4.27.

Prvni postup, prezentovany na obrazku 4.23, méa za cil napodobit prubéh ,ruéniho®

vypoctu. Kdyz se pozorné podivame na matici A, vSimneme si, ze ve tfetim sloupci jsou

vSechna ¢isla nasobky tti. Tj. vhodnymi fadkovymi ipravami d

ocilime ti{ nul v tomto sloupci,

aniz by se zménila hodnota determinantu matice (viz pozndmka 4.12). Pfed tpravami si
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vytvoiime kopii B matice A prikazem copy, abychom nepfrepisovali prvky puvodni matice.
Hledany determinant oznac¢ime pismenem d. V Laplaceové rozvoji ,zustane“ determinant
jediné matice typu 3 x 3, jiz oznac¢ime pismenem C'. Ackoli determinant matice fadu 3 uz
dokazeme spocitat ptimo, je mozné opakovat tentyz postup co pro puvodni matici A, ziskat
upravenou matici ' a jejim Laplaceovym rozvojem dospét k determinantu jediné matice
radu 2. Pti feSeni ¢asto vyuzivame piikazu op, abychom ziskali zddané operandy pfedchozich
vyrazu automaticky a nemuseli je rucné kopirovat.

V druhém ptipadé — obrézek 4.24 — vyuzijeme toho, ze systému Maple neni nutné piiklad
zjednodusovat , vytvarenim nul“ v matici a nechame vse na ném.

Priklad 4.28: Urcete hodnotu determinantu zadanych matic pomoci Laplaceova rozvoje:

10 1 -1 1 2 -1 0 2 1 -2 -1
20 1 =2 2 2 1 1 1 -1 -1 1
A= 3 3 -1 1|’ B = -1 1 2 3|’ ¢ 4 2 2 1
01 1 1 2 1 1 -1 8§ 1 1 2

Konjugovana matice

Definice 4.12: Matici A nazveme konjugovanou matici (resp. komplezné sdruzenou ma-
tict) k matici A s prvky a;;, jestlize matice A obsahuje prvky a;; pro vsechna 1, j, tj. jejiz
prvky jsou komplexné sdruzené k prvkum matice A.

Systém Maple nema piimo ptikaz pro vypocet konjugované matice, lze vsak vyuzit prikazu
conjugate pro zisk komplexné sdruzeného komplexniho ¢isla a map, jimz aplikujeme piikaz
conjugate na kazdy prvek matice. Zminéné lze provést téz pomoci kontextové nabidky, ktera
se objevi po kliknuti prvym tlacitkem mysi na matici — obrazek 4.25.

1 -I1+41
A= -I 1 0
1—-1I0 I
map(x — conjugate(x), 4) 1 -I1+1 1 I1-1
1 11-—1 71 0 complexconjugate' I 1 0
10 1—10 I 1410 -I
1410 -I

Obrdzek 4.25: Vypocet konjugované matice v Maple.

Pro komplexni matici dale zavadime tzv. hermitovskou transpozici. Hermitovsky trans-
ponovand matice je transponovand konjugovand matice. Pro tuto operaci poskytuje Maple
piikaz HermitianTranspose z baliku LinearAlgebra. Operaci je vSak mozné provést téz
pomoci kontextové nabidky po kliknuti pravym tla¢itkem mysi na matici, pripadné zédpisem
AP kde A je dana matice. Ukdzku pouziti a rozdilu mezi obyéejnou a hermitovskou trans-
pozici poskytuje obrazek 4.26. Jelikoz (AT)T = A pro matici A, lze vyuzit také hermitovské
transpozice pro zisk konjugované matice.
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1 <I141
A4=| -1 1 0
1—10 I
A" 1 I1-I
L 11 R .
-7 1 0 |— -I 1 0
11 0
1410 I 1-10 I 1+10 1
A%H
1 IT141 1 1141
1 TI1+41 71 0 hermitian transpose I 1 0
I 1.0 1—10 I 1-10 -I
1—10 -I

Obradzek 4.26: Hermitovska transpozice matice v Maple.

Piiklad 4.29: Uvazujme matice z piiklad 4.23 a 4.24. Ovéite, ze plati pro X € {A, B,C, F'}:

x|~ T¥

4.2 Linearni zobrazeni

Definice 4.13: Nechf U,V jsou vektorové prostory nad K € {R,C}. Rekneme, ze
@ : U —V je linedrni zobrazent, jestlize pro libovolna x,y € U a a,b € K plati:

pla-x+b-y)=a-p(x)+b-p(y).

Piiklad 4.30: Zjistéte, zda je f: R3 — R2, f(x) = (1 + 21, 29)7 linedrn{ zobrazeni.

Resend: Systém Maple neumoziiuje vytvareni vektorovych funkef v pravém slova smyslu.
Lze vsak vytvorit jakysi ,mezistupen“ skalarni a vektorové funkce zapisem vzoru jako po-
sloupnosti prvkua (v kulatych zédvorkach) a obrazu ve formé vektoru. Obrazek 4.27 poskytuje
postup feSeni. Vlevo byly vypisovany vSechny prvky vzoru jednotlivé, vpravo bylo pouzito
oznaceni a prikazu, aby postup odpovidal praci s vektorem. Z tohoto duvodu je v poslednim
prikazu vytvéren seznam pouzitim hranatych zévorek a jeho ,odstranéni* (tj. prechod zpét
k posloupnosti proménnych) piikazem op. Namisto pfikazu map je vpravo operator ~ apli-
kujici predchozi operaci na kazdy prvek pole (tj. vektoru, seznamu, ...). Jak z obrdzku 4.27
vidime, zobrazeni f neni linearni.

Piiklad 4.31: Zjistéte, zda je f : R® — R? linedrni zobrazeni, pficem?z
a) f(x) = (z1 + z9, 11 — 13)7T,
b) flz)=(1,2)7,
c) f(z)=(a%, -2 22)".
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fi= (xl,x2.x3) — {1 +xI,x2) x:=2(1.3)

(x1,x2,x3) —=(1 +xI,x2 xl, x2,x3
y=yl(1.3)
flax]+b-yl,ax2+b-y2,a-x3+b-y3) vl y2, v3
1+axlI+byl

g = unapply( {1 +x1,x2).x)

axZ+by2 (x1.x2.x3) —rable(1.2, {1=1+x1,2=x2},
af(x1,x2,x3) + b-f(y1,y2,y3) datatype = anything, subtype= Vector__, . . storage
a(l+xI)+b(1+yl) ‘ = rectangular, order = F om'an_arder)
ax2+by2
map(x—expand(x). %) expand~(a-g(x) +b-g(y))
ataxl+b+byl ataxl+b+byl
ax2+by? ‘ ax2+by2

glop(a-~[x]) +op(b-~[y])) # glax+b-y)
l4+axl+byl
ax2+by2

Obrdzek 4.27: Reseni pitkladu 4.30.

Priklad 4.32: Dokazte, ze derivace redlného polynomu tietiho stupné je linearni zobrazeni.

Definice 4.14: Necht U,V jsou vektorové prostory nad K € {R,C}, p : U — V je linedrn{
zobrazeni. Jddrem zobrazeni ¢ nazyvame mnozinu

Ker(p) = ¢~(0) = {z € U | p(z) = 0}.

Obrazem zobrazeni ¢ nazyvame mnozinu

Im(p) = @(U) = {p(z) | z € U}.

Poznamka 4.13: Mnozina Ker(y) je vektorovy podprostor prostoru U a mnozina I'm(p)
je vektorovy podprostor prostoru V.

Definice 4.15: Bijektivni linedrni zobrazeni ¢ : U — V nazyvame linedrnim isomorfis-
mem. Rekneme, ze vektorové prostory U,V jsou isomorfni, a piseme U = V| jestlize existuje
néjaky (linedrnf) isomorfismus ¢ : U — V.

Poznamka 4.14: Linearni zobrazeni ¢ : U — V je isomorfismus pravé tehdy, kdyz
Ker(p) = {0}, Im(p) = V.
4.2.1 Matice linearniho zobrazeni

Definice 4.16: Necht U,V jsou vektorové prostory konecné dimenze nad K € {R,C}
s bazemi o = {uy,...,u,} v U a = {vy,...,0,,} ve V, kde m,n € N. Matici linedrniho
zobrazeni ¢ : U — V vzhledem k bazim «, f nazyvame matici

A= (p(u1)g, - p(un)p) € K™,
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jejiz sloupce tvori soutadnice obrazu p(u;),i = 1,...,n vektoru baze « vyjadrené v bazi [.
Tato matice se znadci téz:

A= (90)5704'
Jestlize ¢ : U — U, piSeme pouze:

A= (90)04'

Tuto matici nazyvame matici linedrni transformace.

Piiklad 4.33: Zapiste matici linedrniho zobrazeni f : R* — R? s bdzemi o € R? a 3 € R2,
fx)=(r1+2 29 —3 23,2 21)", kde

a) a=c; B =e,
b) @ = {(1.2,0)7,(-2.1,0)7. (8,1, ~1)7},8 = {(2. )", (0.2)"}.
Resent:
a) Z definice 4.16:
A= (Fe0)en Fle2)ea: fle)ea) = (£((1,0,007),, £ ((0,,0)7) . £ (0.0.1)7), ).
Ze zadan{ potom mame:

F((1,0,007) = (1,2)", £ ((0,1,0)") = (2,0)", f ((0,0,1)") = (=3,0)".

Vzhledem k tomu, ze f(e;)., = f(e;) pro i = 1,2,3, muzeme rovnou psat:
1 2 -3
A= (2 0 0 ) ’
b) Opét z definice 4.16:
A= (F(1,2,07),,F ((-2,1,07),./ (3.1,-1)7),)
Ze zadani mame:

f((1,2,007) = (5,.2)", f ((-2,1,0)7) = (0,—4)", £ ((3,1,—-1)") = (8,6)".
Narozdil od piipadu (a) musime ziskané obrazy prevést do baze 3, tj. najit jejich

soutadnice v této bazi. K tomu lze vyuzit piikaz LinearSolve, jak jsme jej pouzili i
drive — obrazek 4.28. Ziskané soutadnice nasledné zapiseme do matice podle definice:

5 0 4
— 2
A‘(—% 2 1)'
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with( LinearAlgebra) : fie, = (0, —4):

o= (2,1 v, = (0,2): . y :
v = (2.1) vy = (0.2) fu, = LmearSoh’e(B,fu,)) # souradnice fu, v
B:= M’azrir{ [v » v,}]) # vektory baze B 2 i i

20
12

ful = {5.2) . fu3 e (8_6) .
fulB = LmearSafve(B,ﬁ:l] # souradnice fu, vp fu3B = Lz’nearSofve(B_.fuﬂ # souradnice fit, v p

y

h.J|u|

Obrazek 4.28: Nalezeni soutradnic vektoru v piikladu 4.33.(b).

Priklad 4.34: Uvazujme linedrni zobrazeni f : R* — R*, kde
flx) = (x1+ 22+ 23+ 24, —T1 — To — Ty — Ty, X1 — To + T3 — Ty, —T1 + T2 —x3+x4)T.

Urcete Ker(f) a Im(f).
Reseni: Nejprve nalezneme matici linedrniho zobrazeni f. Jelikoz nebyla zaddana zadna
baze, muzeme uvazovat standardni bazi e4 prostoru R*. Ziskdme tak matici:

11 1 1
-1 -1 -1 -1
A= 1 -1 1 -1
-1 1 -1 1
Systém Maple disponuje piikazem NullSpace z baliku LinearAlgebra pro nalezeni baze
tzv. nulového prostoru matice, tj. jadra prislusného zobrazeni. Dale mame k dispozici piikaz
ColumnSpace z téhoz baliku, ktery vypise bazi vektoru zapsanych ve sploupcich dané matice,

tj. bazi obrazu zobrazeni. Piislusné mnoziny (Ker(f) a Im(f)) pak tvori linearni obaly
nalezenych béazi. Nalezeni bézi prostort Ker(f) a Im(f) je uvedeno na obrazku 4.29.

Piiklad 4.35: Zjistéte, zda je nize uvedené zobrazeni f : R" — R™ n € {2,3} linedrni.
Pokud ano, najdéte Ker(f) a Im(f). Je f isomorfismus?

a) f(z,y) = (2,97,
b) flz,y)=(2-2+3 yz—y)",

c) flz,y,2) = ((v +y)* 2 —y,a +y+2)",
) f(

d r,y,2)=(—-2-y+2,2-2—y+23-y—2z7~

Poznamka 4.15: Necht U,V jsou vektorové prostory koneéné dimenze nad K € {R,C}
s bdzemi o v U a 3 ve V. Necht ddle ¢ : U — V je linedrni zobrazeni, A jeho matice. Pak
pro vSechna u € U plati:
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with( LinearAlgebra) : NullSpace( A)
A::.-’Lfazrir([[l_. 1, 1:1]:[_1:_1:_1:_1]: 0 -1
[1:_1: 1:_1]:[_1: 1:_1:1]]) _1 O
11 1 1 \
o] 1
-1 -1-1-1
1 0
1-1 1-1
-1l ColumnSpace( A)
1 0
-1 0
o] 1
0 -1

Obrazek 4.29: Nalezeni bézi prostoru Ker(f) a Im(f) v prikladu 4.34.

Priklad 4.36: Naleznéte matici linedrniho zobrazeni f : R? — R2 jestlize f(1,1) =
(2,-1)T, f(1,-1) = (2,1)T. Aplikaci poznamky 4.15 ovéite, Ze A je skuteéné matici zobra-
zeni f.

Resend: V zadéni nebyla specifikovdna béze prostoru R2, ¢ili uvazujeme standardni bazi
€9. Pro vytvoteni matice A linearntho zobrazeni f potfebujeme najit obrazy vektoru béze
g9, f(1,0) a f(0,1), které tvoii sloupce matice A. Jelikoz f je linedrni, plati:

S(f(L 1)+ f(1,-1)) = (2,0)7,

£0,0) =3

) (f(lv 1) - f(17 _1)) = (07 _1)T'
2 0
)
Rovnost z poznamky 4.15 prechézi do tvaru:

(f(u))82 =A-(u),=A4A u.

Oveéreni provedeme v Maple — obrazek 4.30.

20
A
0 -1

S

Obrazek 4.30: Ovéreni spravnosti nalezené matice v prikladu 4.36.

N | —

f(OaD =

Matice A je proto rovna:

Priklad 4.37: Naleznéte matici linedrniho zobrazeni f : R3 — R* jestlize f(1,1,0) =
(0,0,0,0)T, f(1,0,1) = (1,0,1,0)7, £(0,1,1) = (0,1,0,1). Aplikaci poznamky 4.15 ovéite,
ze A je skutecné matici zobrazeni f.
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Priklad 4.38: Nechtf €3 je bdze prostoru R3 a 3 = {(1,3)%, (=1,4)T} je baze prostoru R?,

matice
1 3 2
A= (—2 5 o)

je maticf linedrniho zobrazeni f : R® — R? vzhledem k bdzim e3, 3, tj. A = (f)ge,. Urcete

(f(L 3, 5))57 (f(27 0, _2))5‘

Piiklad 4.39: Je ddna matice A linedrniho zobrazeni f : R? — R2. Jaky je geometricky
vyznam tohoto zobrazeni? Znézornéte graficky.

2 4= (0 7)
b) A= (é —01>’
¢) A= (g g)

Piiklad 4.40: Najdéte matici A linedrniho zobrazeni f : R — R™ n € {2,3} tak, aby
jeho geometricky vyznam byl nasledujici:

a) projekce na osu y v R?

b) osovéa symetrie kolem osy y v R?,

c¢) kolm4 projekce do osy x v R3,

d) kolm4 projekce do roviny tvoiené osami y, z v R?,
e) otoceni o 30° kolem osy x v R?.

Znézornéte graficky.

4.2.2 Matice prechodu

Definice 4.17: Necht V je vektorovy prostor koneéné dimenze n € N nad K € {R,C} a
a = {uy,...,u,}, B = {v1,...,0,} jsou jeho dvé baze. Matici prechodu z baze [ do béze «
nazyvame matici identického zobrazeni idy : V' — V vzhledem k bazim S, a:

(Zdv)a’ﬁ 9

pro jejiz prvky a;;(j € {1,2,...,n}) plati:

Pozndmka 4.16: Podle definice 4.16 jsou sloupce matice (idy), 5 z predchozi definice

Q,

tvofeny souradnicemi vektoru baze [ v bazi a. Pro libovolné x € V navic plati:

(#)a = (idy), 5 (7).
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Poznamka 4.17: Necht V je vektorovy prostor koneéné dimenze n € N nad K € {R, C},
¢V — V jelinearni zobrazeni a a = {uy, ..., u, }, 5 = {v1, ..., v, } jsou dvé béaze vektorového
prostoru V. Pak plati:

(©)s,s = (idv) g4 (P)aa - (idv), -

Navic, matice (idv), 4 a (idv),,, jsou navzdjem inverzni, tj.:

(idv)a,ﬂ - (ZdV),gla :

Poznamka 4.18: Necht ¢ : U — V je linearni zobrazeni, a1, oy jsou dvé baze vektorového
prostoru U, 1, By jsou dvé baze vektorového prostoru V. Pak plati:

(90)51,041 = (idV)ﬁIﬁQ : (90)5270@ ’ (idU)az,al :

Piiklad 4.41: Necht V = R3, o = {(1,0,0)7, (1,1,0)T, (1,1,1)T}, 8 = {(—1,1,0)7, (1,1,0)7,
(0,0,1)T} dvé baze prostoru V. Urcete matici prechodu od béaze o k bézi 3. Dale urcete
souradnice vektoru x v bazi 3, jestlize (x), = (—1,3,0)T.

Resend: K zapisu matice (idy) 5. POtIebujeme vyjadrit vektory baze a jejich souradnicemi
v bazi §. Nasledné postupujeme podle poznamky 4.16 — obrazek 4.31.

with( LinearAlgebra) : _ Uyg = LfnearSoi’ve(B: u3] # souradnice u, vp
uy :Zlﬂl,O,O): u, !:{},1,0}: Uy = tl'.l'-l:l): o
v ={-1.1, 0): v, = (L1, 0): v, = (0,0, 1p: .
B:= M’an‘ir( [v Ve 1’3] ) # vektory baze B 1
e id, = Matr 4 matice prechod
= M T . 7 "ec
110 .o cm‘fx( [“;5 g H35]) matice prechodu
1
001 ey 00
Uy 1= LinearSofve(B, Hl) # souradnice u, v % 11
_1 0 01
2
1 x ={-1.3,0):
3 .
0 = 7 = 1 '
X5 Id& S souradnice x v B
) 1
Uy = LinearSofve(B, ug) # souradnice u, v B3
0 5
1 2
0 0

Obrdzek 4.31: Reseni pitkladu 4.41.
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Priklad 4.42: Uvazujme prostor V = R3 s bazi o = {(1,0,0)7,(1,1,0)7,(1,1,1)}. Necht
@ : V' — V je linearni zobrazeni s matici v bazi o tvaru:

1 0 1
(Plaa=|(1 1 0
01 1

Urcete matici zobrazeni ¢ ve standardni bazi a najdéte jeho ptedpis.
Reseni: Vyuzijeme poznamky 4.17 — obrazek 4.32.

with( LinearAlgebra) : id = id !
up = (1,0,0): uy :=(1,1,0): uy:={1,1,1): o8 e
- 1 -1 0
CPM::AMGITH{[[LOJ]:[1:1:01:[0:1:1]]) 0 1-1
101 0 0 1
110 . _
011 Pee ™ e=ot'q)rxrx' o e
20 0
idazu:: .-’L{az}‘ix([uj, U, ug]) # souradnice otv € 11-1
111 01 0
011 , . .
001 O'((X2%:25) ) =@ - (X1 X2 X3)
) ) 2.‘(1
R e s B B
.'f3
). 2

Obrdzek 4.32: Reseni piikladu 4.42.

Piiklad 4.43: Urcete matici linedrniho zobrazeni ¢ : Rslxr] — Rslz], které polynomu
p(z) € Rs[z] ptifadi polynom 3 - p”(z) + 4 - p'(z) + p(z), a to:

a) v bazi a = {1, x, 2%, 23},

b) vbazi B={1+z,1— 22>+ 23 2% — 23}

Piiklad 4.44: Nechf V = R? s bazemi «a, 3. Najdéte matici piechodu od baze o k bazi 83,
jestlize

a) a={(-3,0,-3)",(=3,2,-1)", (1,6, -1)"}, 8 = {(-6,-6,0)", (-2, -6,4)", (-2, -3,7)"},
b) a={(2,1,1)7,(2,-1,1)7,(1,2,1)"}, 8 ={(3,1,-5)7, (1,1,-3)", (-1,0,2)"}.

Piiklad 4.45: Nechf ¢ : R? — R? je linedrni zobrazeni v bazich o = {(1,3)7, (—2,4)"},
B={(1,1,1)T,(2,2,007,(3,0,0)T} definované piedpisem

T1+ 219
T
-

? 0
Najdéte matici pfechodu od baze a k bézi 3 pro zobrazen{ ¢, tj. (),

’a.
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4.3 Afinni geometrie

4.3.1 Afinni prostory

Definice 4.18: Afinnim prostorem A = A(V') nad vektorovym prostorem V' rozumime
trojici (A,V,+), kde A je mnozina, jejiz prvky nazyvame body, V je vektorovy prostor
(ktery nazyvame zamérenim afinniho prostoru) a + je zobrazeni, jez bodu a vektoru prifadi
bod. Pro zobrazeni + : A x V' — A a libovolny bod A € A a vektory u,v € V pritom plati:

1. A+ 0= A, kde 0 zna¢i nulovy vektor,
2. A+ (u+v)=(A+u)+v,

3. VA,B e A:dlw eV tak, ze A+ v = B. Tento vektor zna¢ime B — A.

Poznamka 4.19: Dimenzi afinniho prostoru A = A(V) rozumime dimenzi vektorového
prostoru V. Afinnim prostorem dimenze 0 je bod. Afinnimu prostoru dimenze 1 fikame
primka, afinnimu prostoru dimenze 2 fikdme rovina. Podprostoru dimenze n — 1 v afinnim
prostoru dimenze n tikame nadrovina.

Definice 4.19: Afinnim podprostorem B = B(U) afinniho prostoru (A, V,+), kde B C A
a U je vektorovy podprostor prostoru V', nazveme trojici (B, U, +), pokud pro libovolny bod
B € B a vektor u € U plati, ze B+ u € B a pro libovolné A, B € B existuje vektor u € U
tak, ze u = B — A.

Poznamka 4.20: Afinni podprostor B = B(U) lze zapsat pomoci libovolného bodu B € B
jako mnozinu B= B+ U ={B+u | u € U}. Necht U je vektorovy prostor dimenze n nad
K € {R,C} s bazi {uy,...,u,}. Libovolny prvek = € B pak muzeme jednoznacné vyjadrit
jako

i=1

kde k; € K pro i =1,...,n. Toto vyjadieni se nazyva parametrické vyjidreni nebo paramet-
rickd rovnice podprostoru B.

Poznamka 4.21: Afinni podprostor B = B(U), kde U je vektorovy prostor dimenze n nad
K € {R,C}, muzeme zapsat téz pomoci soustavy linearnich rovnic

B={x]| A -x=5b},

kde A je matice typu m x n nad K™, m € N, b € R". Toto vyjadieni se nazyva obecnd
rovnice podprostoru B.

Definice 4.20: Necht B = B(U),C = C(W) jsou dva podprostory afinntho prostoru A(V).
Rekneme, ze podprostory B,C jsou rovnobézné, pokud U C W nebo W C U. Rekneme, ze
podprostory B, C jsou riznobézné, maji-li alespon jeden spoleény bod, ale nejsou rovnobézné.
Rekneme, ze podprostory B,C jsou mimobéiné, nemaji-li zadny spoleény bod, a soucasné
nejsou rovnobézné.
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Priiklad 4.46: Urcete parametrickou rovnici afinniho podprostoru B vektorového prostoru
R* zadaného soustavou rovnic B = {x | A-z = b}, kde

11 -1 1 9
A:(1 -1 1 —1)’ b:<—3)'

Reseni: Staci nalézt feseni systému A -z = b, a to zapsat ve tvaru uvedeném v poznamece
4.20. V Maple k tomu pouzijeme piikaz LinearSolve z baliku LinearAlgebra. Pokud chceme
rovnici zapsat tak, aby byl ,viditelny“ soucet bodu a jednotlivych vektoru prislusného vek-
torového prostoru, je tteba zamezit secteni odpovidajicich si slozek napi. pouzitim dvojitého
zpétného apostrofu. Souradnice bodu a jednotlivych vektoru pak ziskame jednak vhodnym
vyhodnocenim nalezeného feseni, respektive urcenim koeficientu u vytvorenych parametru.
Postup je uveden na obrazku 4.33.

with( LinearAlgebra) : Vector(4, symbol=x) =res
A= ‘k{an‘ﬂ:([[lr 1:_1:1]:[1:_1: 1=_1]]) xl 3
boi-td . 6+1,—1,
1 -1 1-1 2| _
b= (9,-3) 3 3
9 X, t,
-3
Vector(4, symbol=x) exaf res, [IS = ]
res = LinearSolve( 4, b, free=1") +1, ‘ (map(coeff res. t 1))
3 t+i,- (map(cocff res. t,; 1))
6+1, —1 ¥
P ! 0 0 3
£ %) 1 -1 6
=t +1 +
I n| |1 4 0 0
x, 0 1 0

Obrdzek 4.33: Reseni piikladu 4.46.

Piiklad 4.47: Urcete obecnou rovnici afinniho podprostoru B vektorového prostoru R*
zadaného parametrickou rovnici:

1 1 1 1

0 —1 2

x:P+t1'U1+t2'u2: i2 = 9 + 1 0 D) 0
3

Ty 2 0 —1

Resent: Hleddme matici A a vektor b tak, aby Feseni rovnice A -z = b bylo rovno zadané
parametrické rovnici. Parametricka rovnice ma dva parametry, takze dimenze afinntho pod-
prostoru je rovna dvéma. Proto A md hodnost rovnu dvéma (tj. ma dva linedrné nezavislé
radky).

Staci tedy najit dvé linedrné nezavislé rovnice v proménnych zy, ..., x4 vyhovujici za-
danému feseni. Zpusobu, kterymi tohoto 1ze dosdhnout, je nékolik. Jednim z nich je upravit
blokovou matici (uq,ug, P, E), jez odpovida rovnici ty - uy +tg - ug + P = E -z (kde FE je
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jednotkova matice), na schodovity tvar a z fadku, v nichz dostdvame nuly pro parametry
t1 a ty, ,precCist* matici A a vektor b - obrazek 4.34. Jak si muzeme vSimnout, matice A
a vektor b nejsou dany jednoznacné. Stejné feSeni ma mimo jiné také libovolny nenulovy
nasobek rovnice A - x = b.

with( LinearAlgebra) : Marrix([U, P, E])
P:=1{1,0,2,2) 1 111000
1 -1 200100
0 0 020010
2 0-120001
2
res ‘= GaussianElimination( Matrix( [ U, P, E] ),
U:=((1,-1,0,0)[(1,2,0,-1)) 'method'="FractionFree')
11 11110 00
-1 2 03111 00
0 0 00600 30
0-1 00022 -76
E = Matrix( 4, shape= identity) A=res[3.4,4.7]
1000 00 30
0100 22 -7 6]
0010 bi=res[3.4,3]
0001

Obrdzek 4.3/: Reseni piikladu 4.47.

Piiklad 4.48: V prostoru R* vysetiete vzajemnou polohu podprostorii:

a) m:3-x1+x2+2-23=55-11 —x+ 214 =3,
pil’1+5'l’2—4'$3:—3,2'1’2—$3+$4:—2,

b) praxy+2-29—x3=1,21+x3+2 24 =3,
p:(3,-1,0,007 +¢-(=3,2,1,1)7.

eni:

Res
a) Nejprve zjistime, zda maji zadané podprostory spoleény bod. Resime tedy systém
(v8ech) ¢tyf rovnic o ¢tyfech neznamych. Ziskdme jediné feseni. To znamen4, Ze roviny
T a p jsou ruznobézné.

b) Opét se pokusime najit spoleény bod. Soutradnice z parametrické rovnice piimky p do-
sadime do rovnice roviny p. Z pouhého vyhodnoceni vidime, ze rovnici roviny vyhovuje
kazdy bod piimky (pro libovolné ¢). To znamend, ze piimka p lezi v roviné p.

Piiklad 4.49: V prostoru R? najdéte piicku mimobéZzek
. _ T T ) _ T T
pp+t1 “Up = (37373) +t1 : (27271) ) q: Q+t2'u2 - (0757_1) +t2 (17171> )

kterd prochézi bodem A = (4,5,3)". Zobrazte graficky.
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rovnice := {3-x1 +x2+2-x3=5: X, =3 =31 x, =-14+21t: X = rIX ST

2
5.0, +2-x=3, x; +5-x, —4-x3=-3. |rovnice = { X, +2-x, —x =1,

273
2-x2—x3+x4=-2}: x1+x3+2-x4=3}:
solve(rovnice) rovnice

{x1=1,x2=0,x3=1,x4=—1} {1=1,3=3}

Obrdzek 4.35: Redeni piikladu 4.48, a) vlevo, b) vpravo.

Resent: Ukdzeme si dvé rizné feseni, jak dospét ke grafickému zndzornéni. V obou
pripadech budeme vychéazet z toho, ze hledand pricka musi lezet jak v roviné tvofené primkou
p a bodem A, tak v roviné tvorené piimkou ¢ a bodem A. Tedy pricka mimobézek bude
prunikem téchto dvou rovin.

1. Klasicky vypocet.
Vytvorime body a vektory. Zapiseme parametrické rovnice diive uvedenych rovin (po-

moci rovnice piimky a vektoru spojujicim bod pfimky s bodem A). Prunik rovin je
roven TeSeni rovnosti jejich parametrickych rovnic — viz obrazek 4.36.

with( LinearAlgebra) : Soi’ve( [Seq(pl [i]=p,[7].i=1.3 ) ])
u = (2,2,1):u, = (1,1,1): -

{51=—5—453:57=S,_.z1=—4—45,,:r7=0}
P:=1[3,3,3]: 0:=[0,5,-1]: 4:=[4,5.3]: v e

Uy, U, = Vector(P — A). Vector(Q — A) assign( %)
Pi=P
_1 _4 &
-2 0 _452 _452
-4 5 — 3
-1 —452 -1 —452
P, = Vector( P) +5puy 1
3—s5 +21 Vector( [x, ). z]) =emg(p2: [52=0])
325 +21 +52-”(ma_p(cocfﬁp2__.52:1))
3+1 X -4 0
y|=5, o+ 5
p, = Vector(Q) + s, uy + t,-u, z B .
-4s, +,
541,
-1—4s,+1,

Obrdzek 4.36: Reseni pitkladu 4.49.

Piimky zadané parametricky mtzeme v prostoru zobrazit napiiklad piikazem spacecurve
z baliku plots. Na obrazku 4.37 je pro jednoduchost u vSech piimek pouzity parametr

t (coz nicemu nevadi). Kazdou z primek reprezentujeme jednim piikazem spacecurve,
pricku vyznacime ¢ervené a ¢erchované. Zobrazime ji jako tsecku spojujici ptimky p a

q. Pro nézornost jesté vykreslime i bod A ptrikazem plot3d jako ¢ernou tecku.
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restart

with( plots) :

pl = spacecurve([3 +2-1,3 +2-1,3 +¢].t=-3 .2, axes=frame, color= blue) :

p2 = spacecurve( [ t, 5 +1,-1 +t].1=-3 .2, axes = frame, color = green) :

p3 = spacecurve([1 —4-1,5,-4- t],1=-1..0.25, axes= frame, color = red, linestyle= dashdot) :

p4 = plot3d([4,5.3].x=-5 .5, y=-5 .5, style=point, axes= frame, labels= [ "x", "y", "z"],
symbolsize= 20, color= black) :

display(p|| (1 .4), orientation= [ =15, 80,6])

Obrazek 4.37: Grafické znazornéni FeSeni piikladu 4.49.

2. UZit? baliku geom3d.

Systém Maple nabizi balik geom3d pro (Euklidovskou) geometrii v trojrozmérném pro-
storu. Pomoci néj muzeme definovat body, ptimky, roviny apod., s kterymi je mozné
dale pracovat (vykreslovat je, zjistovat jejich vlastnosti, ...). Nac¢teme proto balik a vy-
tvoiime vSe potiebné. Body zavadime piikazem point, piimky piikazem line, roviny
piikazem plane. Pro informace o pfesné syntaxi piikat odkézeme Ctenafe na stranky
napovédy systému, kde je vSe podrobné a piehledné popsano. Upozornéme pouze, ze
napiiklad vektor je nutné zadavat jako seznam (a ne datovy typ Vector).

Po vytvoreni rovin muzeme pouzit prikaz intersection k nalezeni jejich pruniku.
Piikazem Equation muzeme nésledné zobrazit rovnici ziskaného objektu, tj. hledanou
rovnici pricky. Objekty zobrazime piikazem draw. Abychom piicku zobrazili pouze jako
usecku spojujici ptimky p a g, vytvorime ji piikazem segment. Vice na obrazku 4.38.

Priiklad 4.50: Urcete parametrickou rovnici afinniho podprostoru B vektorového prostoru
R® zadaného soustavou rovnic:

$1+2'$2—$3+I5 1
2'1’1+4'3§’2+5E4—.’L‘5 = 4.

Piiklad 4.51: Urcete parametrickou rovnici roviny, v niz lezi body A = [0,2,1],B =
[—1,3,2] a C' = [4,—1,3].

Piiklad 4.52: Lezi bod K = [3,2,0] v roviné obsahujici bod A = [2, 1, 5] a pifimku ur¢enou
bodem B = [2, —1,2] a vektorem u = (1, 3, 3)T? Zobrazte téz graficky.
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restart pl i==draw( (s, p. ql, color=[red, blue, green|,

with( geom3d) : axes = frame, labels= [ "x", "y", "z" ], linestyle
u = [2.2, 1]:w,=[1,1,1]: = [ dashdot, solid, solid]) :

point(P, [3.3.3]) : point(Q. [0,5.-1]) p2 = plot3d( coordinates(A), x=-5 ..10, y=-10
poz’m(./i- [4' 5.3]): T .7, style= point, axes = frame, labels = [ "x",

"y, "z" ], symbolsize = 20, color= black) :
plots| display] ( pl. p2, orientation=[ -15,80,6])

4
plane(pl, [p.pA]): ]
plane(p2, [g,94]) : o /
!
imersecrion(r: pl. p2 ] : “ ::1: -
Equation(r,t') -6
[1—41,5, -41] 8]

segment|( s, intersection(Pr,p.r).

intersection( Qr, g.r) ) : A

Ly

H 0

Obrdzek 4.38: Reseni piikladu 4.49 pomoci baliku geom3d.

Piiklad 4.53: Urcete obecnou rovnici afinniho podprostoru B vektorového prostoru R®
zadaného parametricky:

B =(2,0,1,0,0)" +¢,-(1,0,5,0,2)" +t5-(—1,0,-1,2,0)" +t5-(-2,1,0,0,0)".

Piiklad 4.54: Urcete obecnou rovnici roviny, v niz lezi body A = [2,-2,1], B = [1, —1,4]

a C=1[0,0,1].

Piiklad 4.55: V prostoru R? najdéte piicku mimobézek
prPttiu=(1,2-1)"+t(1,-1L1)", ¢:Q+tz us=(0,9,-2)" +t5-(1,0,0)"

ve sméru uz = (1,2,0)7. Zobrazte graficky.

Priklad 4.56: V prostoru R?, resp. R3, vysetiete vzajemnou polohu podprostoru (¢ € R):
a)p:3-x+4-y=20, q:z=4—-8-t,y=2+6-1,

b) p:(zy)’ =(2,-9" +t-(L-1)" q:(z.y)" =QQ,-1)" +¢-(52)
c)p:rx=3—-6-t,y=—-1+4-t,z=1t, q:x=-2+3-t,y=4,2=3—1.

Vse zobrazte téz graficky.

4.3.2 Afinni zobrazeni

Definice 4.21: Afinni zobrazeni mezi afinnimi podprostory M = M(U),N = N (V) je
zobrazeni ¢ : M — N tvaru
O(M +u) =N+ p(u),

kde M e M,N e N;u e U ap:U — V je linedrni.
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Poznamka 4.22: Necht M = R", N = R*, kde k,n € N. Pak zobrazen{
p(x) =A-z+0,

kde A je matice typu k x n a b = (by,bs,...,bx)T, je afinni, nebot ¢(z) = A -z je linedrn{
zobrazeni, tj.:

p(0+2)=b+A-x.

Definice 4.22: Necht ¢ : M — A je afinni zobrazeni. Je-li ¢ bijekce, pak nazyvdme ¢
requldrnim afinnim zobrazenim, resp. afinitou.

Priiklad 4.57: Najdéte obecnou rovnici piimky ¢, ktera je obrazem piimky p: z—y+3 =0

v afinité
é T\ T —y+2
y) \-2-z+3-y—1)"°

Resent: Piiklad mtzeme vyfesit napiiklad tak, Ze najdeme obrazy dvou bodu pifmky
p v afinité ¢ a z téchto dvou obrazu sestrojime primku g. Mezi body lezicimi na piimce p
jsou napiiklad body [0, 3] a [—3, 0], jejichz obrazy oznac¢me jako Q)1 a Q2. Postup v Maple je
uveden na obrézku 4.39.

x—y+2 g =ax+by+e=0:
0= xy) = —2-x+3-v—1]:
) y rl == evaf(g_. {x=Q1[1],y=Q1[2]})
~a+8b+e=0
=0(0,3
G =403 . r2 = eval(g, {x=0,[1].y=0,[21})
—a+5b+e=0
8 solve( {rl,r2})
{a=e, b=0,c=¢c}
0, =6(-3,0) assign( %)
-1 ci=1:
g
3 x+1=0

Obrdzek 4.39: Reseni pitkladu 4.57.

Priklad 4.58: Napiste predpis afinniho zobrazeni ¢, které je zaddano pomoci matice A
asociovaného linedrniho zobrazeni ¢ a bodu P = [1,0],Q = [3, 8], pficemz ¢(P) = Q,

A:@ —51).

Regeni: Zadefinujeme zobrazeni ¢, v jehoz predpisu zndme matici A. Vektor b uréime
tak, aby ¢(P) = @, viz obrézek 4.40.

Piiklad 4.59: Urcete ptredpis afinntho zobrazeni ¢, které zobrazi bod M = [0, 1] na bod
N = [-3,3] a vektory u; = (1,2)T,v; = (1,0)" po tadé na vektory uy = (=7, —-2)7,v; =
(1,-2)T.
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2 solve([Q[1]1=¢P[1],0[2]=0P[2]])
A4=1. 5 | {b[1]=1,b[2]=5}
P=[1.0]:0=[3.8]: assign(%)
o= (xy) = Ax,» + (bl, EJE}: vy
o(x.y) = -

¢P:¢{l.0} q_\"":?l"'\

2 +b,

3+b,

Obrdzek 4.40: Reseni piikladu 4.58.

Priklad 4.60: Jsou dany afinity

f r\ _ (2-x—y+1 r\ [(x+4-y—1

y) "\ z+y+3 )0 I\y) T\ 242y )

Napisté predpis zobrazeni foga go f.

Piiklad 4.61: Urcete predpis afinniho zobrazeni ¢, které zobrazi bod M = [0,0] na bod

N =[1,—1] a piimky
pix+y—1=0, q:x—y—3=0

po tadé na piimky
prr—2-y+1=0, ¢@:2-z2+y+1=0.

4.4 Bilinearni a kvadratické formy

4.4.1 Bilinearni formy

Definice 4.23: Necht U, V jsou vektorové prostory nad K € R, C. Zobrazeni ¢ : UxV — K
se nazyva bilinedrni, jestlize pro kazdé u,u;,us € U, v,v1,v3 € V a a,b,c,d € K:

o(u,a vy +b-ve) =a-p(u,v1)+b-(u,vs),
olc-uy +d-ug,v) =c-p(up,v) +d- p(ug,v).

Bilinearni zobrazeni f : U x U — K se nazyva bilinedrni forma na U.

Definice 4.24: Necht o = {uy,...,u,} je bdze vektorového prostoru U. Matici bilinedrni
formy f: U x U — K nazveme matici A = (a;;), pro jejiz prvky plati:

aij = f(ui,uj) proi,j=1,..,n.

Pozniamka 4.23: Necht A je matice bilinedrni formy f : U x U — K v bazi a, u,v € U
vektory vyjadiené v této bazi. Pak:

flu,v) =ul - A-wv.
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Piiklad 4.62: Uvazujme bilinedarni formu f na R* zadanou soutadnicovym vyjadienim
vzhledem ke standardni bézi:

fr,y) =—x1 Yo+ o1 - Ys+ T2 Y1 + T2 Yo+ To-Ys — Tg - Ys + Ta - Ys.

Urcete matici této bilinearni formy ve standardni bazi.

Reseni: Matici bilinedrni formy mitizeme vytvofit pifkazem GenerateMatrix z balfku
LinearAlgebra. Ten generuje matice ze zadanych rovnic nebo vyrazi. Vystupem je matice
tvofena z levych stran rovnic a vektor utvofeny z pravych stran rovnic. Nas zajima pouze
matice, proto na konci piikazu uvedeme ¢islo 1 v hranatych zavorkach urcujici prvni z
vystupii. Rovnice v proménnych yy,...,y4 si vytvoiime pomoci piikazu map2 z bilinearni
formy f.

Piikaz map2 aplikuje proceduru s uvedenym argumentem na kazdy operand daného
vyrazu. V tomto piipadé tedy map2(coeff,f,u) aplikuje piikaz coeff, jehoz prvnim ar-
gumentem je bilinearni forma f, na kazdy prvek ,vektoru®“ (typové presnéji seznamu) u.
Vysledkem jsou koeficienty u jednotlivych souradnic ,,vektoru“ wu, tj. u z1, ..., z4.

Na zavér se muzeme vynasobenim vektoru u, matice A a vektoru v presvédcit, ze nalezend
matice je skutecné matici bilinearni formy f. Postup je uveden na obrazku 4.41.

with( LinearAlgebra) :
fi=yntaytontontyy—xuy
u=[seq(x[i].i=1.4)]: vi=[seg(y[i].i=1.4)]:

A = GenerateMatrix(map2( coeff. f,u). v)[ 1]

0-11 0
1 10 1
0 00 -1
0 01 0

Vector| row](u). A.Vector(v)
oy + (—xl -I—xz) »t (xl +x4]y3 + (x2 —xS] ¥

expand( %)
Bty ENy Ny v Tny gy

Obrdzek 4.41: Reseni piikladu 4.62.

Poznamka 4.24: Necht A je matice bilinedrni formy f : U x U — K v bdzi a. Pak pro
matici B téze bilinearni formy f v bazi § plati:

B=(id)} s+ A (id)a,p.

Definice 4.25: Ctvercové matice A, B fddu n se nazyvaji kongruentni, jestlize existuje
regularni matice P tadu n takova, ze:

B=PT. AP

Definice 4.26: Bilinearni forma f : U x U — K se nazyva symetrickd, jestlize pro kazdé
u,v € U plati: f(u,v) = f(v,u). Pokud pro kazdé u,v € U plati: f(u,v) = —f(v,u), nazyva
se bilinearni forma f antisymetrickd.

187



Poznamka 4.25: Necht A je matice bilinearni formy f: U x U — K v bazi a. Matice A
je symetrickd pravé tehdy, kdyz je symetricka bilinearni forma f. Analogické tvrzeni plati
pro antisymetrickou bilinearni formu.

Kazda bilinearni forma je souc¢tem symetrické a antisymetrické bilinearni formy. Pro jeji
matici A plati:

A_ (A+AT)+— (A— A7),

kde prvni s¢itanec odpovida symetrlcke ¢asti, druhy antisymetrické.

Piiklad 4.63: Uvazujme bilinedrni formu f na R? zadanou soufadnicovym vyjddienim
vzhledem ke standardni bézi:

flz,y)=x1-y1 —2-T2- Y2+ 3 -1 - Yo.

Urcete jeji souradnicové vyjddieni v bazi u; = (3, —1)T, uy = (1, -1)T.
Reseni: Vyuzijeme poznamky 4.24. Jeji rovnost nyni prechazi do tvaru:

B = (id)zﬂ cA - (id) g

Jinak budeme postupovat podobné jako v prikladu 4.62, viz obrazek 4.42.

with( LinearAlgebra) :
= lml—Ex»-I—x'»-l—S XYy
Z[ seq(x[i].1=1.2)]: v:= [seq(y[i].i=1.2)]
1= GenerateMatrix(map2(coeff. f,u). v)[ 1]
13
0 -2
id = ((3,-1)|(1,-1
= ((3D(L-1))
31
-1 -1
2ol
B=id" 4.id
B eff
-2 -8
-2 -4

(—Exl —?.xz}yl + (—le —4x2)y2
expand( %)

-2x ¥ 2}1 —Sxm ——Ixm

Obrdzek 4.42: Reseni piikladu 4.63.

Piiklad 4.64: Uvazujme bilinedrni formu f na R?® zadanou soufadnicovym vyjddienim
vzhledem ke standardni bazi:

fr,y) =21 -y1+2-22- Y2+ 222 - y3.
Urcete jeji souradnicové vyjddieni v bézi u; = (1,0,1)7,uy = (0,1, )T, uz = (1, 1,0)T.
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Piiklad 4.65: Pro nasledujici bilinedrni formu f na R3 uréete jeji symetrickou a antisy-
metrickou ¢ast:

flr,y) =2 21 -y2+4-22-ys+6- 25 y1.

Poznamka 4.26: Kazda symetricka ¢tvercova matice je kongruentni s néjakou diagondalni
matici. Tj. pro symetrickou matici A existuje reguldrni matice P tak, 7e D = PT . A . P,
kde D je diagonalni matice. Baze, v niz ma symetricka bilinearni forma diagonalni matici,
se nazyva poldrni bdze.

Pro diagonalizaci symetrickych matic ve smyslu pozndmky 4.26 nemé Maple zadny piikaz.
Podobné, jako jsme to udélali v pripadé Laplaceova rozvoje determinantu, si muzeme opét
vytvorit proceduru, ktera bude provadét ptislusny algoritmus.

Necht n € N je dimenze symetrické matice. Diagonalizaéni algoritmus spoéiva v sestaveni
blokové matice typu 2 -n X n, v jejiz horni poloviné je zadana symetrickd matice, ve spodni
poloviné je matice jednotkovéd (fddu n). Na blokové matici provadime Fadkové a sloupcové
elementarni tpravy tak, abychom v horni poloviné ziskali diagondlni matici (fadu n). Ve
spodni poloviné ziskame matici, jiz jsme v poznamce 4.26 oznacili jako P.

Zékladem algoritmu je vynulovani prvku mimo diagonalu zadané symetrické matice.
Pro prehlednost a zjednoduseni kodu vytvoiime dvé procedury — jednu pravé pro zminéné
,vynulovani®, druhou pro provedeni celé diagonalizace. V procedurach vyuzijeme piikazi
RowOperation a ColumnOperation z baliku LinearAlgebra pro fadkové a sloupcové tpravy
matice a piikazu SearchArray z baliku ArrayTools, kterym najdeme prvni nenulovy prvek
ve sloupci pod nulovym prvkem na diagondle, a NumElems z téhoz baliku pro zjisténi poc¢tu
prvki pole. Vstupem procedury diagonalizace je symetrickd matice, vystupem matice
diagonalni a matice P.

vynuluj := proc(A:: Matrix, radek:: posint, dim:: posint)

uses LinearAlgebra:

local i; for i from radek to dim—1 do
RowOperation (A, [i+1, radek], —A[i+1, radek]/A[radek, radek], inplace):
ColumnOperation (A, [i+1, radek], —A[radek, i+1]/A[radek, radek], inplace):

end do:

return A:

end proc:

diagonalizace := proc(A::( Matrix(square)))
uses LinearAlgebra, ArrayTools:
local 1, r, n, M, E;

n := RowDimension (A):
r := 1:
M := Matrix ([[A], [Matrix(n, shape = identity )]]):
while (r < n) do
if M[r, r] = 0) then l:=SearchArray(M[1l .. n, r], 1, location = first):
if (NumElems(1) > 0) then RowOperation(M, [r, 1[1]], 1, inplace):
ColumnOperation(M, [r, 1[1]], 1, inplace):
M := vynuluj(M, r, n):
r = r+1:
else r := r+1:
end if:
else M := vynuluj(M, r, n);
r = r+l
end if:
end do:
return M[1 .. n, 1 .. n], M[n+1 .. 2%n, 1 .. nJ:

end proc:
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Piiklad 4.66: Uvazujme bilinedrni formu f na R?® zadanou soufadnicovym vyjddienim
vzhledem ke standardni bézi:

flr,y) =221 - yo+2 20 -pn+4-21-ys+4-23-y1+6-22-y3+6- 23 yo.

Najdéte bézi 8 = {uy, ug, uz}, v niz méa f diagonalni matici.

Reseni: Vyuzijeme procedur vynuluj a diagonalizace. Predpokladejme proto, ze jsme
je jiz nacetli. Vytvorime matici bilinedrni formy, pouzijeme ptikaz diagonalizace a ziskame
jak diagonalni matici, tak matici P. Jelikoz P = (id). g (viz pozndmka 4.24), tak ve sloupcich
matice P najdeme vektory baze 8 = {uy, us, ug}. Jestlize chceme pouzit pismeno D napiiklad
jako nazev pro diagonalni matici, je tfeba piikazem unprotect zrusit vyhrazeni tohoto sym-
bolu pro diferencialni operator. Postup vypoctu je uveden na obrazku 4.43.

with( LinearAlgebra) :

=2 vy +2-xv +4-x v +4-x v
f x1}2+ r2}1—|—4 x1}3+4 r3}1+6r2}3+6r3}2

u= [seq(x[i].i=1.3)]: vi=[seq(y[i],i=1.3)]:

A = GenerateMatrix(map2(coeff. fru).v)[1] |p*T 4 p
024 4 0 0
206 0-1 0
460 0 0 -24
unprotect( D)
D, P := diagonalizace( A) B={P[..1],P[ ..2].P[ ..3]}
1
40 o' T2 ) —% 3
0-1 0], L _, B=1{|1 1 -2
0 0-24 2 ol | 2 1
0 0 1 0

Obrdzek 4.43: Reseni piikladu 4.66.

4.4.2 Kvadratické formy

Definice 4.27: Necht U je vektorovy prostor nad K € R,C. Zobrazeni g : U — K se
nazyva kvadratickd forma, jestlize existuje symetricka bilinedrni forma f : U x U — K tak,
ze pro vSechna u € U plati:

g(u) = f(u,u).

Poznamka 4.27: Symetricka bilinearni forma f : U x U — K z pfedchozi definice je
kvadratickou formou g : U — K urcena jednoznacné.

Definice 4.28: Matici kvadratické formy g : U — K nazveme matici symetrické bilinedrni
formy, kterd tuto kvadratickou formu urcuje.

Piiklad 4.67: Uvazujme kvadratickou formu ¢ na R? zadanou souifadnicovym vyjadienim
vzhledem ke standardni bazi:
g(x) = a1 - 29 + x9 - X3.
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Najdéte bézi 8 = {uy, us, us}, v niz mé g diagondlni matici.

Resent: Postupujeme takika identicky s fesenfm pitkladu 4.66. Jediny rozdil je v ziskani
matice prislusné bilinearni formy. Kdyz si uvédomime, co predstavuje Hessova matice, zjistime,
ze prave ji lze pouzit pro ziskani symetrické matice. Zavérem muzeme zapsat kvadratickou
formu v souradnicovém vyjadieni v bazi § — viz obrazek 4.67.

with( LinearAlgebra) : Plap
g::xl-x2+x2-x3: 1 0 0
A= VeczorCafcufus[Hessian][%, [xl_.xz, YS]J 0 _% 0
1
0 > 0 0 0 0
1 1
7 0 > B={P[ ..11.P[ ..2],P[ ..3]}
1
1 -
0 > 0 1 2 -1
B= 1 0
0 2 1
unprotect(D)
D, P := diagonalizace( A) 0
1
1 00 1 -—— -1
%l \
1 : g(¥)'= (¥ 23) D (3 1a:05)
0-—0 1 2 1 9
4 L0 gV =V~ »
0 0 0
0 0 1

Obrdzek 4.44: Reseni pitkladu 4.67.

Piiklad 4.68: UvaZzujme kvadratickou formu ¢ na R? zadanou soufadnicovym vyjadienim
vzhledem ke standardni bazi:

9<I>:2'$12—2'x1-J:2—|—2-x22—2~m2.x3+2.x32_

Najdéte bazi 8 = {uy, us, ug}, v niz mé g diagondlni matici.

Piiklad 4.69: Uvazujme kvadratickou formu ¢ na R? zadanou souifadnicovym vyjadienim
vzhledem ke standardni bazi:

g(x):x12+x32—2-x1-$2+2~x1-x3+10-x2~$3.
Najdéte béazi 5 = {uy, us,us}, v niz mé g diagondlni matici.
Poznamka 4.28: (Sylvestruv zdkon setrvaénosti) Kazdou kvadratickou formu g : U x

U — K na redlném vektorovém prostoru U dimenze n € N lze ve vhodné béazi vyjadrit ve
tvaru (pro p,r € N;r < n):
g(T1, ) =212+ 2 — it — e — 1

pricemz pocet kladnych, zapornych a nulovych koeficientu je nezavisly na volbé béze.
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Definice 4.29: Signaturou kvadratické formy g : U — K na realném vektorovém prostoru
U nazveme trojici (s4,s_, So), kde sy je pocet koeficientu z poznamky 4.28 rovnych 1, s_ je
pocet koeficientt z téze pozndmky rovnych —1 a sq je pocet koeficientu (taktéz z poznamky
4.28) rovnych 0.

Definice 4.30: Necht g : UxU — K je kvadraticka forma na realném vektorovém prostoru
U dimenze n € N. Rekneme, ze g je:

e pozitivné definitni, jestlize Yu € U \ {0} : g(u) > 0,

negativné definitng, jestlize Yu € U \ {0} : g(u) < 0,

pozitivné semidefinitni, jestlize Vu € U \ {0} : g(u) > 0,

negativné semidefinitni, jestlize Vu € U \ {0} : g(u) <0,

indefinitni, jestlize Ju,v € U \ {0} : g(u) > 0, g(v) <O0.

Pozndmka 4.29: Necht g : U x U — K je kvadratickd forma na redlném vektorovém
prostoru U dimenze n € N se signaturou (s, s_, sg). Pak g je:

pozitivné definitni prave tehdy, kdyz s, = n,

negativné definitni prave tehdy, kdyz s_ = n,
e pozitivné semidefinitnd prave tehdy, kdyz s_ = 0,
e negativné semidefinitni prave tehdy, kdyz s, =0,
o indefinitni prave tehdy, kdyz s, >0a s_ > 0.

Rozhodnout o definitnosti kvadratické formy muzeme ruznymi zpusoby. V Maple je nej-
jednodussi vytvorit matici kvadratické formy a tu otestovat piikazem IsDefinite z baliku
LinearAlgebra. Déle je také mozné kvadratickou formu zobrazit graficky, pripadné hledat
jejl minimum ¢ maximum.

Priklad 4.70: Uvazujme kvadratickou formu g na R? zadanou soufadnicovym vyjadienim
vzhledem ke standardni bézi:
(a) g(z) =z - x5,
(b) gx) =+ 22 +3 232 +4 -2 20 +2 21 - 23+ 2 X9 - T3,
(c) gx) =21> =2 2?2+ 23> +2 21 To+4 -2y 23+ 2 T - 13
Urcete jeji signaturu a definitnost.
Piiklad 4.71: Uvazujme kvadratickou formu g na R* zadanou soufadnicovym vyjadienim
vzhledem k néjaké bazi:
(a) g(r) = 21?2+ a0’ + 3%+ w2 +2- 21 Lo +4-21 T3+ 201 Ty + 4T T3+ 4T Ty + 20 T3 Ty,
(b) g(x) =3 232 +2 242 +4 -2 w4 +4 -2y T3+2 X0 T4+ 2 T3 2y,
(¢) g(x) =21 - 23+ 71 - 24

Urcete jeji signaturu a definitnost.
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4.5 Euklidovska geometrie

4.5.1 Skalarni soucin

Definice 4.31:  Skaldrnim soucinem na vektorovém prostoru U nad K € {R, C} rozumime
libovolnou symetrickou bilinearni formu na U, jiz ptislusna kvadratickd forma je pozitivné
definitni. Hodnotu této formy na u,v € U budeme znacit (u,v).

Poznamka 4.30: Skalarni soucin je mozné definovat na vektorovém prostoru U téz jako
bindrni operaci (,) : U x U — K, kterd kazdé dvojici vektort u,v € U ptifadi ¢islo (u,v)
tak, ze pro vSechny u,v,w € U a k € K plati:

o (u,v) = (v,u),
o (u+v,w) = (u,w)+ (v,w),
o (k-u,v)=k-(uv),
o u#0= (uu) >0

k znaéi ¢islo komplexné sdruzené k éfslu k. Pro k € R pritom plati: k = k.

Definice 4.32: Necht U = R", u = (uq, ..., up),v = (vq,...,v,) € U jsou libovolné. Stan-
dardnim skaldrnim soucinem na vektorovém prostoru U nad R rozumime zobrazeni dané

predpisem:
n
(u,v) = Zuz ;.
i=1

Priklad 4.72: Dokazte, ze standardni skalarni soucin z definice 4.32 odpovida definici 4.31,
tj. ze se skutecné jedna o skalarni soucin.

Definice 4.33: Necht U = R". Normou (resp. velikosti) vektoru v = (uy,...,u,) € U
vzhledem ke standardnimu skaldrnimu souc¢inu rozumime ¢islo:

[lull = v/ {u, u) =

Piiklad 4.73: Zjistéte, zda je zobrazen{ g : R? x R? — R, resp. g : R3 x R?* — R, skaldrnim
soucinem:

a) g(z,y) =x1-y1 +x1 - Y2 + To - Y1 + T2 - Yo,
b) gx,y) =4 21 -y1 +3-21 - y2+ 2 T2 - Yo,
C) g(x,y)22-x1-y1—xl-yg—xg-y1+x3-y3,

d) 9(%@):3'$1'y1—$1'y3+$3'yl+$3'ys-
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Piiklad 4.74: Urcete, zda je zobrazeni g : Ry[x] X Ry[z] — R skaldrnim soucinem, jestlize
ai, az, bla b27 C1,C € R:

2) 9(f(x),g(x)) = Off(x) - g(a) d,

b) glay - 2> +by-x+cp,as- 2> +by-x+ o) =ay-ag+by-by+cy o,

c) glap-x®> + by -z +cp,an - 22+ by - T+ o) = ay + by.

4.5.2 Unitarni a euklidovské prostory

Definice 4.34: Vektorovy prostor U = C" se skalarnim sou¢inem (,) : U x U — C
nazyvame unitdrnim prostorem.

Definice 4.35: Normu vektoru u = (uy,...,u,) € U na unitarnim prostoru U = C"

definujeme predpisem:
[lul] = /(u, u).

Poznamka 4.31: (Cauchyova-Schwartzova nerovnost) Necht U je unitarni prostor.
Pak pro libovolné u,v € U plati:

[{w, )| < [lull - |l

pricemz rovnost nastane pravé tehdy, kdyz jsou u, v linearné nezavislé.

Definice 4.36: Necht U je vektorovy prostor. Euklidovskijm prostorem E(U) rozumime
afinni prostor spolu se skalarnim souc¢inem na U.

Poznamka 4.32: Euklidovsky prostor F(R") se standardnim skaldrnim sou¢inem budeme
znacit E,,.

Definice 4.37: Necht E(U) je euklidovsky prostor, u,v € U. Uhel, ktery sviraji vektory u
a v, definujeme jako ¢islo av € [0, 7], pro néz plati:

{u, v)

os(@) = el

Definice 4.38: Necht E(U) je euklidovsky prostor, u,v € U. Vektory u a v nazveme
ortogondlni (resp. kolmé), pokud (u,v) = 0. Vektory u a v nazveme ortonormdlni, pokud
jsou ortogonélni a navic jsou jednotkové velikosti, tj. ||u|| = 1, ||v|| = 1.

Definice 4.39: Bazi tvofenou ortogonalnimi vektory nazveme ortogondlni bdzi, bazi tvorenou
ortonormalnimi vektory nazveme ortonormdlni bazi.

Poznamka 4.33: Pokud nebude uvedeno jinak, bude déle skalarni soucin predstavovat
standardni skalarni soucin.
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Piiklad 4.75: Najdéte ortogondlni bazi podprostoru generovaného vektory (3,2, —4,6)7,
(8,1,—2,-16)T, (5,12, —14,5)T, (11,3,4,—7)" v euklidovském prostoru Ej.

Resend: Maple poskytuje v baliku LinearAlgebra mj. i pifkaz GramSchmidt hledajici
ortogonalni bézi pomoci Gramova-Schmidtova ortogonalizacéniho procesu. Reseni je proto
velmi jednoduché. Jelikoz jsou zadané vektory linedrné nezavislé (a generuji tak cely prostor
R*), o cemz se lze presvédéit napt. pifkazem Basis, mize byt odpovédi také standardni baze
tohoto prostoru — viz obrazek 4.45.

with( LinearAlgebra) :
GramSchmidt( [ (3,2,-4,6), (8, 1,-2,-16), (5,12,-14, 5}, (11,3, 4,-7)])

706 _ 97470 54720
65 17281 25561

3 189 118372 120096
2 65 17281 25561
-4 1| 378 |'| 63934 || 120168
6 65 17281 25561
_ 668 33345 18720

65 17281 25561

B{I.S’I;_‘.'{ [ (\3=2-_4- 6>= (8- 1_2_16>- {5- 12.-14, 5>= {11- 3=4-_?}])

3 8 5 11
2 1 12 3
-4 -2 -4 4
6| | -16 501 -7

Obrdzek 4.45: Reseni piikladu 4.75.

Piiklad 4.76: Najdéte ortogonélni bazi podprostoru generovaného vektory (1,1, —1, —1)7,
(1,-1,1, )7, (—=1,-2,0,1)T v euklidovském prostoru Ej.

Priklad 4.77: Najdéte ortonormdln{ bazi podprostoru generovaného vektory (1,0,1,0)7,
(0,1,0,—7)7, (3,-2,3,14)T v euklidovském prostoru Ej.

Priklad 4.78: V euklidovském prostoru FE, jsou dany vektory u,v. Ovérte, ze jsou orto-
gonalni a doplnte je na ortogonalni bazi celého prostoru:

a) u=(1,-2,2 D)7 v=(1,3,2,1)7,

b) u=(2,3,-3,-4)T, v=(-1,3,-3,4)7,

c) u=(1,7,7, 1), v=(-1,7,-7,1)T.

Definice 4.40: Necht A je podmnozinou euklidovského prostoru E(U). Ortogondlnim
dopliikem mnoziny A v prstoru F(U) nazveme mnozinu:

At ={ueU|YveU: {uv) =0}

Definice 4.41: Necht E(U) je euklidovsky prostor, V jeho podprostor. Kolmd projekce
vektoru u € E(U) do V' je vektor Pu € V takovy, ze (u — Pu) L V.
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Priklad 4.79: Najdéte ortogonalni doplnék podprostoru U generovaného vektory
(1,-1,1,0,0)%, (1,0,1,0, )%, (1,1,0,—1,1)T v euklidovském prostoru E.

Resend: Oznacéme zadané vektory podprostoru U jako uq, ug, us a libovolny vektor z pro-
storu U+ pismenem v. Obecné muzeme psit v = (a,b,c,d,e)’ pro a,b,c,d,e € R. Podle
definice 4.40 musi pro i = 1,2, 3 platit: (u;,v) = 0. Tuto rovnici vytesime. Ziskanym para-
metrum pak ptriradime néjaké nezavislé hodnoty, abychom dostali nezavislé (bazové) vektory
ortogonalniho doplnku — viz obrazek 4.46.

u = {1.,-1,1,0,0): v = subs(res, v)
uw,={1,0,1.0,1): d
Uy = {1,1,0,-1,1}: —€
-e—d
vi={a,b.cde): d
res = Sa!ve( [v%r.ul =0, v%r.u’ =0, ¢
5T B eval(v, {e=0,d=1}), eval(v, {e=1,d=0})
v .H3=O]) 1 0
{a=d.b=-e,c=-e—d.d=d,e=eg} 0 -1
-1, -1
1 0
0 1

Obrdzek 4.46: Reseni pifkladu 4.79.

Priklad 4.80: Najdéte kolmou projekei vektoru (1,2,3)? do podprostoru V' generovaného
vektory (—1,1,1)T, (1,1,1)” v euklidovském prostoru E3. Zndzornéte graficky.

Resend: Oznacme u = (1,2,3)", v; = (=1,1,1)7, vy = (1,1,1)". Dle definice 4.41 plati:
PueV, tj.proa,beR: Pu=a-v;+b-vy. Navic proi=1,2: (Pu,v;) = 0.

K vykresleni 1ze pouzit piikaz ProjectionPlot z baliku Student[LinearAlgebra] —
obrazek 4.47. Piikaz ma mnoho volitelnych parametri. K tomu je jeSté mozné nastavit
i proménnou infolevel podobné, jak jsme se o tom zminili u pifkazu solve (viz ¢dst 1.4.5).
Na obrazku 4.48 je na ukazku nastavena proménna infolevel na hodnotu 1, vpravo jsou
navic zelené vykresleny bazové vektory vy, vs.

Piiklad 4.81: Nechf V je podprostor generovany vektory v;,vs,v3 v euklidovském pro-
storu E,. Najdéte kolmou projekei vektoru w do podprostoru V=*:

a) vy = (5,1,3,3)T, vy = (3,-1,-3,5)T,v3 = (3,-1,5, -3)T, w = (4,2, -5,3)7,

b) v1 = (1,1,2,8)T vy = (0,1,1,3) w3 = (1,-2,1,1)T, w = (2,5,2 — 2)T.

Priklad 4.82: Najdéte ortogonalni doplnék podprostoru U generovaného vektory (1, —3,2)7
(2,1,5)T v euklidovském prostoru Es.

Priklad 4.83: Najdéte ortogonélni doplnék podprostoru U generovaného vektory (1,2, 1,1)7
(3,1,1,1)T v euklidovském prostoru Ej.
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with( Student[ LinearAlgebral) : ijeczionpfoz(u_. {v . v,J}: showecomplement = false,

1

U= (1 2.3): orientation= [ -23, 75])
v = (1.1, 1)
v = (-1,1,1):

Pu=a-v + En-vz :

r.[u — Pu) =0,

%
res = mh’e( [1’1

v?r.(u — Pu) =OD
i)

Pu = subs(res, Pu)

1

3

2

5

2 Projection(navy) of the first verctor (burgunds)) onto the plane (gray)

determined by the other two.
Obrdzek 4.47: ReSeni piikladu 4.80.
with( Student[ LinearAlgebral) : ijecrionpfm( u, {vl, v, }, showcomplement
mfaa:’eve_i’[Srz;denr[[;mearAfgzbra]] ::f L = false, showbasis, orientation= [ -25, T"S]]
ProjectionP oz[u: {vl_. 1=2}: showcomplement | __ - <, 2, 3>
=faf.5'e. orientation= [ -25. 75]) Projection: <1.000, 2.500, 2.500>
i i orthogonal complement: <.341%e-13,

Vector: <1, 2, 3» -.5000, .5000>

Projection: <1.000, 2.500, 2.500>
Orthogonal complement: <.341%e-13,
-.5000, .5000>

Norm of orthogonal complement: .7071

Norm of orthogonal complement: .7071

Projection (navy) of the first veetor (burgunds)) onto the plane

Pt o ection(navy) of the first vector (burgundy) onto the (gray) determinect by the other twa (leafgreen).
plane (gray) determined by the other two.

Obrazek 4.48: Ruzné moznosti grafického zobrazeni feseni piikladu 4.80.

Priklad 4.84: Najdéte ortogonalni bazi podprostoru U generovaného vektory (1,1,1)7,
(1,0,1)T a (1,2,1)T v euklidovském prostoru Es.

Priiklad 4.85: Najdéte kolmou projekci vektoru u do podprostoru V' popsaného rovnici:
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a) = +y =0, piicemz u = (3, -2)7, b) & —y =0, pficemz u = (1,2)7
v euklidovském prostoru Fy (se souradnymi osami x, y). Znazornéte graficky.

Priklad 4.86: Najdéte kolmou projekci vektoru (1, —1,1)7 do podprostoru V' popsaného
rovnici z 4+ z = 0 v euklidovském prostoru Ej3 (se souradnymi osami z, y, z). Znazornéte
graficky:.

4.5.3 Vzdalenost a odchylka

Definice 4.42: Necht A, B jsou dva body euklidovského prostoru E,,. Jejich vzddlenosti
nazveme velikost (normu) vektoru B — A, tj. p(A, B) = ||B — A||.

Definice 4.43: Necht M je afinni podprostor euklidovského prostoru £, a A bod tohoto
prostoru. Vzddlenosti bodu A od afinni podprostoru M nazveme nezaporné ¢islo definované
vztahem:

p(A, M) = min ({|| B — Al|, B € M}).

Poznamka 4.34: Necht M = M(V) je afinni podprostor euklidovského prostoru E,, A
bod tohoto prostoru a B bod pattici do M. Vzdalenosti bodu A od afinni podprostoru
M je rovna velikosti kolmé projekce vektoru B — A do ortogonélniho doplnku zaméteni
podprostoru M, tj. do V+.

Definice 4.44: Necht M, N jsou podprostory euklidovského prostoru FE,. Vzddlenosti
podprostori M, N nazveme nezdporné c¢islo definované vztahem:

p(M,N) = min ({||B — A||, Be M,AeN}).

Poznamka 4.35: Necht M = M(U),N = N(V) jsou dva afinni podprostory eukli-
dovského prostoru E,,. Necht ddle A je libovolny bod patiici do M a B libovolny bod patiici
do N. Vzdélenost podprostoru M, N je rovna velikosti kolmé projekce vektoru B — A do
ortogondlnfho doplitku sou¢tu zaméteni podprostort M, N, tj. do (U + V)+.

Piiklad 4.87: V euklidovském prostoru E, urcete vzdalenost roviny
o:(4,1,1,0)7 +5-(1,-1,0,00" +¢-(2,0,—-1,0)T
od primky
p:(5,4,4,5)" +r-(0,0,1,-4)".
Resend: Standardn{ postup odpovidd pozndmece 4.35. Zavedme proto oznaceni, v némz
oc:A+s-u+t-uy, p:B+r-o.

Necht déle w je vektor ortogonalniho dopliitku a x = B — A. Pak kolmy priumét Pz vektoru x
lezi v ortogonélnim dopliku a zéroven x — Px je kolmy na w. Norma (velikost) kolmé projekce
Pz je pozadovana vzdalenost. K jejimu vypoctu lze pouzit piikaz VectorNorm z baliku
LinearAlgebra. Jelikoz norem existuje vice, je nutné v druhém parametru specifikovat, ze
chceme vypocitat normu euklidovskou (coz je prave ta, jiz jsme v tomto textu definovali).
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Vzhledem k tomu, ze systém Maple disponuje ptikazy k hleddni minima zadané funkce,
muzeme vzdalenost pocitat primo z definice 4.44. Jednim z piikazu hledajicich extrém je
piikaz minimize, ktery v tomto pripadé feSeni nenalezne. Dalsim, jenz uspéch pfinese, je
piikaz extrema. Postup vypoctu je uveden na obrazku 4.49.

with( LinearAdlgebra) : Px = subs(res2[2], Px)
u = (1.-1,0,0): Uy = {2.0,-1,0): 2
vi={0,0,1,-4): 2
A={4.1.1,0): B:=(54.4.5): .
wi= (a, b, e d): 1
res ‘= Soi’ve( [H‘Ar.ul =0, H‘AI.uj =0,
9T B VectorNorm( Px, Euclidean)
woy= 0]) 5

{a=2d,b=2d,c=4d,d=d}

Nalezeni minima vzdalenosti obecného bodu

w = subs(res, w) roviny ¢ a bodu pfimky p podle definice.
2d exn'ema( Veczarf\"arm(ﬁ + 5-ug t+tu, —B—rv
2d Euci’idean): {1} {r.s, r}:'bad')
4d
4 {5}
bod
x=B—A: {{r=1,5=-1,r=0}}
Px:i=w:
res? == sah’e( [Wﬁr.[x —Px) = O])
{d=0}. {d=1}

Obrdzek 4.49: Reseni pifkladu 4.87.

Priklad 4.88: V euklidovském prostoru E5 urcete vzdalenost piimek

p:(9,-2,00" +r-(4,-3, D)7, ¢:(0,-7,2)" +5-(-2,9,2)".

S5 v , ) v s « o
Reseni: Zavedme oznaceni, v némz
p:A+s-u, q:B+t-v.

Nyni zcela vyuzijeme systému Maple. Nejprve urcime vzdalenost ptimek opét pomoci piikazu
extrema. Jelikoz nyni pracujeme s prostorem Fj3, muzeme vyuzit baliku geom3d, piimky
vykreslit, ale také urcit jejich vzdélenost piikazem distance z tohoto baliku. Postup vypoctu
je uveden na obrazku 4.50.

Piiklad 4.89: V euklidovském prostoru F, urcete vzdalenost bodu A od afinniho podpro-
storu M:

a) A= (4,1,—4,-57T, M:(3,-2,1,5)7 +s5-(2,3,-2,-2)T +¢-(4,1,3,2)T,
b) A=(2,1,4,-5)T, M:(1,-1,1,00T +¢-(0,1,2,-2)7,
c) A=(2,1,-1,00T, M:3 -2 +x3—24+6=0.
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with( LinearAlgebra) : line( p, [ point(Al, convert( A, list) ), convert(u, list) ]) :
with( geom3d) : line(q, [ point( B1, convert( B, list) ), convert(v, list) |) :
= (4,-3,1y: v:i=(-2,9.2): |distance(p,q)

A:=1{9.-2,0): B:={(0,-7.2): 7

Nalezeni minima vzdalenosti podle draw([p. ], color=[red, blue]. aves=frame)

definice.
extremal( VectorNorm(A +s-u — B +
—t-v, Euclidean). { }, {s.t}, ES
'bod") e

(7) 4 \

bod -
{{s=-2,1=1}} e
12

-14
16
a 6 50 6r 70-80
2 o 20 3040300

Obrdzek 4.50: Reseni piikladu 4.88.

Priiklad 4.90: V euklidovském prostoru E5 urcete vzdalenost piimek
a) p: (_]—7 7) _4>T +r- (17 -2, 1)T7 q: (17 6, 6>T t+s- (_37 L, 1)T7
b) p: (6,3, -3)T +r-(=3,2,4)T, q:(-1,-7,4)T +s-(-3,3,8)T,

c) p: (2,1,5)T +r-(0,1,1)T, ¢:(=3,-3,-1)T +5-(2,2,1)T.

Priklad 4.91: V euklidovském prostoru E; urcete vzdalenost primky a roviny
a) p: (1,3, =3, —1)T+r-(1,0,1,1)T, o:—mi+ao+as3+zs=23,—3-23+2-25—4-14 = 4,

b) p:(1,6,—6,4)T+r-(1,-5,8,5)T, o:(6,3—5,5)T+s-(1,-2,2,2)T+t-(2, -1, -2, 1)T.

Definice 4.45: Necht M = M(U), N = N (V) jsou afinn{ podprostory euklidovského pro-
storu E,, u, v dva vektory tohoto prostoru. Odchylkou podprostori M, N rozumime odchylku
¢ jejich zaméteni, tj.:

a) je-li U = [u], V = [v], pak ¢(M,N) = a, o € [0, 5], pFicemz plati:

[{u, v)|
[l - []o]|”

b) je-li U CV, resp. U C V, pak ¢(M,N) =0,

cos(a) =

c) je-li UNV = {0}, pak p(M,N) = min ({¢(u,v) : u € U,v € V,u,v # 0}),
d) je-li UNV # {0}, pak g(M,N) = (UN(UNV)E VN (UNV)).
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Poznamka 4.36: Necht v je vektor a U podprostor euklidovského prostoru E,, Pv kolm4
projekce vektoru v do podprostoru U. Pak

cos (¢([v],U)) = cos (¢(v, Pv)) =

Poznamka 4.37: Necht N}, N5 jsou nadroviny euklidovského prostoru E,,, ni, no po fadé
jejich normalové vektory. Pak

¢(N1,N2) = ¢(n1,n2).
Priklad 4.92:

V euklidovském prostoru Ej urcete odchylku piimky p a roviny o, kde
p:(1,0,0,0)" +7-(3,4,4,3)",

o:(2,0,0,)" +5-(1,0,3,0)" +t-(-2,0,—1,0)".

Reseni: Vyuzijeme poznamky 4.36. Nejprve vsak zaved me oznaceni tak, aby

p:A+r-v,

c:B+s-u;+1t-us.
Podle zminéné poznamky plati:

cos (¢(p, o)) = cos (¢(v, Pv)) =

kde Pv je kolmé projekce vektoru v do roviny o. Kolmé projekce jsme pocitali jiz drive,
takze aplikujeme zndmy postup. Vypocet je uveden na obrazku 4.51.

with( LinearAlgebra) : Pv = subs(res, Pv)
up = (1,0,3,0): U, = {(-2,0,-1,0): 3
vi=(3,4,4,3): 0
A:=(1,0,0,0): Bi={(2,0,0.1): 4
Pv'=a-u1-l-b-u2: 0
%I N ] i
res = Soi’ve( [ (v—Pv)*Tu =0, cos(6(p. o)) = VectorNorm( Pv, Euclidean)
%T
(v—Pv) .u2=0])
{a=1,b=-1}

VectorNorm( v, Euclidean)

cos(0(p.6)) =3V Z

o(p. o) =arccos[%ﬁ)

e

Mn@=%ﬁ

Obrdzek 4.51: Reseni pitkladu 4.92.
Priklad 4.93: V euklidovském prostoru E3 urc¢ete odchylku rovin o a 7, kde
c:2-x—y+2—1=0,

T:x+y+2-2z+3=0.
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Reseni: Vyuzijeme poznamky 4.37. Podle zminéné poznamky plati:

¢(07 T) - ¢(na7 n'r)a

kde n,,n; jsou normalové vektory rovin o a 7. Pfitom normadlové vektory rovin odec¢teme
piimo ze zadanych obecnych rovnic. Jelikoz se pohybujeme v prostoru Es3, muzeme opét
vyuzit baliku geom3d a jeho piikazu FindAngle k urceni odchylky. Roviny je ddle mozné
vykreslit. Vypocet je uveden na obrazku 4.52.

with( LinearAlgebra) : plane(c, 2. x—y+z—1=0[x,2]):
with( geom3d) : pfane(’c, x+y+2-z+3=0.[x, 3 Z]} :
rovaice 0= 2-x—y+z—1=0: FindAngle(c, t)
rovinice T:=x+y+2-z+3=0: o 1
- T
not= (21 1): o= (1,1,2): 3

o ' draw( [, T, axes = frame)

nov 1= VeczorNorm[n \ Eucfidean] :
y

nv = Vecrar}\’arm[n . Euc!ﬁean] :
T

%I
?’10 .HT
(D(G:Tj —MCCOS[W]
o(ct)=5n

Obrdzek 4.52: Reseni piikladu 4.93.

Priklad 4.94: V euklidovském prostoru E, urcete odchylku piimky p a roviny o, kde
a) p:(1,0,0,0)7 +7-(3,4,4,3)T, 0:(2,9,0,6)" +5-(0,1,0,5)7 +¢-(0,2,0,-7)T,

b) p:(1,0,0,0)7+r-(1,-1,1,3)7, 0:(3,1,4,5)7+s-(2,-2,3,07 +t-(—1,1,-2,0).

Piiklad 4.95: V euklidovském prostoru F3 urcete odchylku zadanych podprostorii:
a) p:(=2,-2,6)T +r-(0,-7,—4)T, ¢:(6,5,-6)T +s-(3,7,8)7,
b) p: (7,-3, )T +r-(-3,6,-3)T, oc:x—5-y+3-2—-7=0,
c)o:x+2-2—6=0, 7:0+2-y—4=0,
d) o:(1,0,0)" +r-(1,,2)" +s-3,1,1)", 7:2—-2-y+1=0,

Znazornéte také graficky.
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Piiklad 4.96: V euklidovském prostoru Es vedte bodem Q) pifmku ¢ tak, aby néleZela
roviné ¢ a byla kolma k piimce p, kde

Q = (27]-’_3)T7 b: (47573)T+T ' <_67671>T7

Znézornéte graficky.
Reseni: Zavedme oznaceni tak, aby

q:Q+s-v,

c:3-x—2-y+z=1

p:P+r-u, v=(a,b,c)", a,b,ceR.

Aby p L q a q € o, musi platit:
u'v=0, 3-2+a)—2-(1+b)+(-3+c)=1.

Vyftesenim téchto rovnic ziskdme vektor v. Ke grafickému zobrazeni vyuzijeme balik geom3d.
Vykreslovacim piikazum (draw, pointplot3d) nastavime nékolik volitelnych parametri pro
lepsi vzhled. Bod @ zobrazime jako zelenou tecku. Vypocet je uveden na obrazku 4.53.

with( LinearAlgebra) :

with( geom3d) :

rovrice 6= 3-x—2-yv+z—1=0:
ur=1{-6,6,1y: vi={ab,c):
Pi={4.53): 0:=(2.1,-3):

point( PP, convert( P, list) ) :

point( QQ, convert( O, list) ) :
line( p, | PP, convert(u, list) ]) :

line( g, [ OO, convert(v, list) ]) :

plane( G, rovnice &, [x,y,2]):

pl = draw([ p, g, G|, axes= frame, color= [ red,
blue, white], grid=[ 3, 3], gridstyle
= rectangular, thickness=[3,3,1]) :

p2 = plots| pointplot3d]( [ coordinates( QQ) |.
symbolsize= 35, color= green) :

plots[ display] (pl.p2)

%I
rl=u " .v=0

-6a+6b+c=0
r2:=subs({x=2+a,y=1+b,z=-3
+ ¢}, rovnice &)
3a—2b+c=0

res = solve( [r1, ¥2]) -
v = subs(res, v)

a2
. 10 10807

Obrdzek 4.53: Regeni pitkladu 4.96.

Priiklad 4.97: V euklidovském prostoru E3 najdéte rovinu, ktera je rovnobézna s rovinou
c:3-x—2-y+2z=1ama od ni vzdalenost 2. Znazornéte graficky.

Priklad 4.98: 'V euklidovském prostoru F5 najdéte rovinu, kterd ma od roviny o : z—1 =0
odchylku 30°. Znazornéte graficky.

Piiklad 4.99: V euklidovském prostoru E3 najdéte bod @ na pifmce ¢ : (1,—1,0)7 +
r-(1,-2,-3)7 tak, aby jeho vzdalenost od roviny o : 2 -z +y — z = —2 byla rovna /6.
Znazornéte graficky.
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4.6 Diagonalizace matic

4.6.1 Vlastni ¢isla a vlastni vektory

Definice 4.46: Linedrnim operdtorem, resp. linedrni transformaci, na vektorovém pro-
storu U nazyvame libovolné linedrni zobrazeni ¢ : U — U.

Poznamka 4.38: Spolu s linedrnim operatorem budeme také uvazovat jeho matici, kterou
jsme zavedli jiz v definici 4.16 jako matici linedrniho zobrazeni.

Definice 4.47: Rekneme, 7e Gtvercové matice A, B fadu n € N jsou podobné, jestlize
existuje regularni matice P radu n tak, ze

B=P ' A.-P

Poznamka 4.39: Pripomenme, 7ze v Casti vénované bilinedrnim formam jsme v definici
4.25 zavedli pojem kongruentnich matic A, B, pro néz platil podobny vztah:

B=PT.A.P

Definice 4.48: Necht U je vektorovy prostor nad K € {R,C}. Nenulovy vektor u € U
nazveme vlastnim vektorem linedrniho operatoru ¢ : U — U, jestlize existuje ¢islo A € K
tak, ze

o(u) =X -u.

Cislo A se pak nazyva vlastnim cislem linearniho operatoru (.

Definice 4.49: Necht U je vektorovy prostor nad K € {R,C}, ¢ : U — U linedrni
operator, A jeho matice, ¥ matice jednotkova stejného fadu jako matice A. Rovnice

IA—X-E|=0

se nazyva charakteristickou rovnici matice A, jeji leva strana charakteristickym polynomem.

Poznamka 4.40: Vlastni ¢isla matice A jsou kotfeny ji prislusné charakteristické rovnice.
Jestlize A je vlastni ¢islo, pak jemu odpovidajici vlastni vektor je (resp. vlastni vektory jsou)
reSenim rovnice A — A - E = 0.

Definice 4.50: Necht A je matice linearniho operdtoru o : U — U. Algebraickou ndsobnosti
vlastniho ¢isla A linedrntho operatoru ¢ nazveme nasobnost tohoto ¢isla jakozto kotene cha-
rakteristické rovnice matice A. Geometrickou ndsobnosti tohoto ¢isla nazveme dimenzi pod-
prostoru Ker(p — X -id).

Poznamka 4.41: Jeli A =a+b-1, kde a,b € R, I je imaginarni jednotka, vlastni ¢islo
Eeélné matice A fadu n € N s vlastnim vektorem u = u; + [ - ug, kde uy,us € R", pak
A =a—b-1 je také vlastni ¢islo matice A a prislusi mu vlastni vektor w = u; — I - us.
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Priklad 4.100: Naleznéte vlastni ¢isla a vlastni vektory linearniho operatoru s matici A,

kde

1 -1 1
A=|-1 1 1
-1 -1 3

Reseni: Nejprve naéteme balik LinearAlgebra, ktery obsahuje vsechny pifkazy, jez v
feSeni zminime. K nalezeni vlastnich ¢isel a vlastnich vektoru vyuzijeme piikaz Eigenvectors.
Vystupem je vektor vlastnich ¢isel a matice obsahujici po tadé vlastni vektory piislusné
difve uvedenym vlastnim ¢éislum (pfipadné nulové vektory, pokud je geometrickd ndsobnost
vlastniho ¢isla mensi nez algebraickd). Pro ziskani charakteristického polynomu méme k dis-
pozici piikaz CharacteristicPolynomial. Geometrickou nasobnost vlastniho ¢isla muzeme
odvodit piimo z definice pouzitim prikazu NullSpace. Doplime, ze kdybychom chtéli znat
pouze vlastni ¢isla (a nezajimali nds prislusné vlastni vektory), lze pouzit piikaz Eigenvalues.
Vypocet je uveden na obrazku 4.54.

with( LinearAlgebra) : factor( %)
1 -11 (A—1) (r—2)
A=|-1 11
-1 -1 3 E := Mairix( 3, shape = identity) :
NullSpace( 4 — E)
Eigenvectors(A) 1
2 1-11 1
2z 0 11 1
1 1 01 NullSpace(4 — 2-E)
1 -1
CharacteristicPolynomial( A4, ).) 0, 1
44N =5 sl 1| o

Obrdzek 4.5/: Reseni prikladu 4.100.

Priklad 4.101: Naleznéte vlastni cisla a vlastni vektory linearniho operatoru s matici A,
kde

4 =57
A=|1 -4 9
-4 0 5

Reseni: Postupujeme stejné jako v predchézejicim pifkladu. Nyni ziskdvame komplexni
(neredlnd) vlastni ¢isla, muzeme tedy ovéfit tvrzeni poznamky 4.41. Vypocet je uveden na
obrazku 4.55.

Priklad 4.102: Naleznéte vlastni cisla, urcete jejich algebraické a geometrické nasobnosti,
najdéte ptislusné vlastni vektory linearniho operatoru zadaného nize uvedenou matici. Ovéite
dale, ze nalezena vlastni cisla a vlastni vektory skutecné odpovidaji definici 4.48.

7 —12 6 1 -3 1
a) A= (10 —19 10], by B=|0 -1 0],
12 —24 13 -1 -3 3
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1 1 1 1 3 =1 0 0
1 1 -1 -1 1 1 0 0
c) C = : d) F=
1 -1 1 -1 3 0 5 =3
1 -1 -1 1 4 -1 3 -1
with ( LinearAlgebra) : E := Mairix( 3, shape = identity) :
4 -57 NullSpace( 4 — E)
A= 1 -49 1
405 2
1
Eigenvectors(A) NullSpace(d — (2 +3-1)-E)
3 3 3 3
-1+ 11 33
2431 |4 4 47y T
2—31 5 3 5 3
|-+ 12 5 3
1 i iR
1 1 1 |
CharacteristicPolynomial( 4, ) NullSpace(4 — (2_33 -I)- 3E )
S13 4K —5K+17R TRIPR.
factor( %) s ;
8 - 2 _an = _I_ _I
(A—1) (X" —4%+13) 13
factor( %, I) )
“(A=243I) (-A+2+43I) (L—1)

Obrdzek 4.55: Reseni piikladu 4.101.

Postup vypoctu vlastnich éisel a vlastnich vektoru (uvedeny v poznamce 4.40) lze v Maple
projit krok po kroku diky pomocnikium, které najdeme v hlavni nabidce: Tools > Tutors >
Linear Algebra. Konkrétné se jedna o polozky Eigenvalues a Eigenvectors. Dalsim po-
mocnikem v téze nabidce je EigenPlot. Tento maplet vykresli vlastni vektory matice fadu 2
nebo 3 spolu s kruznici, resp. kouli (podle dimenze), kterou transformuje tak, jak to ¢inf zob-
razeni zadané prislusnou matici. Standardné jsou vykreslovany téz obrazy nékolika jednot-
kovych vektorti. Obdobou mapletu je prikaz EigenPlot z baliku Student [LinearAlgebral,
ktery provadi totéz az na transformaci kruznice (resp. koule).

Na obréazku 4.56 je znazornéno pouziti prikazu jak v dvourozmérném, tak trojrozmérném
pripadé. Provedenim piikazu

infolevel [Student [LinearAlgebral] := 1:

priméjeme piikaz EigenPlot navic k numerickému vypisu vlastnich ¢isel a vlastnich vektoru.
Vlastni vektory jsou zobrazovany vzdy v paru od hranice kruznice, resp. koule.

Poznamka 4.42: Necht A, Ay, ..., \, € R jsou vlastni ¢isla (ne nutné riznd) matice A
radu n a uq,ug, ..., u, € R jsou jim piislusné linedrné nezavislé vlastni vektory. Potom je

matice A podobnd diagondalni matici, v niz je diagondla tvorena z vlastnich ¢isel matice A.

Poznamka 4.43: Necht \j, Ao, ..., \, jsou navzdjem ruzna vlastni ¢isla matice A Fadu n.
Potom jsou jim prislusné vlastni vektory uy, us, ..., u, linedrné nezavislé.
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with( Student| LinearAlgebra] ) : 1 -11
Lot A=|-111

23 -1 -13
infolevel| Student| LinearAlgebral] == 1:

EigenPlot( A, showimagevectors = false, axes

EigenPlot( A, showimagevectors = false, axes = normal, caption="")

. =normal) Eigenvalué: 1
Elgez}va}ué: 1 Multiplicity: 1
Multiplicity: 1 Eigenvector: < 1, 1, 1 >

Eigenvector: < -1, 1 >

Eigenvalue: 2

Eigez}va}ué: 3 Multiplicity: 2
Multiplicity: 1 Eigenvectors: < 1, 0, 1 >
Eigenvector: < 0, 1 > < -1, 1, 0 >

S5 ¢

xisan egenvector if it is collinear with its im age
utuder left-multiplication by a square matsix 4

Thuss, x satisfiesthe equationAx=Ax Shownin
the figure: eigerrectors (bur gundy and navy).

Obrazek 4.56: Grafické znazornéni vlastnich vektoru.

Pozndmku 4.42 muzeme ovérit na prikladu 4.100. Matice P z poznamky 4.47 je pritom
matici vlastnich vektoru, kterou obdrzime jako vystup piikazu Eigenvectors. Jelikoz je
pismeno D v Maple rezervovano, oznacili jsme diagondlni matici pismenem J — obrézek
4.57.

with( LinearAlgebra) : J = DiagonalMatrix( C)
1 -11 200
A=] -1 1 1]/: 020
-1-13 001
-1
C, P := Eigenvectors(A) P .4.P
2] [-111 200
2 101 020
1 011 001

Obrdzek 4.57: Ovéreni podobnosti matice A z piikladu 4.100 s diagonéalni matici.

Priklad 4.103: Dejte priklad matice fadu 4, jejiz vlastni ¢isla jsou 1,2, 3, 4.

Priiklad 4.104: Dejte piiklad matice fadu 2, jejiz vlastni ¢isla jsou 1,2, obé geometrické
nasobnosti rovné jedné.
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Priklad 4.105: Dejte priklad matice fadu 2, jejiz vlastni ¢islo 3 mé algebraickou nasobnost
rovnu dvéma, ale geometrickou nasobnost rovnu jedné.

Priklad 4.106: Uvazujme linearni operator zadany matici A ve standardni bazi. Najdéte
bazi, v niz ma dané linedrni zobrazeni diagondlni matici:

2 -3 1 3 -1
a) A=[1 -2 1], C)A:(1 o)’

d) A:(Z ?)

4.6.2 Ortogonalni a unitarni operatory

—_ =
|

o

[\

=
N
I
— N =
— =N
W~

Definice 4.51: Necht U a V jsou vektorové prostory se skaldrnim souc¢inem nad R, resp.
nad C, tj. jedna se o euklidovské, resp. unitarni prostory. Zobrazeni ¢ : U — V se nazyva
ortogondlni, resp. unitdrni, jestlize pro vSechna uy, us € U plati:

(pur), p(uz)) = (u1, ug).

Poznamka 4.44: Necht ¢ : U — U je linedrni operdtor, a ortonormélni baze prostoru U.
Pak je ¢ ortogonalni (nad R), resp. unitarni nad C, pravé tehdy, kdyz pro matici A = (¢),
plati:

AT = (A)

kde A znaé¢i matici komplexné sdruzenou k A. Pro redlnou matici je A = A.

Definice 4.52: Matici A spliujici podminku v poznamce 4.44 nazyvame ortogondlni, resp.
unitdrni, matici.

Vlastnosti matic jako jsou podobnost, ortogonalita nebo unitdrnost muzeme v Maple
testovat (ovérovat) piimo podle definice nebo k tomu vyuzit piikazy baliku LinearAlgebra
davajici standardné odpovéd typu ,ano/ne“: IsSimilar, IsOrthogonal, IsUnitary.

Poznamka 4.45: Vlastni ¢isla unitarnitho operatoru maji absolutni hodnotu 1. Vlastni
vektory prislusné ruznym vlastnim c¢islim jsou na sebe kolmé.

Poznamka 4.46: Kazda ortogonalni matice radu 3 reprezentuje otoceni kolem osy urcené
vlastnim vektorem k vlastnimu ¢islu +1 nebo —1. Toto otocenti je pripadneé slozené se symetrii
podle roviny kolmé k této ose prochazejici pocatkem.

Matice ma tedy alespon jedno vlastni ¢islo rovné +1 s odpovidajicim vlastnim vektorem
v. Zbyla dvé vlastni ¢isla muzeme obecné psat ve tvaru cos(a)) 41 -sin(a) a cos(a) — I -sin(w),
kde I je imagindrn{ jednotka a a € [0, 2 - 7|. Necht témto vlastnim ¢islum odpovidaji viastnf
vektory uy + I - ug a uy — I - us.

Jestlize nyni prejdeme k béazi {v,uq,us}, bude mit ortogonalni matice tvar:

+1 0 0
0 cos(a) —sin(a) |,
0 sin(a) cos(a)
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pricemz « predstavuje uhel otoceni kolem osy urcené vektorem v. Pokud je jemu odpovidajici
vlastni ¢islo rovno —1, pak je otoceni slozené s reflexi podle roviny tvorené vektory wuq, us.

Priklad 4.107: Urcete, jakou geometrickou transformaci reprezentuje zobrazeni dané ma-
tici (ve standardni bézi):

Reseni: Nejprve se pifkazem IsOrthogonal piesvédéime, ze A je ortogonalni matice.
Nasledné urcime vlastni ¢isla a vlastni vektory prikazem Eigenvectors. Matici vlastnich vek-
toru ulozime do proménné P. V bazi slozené z vlastnich vektorti méa dané zobrazeni matici J,
v niz jsme vSak ,preskladali“ vlastni ¢isla tak, aby jeji tvar odpovidal matici v poznamce 4.46.
Prestoze je na prvni pohled ziejmé, jakou transformaci J provadi, muzeme se piikazem solve
piresvédéit, Ze tihel otoeni o kolem osy dané vlastnim vektorem (1, —2,1)T, ktery odpovidd
vlastnimu ¢islu —1, je roven 0. Tj. k zadné rotaci nedochazi. Vzhledem k vlastnimu ¢islu
—1 tak dochézi ,pouze” k reflexi podle roviny uréené zbylymi vlastnimi vektory: (—1,0,1)7
a (2,1,0)T. Vypocet je uveden na obrdzku 4.54.

V systému Maple muzeme feseni znazornit téz graficky pomoci baliku geom3d. Uvazujme
proto trojihelnik 7" zadany body T'1 = [2,2,2],72 = [3,4,3] a T3 = [-2, 4, 2]. Uréime obrazy
bodu T'1, T2, T3 (tak, ze je prevedeme na vektory t1, 2, t3 a vypocteme jejich obrazy ¢1,
q2, ¢3) a oznacéime je Q1, @2, Q3. Dostaneme tedy trojihelnik @ jako obraz trojihelniku T
v zobrazeni daném matici A. Nakonec vykreslime osu otaceni modrte, trojuhelnik 7' zelené,
trojihelnik ) ervené a rovinu tvoienou vektory (—1,0,1)T a (2,1,0)7 ¢erné. Z obrazku 4.59
je vidét, ze se skuteéné jedna pouze o reflexi podle zminéné roviny.

with ( LinearAlgebra) : J = DiagonalMatrix([ -1,1.1])
2 2 -1 -100
A= % 2 -1 2 010
-1 2 2 001
IsOrthogonal (A) solve([cos(o) =1,sin(a) =0])

true {a=0]}
C, P := Eigenvectors(A)

1][-12 1
1], o1 -2
-1 10 1

Obrdzek 4.58: Reseni prikladu 4.107.

Priklad 4.108: Urcete, jakou geometrickou transformaci reprezentuje zobrazeni dané ma-
tici (ve standardni bazi):

A:

Wl =

Resent: Resfme analogicky predchozimu pifkladu. Vlastni vektory vypoctené pifkazem
Eigenvectors nejsou tentokrat v nejjednodussim tvaru, a proto na né aplikujeme dalsi
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with(geom3d) : draw( [T, Q. 1, G|, axes = normal, color= [ green, red, blue,
line(l, [ point(S, [0,0.0]), [1,-2.1]]): black], view=[ -3 ..5,-2..5,-2 .5]. labels=["x","y", "z"]]
point(T1,2,2,2) ., point(72,3,4,3), i
point(T3,-2,4,2) :
triangle(T, [T1,T2,T3]) :

t|| (1..3) := seq( Vector( coordinates(
T|7)).i=1.3):

gl (1.3) = seq(convert(A.t | i list),
i=1.3):

triangle( Q, [seq(pomt(Q || &g || 7).
i=1.3)]):

Iine(r, [S.[-1,0,1]]):
line(s, [S.[2.1,0]]) :
plane(o, [r.s]):

Obrdzek 4.59: Grafické zobrazeni feseni prikladu 4.107.

with ( LinearAlgebra) : J := DiagonalMatrix( C)
2 -1 2 1 0 0
1
== 2 2 -1} 1 1
4= . 0 5 +51/3 0
-1 2 2 “ -
1 1
0 0 —— =13
IsOrthogonal (A) 2 2 V3
true
C, P := Eigenvectors(A4) : c[1] 0 0
c
1 J2:= Re(C[2]) -Im(C[2])
1 1 T 0 Im(C[2]) Re(C[2])
St 1 0 0
1 1 1 1
773 © 7 TV

map| x— expand|( rationalize(x) ), P

—
]
M|b—‘
5
h)|»—t

1 -1 Llym Lzl
2 2 2 2
lym_1 1 1.7
1 21"3 2 2 2]"3 Soh’e[ cos(oc]=%,sin[o:)=\f?”
1 1 1 oo Lo
3

Obrdzek 4.60: Reseni piikladu 4.108.

zjednodusujici piikazy rationalize pro rozsifeni zlomku a expand pro roznasobeni. Dvé
z vlastnich ¢isel nejsou redlné, a proto je rozdélime na redlnou a imaginarni ¢ast. V bazi
yupravenych® vlastnich vektoru m& matice zobrazeni tvar J2. Nakonec ur¢ime thel rotace
a. Vypocet je uveden na obrazku 4.54.

Stejné jako v ptrechazejicim piikladu muzeme feSeni znézornit graficky pomoci baliku
geom3d. K demonstraci rotace pritom vyuzijeme tentyz trojuhelnik 7" jako diive — obrazek
4.61.
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with(geom3d) : draw( [T, Q,1], axes= normal, color= [ green, red, blue], view
line(l, [ pont(S,[0.0,0]).[1,1,1]]): =[-3.5,-2.5,-2.5], labels=["x","y","z"])
2

point(T1,2,2,2),point(72,3.4,3),
point(T3,-2,4,2) :
triangle(T, [T1,T2,T3]) :

t|| (1..3) := seq( Vector( coordinates(

T|i)),i=1.3):
gl (1.3) = seq(convert(4.1|| i, list),
i=1.3):

triangle( O, [ seq(point( Q|| 1, q17).
i=1.3)]):

Obrdzek 4.61: Grafické zobrazeni feseni piikladu 4.108.

Priklad 4.109: Urcete, jakou geometrickou transformaci reprezentuje zobrazeni dané ma-
tici (ve standardni bazi):

1 1 =2 30 —4
a) A=1. (1 1 V2, c) A=¢-105 0],
\/§ _\/5 0 4 0 3
3 -2 6 1 0 V3
by A=1-16 3 -2/, d) A=1.-10 2 0
—2 6 3 V3 0 —1
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5 Chyby

V této kapitole si ukdzeme nejcastéjsi chyby pii praci se systémem Maple.

5.1 Chybové zpravy (Error Messages)

5.1.1 Math mode / Text mode

Jednou z prvnich chyb, kterych se uzivatelé ¢asto dopoustéji, je nevénovani dostatecné po-
zornosti pitkazovému (matematickému) a textovému rezimu. Pitkazovy (matematicky) rezim
(Math mode) slouzi k zépisu piikazu. Po kliknuti na kldvesu Enter dojde k jeho vyhodnoceni.
Textovy rezim slouzi k zapisu obycejného textu. Po kliknuti na klavesu Enter se ,pouze*
piesuneme na novy fadek. Castd a nékdy tézko odhalitelnd chyba je ,smichani“ téchto dvou
rezimu pri zapisu prikazu, kdy zpravidla ziskavame chybné vysledky. To, jestli je cely prikaz
zapsany v piikazovém (matematickém) rezimu, muzeme poznat z fontu pisma (ale nemusi
tomu tak nutné byt). Nejjistéji to pozndme umisténim kurzoru na piikaz, kdy se objevi
(nanesteésti slabé viditelny) sedy obdélnik tvoreny prerusovanou ¢drou vymezujici znaky za-
psané v pitkazovém (matematickém) rezimu — viz obrazek 5.1. U piikazu na druhém rddku
je vzdy umistén kurzor pred cislici 2. Muzeme si tedy vSimnout zminéného prerusovaného
obdélniku, ktery v prvnim piipadé (vlevo) zahrnuje pouze ¢islici 2. Piikazy na prvnim rddku
byly vytvotreny obdobné.

Chybné zadané piikazy (na prvni pohled neni poznat rozdil). |Spravné.

15+20 15+ 20
20 35

sm[g]-cos(ﬁ) ) sin[%]-cos(rd +p

e

(3]
—

Obrdzek 5.1: Chyby v pouziti matematického a textového rezimu.

5.1.2 Chybné argumenty prikaza

Dalsi velmi ¢astou chybou (ne-li nejcastéjsi) je spatné zadani argumentu pifkazu. Kazdy
prikaz ma definované pouziti. Vzdy mu musime nastavit povinné argumenty, muzeme pridat
volitelné (charakterizované slovickem optional). Argumenty musi byt zadany vzdy v ta-
kovém tvaru, jaky je predepsany. Informace o tom, jak dany piikaz pouzit, jak specifikovat
argumenty piikazu, které argumenty jsou povinné a které volitelné, nalezneme v napovédeé
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systému Maple k prislusnému piikazu. Nésleduje ptehled chybovych zprav, které Maple pii
Spatném zadani argumentu vypisuje.

Chybné Spravné

sin( [5]) sin(5)
Error, invalid input: sin sin(5)
expects its Ilst argument, x,

type algebraic, but
LinearAlgebra[ Eigenvalues](2) LinearAlgebra| Eigenvalues] ({(1,4)]{4, 1))
Error, (in LinearAlgebra:-— 5

genvaluss) walid input:

LinearAlgebra:-Eigenvalues _31
expects its 1st argument, A,

to be of type Matrix(square)
but received 2

solve(5-x—7-y=-9,3-x+y=5) solve({5-x—T7-y=-9,3-x+y=5})
Error, invalid input: too mansy {x=l:y=2}
and/or wrong tvpe of arguments

sed to solve; first unused
argument is 3*x+ty = 5

simplifi(jx- s, {y=01})

Obrdzek 5.2: Ve vsech pripadech si Maple stézuje na Spatny vstup. Nejprve je piikazu sin zadan
seznam, kdezto Maple oc¢ekava algebraickou hodnotu. Argumentem piikazu Eigenvalues mé byt
¢tvercova matice (nikoli redlné ¢islo). Piikazu solve jsou v chybné varianté zaddny dvé rovnice
jako dva parametry, piikaz vsak ocekava, ze v ptripadé vice rovnic budou tyto zadany v jediném
parametru jako seznam (resp. mnozina). Nakonec piikaz simplify neakceptuje nerovnosti jako
dodatecéna omezeni.

Chybne Spravné
roots(sin(x) ) roots(x)
Error, (in roots) argument must be a [[0,1]]
polynomial over an algebraic number field
X X
corzverr[ — parﬁac] convert| ———-. parfraec, x
(x-b) (x-b)

rror, (in convert/parfrac) the variable 1 b
nams (for conversion to partial fractions) x— b + 2
must be provided (x—5)

Obrazek 5.3: Piikaz roots ocekdva jako argument polynom nad &iselnym télesem, coz sin(x)

neni. Prikaz convert vyzaduje uvedeni jména proménné, pokud upravovany vyraz obsahuje vice
neznamych.
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Chybné Spravné

simplify(|x-31. x=0) simplify (x5, {x=0})
Error, (in simplifv/deo) inwvalid 0
simplification command

simplify( |x-y|, assume=x) simplify( |x-y|, assume(x=0) )
Error, (in assuming) when calling
'assume'. Received: 'last ockie

X, has no property'

Obrdzek 5.4: Chybné zapisy omezujicich podminek pro pitkaz simplify spolu s jejich spravnymi
variantami.

5.1.3 Nespravné pouziti zavorek

V systému Maple muzeme pouzivat vsechny typy zavorek, kazdy typ ma vsak jiny vyznam
a tedy jiné pouziti. Navic je tieba ddvat pozor na pocet levych (otevirajicich) a pocet pravych
(uzavirajicich) zévorek. Vzdy, kdyz se tyto pocty nerovnaji, systém vypise chybovou zpravu
Error, unable to match delimiters (obrazek 5.5).

Chybné zadané piikazy. Spravné.
1.3)"2 1.372
Error, unable to match delimiters 9

2.2—-(3—-1( +4)
Error, unable to match delimiters

[

—(3—1(+4))

3. {sin(x-(x+1)),cos(x-(x+1)),tan(x-(x+1)}

Error, unable to match delimiters 3. {sin(x-(x+1)),cos(x (x-l—l}} tan(x- (x + }}}
.ig}_r_‘_uzuz-l-lll,:cq|.x|.x+1||,tar|.xuz+l|}i {cos(x (x+1)),sin(x(x+1)),tan({x(x+ 1))}

4.cos(]t}
Error, unable to match delimiters

; ; 4. cos(rw)

-1

S.COS(TC]
Error, invalid interwval 5,(:05(]-:]

cos(rf -1

Obrdzek 5.5: Chyby v pouzivani zavorek.

5.1.4 Nespravné prirazeni

Systém Maple disponuje tzv. systémovymi proménnymi a piikazy. Jejich nazvy jsou chranéné,
tj. do chranénych proménnych neni mozné prifazovat jiny typ hodnot, nez pro ktery jsou
urceny, a nazvy prikazu neni mozné pouzivat jinak nez jako piikazy s definovanym pouzitim
(tj. neni mozné si napf. vytvorit proménnou se stejnym nézvem jako néktery z piikazu).
To, jestli je néjaky nazev chranény ¢i nikoliv, je mozné zjistit pitkazem type majicim dva
argumenty: nazev (jméno), u néjz chceme zjistit, zda je chrdnény, a argument protected
(ktery uz se nenastavuje na zddnou hodnotu) — viz obrazek 5.6.
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1. Digits :== 1

Error, inwvalid

Chybné zadané piikazy.

Spravne.

1. Digits := 15

2. solve:=13

Error, attempting to assign to

assignment to Digits 15

o

type( solve, protected)

SISPA= true

which i1s protected

3.int:=35

Error, attempting to assign to

3. typel int, protected)

“int” true

which i1s protected

Obrdzek 5.6: Chyby v pfifazovani hodnot do proménnych.

5.1.5 Deéleni nulou

Kdyz se pti tipraveé zadaného vyrazu (piikazu) dostane Maple do situace, kdy ma délit nulou,
vypise zpravu Error, numeric exception: division by zero. Tato situace se muze prihodit

i u vyrazu (piikazii), u nichz to neo¢ekavame (napi. u funkce In) — obrézek 5.7.

T
tan| —
2
Error, (in tan) numeric exception: division by zero
In(0)
Error, (in In) numeric exception: diwvision by zero
g
a —1
a:=1:
a—1
Error, numeric exception: division by zero

Obrdzek 5.7: Vyhodnoceni vyrazu, v némz se déli nulou.

5.1.6 Nespravny zapis mocnin

Nékteré chybové zpravy pii praci s mocninami nabizi obrazek 5.8.

5.1.7 Nespravné pouziti objektt

V systému Maple muzeme narazit také na chybovou zpravu Error, illegal use of an object
as a name. Ta se objevi vzdy, kdyz pouzijeme néjaky objekt, ktery neni jménem, na misté,

kde systém jméno ocekava. Vyznam chyby bude nejlépe patrny z obrazku 5.9.

5.1.8 Nespravné definice a pouziti funkci

Ruznych chyb se muzeme dopustit i pfi definici a pouziti funkce (obrézek 5.10).
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Chybné zadané pifkazy. Spravneé.
Chybi zéklad mocniny.
1. 2
Error, invalid power 1. 372
L2 9
Spatné uvedeny zaklad, ktery chceme umociiovat (je tam navic &arka).
2. 3_."“2 2,342
Error, invalid power 9
22
V exponentu neni mozné pouzit <.
3.370(£2) 3.3"2
Error, invalid 9
Za pismenem b je mezera, chybi tak zdklad mocniny.
4.0 15"
Error, invalid base = p*
B
Obrdzek 5.8: Nespravny zapis mocnin.
Chybné zadané piikazy. Spravne.
1.[a,b] :=1[5.6] 1.a,b:=5,6
Error, illegal a hame 5,6

2. seq(LI=1.5)

rror, illegal use

of an object as a name

2. seq(i,i=1.5)

Al

1,2,3.4.5

3.1:=2 3. J=2
Error, i1llegal n object as = name 2
Obrdzek 5.9: Nespravné pouziti objektu.
Chybné zadané piikazy. Spravneé,
2 — 2
1. fi=x —x 1. fr=x—x
EIIC'I, .'i.r.val:i.:L QEperacor "CE\;E_;:IHE:TBI name x_}_r"
f=% 24
2 2
2. f(x} = XX 2. f[x} =x
x—=x—x"2 x—>x2
3. fi=3-—>x
Error, inwvalid name 3 f:: _x—)—S
x—+3
4.g(x.y)
Error, invalid function arguments
&(xz X); 4. g(xy) .
g(x.y)

Obrdzek 5.10: Nespravné definice a pouziti funkei.
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5.1.9 Chyby pri vykreslovani

Nasleduji chyby vyskytujici se pii vykreslovani. Jako u kazdého piikazu musime dbat na
spravné uvedené argumenty i u piikazu pro vykreslovani funkei a vyrazu. Chyby uvedené na
obrazku 5.11 jsou zpusobeny predevsim nespravné uvedenym rozsahem proménné .

Chybné zadané piikazy. Spravneé.
1. plot(x,x=2.5) 1. plot(x,x=2.5)
Error, (in plot) unexpected
opticn: x = 2.5
3
r
3 4 3
X
2 =9
2. plot(x,x=2 .a) 2 plot =25
Error, (in plot) expecting a real |- P° (xx=2.5)
constant as rangs endpoint but ?
received a 4
3
2
2 3 4 5
x
3. f(x) =x:plot( f,x=2.5) 3. f(x) =x:plot(f(x).x=2.5)
Error, (in plot) expected a range 5
but received % = 2 5 4
3
2
2 3 4 3
x
4. f(x) = x: plot( f(x),2.5) 4 f(x) = x: plot(f,2.5)
Error, (in plot) procedure 5
expected, as range contains no 4
plotting variable
3
2
2 3 4 3

Obrdzek 5.11: Chyby pfi vykreslovani.

5.1.10 Dalsi chybové zpravy

Zavérem chybovych zprav ukazme jesté tii casté chybové zpravy, obrazek 5.12.
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Chybné zadané piikazy. Spravné.

2 2
1. coi’i’ecz(x —5x+2-xy 1. coi’i’ecr(x —5-x+2-x-y:x)

I (i cnllect) 2
Error, (in collect) X+ (-5+2y)x
2.f=2x 2. f=2x

2y 2x
g(x) = unapply( f.x) g = unapply( f.x)

x—unapply( /. x) x—2x

g(2) g(2)
Error, (in unapply) variables must be 4

unigue and of type name

11 11
3. j‘j‘ dxdy 3j‘j‘ 1dxdy

070 00
Error, (in int) integration range or 1
variable must be provided

Obrdzek 5.12: Dalsi chybové zpravy.

5.2 Varovani (Warnings)

Kromé chybovych zprav vypisuje systém jesté tzv. varovani. Varovani muze signalizovat nasi
chybu (v zdpisu piikazu), ale zpravidla informuje o davodech, pro¢ nemuze systém zadany
prikaz vyhodnotit (nékdy jej pfesto vyhodnoti). Pii vypisu varovani s textem Warning,
solutions may have been lost je nutné pieformulovat problém (zapsat ptikaz jinak, nebot
jej Maple nedokéze vyhodnotit). Ne vzdy je toto mozné. Zpravidla muzeme jinou formulaci
problému dosdhnout alespon ,néjakych zlepseni®.

Varovani. Reseni.

2 x 2
1. V=[J [iJ dydx 2o o2
A Y 1. assume{x>0]:V:[J [—] dy dx

Warning, unable to determine if 0 is between

1/% and ®; try to use assumptions or use the _ 9
AllSolutions coption V_,T
9
V==
4
B b
2 1 1
4. dx 2. assume( a<1<h): dx
| x—a . x—a
Warning, unable to determine if a is between 1 -In(1—a~) +1In(b~—a~)

and b; try to use assumptions or use the
Allsolutions option

b

dx
Jyx—a

3. solve(sin(z) < 0)
3. solve(sin(x-y) < 0) RealRange( Open( -1t), Open(0) )
Warning, solutions may have been lost

Obrdazek 5.13: Varovani.
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Varovani. Reseni.

plotlax,x=1.3) a=2:plot{laxx=1.3)
Warning, expecting only range variable x in P
expression a*x to be plotted but found name a

1n

Obrdzek 5.14: Varovani po spusténi pitkazu plot.

5.3 Ostatni chyby

Podkapitola ukazuje nékolik castych chyb, které vsak nevyvolavaji chybové zpravy ani va-
rovani.

5.3.1 Nenacteni baliku (knihovny)

Chybné Spravné
1. divisors(50) 1. numtheory| divisors | (50)
divisors(50) 1.2, 5. 10,25, 50
nebo
with ( numtheory) :
divisors(50)
1,2, 5. 10, 25, 50}
2. ArcLength( [ cos(x).sin(x) ],x=0.Pi) 2. Student| Calculusl || ArcLength]( [ cos(x), sin(x) ], x=0..Pi)
ArcLength( [ cos(x), sin(x) ],x=0.x) b
nebo

with ( Student| Calculusl |) :
ArcLength([cos(x), sin(x) ].x= 0 ..Pi)
b

Obrazek 5.15: Pti nenacteni pottfebného baliku (knihovny) se piikaz pouze ,piepiSse* na nasledujic
Fadek.

5.3.2 Nespravné pouzivani nékterych symboli

Maple je tzv. case sensitive, tj. zélezi na velikosti pismen. Navic napt. pro Eulerovo ¢islo je
vyhrazen specialni symbol riuzny od pismene e psaného na klavesnici pocitace.
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Chybné Spravné
1. sin(pi) sin(Pi)
sin(T) 0
2. ln(ez) 2. ln(e:)
lnl::ez) 2
3, 1E! 3, 1+1
=1 1-1
1+i I
1—1

Obrazek 5.16: Nespravné pouzivani nékterych symboli.
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6 Navody k reSeni prikladu

6.1 Uvod do systému Maple

Priklad 1.2: Pro vlozeni zadaného vyrazu potiebujeme: sumacni symbol a symbol nekonecna.
Sumacni symbol nalezneme v paleté Expression, symbol nekoneéna v paleté Common
Symbols. Zlomek muzeme bud vzit také z palety Expression, nebo jej zapiseme rucné
pomoci lomitka.

Priklad 1.3: Potfebujeme vlozit zlomek a mocninu (resp. exponent). Oboji najdeme v paleté
Expression. Muzeme také pouzit lomitko a ,stiisku“.

Piiklad 1.4: Opét vyuzijeme jiz diive zminénych palet. Pozor vSak na vkladani Eulerova
¢isla. To je nutné vzit z palety (resp. pouzit piikaz exp). Zapsané pismeno e z kldvesnice
Maple bere jako ,jobycejné“ pismeno (proménnou) e.

Priklad 1.6: K zadéni vyrazu potiebujeme piikaz sqrt pro vlozeni odmocniny a piikaz exp
pro vlozeni Eulerova ¢isla. Piikaz ma jeden parametr, kterym je exponent Eulerova ¢isla (t;.
pro Eulerovo ¢islo samotné zaddavame exp(1)). Vlozit Eulerovo ¢islo je mozné téz zapsanim
pismene e, vyvolanim funkce automatického dokonc¢ovani a zvolenim polozky Exponential
e’

Piiklad 1.7: Nejrychlejsi zpusob je zadat do dokumentu ?sum, piipadné zadat sum, umistit
kurzor na prikaz a stisknout klavesu F2.

Priklad 1.8: Je nékolik zpusobu, jak to zjistit. Zfejmé nejrychlejsi je vyhledavat v napovede
klicova slova matrix a vector, pripadné Linear Algebra.

Priklad 1.10: Pozor na rozdil mezi poctem platnych cifer a poc¢tem desetinnych mist.
Priklad 1.11: Kdyz zapisime néjaké cislo s desetinnou teckou, Maple jej automaticky bude
brat jako cislo v pohyblivé fadové c¢arce a vypocty s nim bude zaokrouhlovat na pocet
platnych mist specifikovany proménnou Digits.

Priklad 1.13: Pouzijeme piikaz isolve.

Priklad 1.14: Pouzijeme piikaz isolve. Systém Maple vypiSe feSeni s pouzitim konstant,
které jsou prirozenymi ¢isly (bez nuly). Spravné vsak maji byt pouzity nezaporné celo¢iselné

konstanty:.

Pifklad 1.16: Resfme jako soustavu nerovnic pifkazem solve.
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Priklad 1.17: Pouzijeme piikaz solve. Pro a = 0 bychom dostali linedrni polynom.
Pifklad 1.18: Resfme opét pitkazem solve. Pozor, dand rovnice ma nekoneéné mnoho fesent.

Piiklad 1.19: Resfme jako soustavu rovnic pifkazem solve.

6.2 Matematicka analyza s Maple v R

Priklad 2.3: Pouzijeme zavedeni predpokladu: assuming.
Priklad 2.4: Pouzijeme piikaz simplify.

Piiklad 2.5: Pouzijeme piikaz simplify.

Priklad 2.6: Pouzijeme piikaz factor.

Priklad 2.7: Pouzijeme piikaz simplify.

Piiklad 2.8: Vyuzijeme piikazu simplify, factor a convert.
Priklad 2.12: Pro vSechna z € R plati: sin(x) € [—1,1].

Priklad 2.13: Plati: f(x) = m a f(—z) = m. Z toho méame: f(z) # f(—=),
f(z) # —f(—x) a tedy funkce nenf suda, ani lichd. D(f) =R\ {2,3}, H(f) =R\ (—4,0].
Obor hodnot uréfme z toho, ze polynom z? — 5 - x + 6 nabyva vsech kladnych hodnot (a
proto musi i funkce f(x)). Zminény polynom nabyva téz zapornych hodnot, a to na intervalu
(2,3), pricemz tu nejmensi presné uprostied intervalu, tj. v bodé x = g Funkce f(z) v tomto
bodé naopak nabyva své nejvyssi hodnoty na intervalu (2,3), a to hodnoty —4.

Z predeslého plyne, ze funkce neni ohranicena.

Priklad 2.14:
(a) f(z) =9—12% f(—x) =9 — 2? = f(z) = sudd funkee,

(b) f(z) =+/z, f(—x) = \/—2 = ani sud4, ani lich4,
(c) flz) =21, f(—z) ==t = —f(x) = lichd funkce.

)

Priklad 2.15:

(a) f(z) =2z, kde z € (0,1), r—92 .. <0
(b) flz) = L (f) f(z) =142 . 0<z<1,
o z+1 ... z>1
(c) flz) =1 +1,
(d) f(z)=e", (g) f(x) = arctan(z),
_Jr 2o w2 ) In(=z) .. z<0
(©) flz) = {x -2 r>2 () flz) = {ln(:zc) x>0
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Pitklad 2.16: f(z) =23 —k -2+ 22, f(—x) = —(2* + k - 2* + 2 ). Z toho dostdvame:
k=—k=0.
Priklad 2.17:

(a) Pro a # 0 se jedna o bijekci.
(b) Ano, je to bijekce.

(
(d

)
)
c) Nejedna se o bijekci, funkce neni prostd.
) Ano, je to bijekce.

)

(e) Ano, je to bijekce.

Priklad 2.19:

Priklad 2.20: Kazda funkce osové symetrickd vzhledem k piimce y = z je sama sobé inverzi.
To znamena, ze jich je dokonce nekonec¢né mnoho.

Pifklad 2.22: g~*(z) = % - In(z). Legendu muzeme do grafu piidat nastavenim parametru
legend piikazu plot nebo kliknutim na graf a vybérem z kontextové nabidky.

Priklad 2.23: Pouzijeme piikaz animate. Funkce h(z) je klesajici pro a < 0, rostouci pro
a > 0 a konstantni pro a = 0.

Priklad 2.25: Vychazime z definice 2.8, pouze se nyni priblizujeme k bodu zy zprava, tj.
uvazujeme interval (zg, zg + 0).

Priklad 2.26: Vyjdeme z definic 2.9 a 2.10. Uvazujeme bod oo (resp. —o0) a chceme popsat
stav, kdy pro libovolné ,vysokou“ (resp. ,nizkou“) hodnotu M existuje hranice, nad niz
(resp. pod niz) pro vSechna z plati, ze funkéni hodnota f(x) je vétsi (resp. mensi) nez ona
puvodné (libovolné) zvolena hodnota M.

Priklad 2.27: Maple zvladne urcit vSechny limity. Postupujeme tedy klasicky vyuzitim sym-
bolu pro poéitani limit z palety, kontextové nabidky nebo ptikazu 1imit.

Priklad 2.28:

(a) Zavedeme substituci y = z°.
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Vyuzijeme vzorce cos(z) = cos($)* — sin($)>.

Rozsitime vyrazem v x? + 5+ 3.

Rozsitime vyrazem i a uvédomime si, ze pro & — —oo je x = —Vz2.

Zadany zlomek rozlozime na soucet dvou zlomku a zavedeme substituci u = —uz.

Dalsimi drobnymi dpravami umime rozhodnout, kam se ktery vyraz (zlomek) limitné
blizi pro u — oc.

Vyuzijeme vzorce sin(2 - t) = 2 - sin(t) - cos(t) a platnosti lir% Smwﬂ = 1.
z—

Priklad 2.29:

(a)

(b)

Staci dat ptiklad takika jakékoli ,rozumné“ funkce definované na néjakém neprazdném
intervalu — viz definice 2.7.

Vychazime z 2.10. Je tieba dat priklad funkce f(z), jejiz hodnoty se blizi néjakému
kone¢nému ¢islu pro x — oo (resp. z — —o0). Mohla by néco takového splnovat néjakéa
polynomidlni, mocninnd, exponencialni, ¢i goniometrickd funkce?

Takika ,opacny* piipad k predeslému. Hledame funkci f(z), kterd pro néjaké konecné
velké x ,roste nade vSechny meze“ (resp. ,klesd pod vSechny meze“). Mohla by néco
takového splnovat néjakd polynomidlni, mocninné, exponencidlni, ¢i goniometricka
funkce?

Nyni chceme najit funkci f(z), jejiz hodnoty se blizi co (resp. —oo) pro & — oo (resp.
x — —o0). Opét je na misté stejnd otdzka: splnuje toto néjakd polynomidlni, mocninnd,
exponencialni, ¢i goniometricka funkce?

Musime spojit vSechny predeslé body. Na bod (a) muzeme zapomenout. Pokud splnime
vsechny ostatni, bude splnéna i tato podminka. Jedno mozné teseni je najit funkci
splinujici (b) a (d) — takovou funkei jste jiz moznéd dokonce nasli — a zkombinovat ji (tj.
napft. vynasobit) s funkei splaujici bod (c).

Priklad 2.31:

(a)

(b)
(c)

Musime se obejit bez systému Maple, jelikoz ptikaz discont neumi hledat nespojitosti
u funkei definovanych po ¢astech. Podezielé body z nepojitosti jsou body 1 a 2. Musime
ovérit, zda v nich existuje limita a zda je rovna ptislusné funkéni hodnoteé.

V tomto ptipadé piikaz discont pracuje bezchybné.

Opét se musime obejit bez systému Maple. Postupujeme analogicky k feseni prikladu
2.30.

Priklad 2.32: Postupujeme analogicky k feSeni piikladu 2.30. Hledani ¢isel ¢ a d vede na
soustavu dvou rovnic.

Piiklad 2.33: Jsou dvé hlavni moZnosti, jak postupovat. Bud vzit zndmou funkei, ktera neni
spojitd, ale vime, ze mé limitu v kazdém bodé (na daném intervalu), nebo vzit funkei spojitou
(ta mé limitu v kazdém bodé) a nespojitost ,,vytvorit“, aniz bychom porusili existenci limity.
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Priklad 2.34: Systém Maple zvladne urcit vSechny derivace. Ke spravné odpovédi je nutné
porozumét vypisu systému v piipadé (b). Symbol D tu znaci diferencidlni operétor.

Priklad 2.35: Je tifeba najit spojitou funkei f(x), pro niz by v néjakém bodé xy neexistovala

limita z definice 2.14: lim %ﬁéxo) K tomu, aby tato limita neexistovala, staci, aby se
T—TQ

nerovnaly limity zleva a zprava, tedy aby platilo: lim %ﬁ:émo) # lim f@)=f@o)  Jax

T—T0~ r—zot T—Zo
musi vypadat funkce splinujici predchozi nerovnost?

Kdyz najdeme pravé popsanou funkei, je jiz jednoduché napi. definovanim po c¢astech
vytvorit funkei, kterd bude mit na daném intervalu libovolny pocet (a tedy i napf. rovny
dvéma) bodu, v nichz bude funkce spojitd, ale nebude v nich mit derivaci.

Priklad 2.36: Z poznamky 2.4 vime, ze smérnice tecny je rovna derivaci funkce v piislusném
bodé. V rovnici tecny tak zbyva urcit pouze konstantni ¢len, jehoz hodnotu zjistime z toho,
Ze tetna mé s funkei jeden spoleény bod.

Priklad 2.37: Jelikoz ma byt te¢na rovnobézna s néjakou primkou, musi mit stejnou smérnici.
Tedy pokud y = k-z+q je rovnici tecny k funkei f(x) v bodé xq, pak musi platit k = f'(zq) =
12 (nebot 12 je smérnice rovnobézné primky). Jelikoz f/(xg) = 3 - 7y, dostdvdme dva ruzné
body zg a tedy dvé tecny.

Piiklad 2.38: Resime obdobné jako predchozi piiklad. Smérnice zadané pifmky je rovna —%.
My pottebujeme nyni smérnici kolmice. K tomu vyuzijeme linedrni algebry, odkud vime, ze
dva vektory jsou na sebe kolmé, jestlize je jejich skaldrni soucin roven 0. Mame-li piimky
y==k-xay=1[0-x pak tyto jsou na sebe kolmé, jestlize 1 + k-1 = 0. Z toho dostavame, ze
smeérnice hledané kolmice je rovna 3, coz je tedy smérnice tecny. Tedy pokud y = k- x + ¢q je
rovnic teény k funkci f(x) v bodé xg, pak musi platit k = f'(x) = 3. Jelikoz f'(xq) = 3-x0?,
dostavame opét dva ruzné body xg a tedy dvé tecny.

Priklad 2.40: f(z) = \/z,xo = 49, h = 2.
Priklad 2.41: f(z) = J/x,x9 = 125, h = —2.
Pitklad 2.42: f(x) = 2,29 = 3,h = —0.05.

Priklad 2.43: Pouzijeme piikaz taylor pro bod x = 0 a ziskany vysledek pfevedeme na
polynom piikazem convert.

Priklad 2.44: Pouzijeme piikaz taylor pro bod x = 1. Proménnou Order nastavime na
hodnotu 5 a ziskany vysledek prevedeme na polynom piikazem convert.

Priklad 2.45: Pouzijeme piikaz taylor pro bod x = 2.

Priklad 2.47: Postupujeme analogicky k prikladu 2.46.

(a) Uvazujeme funkci e”, kterou rozvineme do Taylorova polynomu v bodé zy = 0, a hleddme
aproximaci v bodé x = —1. Stejnym postupem jako v piikladu 2.46 dospéjeme k tomu,
Ze je pro pozadovanou presnost potieba nastavit proménnou Order na hodnotu 7.
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(b)

Uvazujeme funkci +/z, kterou rozvineme do Taylorova polynomu v bodé xy = 243,
a hledame aproximaci v bodé x = 250. Nyni musime k odhadu velikosti Taylorova
zbytku pouzit poznamku 2.7, nebot zy # 0. Tvar zbytku je pak nejjednodussi vyhod-
nocovat postupné pro n = 1,2, ..., nebot Maple neumi vyfesit piislusnou nerovnici.
Dostatecné n v tomto pripadé: n = 2.

Priklad 2.50:

(a)

(b)

Funkce f ma tii stacionarni body, z nichz jediny je lokalni extrém, dalsi dva jsou body
inflexni. Funkce nemé zadnou asymptotu.

Funkce f ma dva stacionarni body, oba jsou lokalnimi extrémy. Funkce ma dale tii
inflexni body. Funkce neni definovana ve dvou bodech, v nichz ma asymptoty bez
smérnice. Asymptoty se smérnici neexistuji. Aby Maple tento piiklad spravné vyftesil,
je potieba nacist balik RealDomain.

Funkce mé dva stacionarni body, z nichz jeden je lokalni extrém, druhy je inflexnim
bodem. Funkce neni definovana v jediném bodé, v némz méa asymptotu bez smérnice.
Funkce ma také asymptotu se smérnici.

Funkce méa nekonectné mnoho staciondrnich bodu (na zjisténi tohoto v Maple je tieba
pouzit atribut allsolutions), vSechny jsou vsak inflexnimi body. Funkce ma i dalsi
inflexni body (vzdy uprostted intervalu tvoreného staciondrnimi body). Funkce nem4
asymptotu bez smérnice ani asymptotu se smérnici. Opét pozor na vypocet systému
Maple — pii pocitani limit v nékterych ptipadech vypisuje interval jako hodnotu limity
(limita vSak neexistuje).

Zasadni otazka v tomto ptikladu je, zda je funkce f(z) spojita v bodé 0. Funkce ma tii
stacionarni body a vSechny jsou jejimi lokalnimi extrémy. Funkce ma déle dva inflexni
body a zddnou asymptotu (bez smérnice ¢i se smérnici).

Priklad 2.54:

Staci rozlozit na dva zlomky a urcit ptimo ze znalosti ,tabulkovych® integralu.

Vyraz pod odmocninou je mozné upravit tak, aby se dala odmocnina odstranit (apli-
kovat). Poté uz se vysledek uréi podobné jako v predchozim piipadé.

Po rozndsobeni je mozné integrovat kazdy clen zv14st.
Rozklad na parcidlni zlomky:.

Opét rozklad na parcialni zlomky. V tomto ptipadé je vsak vyrazné pracnéjsi nez
predchozi, nebot jeden ze ziskanych parcidlnich zlomku je tfeba déle upravit (rozlozit),
abychom integraci ziskali ptirozeny logaritmus. Tim se nam vsSak objevi dalsi zlomek,
u néjz je tteba rozpoznat, ze pripomind derivaci funkce arkus tangens (arctan), jen je
potieba zlomek opét upravit do vhodného tvaru.

Zavedeme substituci t =5 -z + 6.
Zavedeme substituci ¢t = In(x).

Zavedeme substituci t = % + 1.
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(i) Resime metodou per partes, piicemz funkce, kterou budeme chtit derivovat, bude
funkce 2. Maple pii pouzit{ piikazu Parts vyuzije znalosti [ cos®(z) do = % - cos(z) -

sin(z) + 3 - z, k ¢emuz dospéjeme uzitim vztahu cos?(z) = H%S(QI) Integral ziskany

metodou per partes je tfeba rozlozit a na jeden z nich pouzit substitu¢ni metodu.
(j) Resfme metodou per partes. Funkci, kterou budeme derivovat, je funkce In(z).

(k) Resfme opét metodou per partes. Funkci arctan(z) si zapfseme jako arctan(z)-1 a prave
samotnd funkce arctan(z) bude ta, kterou budeme derivovat.

(1) Resfme nejprve substituéni metodou polozenim ¢ = x2. Nasledné pouzijeme metodu
per partes, pricemz funkce, kterou budeme derivovat, bude funkce x.

Priklad 2.55: Ve vSech pripadech vyuzivame Newton-Leibnizovy formule.
(a) Resfme metodou per partes.
(b) Zavedeme substituci z = 2.
(c) Zavedeme substituci cos(z) = t.
(d) Zavedeme substituci e* = t.
(e) Resfme metodou per partes.
(f) Zavedeme nejprve substituci t = e® a ndsledné u? =t — 1.

Priklad 2.58:

(a) Resfme naprosto analogicky s pifkladem 2.56. Vysledek je: S = 16:v2

3
202
pl = pfor( [4— X, xh], x=-J2 .J2. = x—>pz'ecewflse(x < 0,-x, x3) :
color="NavyBlue", thickness = 2) : g=x—1:

p=plot({f(x),g(x)},x=-1.1, color="NavyBlue",

2
f = plortools[ transform | ( (xy)— [x ytx ] ) : thickness = 2, scaling = constrained) :

p2 = pfar(-'-l -2 xg_.x=—v-'{? A2, tr = plottools| rransform | ( (x,¥) = [xy+f(x)]):
filled= true, color= cyan) : g = plot(g(x) -f(x),x=-1..1, filled= true, color
plots[ display] ([ f(p2).pl ], scaling= constrained) = cnan} :
plots[display](tr(q).p);
3
03
2 06
0.4
L 0.2
-1 035 0 03 1
-1 -0 0 05 1 r

Obrazek 6.1: Zobrazeni plochy z piikladu 2.58.(a) vlevo, zobrazeni plochy z piikladu 2.58.(b) vpravo.
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(b) Obsah zadané plochy je tfeba pocitat ,na dvakrat“. Nejprve se spocita obsah plochy
mezi kiivkami y = —z a y = 1 na intervalu [—1,0], ndsledné obsah plochy mezi
kiivkami y = % a y = 1 na intervalu [—1,0]. Vysledek je: S = 2.

(¢) Staci si uvedomit, mezi kterymi ¢dstmi kiivek lezi zadand plocha. Vysledek je: S = 3.

2 "~ "o -
pl ::pfor(x .x=0..1, color="NavyBlue", Ihzckne.s.s—?.) tpl !=pfox[ [tan(x),0],x=0 ..

.:..|r.|

; —. y=-2..2, color
p2 = plots| implicitplot ) (}" =x,x=0.1,y=0 .1, color
="NavyBlue", thickness = 2) : = "NavyBlue", thickness= 2] :

f:= plottools| xransform]( (xny)— [r y+ xg]) : . i T
p3 ::pi’or(v-'{? - xE: x=0..1, filled= true, color= cyam) : p2 = plots[ impliciiplot] [x— FR 0 g
plots[display]( f(p3).p1.p2) ]

T y=0..1, color

| ="NavyBlue", thickness=2

03 p3 = pfor[tan{x}: x=0 ..g:ﬁi’i’ed= true, color= cyan] :
plots[ display](p3. p2. pI)
0.6 ,
0.4
1
0z /"ﬂ
0
0 mx x 3z m Sz 3m Fm om
o 02 04 06 03 1 32 16 32 8 32 16 32 4
x 1 x

Obrazek 6.2: Zobrazeni plochy z prikladu 2.58.(c) vlevo, zobrazeni plochy z piikladu 2.58.(d) vpravo.

fi= x—>piecewise(x <0, e_x: ex) :

gi=x—1:

p=plot({f(x).g(x) }.x=-1n(2) ..In(2). color="NavyBlue",
thickness = 2, scaling= constrained) :

tr := plottools| transform | ( (x,¥) = [xy+f(x)]):

g = plot(g(x) -f(x),x=-1n(2) ..In(2).filled= true, color = cyan) :

plots| display](ir(q). p, scaling= constrained);

0z 04 0é

Obrazek 6.3: Zobrazeni plochy z piikladu 2.58.(e).

(d) Resfme rovnou podle poznamky 2.23. Vysledek je: S = @
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(e) Resime opét rozdélenim na dva urcité integraly. Vysledek je: S =4 -1In(2) — 2.

Priklad 2.59:

(a) Pomoci derivace musime urcit rovnici teény. Déle uz fesime analogicky k predchozim
prikladum. Vysledek je: S = %.

= xﬁpiecewise[x <lo4x- 7] : pl = plot([ 3. x = 2]. x=-2 .1, color="NavyBlue",
zhickne.s.s=2) :

2
g=x—=x —2x+2: 7= plottools| transform | ( (x,y) =[xy +3-x—2]):

(=]

p=plot( {f(x),g(x) }.x=0 .3, color="NavyBlue",

3
thickness = 2, scaling = constrained) : p2= pi’oz(x —3-x+2,x=-2.1, filled=true, color= C’J"a”) :
p2 = plots| implicitplot|(x=0,x=0..3,y=0..2, color plots[display] ( f(p2).pI)
="NavyBlue", thickness=2) : 1
tr == plottools| transform | ( (x,¥) — [xy+f(x)]): J

g = plot(g(x) -f(x),x=0..3,filled= true, color= cyan) :
plots| display| (tr(q). p. p2. scaling= constrained) ;
5

1

4

3

Obrazek 6.4: Zobrazeni plochy z ptikladu 2.59.(a) vlevo, zobrazeni plochy z piikladu 2.59.(b) vpravo.

b) Opét musime uréit rovnici teény a také jeji prusecik s funkef y = 2. Vysledek je:
y Je) ) y J
S =2

4

(¢) Nynf je tfeba urcit rovnice dvou tecen a jejich prusecik. Vysledek je: S = %

Priklad 2.60: Ve vSech pripadech vyuzijeme poznamky 2.24:
(a) Vysledek je: S = 23,
(b) Vysledek je: S =12 - 7.
(c) Vysledek je: S = 2L

Piiklad 2.61: Je tfeba odvodit rovnici kruznice. Mame dvé moznosti — bud popsat ,,horni“ po-
lovinu kruznice vztahem y = v/r? — 22 a ,,spodni“ polovinu kruznice vztahem y = —v/r? — 22,
nebo kruznici popsat parametricky predpisem z = r-sin(t),y = r-cos(t),t € [0, 2-7]. Nésledné
vyuzijeme odpovidajictho urcitého integralu. Pti pouziti prvniho postupu je v Maple nutné
pridat pfi vypoctu integralu predpoklad, ze r je nezdporné (realné) ¢islo, abychom dospéli
k pozadovanému vysledku.

229



f= x—>pz'ecewr;se[x < %.—4-x+ T.2:x— 8] :

g:zx—hx? —6-x+8:
p=plot({f(x).g(x)},x=1 .4, color="NavyBlue", thickness = 2,
sealing= constrained) :
tr == plottools| transform | ((xy) — [y +f(x)]):
q = plot(g(x)-f(x),x=1..4,filled= true, color = cyan) :
plots[ display](tr(q), p, scaling= constrained) ;
3

2

Obrazek 6.5: Zobrazeni plochy z piikladu 2.59.(c).

pl :=pfor[ [3- 22: 31— 23: t=-J3 ..J?]: scaling

= constramed, filled = true, color= cyan] :
p? :=pfor( [3- IE: 3-r— 33: t=-/3 ..\.F{?]: scaling

= constrained, color="NavyBlue", thickness= 2) :
plots| display] (pl. p2)

pl = plot([2- (t —sin(t)),2-(1 —cos( £)),=0.2-%],
scaling = constrained, filled= true, color = cyan) :

p2 =plot([2- (t—sin(z)),2-(1 —cos( 1)).t=0.2-w],
scaling= constrained, color = "NavyBlue", thickness=2) :

plots| display] (pl, p2)

Obrazek 6.6: Zobrazeni plochy z piikladu 2.60.(a) vlevo, zobrazeni plochy z piikladu 2.60.(b) vpravo.
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pl = pi’oz[ [3 -sins{r]: 3 -coss{ t),t=0 ..J'c]: plots|display](p1. p2)

. ) 3
scaling= constrained, filled= true, color

= C'yanj : 2

. 3 3
p2 ==pi’m([3-sm (t),3-cos {x},z=0..1t], 1
scaling= constrained, color="NavyBlue", 0

thickness=2 ) :

Obrdzek 6.7: Zobrazeni plochy z piikladu 2.60.(c).

Priklad 2.64: Ve vSech pripadech vyuzijeme poznamky 2.25.

_ 2613 16
(a) l=202 -3

-1 2'62+64+1'<62—1>
e?+1

(b) 1=° =235

(c) Systém Maple vyjadii feseni za pomoci eliptického integralu. Informace k tomuto
vysledku muzeme nalézt v napovédé. Piikazem evalf ziskdame priblizné numerické

feSeni. ,
22
V2 _ 2 =
=22 EllipticE(% )—2~\/§~0f\/ﬁdx—3.82

(d) 1 =2-v2- EllipticE(*2) =2- /2. fvl i1 dr = 3.82

2

Priklad 2.65: Ve vSech pripadech vyuzijeme poznamky 2.26.

(a) 1=2-V3

() l=2-7-vV1+16-7>— 3 -In(—4 -7+ 1+ 16-72)

Pifklad 2.66: Resime analogicky jako v pifkladu 2.61, jen misto obsahu kruhu po¢itdme
obvod kruznice.

Priklad 2.69: Ve vsech pripadech vyuzijeme poznamky 2.27:

(a) Vysledek: V =37
(b) Vysledek: V = %
(c) Vysledek: V = &F.
(d) Vysledek: V = &%
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p2 = plots| implicitplot (y2=x,x=0 .1,¥y=0.1, color

"NavyBlue", thickness=2 ) :

—>[x_.y+x2]) :

f = plottools| transform | ( (x, )

plots display]( f (p3).pl.p2)
1
0z
04
04
0z
DD 0z 04 0.6 0z 1

pl :Zploz(xz, x=0..1, color="NavyBlue", zh.ickmess=2) :

p3 :=plot(ﬁ —xz,x= 0..1, filled=true, color=qvan) :

p: pIorSd[[ J_] 6=0.2-m x=0 .1, axes= frame,

coords = cylindrical, labels=["x","y", " “])
plots| display] ( p, orientation= [ - 80_ 185_ 105])

Obrazek 6.8: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z piikladu 2.69.(a).

pl = plot(sin(x), x
p2 = plot( [sin(x),

thickness=2) :
plots| display] ( pl. p2, scaling = constrained)

=0 .x, filled= true, eolor= cyan) :
0], x=0 .m, color="NavyBlue",

0z
06
04
0z

va
El
15
El
-1
El
El

>|
|

p = plot3d(sin(x),6=0.2-w x=0 .1, axes= frame,
coords = cylindrical, labels= [ "x", "y", "z"] ) :
plots| display] ( p, orientation= [ -75, 185, 100])

Obrazek 6.9: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z piikladu 2.69.(b).
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fi=x —>piecmvise(x <1, 1 x] :
X

2)'

2, filled=true, color

% =1 .2, color

thickness=

pl ==pior[ [f(x),2],x=

="NavyBlue",

p2 ==pior[2 —f(x),x= % .

=cyam):

tr := plottools| transform | ( (x, ¥) =
plots[display] (r(p2).plI)
2

[xy+f(x)]):

13

16
F

14

12

1

:pfot.?d( [f(x).,2],8=0.2-mt.x= % .2, axes

= frame, coords= eylindrical, labels=["x","y", "z" ] ] :

plots| display] ( p, orientation= [ -85, 185.-35])

Obrazek 6.10: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z piikladu 2.69.(c).

pl = pfoz( [.j 4-7 .2 —x],x= 0 ..2, color="NavyBlue",
thickness = 2)
tr := plottools| transform | ( (x,¥) =[x,y +2 —x]) :

p2 = pfor( J 4- x2 —2+x,x=0.2, filled=true, color

=cyan) :
plots[ display] (tr(p2).pl)
2
1.5
1
05
1]
1] 0.5 1 1.5 2

)4 !=plor3d( [ 2-x 4—x2 ], 0=0.2-mx=0.2, axes

= frame, coords = cylindrical, labels=["x","y", "2"] )
plots| display | ( p, orientation= [ -85, 0, 130] ]

Obrazek 6.11: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z piikladu 2.69.(d).

233




Priklad 2.70: Ve vSech pripadech vyuzijeme poznamky 2.28:

(a) Vysledek: V =

37
1

L2,

o3

3
] -cos(s), [z—%]-sm{s} R

J? axes = frame, labels= [ "x", "y",

3

pl = pfox[ zz t— I?, t=0 ﬁ . filled=true, color= cyan] :
3

p2 = ploz[ For— I?_. =0../3 | color="NavyBluc",

thickness= 2

plots| display] (pl, p2, scaling= constrained)

0.6

0.4

06 ~().9
04

y

02 021

0 ]

0 1 z 3 041

1)
plor.s[dwpfm]{p orientation= [ 85, 10, 160])

0.6

Obrazek 6.12: Zobrazeni zadané plochy a ziskaného rotacniho télesa z piikladu 2.70.(a).

288 s

(b) Vysledek: V =

3-31'113(:],3-(:033( r},r=—§ ;

pl = ploz[
= true, color=cyan

, color

3-91'113[:], 3-0093[ t),t=-

| A
w|;|

p2 = plaz[

="NavyBlue", thickness =2, scaling= constrained | :

L filled p=

pfoz.?d[ [ 3 -sins{x}, 3-c053{z} cos(s), 3 -cosg{x} -sin(s) ], s
=0 ..2-J'c,t=—§ % axes = frame, labels= [ "x","y", "z"]):

plots| display] ( p. orientation= [ 85, 10, 150])

plots| display] (pl, p2) ]
~ 2
3 -1
¥ {H
4 ]
A
1 e
| ] 2 3
I 0] r ‘_3-10
3 2 1 i} 1 2 3 X < 3 oz

Obrazek 6.13: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z piikladu 2.70.(b).

(c) Vysledek: V =3 -7.

(d) Vysledek: V =4 - 72,
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pl :Zplax([sinz{z}: 1-cos(t),t=0.. J'c]: color P :Zplaz.?d([sinz{z]_. (1 — cos(t))-cos(s),

="NavyBlue", thickness= 2, scaling= comzramed) : (1 — cos(t))-sin(s) ]: s=0.2-mt=0.m
f = plottools| transform | ( (x,y) =[xy +1-/1—x ) : axes = frame, labels=["x","y","z" ) :

p2 =plot(2-J 1 —x ,x=0..1, filled= true, color= cyan) : |plots| display] ( p, orientation= [-8-5: 10, 1507)

plots| display| ( f(p2).pI)
2

0.5

D.
002040602 1 x

Obrazek 6.1/: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z piikladu 2.70.(c).

pl =plot([2 + sin(z).2 + cos(t),1=0..2- 1], color="NavyBlue", |p = plot3d([2 + sin(z), (2 + cos(z))-cos(s),

thickness= 2, scaling= constrained, view= [0 ..4,0..4]) : (2 +cos(t))sin(s)].s=0.2-mt=0.2-m,
f:= plottools| transform | ( (xy)— [x y+2—J1—(x— 2}2 ]) : axes=frame, labels=["x","y", "2"], scaling

( ﬁ ) = constrained) :
p2 =plot\2-J 1= (x—2)" ,x=1.3, filled=true, color=cyan) : plots| display] ( p, orientation= [ 85, 10, 150])

plots[ display]( f(p2).pl)
4

(%]

Obrazek 6.15: Zobrazeni zadané plochy a ziskaného rota¢niho télesa z piikladu 2.70.(d).

Priklad 2.71: Koule vznikne napftiklad rotaci ,horni* poloviny kruhu kolem osy z. Je tedy
potieba odvodit rovnici kruznice o poloméru r a jeji ,horni“ polovinu pouzit pro dosazeni
do vztahu pro vypocet objemu.

Priklad 2.72: Vélec o poloméru podstavy r a vysce valce v vznikne rotaci (kolem osy x)
obdélnika tvoreného stranou o délce v na ose z, kolmicemi v krajnich bodech o délkach r
a zbylou stranou o délce v (spojujici kolmice ,na druhé strané).

Priklad 2.73: Kuzel vznikne rotaci trojihelnika kolem osy z. Trojihelnik je tvotfen tseckou
na ose r odpovidajici vysce kuzele a kolmici na jednom konci tsecky o délce rovné po-
loméru kuzele. Linedrni funkce pak spoji ,zbyvajici konce“ tisecky a kolmice (pii vhodném
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,rozmisténi® muze byt linedrni funkei funkce y = = - z).

Priklad 2.76: Ve vSech ptipadech vyuzijeme poznamky 2.30. Obsah plasté zpravidla poc¢itame
rozdélenim na ¢asti plasté ziskané rotacemi jednotlivych funkei na odpovidajicich intervalech.

=L.7-(134-v5-3-In(V5+2) —16) =9.14 .
S=2-7-(V2+In(1+V2)) = 14.42.
S=7-(VI7T+2-In(2) —In (1+V17) +2- V2 +1In (1 + v2) 4+ 6) = 42.68.
S

=47 (V2+42) =42.90.

Priklad 2.77: Ve vSech pripadech vyuzijeme poznamky 2.31:

Pifklad 2.78: Resfme zcela analogicky k pifkladu 2.71.

Pifklad 2.79: Resime analogicky k ptikladu 2.72. Pozor na to, ze v zadéni se pozaduje povrch
celého valce, tj. musime urcit povrch plasté i podstavy valce.

Piiklad 2.81: Postupujeme stejnym zpusobem jako v ptikladu 2.80. Tentokrat je funkce
1
nespojitda v bodé 0, a musime tak urcit linr}r [z In(z) dz.
t
Piiklad 2.83:
(a) Integral diverguje: lim (2-/x) = oc.
T—00

[e.e]

(b) [ 1= de = lim arctan(z) 4 lim arctan(z).
“n T——00 T—00

(c) Maple ve vyledku zobrazi Fresneluv integrél definovany jako

[ (1
FresnelS (z) = /sin (5 S t2) dt,
0

nebot neumi zapsat feSeni{ analyticky pomoci standardnich funkci. Pifkazem evalf
zjistime, ze prislusny integral konverguje.

(d) Integral diverguje: lim In(z) = oo.
T—00
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6.3 Matematicka analyza s Maple v R”

Priklad 3.4: Nakreslené oblasti jsou zobrazeny na obréazcich 6.16 — 6.18

(a),(b)

plots| implicitplot] () = 1.x=-7 . 7.y=-7.7. |plots|inequal]({0 < x,x <y, y =<1} x=0.1,y=0.1,

coloring = | cyan, white|, filled = true, thickness optionsfeasible = (color= cyan), optionsexcluded
=2, gridrefine=3) = (color=white), labels=["x", "y"])
1
6
0z
’ 06
v
04
6 02
x
0

1} 0z 04 0a 0z 1
x

Obrazek 6.16: Zobrazeni zadané oblasti z piikladu 3.4.(a) vlevo, zobrazeni zadané oblasti z piikladu
3.4.(b) vpravo.

(), (d)

plots| impliciplot] [ (x — 2]2 +1 > 1.x=0.4, |Pl = plots[implicitplot] ([1 < || + [|].x=-4 .4, y=-2.2,
} ) ) color=black, thickness =2, gridrefine=13) :

y=-2..2, coloring = [eyan, white]. filled p2 = plots[ implicitplot| ( [max (1 — |x|-|y]. |x| + [} —2)

= true, thickness =2, gridrefine=3 :' <0],x=-4.4,y=-2 .2, color=black, thickness=2,
2 gridrefine= 3, filledregions, coloring = [ "cyan", "white"] ) :
plots| display] (pl, p2. view=[ -3 ..3,-3 ..3])
3
r 1
A
1 »
2 4 e \ -
v 3 -1 N/ EE
-1 . ]
> S

Obrazek 6.17: Zobrazeni zadané oblasti z piikladu 3.4.(c) vlevo, zobrazeni zadané oblasti z piikladu
3.4.(d) vpravo.
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(e)

pl = plots| implicitplot] [O:x=0 doy=Jx(1—x) plots[ display] ([pll (1.5)]. view=[-2..2,-2 .2])

/ 2 |
w1 —x ,color=cyan):

2
p2 := plots| implicitplot| [O:x= 0.1, y=-/1—x _
A
-Jx(1 =x) , color=cyan) :

2 [ 7
p3 :=pfoz[ [ -J1—x.J1—x |.x=-1.0, color= black,
filled= | color= eyan],l : -2 2

p4 ==pi’ox( [ -J1 —xz._ J1 ¥ ],x=0 W1, coi’or=bi’ack) :
i 1 /

AR

p3 =plot| | - J-"' 1 [x——] .
4 A

v

[3=)

=0..1, color= black, linestyle= dot

Obrazek 6.18: Zobrazeni zadané oblasti z piikladu 3.4.(e).

Priklad 3.6: Piislusné defini¢ni obory jsou zobrazeny na obrazcich 6.19 — 6.21

(a), (b) Vyraz pod odmocninou musi byt nezdporny.

plots| implicitplot] (1 -X -4 }'2 =0,x=-2.7y= pfors[impi'icizpfoz](sin(x2 +}'2) >0,x=-3.3,
-4 .5, coloring = | cyan, white]., filled= true, y =-3..3. coloring = [cyan, white]. filled

. . . y = i =7 aride =
thickness =2, gridrefine= 3, view=[-2.2.,-2..2]) true, thickness =2, gridrefine 3)

7

Obrazek 6.19: Zobrazeni defini¢cniho oboru funkce z piikladu 3.6.(a) vlevo, zobrazeni defini¢niho
oboru funkce z pfikladu 3.6.(b) vpravo.

»1

il
-2 }\_D_J/g 2

(c), (d) Argument funkce In musi byt kladny. Argument funkce arccos musi nabyvat hod-
not z intervalu [—1,1]. Systém Maple méa s vykreslenim piislusné mnoziny piipadu
(d) ,problémy“. Pii vyssich hodnotédch parametri gridrefine a crossingrefine je
vysledek akceptovatelny.

(e), (f) Vyrazy pod odmocninami musi byt nezaporné. Diky jejich tvaru je pro né mozné vy-
tvorit jedinou nerovnost a zbyvajici ¢ast podminky ,,schovat® do rozsahu proménnych,
abychom mohli pouzit piikaz implicitplot. Argument funkce In musi byt kladny,
tzn. x > 0Ay—x > 1nebox <0A0<y—x <1 pro piipad (f).
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X

plots| implicitplot](x + v > 0,x=-2 .2, ‘ <1.x=-2.2.y=-2.2.
e ' '

y=-2..2, coloring = [cyan, white],
filled= true, thickness=2)
- 2

plots| implicitplot] [
x

coloring = [ cyan, white], filled = true, thickness

A
=2, gridrefine="7, crossingrefine =6
4

2

Obrdzek 6.20: Zobrazeni definiéniho oboru funkce z piikladu 3.6.(c) vlevo, zobrazeni defini¢niho
oboru funkce z pifikladu 3.6.(d) vpravo.

with( plots) :

2 2
lots[ implicitplot]\\1 —x ). (1 —y ) =0,x=
plots| implicitp ](( ) ( } ) ) pl =inequal({ x> 0,y—x>1},x=0.4,y=-4 .4,

-1.1,y=-1.1 coloring = [ cyan, white]. optionsfeasible= [ color="cyan"], optionsopen= [ linestyle
filled = true, thickness =2, gridrefine= 3, view = dot, color= white, thickness=2], aptionsexcluded= [ color
=[-2.2.-2 2]) ="white" ] , numpoints = 10) :
) 5 p2i=iequal({ x<0,y—x<1,y—x>0},x=-4.0,y=-4 .4,

optionsfeasible = [ color="cyan" |, optionsopen= [ linestyle
= dot, color= white, thickness=21], optionsexcluded= [ color
="white" ] , numpoints = 10) :

display(pl. p2)

4
il #
-
k] il
-2 41 1} 2 -~
"
-
2 e
'i
1
J
P
)
—
B L B R 1 2 3
S0
L
-2 "r "a
R -2
- -
SR
% o
L -3
=
d
4
”

Obrazek 6.21: Zobrazeni defini¢niho oboru funkce z piikladu 3.6.(e) vlevo, zobrazeni defini¢niho
oboru funkce z piikladu 3.6.(f) vpravo.

Priklad 3.7:
(a) Pro nékteré hodnoty parametru contours Maple nezobrazi vrstevnice y = —z ay = .

(b) Pro rovnomérné rozlozeni vrstevnic na zadané oblasti je vhodné specifikovat parametr
contours seznamem funkcnich hodnot.

(¢) Zadana funkce je nespojitd pro y = 0, s ¢imz si Maple ,neumi poradit® a vykresluje
v tomto misté svislou plochu. Ptikaz plot3d nema k dispozici parametr discont, coz se
obchézi vytvorenim dvou grafti tak, abychom se nespojitosti ,,vyhnuli“ — vykreslime
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prfot.'j’(:,l’()c;E —yz, x=-5.5,y=-5.5, style

= patchcontour, axes = ﬁame)

“

Obrazek 6.22: Zobrazeni vrstevnic funkce z piikladu 3.7.(a).

plots| contourplot] ﬁ,x=—5 W5,y=-5.5, |plot3d ﬁ,x=—3 L3, y=-3 .3, sple
x +y x +y
grid=[100, 100], view= [ -4 .4,-4 .4], = patchcontour, axes = frame, numpoints = 5000,
contours=[0.1,0.2,0.3,1,1.5,3,4, 5, 10]] view=[-1.1,-1.1,-1..30], contours = 15]

4

Obrazek 6.23: Zobrazeni vrstevnic funkce z piikladu 3.7.(b).

funkci nalevo od mista nespojitosti a napravo, grafy pak spojime v jeden ptikazem
display.
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plots| eontourplot] [ X x=-5 S, y=-5.5grid |pl = pfor.?d[ X x=-5 .5, y=-5 ..-0.01, style= patcheontour, axes
y v

o

= [200,200], contours=[ ~0.5,-1,-2,-3, = frame, numpoints = 5000, view= [ -5 ..5,-5 ..5,-5 5]] :

-5,0.5.1,2,3,5]. view=[ -2.2.-2.2])
: p2 = pfor.?d[ X x=-5 .5, y=0.01..5, style= patchcontour, axes
¥
) = frame, numpoints = 5000, view=[ -5 ..5,-5 .5.-5 5]) :
plots[ display] (pl, p2)
2 Zi\ 2

Obrazek 6.24: Zobrazeni vrstevnic funkce z piikladu 3.7.(c).

(d)

plots| contourplot|(x-y, x=-5 .5, y=-5 ..5) |plot3d(x-y,x=-5 .5, y=-5 .5, style= patchcontour, axes = frame)

RS

N

j;/ A
N

Obrazek 6.25: Zobrazeni vrstevnic funkce z piikladu 3.7.(d).

Piiklad 3.10: Polozime § = min{e, 1}. Nésledné musime ukazat, ze pro libovolnd x, y spliujici
2] < 6, |y] < &, [, 4] # [0,0] plati

2212
2—y < €.
% 4 y?
Jelikoz x,y spliuje [z,y] # [0,0], je aspon jedno z nich nenulové. Bez tGjmy na obecnosti
predpokladejme, Ze napiiklad y # 0. Pak pro jinak libovolna z, y plati: 22 < 22 + 4%, Z toho
mame: ,

-y 2

R — < .

% 4+ y? Y

241



Pro e > 1 mame |z| < 1, |y| <1 a tedy
2202

2—y2<y2<1<8.
ety

Pro e <1 méme |z| < ¢, |y| < € a tedy
22y

2 2
—_ < <e“<e.
x2 492 Y -

Priklad 3.11:

(a) Maple urci spravné, ze limita neexistuje. Sami to muzeme ovérit napiiklad priblizovanim
se po primkach y = k- x. Vysledek je zavisly na k, tj. na ptimce, po niz se k limitnimu
bodu blizime.

(b) Maple limitu neumi spocitat. Limita v tomto piipadé opét neexistuje, coz muzeme
stejné jako v predchozim pripadé ovérit priblizovanim se k limitnimu bodu po primkach.

(c) Maple limitu nespocitd. Limita neexistuje, coz muzeme zjistit pomoci transformace do
polarnich soutradnic. Ziskany vysledek zavisi na thlu ¢.

(d) Maple limitu nespoc¢itd ani v tomto piipadé, i kdyz staci pouze dosadit.

(e) Maple limitu nespocita. Limita existuje a je rovna 0. Oveérit to muzeme transformaci
do polérnich soutadnic a aplikaci poznamky 3.4.

(f) Maple limitu nespocita. Proménna y tu ptritom neni zdrojem nespojitosti, a tak za ni
muzeme dosadit a pocitat zadanou limitu pouze jako limitu v proménné x.

(g) Maple limitu nespocita ani tentokrat. Limita existuje a je rovnd % Vysledek ziskdme
po rozsiteni zadaného vyrazu doplnénim citatele na rozdil ¢tvercu, nasledné uprave
a dosazeni.

Priklad 3.13: V piipadech a) — d) jsou body nespojitosti tvoreny vzdy body, které nejsou
v definiénim oboru funkce f(z,y). Ve vSech bodech definiéniho oboru jsou funkce totiz spo-
jité.

(a) Jmenovatel rovny nule, takze jedinym bodem nespojitosti funkce f(x,y) je bod [0, 0].
(b) Jmenovatel rovny nule, tj. body [z,y] takové, ze z = 0 nebo y = 0.

)

)
(c) Jmenovatel rovny nule, tj. body [z, y] takové, ze y = 0.
(d) Argument funkce In(z) nekladny, tj. body [z, y] takové, ze z* + y* = 1.
)

(e) Funkce f(x,y) nemd body nespojitosti. Jediny ,podeziely* bod z nespojitosti je bod
[0,0], v némz je vsak limita rovna funkéni hodnoté (viz piiklad 3.9).

Priklad 3.14:
(a) Podle prikladu 3.11.(g): C' = 3.
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(b) Podle piikladu 3.11.(c) limita v bodé [0, 0] neexistuje, tj. neni mozné ,dodefinovat* C'
tak, aby zadand funkce byla v bodé [0, 0] spojité.

Priklad 3.15:

(a) fo(z,y)=2- :v-ly+l,
g//(xay> =% - Y
:f:lx(x7y>:2y xlza
y/c/y(x7y) =2 T,
17 _ 9.
:L{/x(x7y) : 21 z,
yy(xvy) - ?7
(b) fo(z,y) =8 (&> -y +y)-a-y,
() =4 (24 y) ()
" (ryy) =56-28 yt + 1202t gt + 72 2%yt + 8-yt
;’y(x,y):32~x7-y3+96-x5~y3+96~x3-y3—|—32-x'y3,
Z’Iip(x,y):32-x7-y3+96;1x5~y3+96~x3-y3+32-m-y3,
(@ y) =12 y% - (2 + 1),
(c) fi(z,y) =22,
y(z,y) =¥ - In(z),
w(ry)=av2 -y (y—1),
w(@y) =271 (y - In(z) + 1),
é:z(x,y) = xz_l (y -2111(:15) +1),
yy(:c7y) =T hl(l') )
(d) falz,y) =y -In(z+y)+ 735,
e =aobie o)+ 2,
:Qly<x7 y) (I + y) ery + m - (erz)Qa
;;(1’7 y) (x2+ y) + miy + m - (I+z)2’
" _ T+
yy(x’y) =T (achy)y2

Priklad 3.16:
(a) £1(1,2) = L{,f'(l 2) =225
(b) file.e) =12, f(e.e) =
(©) f1(1.2)=0,f)(1.2) =1

Priklad 3.18:
(a) fu(A) =2,

(b) Piikaz DirectionalDerivative neumi pracovat s obecnymi sméry. Je proto potieba
vypocitat fesenf jinak. f],(A) = 3 - (cos() + sin(w)).

Priklad 3.20:
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(a) f(x,y) =Y, [$07 yO] = [3’ 1]7 [[)3, y] = [3'057 0'99]7

(b) Nejprve pievedeme stupné na radidny. f(x,y) = /x - cos(y), [0, 0] = [3, 5], [z, y] =
[3.05, 2571,
(C) f(l',y) = arctan(%), [x07y0] = [17 H: [ZE, y] = [1027 095]7

(d) f(wmy) = 10g4($ ’ y2)’ [an yO] = [47 1]’ [$a y] = [4'01’ 097]

Priklad 3.22:

Priklad 3.23: Ve vsech prikladech pouzijeme piikaz mtaylor.
(a) musime specifikovat bod [z = 1,y = 1],
(b) musime specifikovat bod [z = 0,y = 7],
(c) musime zménit proménnou Order nebo pridat tfeti parametr piikazu mtaylor,
)

(d) musime specifikovat vSechny t¥i proménné.

Priklad 3.24:
(a) f(z,y) = /25 + 3, [x0, 0] = [1,2], [x,y] = [1.02,1.97],

(b) Nejpr\:gtle pfevedeme stupné na radidny. f(x,y) = /x - cos(y), [0, 0] = [3, 3], [z, y] =
[3.05, L]

(c) f(z,y) = arctan(), [zo, yo] = [1,1], [z,y] = [1.02,0.95],
(d) f(z,y) =logy(z - y?), [0, y0) = [4, 1], [x,y] = [4.01,0.97].

Priklad 3.25: Definice lokalniho minima je naprosto stejnda s definici 3.9, jen nyni pozadujeme,
aby pro vSechna X z néjakého okoli bodu X* platilo: f(X) > f(X*).

Priklad 3.30:
(a) Funkce ma 2 stacionarni body, z nichz jeden (bod [1,1]) je lokdlnim minimem.

(b) Funkce mé 4 staciondrni body. Dva z nich jsou lokdlnimi extrémy. Bod [0, —1] je
lokdlnim minimem, bod [0, 1] je lokdlnim maximem.

(¢) Funkce mé 8 staciondrnich bodi. Ctyfi z nich jsou lokdlni extrémy. Body [— Y2, — v2€]

2.e ) 2-e
a [%, *%?] jsou lokélni minima, body [—@ @] a [@ _Q] jsou lokdln{ maxima

€
2-e 7 2-e 2-e 2-e
zadané funkce.
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(d) Funkce méa nekoneéné mnoho stacionarnich bodu, které jsou téz jejimi lokalnimi extrémy.
V bodé [0, 0] se nachdzi lokalni minimum. Ostatni stacionarni body, které jsou viechny
lokalnimi maximy, lezi na kruznici 22 +y? = 1. Klasickym zptisobem neumime o téchto
bodech rozhodnout. Pro ovéteni, ze se jedna o lokalni maxima, muzeme zavést substi-
tuci t = 2% + 9? a vySetfit lokalni extrémy funkce, jako by se jednalo o funkci jedné
promeénné.

(e) Funkce ma jediny stacionarni bod ([2,4]), ktery je jejim lokdlnim minimem. Pro y =0
neexistuje parcialni derivace podle proménné y. Podle toho, jak chapeme pojem okoli
bodu (funkce neni definovand pro y < 0), bychom méli vySettit jesté body, pro néz
y = 0. Nicméné pro y = 0 funkce lokélniho extrému nenabyva, o ¢emz je potieba se
presvedcit vySetfenim okoli ,potencidlniho® lokdlnitho minima v bodé [%, 0].

(f) Funkce mé jeden stacionarni bod, ktery neni jejim lokalnim extrémem. Pro z = —1
nebo y = —1 neexistuji parcidlni derivace zadané funkce. Opét je na uvazeni, jak chapat
pojem okoli bodu a pripadné vysSettit i lokalni chovani funkce v ptipadech z = —1 nebo
y = —1. Jiz z grafu je vidét, ze funkce tu dosahuje lokalné své nejvyssi hodnoty v bodé
[—1, —1], takze je mozné mluvit o lokdlnim maximu funkce v tomto bodé.

(g) Funkce ma nekoneéné mnoho stacionarnich bodu, zddny z nich vsak neni jejim lokdlnim
extrémem. Funkce mé déle dva body, v nichz neexistuji parcidlni derivace. Bod [0, 0]
neni lokdlnim extrémem funkce, bod [2, 3] je lokdlnim minimem.

Priklad 3.31: Definice absolutniho minima je naprosto stejna s definici 3.11, jen nyni pozadujeme,
aby pro vsechna X z mnoziny M platilo: f(X) > f(X*).

Priklad 3.35:

(a) V tomto piipadé ani neni potieba nic pocitat. Jen si pozorné precist zadani a zamyslet
se nad nim. Nejvétsi hodnota (absolutni maximum) zadané funkce je dédna ,piimo*
mnozinou M a jsou to tedy vSechny body na jeji hranici. Absolutni minimum ziskame
tak, kdyz si uvédomime, ze druhd mocnina redlného ¢isla je vzdy ¢islo nezaporné (tj.
vétsi nebo rovno nule).

(b) Opét neni tieba nic pocitat, sta¢i pouzit ,selsky rozum®. Mnozinu M muzeme piepsat
do intervalu: x € [—1,1],y € [—1,1] a odtud uz je na prvni pohled vidét, ze absolutni
minimum se nachédzi v bodé [—1, —1] a absolutni maximum v bodeé [1, 1].

(c) Absolutni minimum funkce uréime jiz ze zaddni, nebot absolutni hodnota nabyva své
nejmensi hodnoty pro nulovy argument a ten je uvniti mnoziny M. Absolutni maxi-
mum muzeme hledat klasickou cestou. Zadana funkce nema stacionarni body, mé ovsem
nekone¢né mnoho bodu, kde neni diferencovatelna. Z grafu funkce (piipadné rovnou ze
zadani) zjistime, ze absolutni maximum lezi na hranici mnoziny M. Napiiklad piikazem
extrema muzeme extrém najit, a to hned ve étyfech bodech: [\/75, \/75], [‘/75, —‘/75],
P a2, 4]

(d) Postupujeme ,klasickym® zptusobem. Ur¢ime lokaln{ extrémy (lok. max. v bodeé [1,1})
a nasledné extrémy na hranici mnoziny M. Celkem dostaneme, ze absolutni maximum
je v bodé [1,1], absolutni minima jsou dvé, a to v bodech [0, 4] a [4, 0].
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(e) Zadany trojihelnik M je mozné vykreslit nésledujici posloupnosti piikazu:
pl := plots[pointplot] ([[0, 2], [3, 0], [0, -1]], color = red,
symbolsize = 20, symbol = solidcircle):
p2 := plots[polygonplot] ([[0, 2], [3, 0], [0, -1]], color = red,
style = line, thickness = 2):
plots[display] (p1, p2)

Zakladnim krokem je zapis jednotlivych usecek trojihelniku v proménnych x a y. Pak
pokracujeme ,klasickym* zpusobem. Ur¢ime lokalni extrémy (lok. min. v bodé [ 1)
a nasledné extrémy na hranici mnoziny M. Celkem dostaneme, ze absolutni maximum
je v bodé [0, —1], absolutni minimum v bodé [1, 1].

(f) Postupujeme opét ,klasickym* zpusobem. Nejprve hleddme lokalni extrémy. Dostavame
,tr1* staciondrni body, pricemz jeden z nich pokryvéa vSechny body takové, ze y = 0.
Tento staciondrni bod (body) vsak neni extrémem jiz na prvni pohled, protoze funként
hodnota je pro néj rovna nule. Zbylé dva staciondrni body [, |, [-%, —5] jsou lokdlni
minimum a maximum zadané funkce. Nyni je potieba si uvédomit, ze funkce sinus je
periodicka s periodou 27, takze téchto lokdlnich extrému je vlastné nekoneéné mnoho
a vSechny jsou soucasné i extrémy globalnimi na celém definicnim oboru. V zadani
byla specifikovana mnozina M, a tak je potfeba omezit mnozinu téchto extrému tak,
aby vyhovovala zadani, tj. absolutni maxima jsou body 5+2-k-m % —2-1-7 pro

k,l € Ny, absolutni minima jsou body [57r +2-k-m,—%—2-1-7| pro k: [ € Np.

Piiklad 3.37: Resime naprosto stejnym postupem jako v pitkladu 3.36. Hledana kladn4 ¢isla
jsow: x =y =z =4.

Priklad 3. 38 Opét postupujeme stejné jako v prikladu 3.36. Minimalizujeme funkci f(z,y) =
T+y+ —>= F pro x > 0,y > 0. Nejmensi mozny soucet takovych ¢isel je 20 pro z = 5,y =
5,z = 10.

Priklad 3.39: Vzdalenost bodu o soutadnicich [z,y, z] od poc¢dtku souradného systému je:
x? + y? + 22. Tento soucet musime minimalizovat pro z = x -y — 1. Piepisem analogickym
k predchozim ptikladim dostavame tilohu minimalizovat funkci

flz,y) = a2 +y?+ (v-y—1)2

na celém jejim definicnim oboru. K tomu muzeme vyuzit piikaz minimize. Nejblize pocatku

je bod [0,0, —1].

Priklad 3.40: Hleddme rovnici piimky y = k - © + ¢, tj. redlna cisla k a ¢, pro néz plati, ze
S=(q—2?+(k+q—32?+(2-k +q—5)? je minimalni. Muzeme opét vyuzit piikazu
11

minimize a dostavame: k = 2, q=%-

Priklad 3.42: U kazdého ptipadu vykreslime mnozinu {2 a z obrazku ur¢ime meze dvojnasobného
integralu.

(a)
Muzeme volit nasledujici:

0<z<1,0<y<z, mneho 0<y<1,0<x<y.
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plots|inequal |({[0 <% 0 <y, x+y<1},x=0.1,y=0

=2 [ 71
1= 1| = : -2 .
..1, optionsfeasible = (color = cyan), optionsexcluded pfaz[[ VImx 1= ]x 0.1, thickness=2, color

(co!m =white), labels=["x","y"]) = black, filled= | color= cyan), scaling= con.muz’ned,'

1 1

032
05

06
¥ 0

0.4 02040608
X

02 05

]

0 02 04 06 08 1

X

Obrazek 6.26: Zobrazeni mnoziny €2 z piikladu 3.42.(a) vlevo, zobrazeni mnoziny Q z piikladu
3.42.(b) vpravo.

Celkem tak ziskame:

Muzeme volit néasledujict:
0<z<1l,—vV1—-22<y<+V1-—2a2

Celkem tak ziskame:

1= [ fa)deay - / / f(z,y) dy dz.
Q 0 _ia?

Muzeme volit nasledujici:
d<rx<L0,—r—-3<y<z+3, 0<zr<dqr—-3<y<—z+3.

Celkem tak ziskdme:

0 z+3 3 —z+

I:/ f(x,y)d:cdy://f(a:y dyd:t:—l—// (z,y) dy dx.
0

-3 —x—3 0 z-—3

Muzeme volit nasledujici:



plots| implicitplot|(|x| + M| < 3,x=-4 .4, y=-4 .4, p = plots pointplot | ([[2.1].[ -2, 1]. [0, 0]]. color

view= [ -4 .4,-4 4], coloring = [ cyan, white], = red, symbolsize= 20, symbol = solidcircle) :
filled = true, thickness= 1, gridrefine=6) x

4

fi=x—1:g :=x—>piecewrlse[x < O:—é: E] :
tr = plottools| tra Sﬁarm][[ ¥~y +f(x)]):
q = plot(g(x) -f(x).x=-2 .. 2, filled= [ color=cyan]) :

5 r=plot({f(x),g(x)}.x=-2..2, color="black", thickness
! =2, scaling = constrained) :
1 plots| display] (p. tr(q).7)

0E
0.6
0.4
0z

Obrazek 6.27: Zobrazeni mnoziny Q z piikladu 3.42.(c) vlevo, zobrazeni mnoziny 2 z piikladu
3.42.(d) vpravo.

Celkem tak ziskame:

0

I—/ fxyd:cdy—//fxy dydx—l—//fxy dy dx.

Priklad 3.43: Podobné jako v predchozim ptikladu si nejprve zobrazime mmozinu ohrani¢enou
integracnimi mezemi a nasledné mnozinu vyjadiime v obraceném potradi mezi.

(a)

Ptepis mnoziny v obraceném potfadi proménnych:

w\a

0<y<20<z<2-y

Celkem tak ziskdme:

jjf(w,y) dy dafjff(x,y) dx dy.

(b) Pfepis mnoziny v obrdceném pofadi proménnych:

N O
INIA
< =
INIA
A~ Do
ol oke
INIA
8 8
INIA

Celkem tak ziskdme:
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pl = plots| implicitplot|( {x=0},x=0.4,y=0.2,color |pl := plots[| implicitplot]( {x=2},x=0.3,y=2 .4,
= black, thickness=2) : color=black, thickness=2, scaling = constrained) :
p2 = me[ 2, %l x=0..4, thickness =2, color= bfack] : p2 :ji’lifi][ ‘5 2-x],x=0..2, thickness =2, color
__ X A _ _ ) p3 = plot( x.x=0 .2, filled=true, color=eyan) :
p3 = pfm[E 2" x=0.4,filled= true, color= c}am] : £:= plottools| transform] ( (%, ¥) — [x y +x]) -
lots| display](pl. f(p3),p2?
f::pggmgfg[;mmfgm][{xJ y) =%y + i]] : plots[ display] (p .{(P ). p2)
plots[ display](pl.f(p3).p2?)
z 3
15
ri
ro1
03 !
0 0
0 1 2 3 4 003 1 15 2
X X

Obrazek 6.28: Zobrazeni mnoziny ohrani¢ené integracnimi mezemi z piikladu 3.43.(a) vlevo, zob-
razeni mnoziny ohranicené integracnimi mezemi z piikladu 3.43.(b) vpravo.

2 2.x

2y . o
/!f(x,y) dyd:vzo/g/f(x,y) dr dy + 2/g/f(av,y) dx dy.

0

(c¢) Ptepis mnoziny v obrdceném poradi proménnych:

O0<y<4 y<z<2

Celkem tak ziskame:

2 22 4 2
//f(fc,y) dydr://fxy dz dy.
0 0 0 Vi
(d) Ptepis mnoziny v obrdceném poradi proménnych:
0<y<Ly<z<Jy.
Celkem tak ziskame:
1 22 1 Yy
//f(x,y) dy dzr://f(fc,y) dx dy.
0 o3 0 vy
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pl = plots[ implicitplot] ( {x=2},x=0.3,y=0..4, color pl = plot( [xz. x?’]. =0 1. thickness=2. color
= black, thickness =2, scaling = constrained) : T o )
2 = black, scaling= comzramed) :
p2i= pfaz(x .x=0 .2, filled=true, color= eyan) : !
2 p2 = pfor(x —x ,x=0..1, filled= true, color= cyan) :
p3 = pfaz( [ 0. x ], x=0..2, thickness= 2, color= bi’ack) : 3
plots[ display] (p|| (1..3)) = plottools| ransform ] (x y) =[x y +x]) :
4 plots| display](f(p2).pI)
1
3 08
51 08
04
1
02
0 0
0051152 0 02 04 06 08 |
x X

Obrazek 6.29: Zobrazeni mnoziny ohranicené integracnimi mezemi z piikladu 3.43.(c).

Pitklad 3.45: Reseni je velice jednoduché. U pifkladu 3.42 staci dosadit f(z,y) = 1 do
integralu, které jsme ziskali fesenim piikladu. U piikladu 3.43 staci dosadit f(z,y) = 1 jak
do zadéni, tak do feseni piikladu.

Piiklad 3.46: Vyjdeme z rovnice kruznice o poloméru r: 2% +y? = r2. Jestlize postupujeme od
proménné x, meze prvniho integrélu jsou zrejmé: = € [—1, 1]. Nésledné potiebujeme vyjadrit
meze proménné y, coz provedeme pravé z rovnice kruznice: y € [—v1? — 22, vr? — 22].
Podle vztahu v poznamce 3.20 jiz jednoduse pomoci systému Maple uréime pozadovany
obsah kruhu.

Priklad 3.47:2 Postupujeme analogicky predchozimu prikladu. Tentokrat vyjdeme z rovnice
elipsy: i—; + ¥ = 1. Proménna = nyni nabyva hodnot z intervalu [—a, a], pro meze proménné

yplati:ye[—b-\/l—z—;,b' —fl”—z]

Priklad 3.49: Ve vsech piipadech je vhodné pro ziskani predstavy vykreslit alespon néaznak
tvaru ziskaného télesa. Déle je vhodné si zobrazit podstavu télesa, z niz odvodime integracni
meze. Dvojny integral ndm ndasledné spocita systém Maple, jen v piipadé (c) neziskdme
presnou (symbolickou) hodnotu a musime pouzit piikaz evalf.
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6—2-x

pl ::pforj’d[[x,y,ﬁ —2-x—3y, ],x=0.3,y=0. 3

transparency =0 .6] :

p2 = plot3d([x 0,z].x=0.3,z=0..6 — 2- x, transparency = 0.6,
axes= frame) :
p3i=plot3d([0,y.z].y=0.2,2=0..6 — 3- y. transparency=0.6) :

p4 :=pfot3d[ [,0,0],x=0.3.y=0.2 — %-x, zramparemqv=0.6] :

plots| display] (pl| (1.4))

3%

pfot[ -3x +2,x=0.3, filled

= [ color = cyan], color= bfack)

2
15

1
0.5

0

0 1 2 3

X
2
3 ?-x+2
V=If 6 —2-x—3 pdydx

070

V=6

Obrdzek 6.30: Reseni pifkladu 3.49.(a).
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pl ::plgtjd([x, v, xz +2- v, ],_x=—1 Wl y=|x .2 —xz,

transparency = 0.6, axes= ﬁame) :

p2 ::p.!'or3d( [x, x|, 2],x=-1.1,2=0 X +2-|x|,

transparency = 0.6):

p3 ==pIot3d( [x,Z — xz, z],x=—1 L1,z=0.4 —xl_.

transparency = 0.6) :

pd = plot.?d( [ x,y,l]]_.x=—] JlLy=|x .2 —xz, transparency
~0.6):

plots[ display] (p|| (1.4))

pl !:pfot( [2 —xz_. |x|]_.x=—] .1,¥=0.2, color
= biack) :
p? ::pior(2 —x2—|x|_.x=—1 .1, filled= true,
cofor':cyan) :
[ 1= plottools| transform | ( (x,¥) =[x, ¥

+1x[1)
plots display](f(p2).p1)

¥ 1
0.3
-1 -0 0 05 1
02— 1 2—x*
2
V= -[ (x +2y) dydx+-[f (x
-1"-x 0
+2-y] dydx
1
=

Obrdzek 6.31: Reseni pitkladu 3.49.(b).

2

pl = seq(pfor.?d( [x,y,zn-cxz+}2],x=—2 2oy=-J4—x

p2 = Seq(plor.?d( [x, zn-/ 4 —_::2 ,z],x=—2 .2,z=0 ..54,

transparency = 0.6),zr1 in[-1,1] ) :
plots| display](pl.p2)

w4 —xz,axes=ﬁ'ame, :mnsparency=0.6),zn in [0, 1]) :

pl :Zpior([\/?,—ﬂ],x=—2

.2, filled= true, color= cyan) :

p2 = plots| implicitplot | ( [xz -I—y;3 = 4], x
=-2.2,y=-2.2, color= black] :
plots| display](pl. p2)

—

2 Ja— 2492
€ dydx

[

i
V=f [—Ierf(l.u—xz)e‘zﬁ)dx
)
evalf (%)

F=168.3835544

Obrdzek 6.32: Reseni pitkladu 3.49.(c).
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pl = Seq[plot.?d[ [x,y, zn- (5-)42 +2-x-y) ],x=0 2,y=0.1

— % axes = frame, transparency = 0.6],214 in [0, 1]] :

3 :=plot3d[ {x 1-3.z|x=0.2.2=0 A 420,

transparency=0.6 | :

plots[ display](p|| (1..3))

p2 = plot.?d( [x,0,2z],x=0.2,2z=0 ..S-XE, transparency = 0.6) :

plot[l - %,x= 0.2, filled= [ color = cyan],

color= black, scaling= constrained ]

0sg
né
0.4
0z

(5-2;2 +2-X-y) dydx

11

F=—
3

Obrdzek 6.33: Resenf pitkladu 3.49.(d).

2

pl = Seq[plot.?d[ XV, zn[i] x=1 ..2,y=L X, axes
y X

= frame, transparency= 0.6],214 in [0, 1]] :
-1 4
p2 :Zploz.?d( [x,x ,z],x=l W2,2=0.x ,z}'amparency=0.6) :
p3: ploz3d[[2,y,z],y= 0.5.2,z=0.4 -y_z, transparency = .6:] :
p4 = plot3d([x.x,z],x=1.2,2=0 .1, transparency = 0.6) :
plots| display] (p|| (1.4))

pl = plots| implicitplot]

X <2y= L,y=-¥],x
X

=1.2,y=—.2, calor=black] :

N|l—l

p2 :=plot(x —x 1, x=1..2, filled= true, color
=qvan) :

tr := plottools | transform | ( (x,¥)— [x,y -I-_v.c_1 ]) :

plots| display] (#r(p2).pl)

0.3

1 12 14 16 18 2
x

assume(x > 0)
2 x

)6

1

dydx

L
x

Obrdzek 6.34: Reseni pitkladu 3.49.(e).
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Priklad 3.50: Kvadr je tieba vhodné umistit do souradné soustavy — naptiklad tak, ze spodni
roh podstavy dame do bodu [0, 0, 0], zbylé rohy podstavy budou v bodech [a, 0, 0], [0, b, 0]
a [a,b,0]. Vyska kvddru bude rovna c. Z toho vyplyvd, ze funkce ohranicujici kvadr je
konstantni funkce f(z,y) = ¢ a podstavu kvddru muzeme piepsat do mezi nésledovné:
z € [0,a],y €[0,D].

Piiklad 3.51: Je potieba znat rovnici koule: 2% 4 3% + 22 = r2. Koule vyjadiend touto rovnici
ma stied v pocatku souradné soustavy. Jeji objem urcime tak, ze spo¢itame objem jeji horni
poloviny (kterd lezi nad rovinou z = 0) a ten vyndsobime dvéma. Pl4st horni poloviny

koule je popsan funkei f(z,y) = /r? —x? —y?, podstava je tvorena kruhem popsanym
nerovnici 2 + y? < r?. Integracni meze tak muzeme zapsat nasledovné: x € [—r, 7|,y €

[—V/r2 — 22 /12 — 22|

Priklad 3.52: Opét je potieba vhodné umistit valec do soutadného systému. Muzeme napiiklad
podstavu valce umistit do roviny z = 0 tak, ze jeji stfed je v pocatku souradné soustavy.
Podstava je pak popsana nerovnici 22 4+ y? < r? a je mozné ji piepsat do integra¢nich mezf
nasledovné: z € [—r,7],y € [—Vr?2 — 22 1/r2 —22]. Vélec je shora ohrani¢en konstantni
funkei f(z,y) =

Piiklad 3.54: Postupujeme stejnym zpusobem jako v prikladu 3.53.
Vysledky:
(a) S=3-V1
(b) S o+ }gg In(5) + 2 - v/5+ 8 . gresinh (2-V6) = 5.58,
(c) ptislusny integral musime vyhodnotit numericky, S = 583.77,
(d) prislusny integral musime vyhodnotit numericky, S = 7.57,
)

(e) prislusny integral musime vyhodnotit numericky, S = 6.00.

Priklad 3.55: Kouli umistime opét stiedem do pocatku souradného systému. Povrch horni
poloviny koule je pak popsan funkci f(z,y) = /72 — 2% — y2. Integra¢ni meze muzeme za-
psat nasledovné: z € [—r, 7|,y € [-Vr? — 22, V/r? — x2]. Ziskany vysledek je tfeba vynasobit
dvéma (nebot pocitdme povrch pouze horni poloviny koule).

Priklad 3.56: Povrch horni poloviny koule je popsan funkci f = /25— . Déle
je treba odvodit integracni meze. Rovina z = 2 protne kouh % bodech kruzmce popsane
rovnici 22 + y? = 21 a rovina z = 4 protne kouli v bodech kruznice popsané rovnici z? +
y> = 9. Mnozina § je tedy prstencového tvaru vymezend kruznicemi o polomérech v/21
a 3. Diky symetrii celého télesa je mozné zabyvat se pouze prvnim oktantem a vysledek
vynésobit ¢tyfmi. Integracni meze (meze ¢asti mnoziny §2) bychom pak zapsali nésledovné:
ze0,3,y € [VI—22 21 — 22 U x€[3,V21],y € [0,v21 — 2.

Pro ziskani symbolického vysledku je tieba prevést integral do polarnich souradnic, napft.
piikazem ChangeOfVariables z baliku Student[MultivariateCalculus]. Maple to ne-
zvladne dokonale, a tak je potieba nasledné zapsat do polarnich soutadnic jesté mnozinu
Q (pro ziskéani integrac¢nich mezi). V polarnich soutadnicich je navic jednodussi mnozinu §2
zapsat, a tak ji prepiseme rovnou celou. Pro polomér r plati: 3 < r < /21, a pro thel 6:
0<0<2- 7.
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flay) =J25 -2 =5

f 2 2
() =y 25— =7

Student| MultivariateCalculus| [ ChangeOfVariables| [‘/1 + [if(r L)] + [if(x: 1)] ] y dx,

[ cartesian, ,, pola.r}_: e]

Obrdzek 6.35: Reseni piikladu 3.56

Piiklad 3.58: Muzeme vyuzit dvojnych integralu jiz ziskanych pfti feseni prikladu 3.48 a pouze
funkei f(x,y) ,prepsat” do mezi pro proménnou z v tietim integralu. Ziejmé plati:

(a) 2 €[0,2% +y7,

(b) = € [0,64 — 7).

Priklad 3.59: Postupujeme analogicky k feSeni prikladu 3.50. Kvadr vhodné umistime do
soufadné soustavy a jeho meze pak muzeme zapsat nasledovné: = € [0,a],y € [0,b],z € [0, c].

Priklad 3.60: Koule je specidlnim pripadem trojosého elipsoidu z ptikladu 3.57 pro a = b =
¢ = r. Muzeme tedy pouze pozménit tyto hodnoty v feseni v prikladu 3.57 a ziskame vztah
pro objem koule o poloméru r.

Priklad 3.61: Postupujeme analogicky k teSeni prikladu 3.52. Valec vhodné umistime do
soutadné soustavy a jeho meze pak muzeme zapsat nésledovneé:
LS [_Ta TL y e [_\/TQ - 1'2, \/7«2 - x?]’ z € [_Ua U]'

Piiklad 3.63: Zadand funkce ptedstavuje plast horni poloviny koule o poloméru r = 1.
V prikladu tak pocitame objem horni poloviny koule o zminéném poloméru a z predeslych
prikladi vime, ze by vysledek mél vyjit 27” Muzeme napiiklad zapsat dvojny integrél
v kartézskych soutadnicich a pouzit piikaz ChangeOfVariables. Nové integracni meze od-
vodime velmi snadno, nebot se jedna o kruh o poloméru 7 = 1. Dostédvame tedy: r € [0, 1],60 €

0,2 - 7].
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Priklad 3.64: Ve vsech prikladech (3.46, 3.51, 3.52, 3.60 a 3.61) jsme v tomto textu vyuzili
kartézskych soutadnic. Nyni tedy provedeme piislusné vypocty v soufadnicich polarnich,
sférickych a cylindrickych.

V prikladu 3.46 poc¢itame obsah kruhu o poloméru r. V polarnich souradnicich muzeme
kruh popsat nésledovné: z = p - cos(f),y = p - sin(f), kde p € [0,7],0 € [0,2 - w]. Podle
poznamky 3.24 tak pocitame integral

2w r
/ / p dp db.
0 0
Jak v ptikladu 3.46, tak i nyni bychom méli obdrzet tabulkovy vzorec: S = - r2.
V prikladu 3.51 pocitame objem koule o poloméru r. Vyuzijeme polarnich soutadnic,

v nichz popiseme podstavu horni polokoule nésledovné: = = p - cos(6),y = p - sin(6), kde
p €10,7],6 €[0,2-x]. Podle pozndmky 3.24 tak pocitdme integrél

27 7
2-//p-\/r2—p2-cos(9)—p2-sin(9) dp db.
00

Jak v ptikladu 3.51, tak i nyni bychom méli obdrzet tabulkovy vzorec: V = % s,

V prikladu 3.52 pocitame objem valce o poloméru podstavy r a vySce v. Vyuzijeme opét
polarnich soufadnic, v nichz popiseme podstavu valce: x = p - cos(#),y = p - sin(d), kde
p €10,7],6 €[0,2-x]. Podle pozndmky 3.24 tak pocitdme integrél

2w r
/ / p-vdpdf.
0 0
Jak v piikladu 3.52, tak i nyni bychom méli obdrzet tabulkovy vzorec: V = 7 - 72 - v.
V piikladu 3.60 pocitame objem koule o poloméru r. Ve sférickych souradnicich muzeme

kouli popsat nésledovné: z = p - cos(¢) - sin(f),y = p - sin(¢) - sin(f),z = p - cos(f), kde
pel-rrl,pel0,2-7,0¢c0,2-7|. Podle pozndmky 3.25 tak pocitdme integral

22w r
///sin(@) - p* dp do db.
0 0 —r
Jak v prikladu 3.60, tak i nyni bychom méli obdrzet tabulkovy vzorec: V = % oS,
V piikladu 3.61 pocitame objem valce o poloméru podstavy r a vysce v. V cylindrickych

souradnicich muzeme véalec popsat nasledovné: = = p - cos(d),y = p - sin(f),z = z, kde
p€10,r],0 €10,2- 7],z € [0,v]. Podle poznamky 3.26 tak pocitdme integral

2 r v
///p dz dp df.
00 0
Jak v pifkladu 3.61, tak i nyni bychom méli obdrzet tabulkovy vzorec: V =7 -r? - v.
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Priklad 3.65: Vsechny tii fady umi Maple ,,secist®.

(a) 2_31 m =1, (b) 2—31 # = %2’ (c) 2_31% = o0, fada diverguje.

Priklad 3.68:

(a) s, =+/n, s = lim s, = co = fada diverguje,

— 00
oo
(b) ap = ——— > L = 1 = 1 fada Y -1 diverguje = zadana fada
n Vn24+2n Vn24+2-n+1 V(n+1)? n+1’ = n+1

také diverguje,

o
(c) a, = v o %5, fada Y- /-5 konverguje = konverguje i zadand fada,
n=1

vni+1
> 1
(d) p0u21jeme limitni srovnédvaci kritérium a budeme srovnavat s fadou Z poy ) 0 niz vime,
n=1

ze konverguje,
pouzijeme limitni verzi podilového kritéria a zjistime, ze fada konverguje,

vyuzijeme opét limitni verze podilového kritéria a zjistime, ze fada diverguje,

(g) vyuzijeme limitni verze odmocninového kritéria a zjistime, ze zadand rada konverguje,
(h) vyuzijeme limitni verze podilového kritéria a zjistime, ze zadana tfada konverguje,

staci zadat systému Maple a zjistime, ze zadana rada konverguje; jinak je mozné pouzit
naptiklad integralni kritérium.

Priklad 3.71:

(a) Jak soucet zadané fady, tak soucet fady absolutnich hodnot umi urc¢it Maple piimo.
Zadana tada konverguje absolutné.

(b) Soucet zadané rady i rady absolutnich hodnot opét uréi Maple pifmo (i kdyz je potieba
se ,nevydésit® vypsanym tvarem vysledku pro soucet zadané rady). Zadana fada kon-
verguje neabsolutneé.

(c) Pomoci Leibnizova kritéria zjistime, ze zadanéd fada konverguje. Pomoci integralniho
kritéria ovérime, ze fada absolutnich hodnot diverguje. Zadana fada proto konverguje
neabsolutneé.

(d) Pomoci Leibnizova kritéria zjistime, ze zadané fada konverguje. Srovnavacim kritériem
oo

s fadou ) % ovérime, ze fada absolutnich hodnot diverguje. Zadana rada proto kon-
n=1
verguje neabsolutneé.

(e) Pomoci limitni varianty odmocninového kritéria zjistime, ze fada absolutnich hodnot
konverguje. Zadana tada proto konverguje absolutné.

(f) V prikladu 3.67.(c) jsme zjistli, ze fada absolutnich hodnot zadané fady konverguje,
tedy zadand rada konverguje absolutné.
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6.4 Linearni algebra s Maple v C"

Priklad 4.2: Musime najit linearni kombinace vektoru béaze tak, abychom ziskali vektory baze
standardni. Tj. napt. pro

e1=(1,0,0) == -(3,0,0)+0-(0,2,0) +0-(0,0,1).

1
3
Soufadnice vektoru ey v bézi a jsou proto (3,0,0).

Priklad 4.3: Nejsou. Je mozné se o tom presvédcit napi. pouzitim ptikazu Basis.

Priklad 4.4: Negeneruji. Opét je mozné se o tom presvédcit napt. pouzitim prikazu Basis.
Bézi tvoii pouze 2 z vektoru.

Priklad 4.6:

-2 -6 0 -4 =2
G*-3-F=|2 1 1 |, A—F =nedefinovino, A-G-F-A=| 5 59 |,
2 -9 —14 -7 13

B-A-C-H—B-F-BT=113.

Priklad 4.7:

-3 2 1

Priklad 4.8: Ve vSech pripadech vyuzivame vytvoreni matice pomoci piikazu Matrix(4,f),
kde funkce f specifikuje pozadovanou zavislost.

Priklad 4.9:

a) Napiiklad A = <8 (1)> . b) Napiiklad A = ((1) (1)> .

Piiklad 4.10: Zvolime né&jaky vektor, napi. u = (1,1)T. Vypocteme v = A - u pro néjakou
hodnotu a a pomoci prikazu PlotVector vykreslime u a v.

Priklad 4.13: Postupujeme zcela analogicky ptikladu 4.11. Soutadnice vektoru v v bazi «
jsou: (0,1,2)T.

Priklad 4.14: Muzeme pouzit napr. prikazu Basis:
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a) vektor ug, b) zadny z uvedenych.

Pitklad 4.15: Jestlize vhodné zvolime bazi, tj. napf. a = {1, x, 22, 23} pro Rs[z], vektor 1 —x
m& v této bazi soutadnice (1,—1,0,0) atd. Posléze jiz muzeme pouzit prikaz Basis jako
v ptedchozim prikladu.

a) vektory jsou linedrné zavislé, napt. 2% — 1= —(1 — z) — (v — 2?) — (2* — 23),

vektory jsou linedrné nezavislé,

)
b) totéz co za (a), napt. 25 + 1 = (1 +z) — (z + 2?) + (2% + %),
c)

)

d) neni nutné ani cokoli poc¢itat, jedna se o 4 vektory v prostoru dimenze 3.

R, [x] se standardnim s¢itanim polynomu a skaldrnim nésobkem polynomu je vektorovy
prostor — je tfeba ovérit, ze plati:

1. p(x) =0 € R,[z] je nulovy prvek, tj. Vq(z) € R,[z] : ¢(x) + p(x) = q(x),

2. Yq(z) € Ryfz] : 3 — q(x) € Ry[z] : q(z) + (—q(x)) =0,

3. Vp(2),q(z),r(x) € Rofz] : (p(x) + q(2)) + 7(x) = p(x) + (¢(z) + 7(2)),

4. Vp(z), q(z) € Ry 2] : p(z) + q(z) = gq(z) + p(2),

5. Va,b € R,p(x) e R,[x] :a-(b-p(x)) = (a-b)-p(x),

6. p(z) =1 € R,[z] je jednotkovy prvek, tj. Vq(x) € R,[z] : ¢(z) - p(z) = q(z),
7. Va € R, p(z),q(z) € Ry[2] s a- (p(z) + q(x)) = a- p(z) + a - q(z),

8. Va,b e R,p(x) e R,[z]: (a+Db) -p(x)=a-p(x)+b-pz).

Pifklad 4.16: Resfme analogicky pifkladu 4.12:
a) ,kritické* hodnoty: a = —1,b =1,

b) ,kritické“ hodnoty: a = 0,b = —2.

Pifklad 4.17: Resfme opét analogicky piikladu 4.12: ,kritické“ hodnoty: a = 1,b = 2, ¢ = 6.

Piiklad 4.19: ReSeni probihd analogicky pifkladu 4.18. Postup v pifpadé (a) ilustruje obrazek
6.36. Pokud pouzivame piikaz assign a tfeSime vice prikladu najednou, je tfeba mit na
pameéti, ze vytvaiime proménné, do nichz prifazujeme néjaké hodnoty — to muze v dalsich
piikladech ,vadit® a je tfeba bud zménit ndzvy proménnych nebo z pouzivanych jmen
(21, T2, ...) hodnoty odstranit. O spravnosti feSeni se muzeme téz presvédcit dosazenim do
puvodni rovnice.

Pifklad 4.20: Resfme opét analogicky pifkladu 4.18. Dostdvame nekoneéné mnoho feseni pro
ti ruzné realné parametry.
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with( LinearAlgebra) : res = ;’Lfa!rix( [.ﬂ'eg( [x{,], i=1.3 ) ]} :
A= Marrix([[1,2-L0],[0,3 —L6—2-I],

[2,0.-1],[1,1.1]]) solve( {seq((R[,1.3].res) [1]=R[£ 4],
Lz 0 i=1.3)}. [x. 3,3}
03-16—2I b -

= [q=3+2Lx=1-Lxg=1+]]
2 0 -1 . -
assign (%)
1 1 1 res
yi=(54+4-110,5 +3-15 +2-I) 3421
5441 1—1
10 1+1
5431
5421

R = GaussianElimination( Matrix( [ 4, v]) )
1 21 0 5+41
03-1 6—21 10
0 0 -14+8I-9+4+7I
0 0 0 0

Obrdzek 6.36: Reseni pitkladu 4.19.

Piiklad 4.21: Muzeme fesit mnoha zpusoby, které Maple nabizi. Vzdy bychom se méli do-
pracovat k vysledku, v ném? se ve jmenovatelich objevuji v sou¢inu vyrazy a? + b* a c, tj.
zadand soustava ma pravé jedno reSeni, pokud jsou tyto ruzné od nuly.

Priklad 4.23: Postupujeme stejné jako v ptikladu 4.22.
Priklad 4.24: Postupujeme stejné jako v prikladu 4.22.

Priklad 4.25: V zadani neni specifikovan postup vypoctu, takze staci pouze ,prepsat” do
systému Maple a vyhodnotit.

Priklad 4.26: Totéz jako v predeslém piikladu. Pouze je tteba dét si pozor na zapis symbolu
pro nasobeni matic.

Priklad 4.28: K Laplaceovu rozvoji vyuzijeme zavedeny piikaz laplace. Matice lze jednoduse
upravovat do tvaru ,,vyhodnéjsich® pro vypocet, nicméné to neni nutné. Piimym vypoctem
determinantu muzeme ovérit spravnost vypoctu pomoci Laplaceova rozvoje.

Piiklad 4.29: Pro redlné matice z pifkladu 4.23 neni tieba nic ovéfovat, nebot konjugovana
matice je shodnd s ptuvodni matici (podobné jako v piipadé redlného ¢isla). U neredlnych
matic vyuzijeme napft. piikazi conjugate a map.

Priklad 4.31:
a) stejnym postupem jako v prikladu 4.30 ovéiime, Ze zobrazeni je linearni,

b) stejnym postupem jako v piikladu 4.30 ovéiime, ze zobrazeni neni linedrni,
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c¢) stejnym postupem jako v piikladu 4.30 ovéfime, ze zobrazeni neni linearni.

Pifklad 4.32: Oznacme p(x) redlny polynom ttetiho stupné. Pak p(z) = a-2®+b-2%+c-z+d,
kde a,b,c,d jsou redlna ¢isla. Oznacme f : Rsx] — Ra[z] zobrazeni piifazujici polynomu
jeho derivaci. Pak:

flp(z))=3-a-2°+2-b-z+c.

Nynf je tieba ovéfit podminku linedrniho zobrazeni, tj. ze pro libovolnd k, I € R ap(z), q(z) €
Rs[z] plati:
f(k-p(x) +1-q(@) =k- f(p(x)) + 1 fla(x)).
Priklad 4.35:
a) stejnym postupem jako v prikladu 4.30 ovéiime, ze zobrazeni neni linedrni,

b) stejnym postupem jako v prikladu 4.30 ovérime, ze zobrazeni je linearni, jadro a obraz
zobrazeni najdeme tak jako v ptikladu 4.34 a zjistime, Ze se jedna o isomorfismus,

¢) stejnym postupem jako v piikladu 4.30 ovéiime, ze zobrazeni neni linearni,

d) stejnym postupem jako v pirikladu 4.30 ovéiime, Ze zobrazeni je linedrni, jadro a obraz
zobrazeni najdeme tak jako v piikladu 4.34 a zjistime, Ze se nejednd o isomorfismus.

Priklad 4.37: Muzeme postupovat zcela analogicky piikladu 4.36. Nyni napf.

f(1,0,0) = = - (f(1,1,0) + f(1,0,1) — f(0,1,1)).

DN | —

Priklad 4.38: Vyuzijeme poznamky 4.15. Uvedena rovnost v tomto piipadé prejde do tvaru:

(f(W)s = (P)pes - (W)ey = A~ (u)ey.

Vysledek tedy ziskdme pouhym vynasobenim matice a zadanych vektoru. Vektory baze 5 k
nicemu nepotiebujeme.

Pifklad 4.39: Nalezenim obrazii vektorii standardni béze R?, tj. vektoru (1,0)T a (0,1)7
zjistime, ze matice A predstavuje

a) otoceni o 90 stupnu proti sméru hodinovych rucicek,
b) preklopeni pfes osu x,
¢) dvojnasobné zvétseni.

Moznosti, jak dané transformace znazornit graficky, je nékolik. Jednou z nich je naptiklad
zobrazeni nékterych vektoru pomoci piikazu VectorCalculus [PlotVector].

Piiklad 4.40: Podobné jako v predchozim prikladu muzeme vyjit z obrazu vektoru standardni
baze R?, resp. R3, tj.:

o () (0) =) (o) (=)
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a1 a2 ais 1 0 @11 a2 ais 0 0
d) lan ax axs|- (0] =[(0], agr axp ax |- 1| =1|1],

as; as as3 0 0 asp asp as3 0 0

@11 Q12 Q13 0 0

asy aza azz |- |10 =1{(0],

as; asy as3 1 1

a1 G12 a13 1 1 a1 G12 Aa13 0
e) {axn ax ax]|-|10]=10], Qg1 G2 aA23 COS(% )

g1 a3z G33 0 0 g1 A3z a33 sin(%

a11 G2 a3 0 0

921 922 a23 0 = — sm(%)

a3; age ass 1 COS(%)

Pitklad 4.43: Ozna¢me obecny polynom tfetiho stupné p(z) =a-23+b-2? + ¢ x + d. Pak
o) =a-2°+(b+12-a) - 2°+(c+8-b+18-a) - v+ (d+4-c+6-b).

Tedy v bézi {1, z, 22, 23}

1 1 0 4 0 6 0 0
ol |o 1] (1 o| s o| |18
Plof = fof “lo]l o] P~ 1| #“lo] |1
0 0 0 0 0 0 1 1
A vbazi {1+ 2,1 -z 2%+ 23 2% — 23}
1 3
0 2
an =p(l4+z)=2+5=3-14+2)+2-(1—2) = ol
0 0
0 —2
1 -1
ar =p(l—z)=2+5=-2-1+2)—(1—2) = o |
0 0
0 16
0 2 3 2 3 2 3 —10
gl | =ele"+a) = =16-(1+2) =10- (1 —2) +7- (2" +27) +6- (" —2") = | |,
0 6
0 —2
elo| =el@—o) == 2.t 48 (1-2) 6 (P +2%) 5 (2 —a¥) = | °
1 -5
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Priklad 4.44: Hleddme (idgs) 5. Musime proto vyjadrit vektory baze o v soutadnicich bdze

B.

Priklad 4.45: Hleddme (90)570. Vyuzijeme k tomu poznamky 4.18, kterd v tomto piipadé
prejde do tvaru:

(P)pa = (ides)g o, (P)eser - (1dg2),, 4 -

Dale si sta¢i uvedomit, ze

1 2
(QO)E:;,EQ = -1 0
0 0

Piiklad 4.50: Resfme analogicky piikladu 4.46.

Priklad 4.51: Jednou z moznosti je sestrojit rovnici ze souradnic bodu A a vektoru B — A a
C — A. Dalsi z moznosti je pouziti baliku geom3d.

Priklad 4.52: Jednou z moznosti je opét klasicky vypocet, v némz rovnici sestrojime naptiklad
ze soutadnic bodu A a vektort u a B— A. Vykreslit bod a rovinu je mozné ptikazem plot3d.
I zde méme téz moznost pouzit na vse balik geom3d. Zjistime, ze bod K v zadané roviné
nelezi.

Pitklad 4.53: Resfme analogicky piikladu 4.47. Afinni podprostor je tvofen tfemi linedrné
nezavislymi vektory, tzn. obecnd rovnice bude tvorena dvéma (=5-3) rovnicemi (matice A
bude mit dva linedrné nezavislé radky).

Piiklad 4.54: Obecnd rovnice roviny mé v R? tvar
a-r+b-y+c-z+d=0.
Dosazenim soutradnic jednotlivych bodu a nalezenim feseni urc¢ime hodnoty koeficientu a, b, ¢, d.

Piiklad 4.55: Resime analogicky pifkladu 4.49.

Priklad 4.56: Opét jsou dvé hlavni moznosti, jak postupovat: klasickym vypoctem, piipadné
pouZitim vhodného baliku pro geometrii: geometry pro R?, geom3d pro R3.

a) p a q jsou tataz piimka,
b) p a ¢ maji jeden spoleény bod,

¢) p a ¢ jsou mimobézné.

Priklad 4.59: Jestlize ¢(x) = A -z + b, pak musi platit: (M) = N, A-u; =uy a A- vy = vs.

Priklad 4.60: Staci spravné piepsat operaci skladani zobrazeni. Pokud v Maple definujeme
funkce nasledujicim zpusobem:

f:=(x,y)— Vector([2*x-y+1, x+y+3]); ,
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pak
(fog)(z,y) =1(glx,y) [1],g(x,y) [2]).

Priiklad 4.61: Jestlize ¢(x) = A-x+0b, pak jednoduse ziskdme vektor b, nebot b = ¢(M) = N.
Déle jisté zobrazeni ¢ prevede prusecik piimek pi,¢; na prusecik piimek po, ¢o. Nakonec je
tfeba si uvédomit, ze zobrazeni ¢ prevede normélovy (resp. smérovy) vektor piimky p; na
néjaky nasobek normélového (resp. smérového) vektoru pifmky pe. Totéz plati pro piimky
41 a qs.

Priklad 4.64: Postupujeme analogicky piikladu 4.63.
Priklad 4.65: Vyuzijeme poznamky 4.26.

Pifklad 4.68: Resfme analogicky pifkladu 4.67.
Pifklad 4.69: Resfme analogicky pifkladu 4.67.

Piiklad 4.70: Resfme opét podobné jako v predeslych piikladech. Po tpravé na diagonalni
tvar uréime signaturu, z niz také zjistime, ze vsechny kvadratické formy (a) — (c) jsou inde-
finitni.

Pifklad 4.71: Resime opét podobné jako v predeslych piikladech. Po tpravé na diagondlni
tvar urc¢ime signaturu, z niz také zjistime, ze vsechny kvadratické formy (a) — (c) jsou inde-
finitni.

Priklad 4.72: Staci si uvedomit, ze f(u,v) = > u; - v; je symetricka bilinedarni forma, jiz
i=1
pifslusnd kvadratickd forma g(u) = > u;? je pozitivné definitn.
i=1

Priklad 4.73: Podobné jako v pfedchozim piikladu staci ovérit, zda je zadané zobrazeni
symetrickou bilinearni formou a zda ji prislusné kvadraticka forma je pozitivné definitni:

a) g ((L _1)T7 (17 _1)T) = 07
b) bilinedarni forma neni symetricka,
¢) g ((0,1,0)7,(0,1,0)) =0,

d) bilinedrni forma neni symetrické.

Priklad 4.74:
a) Nejjednodussi je asi ovérit vlastnosti skaldrniho sou¢inu z poznamky 4.30.
b) V bazi {2, 2,1}: ¢ ((al,bl,cl)T, (a9, bQ,CQ)) = (a1, b1,c1)T - (ag, by, c2).

¢) V bazi {2% x,1}: g ((a1,b1, 1), (a2, b2, 2)) = a1 + bo. Staci ukdzat, ze se nejednd o
bilinearni formu.
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Piiklad 4.76: Piikazem Basis z baliku LinearAlgebra muzeme jednak ovéfit linearni nezavislost
zadanych vektoru, ale také je doplnit o vektory standardni baze a vybrat bazi celého prostoru
R*. Nakonec zbyva pouzit pifkaz GramSchmidt.

Priklad 4.77: Postup prakticky stejny jak u piikladu 4.76. Nakonec je tieba ortogonalni bazi
normalizovat, napt. piikazem LinearAlgebra[Normalize].

Priklad 4.78: Taktéz stejny postup jak v predchéazejicich prikladech.

Pifklad 4.81: Nejprve je tieba urcit ortogonalni doplnék, tj. V1, (analogicky, jak jsme to
delali v pifkladu 4.79), nasledné se najde kolméa projekce w do V+:

a) Pw=(2,2,-2, -2
b) Pw=(4,2,1,—1)7.

Piiklad 4.82: Resime analogicky pifkladu 4.79.
Piiklad 4.83: Resfme analogicky piikladu 4.79.
Pifklad 4.84: Resfme analogicky pifkladu 4.75.

Piiklad 4.85: Resime analogicky pifkladu 4.80. Jediny ,zadrhel* muze byt zaddni pod-
prostoru V' rovnici. Bazovy vektor podprostoru V' vsak ziskdame velice jednoduse, kdyz si
uvédomime, ze se jednd o piimku, v jejimz rovnicovém vyjadieni je zakomponovany jeji
normalovy vektor. Piikaz Student [LinearAlgebra] [ProjectionPlot] akceptuje i podpro-
stor zadany obecnou rovnici.

Piiklad 4.86: Resfme analogicky piikladu 4.85.

Pitklad 4.89: Redfme podobné jako pifklad 4.87. V pifpadé (b) je tfeba pfi pouziti pitkazu
extrema, piip. minimize, uvést predpoklad, ze fesime pouze v oblasti redlnych cisel.

V piipadeé (c) je mozné postupovat ,standardné“ tak, ze napfed odvodime parametrickou
rovnici nadroviny a dal postupujeme jak v predchozich piikladech. Kdyz si vsak uvédomime,
7e 7 obecné rovnice okamzité ziskdme norméalovy vektor (3,0,1,—1)T (ktery je kolmy na
nadrovinu), muzeme z bodu A a zminéného normélového vektoru vytvorit primku, na niz se
realizuje hledand vzdélenost. Pak uz sta¢i jen najit prusec¢ik piimky a nadroviny a spocitat
velikost. Vysledky:

a) p(A, M) =9,
b) p(A, M) = V3,
C) p(A’M) = \/ﬁ

Pitklad 4.90: Resfme podobné jako pifklad 4.88. Vysledky:
a) p(p,q) = 2 - V2,

b) p(p,q) = 13,
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¢) p(p,q) = 3.

Piiklad 4.91: Resime analogicky piikladu 4.87. V piipadé (a) je tieba odvodit parametrickou
rovnici roviny o. Piipad (b) je specificky tim, ze piimka p je rovnobézna s rovinou o. A proto
napiiklad piikaz extrema nenajde zadny extrém (vzdélenost je totiz v jistém smyslu ,stale”
stejnd). Vysledky:

a) p(p,o) =5,
b) p(p,o) = 3.

Pifklad 4.94: Resfme analogicky pifkladu 4.92. Vysledky:
a) ¢(p,o) =1,

b) p(p, o) =

w3

Priklad 4.95: Postupujeme podobné jako v predchozich ptikladech. Ke grafickému zobrazeni
(pripadné i vypoctu) muzeme pouzit balik geom3d.

a) staci zjistit odchylku smérovych vektoru primek p, ¢, vysledek: p(p, q) = 0.43(rad),

b) lze spocitat odchylku smérového vektoru piimky od normélového vektoru roviny; hle-
dand odchylka je doplnék pravé spocitané do 90 stupit (tj. do 7), vysledek: p(p, o) =
1.31(rad),

c¢) postup totozny s prikladem 4.94, vysledek: p(o,7) = arccos(%),

d) zékladem je uréeni normalového vektoru roviny o; nejjednodussim postupem je urécit
jej tzv. vektorovym soucinem (ktery jsme vSak v textu zatim nezminili) vektoru z
parametrické rovnice roviny, k ¢emuz slouzi piikaz LinearAlgebra[CrossProduct];
jinak lze, samoziejmeé, odvodit obecnou rovnici roviny o (standardné) a z ni urcit
normélovy vektor roviny; vysledek: p(o, 7) = 0.46(rad).

Priklad 4.97: Hledana rovina ma byt rovnobézna se zadanou, tj. bude mit stejny normalovy
vektor. To znamend, Ze staci urc¢it hodnotu d € R v rovnici roviny, kterd ma tvar: 3-x —2-y+
2z 4+ d = 0. Postup lze napriklad tak, ze zvolime libovolny bod na zadané roviné, sestrojime
v ném piimku kolmou na obé roviny (diky norméalovému vektoru rovin), uréime prunik s
hledanou rovinou a spoc¢itame vzdéalenost. Priklad m& dvé feseni.

Priklad 4.98: Aby odchylka rovin byla 30°, musi byt odchylka normalovych vektort rovin
rovna 30°. Staci proto najit vektor, ktery svird s vektorem (0,0,1)" thel 30°, tj. Z (rad).
Takovych vektort (a potazmo i rovin) je nekoneéné mnoho. Staéi najit libovolny (libovolnou)
z nich, tj. napt. rovinu: z +y + V6 -z =0.

Piiklad 4.99: Zpusobu feSeni je mnoho. Muzeme napiiklad vyuzit stejny postup jako v
pitkladu 4.97, éili najit rovinu majici od zadané vzdalenost v/6 (dvé feseni) a bod @ hledat
jako prunik nalezené roviny a zadané primky ¢. O spravnosti vysledku se muzeme presvédéit
napiiklad pouzitim piikazu distance z baliku geom3d.
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Priklad 4.102: Postupujeme analogicky jako v piikladech 4.100 a 4.101. Pro ovéteni definice
4.48 je tteba se presveédcit, ze A-u = X - u, jestlize A je matici linedrniho operatoru, A jeji
vlastni ¢islo a u prislusny vlastni vektor. Pro pripad (a) je naznaceno, jak ziskat soucin A -u
pro nékteré vlastni vektory.

a)

with( LinearAlgebra) : E := Matrix( 3. shape= identity) : (4) .P[..,1]=4.P] .., 1]
7 -12 6 NullSpace(4 — E) 7-12 6])[2 2
A:=1]10 -19 10 - 2 10 -19 10 || |1|=|1
12 -24 13 0.1 12-2413(/[0| |o
1 0
C, P = Eigenvectors(A) “(4).P[...3]=4.P]...3]
2 -1 1 NullSpace( A + E) 1 1
1 2 1 7-12 6 2
Ll o & 2 10 -19 10 5 (=] _5
-1 6 5 12 -24 13 6 6
01 1 6 1 -1
1
Obrdzek 6.37: Reseni piikladu 4.102.(a).
b) A1 = 2, alg. ndsobnost = 2, geom. nasobnost = 1; \y = —1, alg. i geom. ndsobnost = 1,
c) A1 = 2, alg. i geom. nasobnost = 3; Ay = —2, alg. i geom. nasobnost = 1,

d) A\ = 2, alg. ndsobnost = 4; geom. nasobnost = 2.

Priklad 4.103: Nejjednodussim piikladem je diagonalni matice s ¢isly 1,2, 3,4 na diagondle.

Priklad 4.104: Staci si uvédomit, ze vlastni ¢islo diagonalni matice mé stejnou algebraic-
kou i geometrickou ndsobnost, tj. podobné jako v predchozim piikladu muze byt odpoveédi
diagondlni matice s ¢isly 1,2 na diagonéle.

(o 3)

ma vlastni ¢islo 3 s algebraickou nasobnosti rovnou dvéma, ovsem jeho geometrickd nasobnost
je také dva. Pokud nevime, jak matici modifikovat, aby se zménila geometrickd nasobnost
vlastniho ¢isla, nabizi se vzit obecnou matici

(¢ a)

kde a, b, ¢, d jsou realna cisla. Nasledné vypocteme obecné vlastni ¢isla a uréime podminky,
za jakych budou vlastni ¢isla rovna tfem. Dosadime zpét do matice, ktera mé nyni tvar

_d+6 _M
)
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Pro ¢ # 0 ovérime, ze kazda takova matice ma vlastni ¢islo 3 algebraické nésobnosti dva
a geometrické ndsobnosti pouze jedna. I pro ¢ = 0 existuji pozadované matice, jsou to matice

(b 3)

Priklad 4.109: Je tfeba najit vlastni vektory. Pokud je linedrné nezavislych vlastnich vek-
toru tolik, jakd je dimenze zadané matice, je zadand matice podobna s diagonalni matici.
Zobrazeni ma pritom digondlni matici v bazi dané pravé vlastnimi vektory zadané matice.

tvaru

kde b # 0.
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